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Notice

EMERSON (“SELLER”) SHALL NOT BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS IN THIS MANUAL OR OMISSIONS FROM THIS
MANUAL. SELLER MAKES NO WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THIS MANUAL AND, IN NO EVENT, SHALL
SELLER BE LIABLE FOR ANY SPECIAL OR CONSEQUENTIAL DAMAGES INCLUDING, BUT NOT LIMITED TO, LOSS OF PRODUCTION,
LOSS OF PROFITS, ETC.

PRODUCT NAMES USED HEREIN ARE FOR MANUFACTURER OR SUPPLIER IDENTIFICATION ONLY AND MAY BE TRADEMARKS/
REGISTERED TRADEMARKS OF THESE COMPANIES.

THE CONTENTS OF THIS PUBLICATION ARE PRESENTED FOR INFORMATIONAL PURPOSES ONLY AND, WHILE EVERY EFFORT HAS
BEEN MADE TO ENSURE THEIR ACCURACY, THEY ARE NOT TO BE CONSTRUED AS WARRANTIES OR GUARANTEES, EXPRESSED OR
IMPLIED, REGARDING THE PRODUCTS OR SERVICES DESCRIBED HEREIN OR THEIR USE OR APPLICABILITY. WE RESERVE THE RIGHT
TO MODIFY OR IMPROVE THE DESIGNS OR SPECIFICATIONS OF SUCH PRODUCTS AT ANY TIME.

SELLER DOES NOT ASSUME RESPONSIBILITY FOR THE SELECTION, USE, OR MAINTENANCE OF ANY PRODUCT. RESPONSIBILITY FOR
PROPER SELECTION, USE, AND MAINTENANCE OF ANY SELLER PRODUCT REMAINS SOLELY WITH THE PURCHASER AND END-USER.

Warranty

1. LIMITED WARRANTY: Subject to the limitations contained in Section 2 herein and except as otherwise expressly provided
herein, Emerson (“Seller”) warrants that the firmware will execute the programming instructions provided by Seller and
that the Goods manufactured or Services provided by Seller will be free from defects in materials or workmanship under
normal use and care until the expiration of the applicable warranty period. Goods are warranted for twelve (12) months
from the date of initial installation or eighteen (18) months from the date of shipment by Seller, whichever period expires
first. Consumables and Services are warranted for a period of 90 days from the date of shipment or completion of the
Services. Products purchased by Seller from a third party for resale to Buyer (“Resale Products”) shall carry only the
warranty extended by the original manufacturer. Buyer agrees that Seller has no liability for Resale Products beyond
making a reasonable commercial effort to arrange for procurement and shipping of the Resale Products. If Buyer
discovers any warranty defects and notifies Seller thereof in writing during the applicable warranty period, Seller shall, at
its option, promptly correct any errors that are found by Seller in the firmware or Services, or repair or replace F.O.B. point
of manufacture that portion of the Goods or firmware found by Seller to be defective, or refund the purchase price of the
defective portion of the Goods/Services. All replacements or repairs necessitated by inadequate maintenance, normal
wear and usage, unsuitable power sources, unsuitable environmental conditions, accident, misuse, improper installation,
modification, repair, storage or handling, or any other cause not the fault of Seller are not covered by this limited
warranty, and shall be at Buyer's expense. Seller shall not be obligated to pay any costs or charges incurred by Buyer or any
other party except as may be agreed upon in writing in advance by an authorized Seller representative. All costs of
dismantling, reinstallation and freight, and the time and expenses of Seller's personnel for site travel and diagnosis under
this warranty clause shall be borne by Buyer unless accepted in writing by Seller. Goods repaired and parts replaced during
the warranty period shall be in warranty for the remainder of the original warranty period or ninety (90) days, whichever is
longer. This limited warranty is the only warranty made by Seller and can be amended only in a writing signed by an
authorized representative of Seller. Except as otherwise expressly provided in the Agreement, THERE ARE NO
REPRESENTATIONS OR WARRANTIES OF ANY KIND, EXPRESSED OR IMPLIED, AS TO MERCHANTABILITY, FITNESS FOR
PARTICULAR PURPOSE, OR ANY OTHER MATTER WITH RESPECT TO ANY OF THE GOODS OR SERVICES. It is understood
that corrosion or erosion of materials is not covered by our guarantee.

2. LIMITATION OF REMEDY AND LIABILITY: SELLER SHALL NOT BE LIABLE FOR DAMAGES CAUSED BY DELAY IN
PERFORMANCE. THE SOLE AND EXCLUSIVE REMEDY FOR BREACH OF WARRANTY HEREUNDER SHALL BE LIMITED TO
REPAIR, CORRECTION, REPLACEMENT, OR REFUND OF PURCHASE PRICE UNDER THE LIMITED WARRANTY CLAUSE IN
SECTION 1 HEREIN. IN NO EVENT, REGARDLESS OF THE FORM OF THE CLAIM OR CAUSE OF ACTION (WHETHER BASED IN
CONTRACT, INFRINGEMENT, NEGLIGENCE, STRICT LIABILITY, OTHER TORT, OR OTHERWISE), SHALL SELLER'S LIABILITY TO
BUYER AND/OR ITS CUSTOMERS EXCEED THE PRICE TO BUYER OF THE SPECIFIC GOODS MANUFACTURED OR SERVICES
PROVIDED BY SELLER GIVING RISE TO THE CLAIM OR CAUSE OF ACTION. BUYER AGREES THAT IN NO EVENT SHALL
SELLER'S LIABILITY TO BUYER AND/OR ITS CUSTOMERS EXTEND TO INCLUDE INCIDENTAL, CONSEQUENTIAL, OR PUNITIVE
DAMAGES. THE TERM “CONSEQUENTIAL DAMAGES” SHALL INCLUDE, BUT NOT BE LIMITED TO, LOSS OF ANTICIPATED
PROFITS, LOSS OF USE, LOSS OF REVENUE, AND COST OF CAPITAL.

Precautions and warnings

Note
The analyzer electronics and oven assembly, when housed inside a purged enclosure, meet the certifications and classifications
identified in the Specifications section of the this manual (see Equipment description and specifications) and in the Rosemount
700XA Product Data Sheet, which is located on the Rosemount website (Emerson.com/Rosemount). Emerson does not, however,
accept any responsibility for installations of these, or any attached equipment, in which the installation or operation thereof has
been performed in a manner that is negligent and/or non-compliant with applicable safety requirements.
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 WARNING

SAFETY COMPLIANCE

Install and operate all equipment as designed and comply with all safety requirements. The seller does not accept any
responsibility for installations of the Rosemount Gas Chromatograph or any attached equipment in which the installation or
operation thereof has been performed in a manner that is negligent and/or non-compliant with applicable safety requirements.

 WARNING

SAFETY COMPLIANCE

If the unit is not operated in a manner recommended by the manufacturer, the overall safety could be impaired.

 WARNING

SUPPLY MAINS CONNECTION

The unit is intended to be connected to supply mains by qualified personnel in accordance with local and national codes.

 WARNING

EXPLOSION HAZARD

Do not open when energized or when an explosive atmosphere is present.

 WARNING

EXPLOSION HAZARD

Keep cover tight while circuits are live.

 WARNING

EXPLOSION HAZARD

Use cables or wires suitable for the marked "T" ratings.

 WARNING

EXPLOSION HAZARD

Cover joints must be cleaned before replacing the cover.

 WARNING

EXPLOSION HAZARD

Conduit runs to GC enclosure must have sealing fitting adjacent to enclosure.

 WARNING

POWER

A suitable APPROVED switch and fuse or a circuit breaker shall be provided to facilitate the disconnection of mains power.
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 WARNING

VENTILATION

The unit is required to be used in a well ventilated area.

 WARNING

LEAK TESTING

All gas connections must be properly leak tested at installation.

 WARNING

PRECAUTIONARY SIGNS

Observe and comply with all precautionary signs posted on the GC. Failure to do so may result in injury or death to personnel or
cause damage to the equipment.

 WARNING

VENTILATION

If you plan to place the GC in a sealed shelter, always vent the GC to atmosphere with ¼-in. tubing or larger. This will prevent the
build up of H2 and sample gas

 WARNING

TOXIC VAPORS

Exit ports may discharge dangerous levels of toxic vapors.

Use proper protection and a suitable exhaust device.

 WARNING

BURN HAZARD

Some parts of the analyzer may be heated to 120 °C (248 °F).

To prevent burns, do not touch any of the hot parts. All parts of an analyzer are always hot unless it has been switched off and
allowed to cool down.

Before fitting, removing, or performing any maintenance on the analyzer, make sure that it ha been switched off and allowed
to cool for at least two hours.
When handling the analyzer, always use suitable protective gloves.
These precautions are particularly important when working at heights.
If burned, seek medical treatment immediately.

Failure to observe this warning could cause an explosion or potentially hazardous situation, which if not avoided, may cause
personal injury or death.

 CAUTION

REPLACEABLE PARTS

No user replaceable parts inside except a few parts which are only to be accessed by trained service personnel. All replacement
parts must be authorized by Rosemount to ensure product certification compliance.
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 WARNING

Physical access

Unauthorized personnel may potentially cause significant damage to and/or misconfiguration of end users’ equipment. This could
be intentional or unintentional and needs to be protected against.

Physical security is an important part of any security program and fundamental to protecting your system. Restrict physical access
by unauthorized personnel to protect end users’ assets. This is true for all systems used within the facility.

NOTICE

The Rosemount 700XA is CSA-certified and ATEX-certified. See the certification tag on the GC for specific details about its agency
approvals.

NOTICE

When the vapor regulators and flow switches are fitted, they must be suitably certified with the ratings Ex d IIC Gb T6/T4/T3 and
for a minimum ambient temperature range Ta = -4 °F to +140 °F (-20 °C to +60 °C).

NOTICE

Where right angle bend cable adapters are used, they shall be appropriately certified and shall interface with enclosures via
appropriate certified barrier glands.

 CAUTION

EQUIPMENT DAMAGE

If the GC is heated without carrier flow, damage to the columns may occur.

 CAUTION

WASTE DISPOSAL

Waste electrical and electronic products must not be disposed of with household waste. Please recycle where facilities exist.
Check with your local authority or retailer for recycling advice.
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1 Overview
This section provides a description of the Rosemount 700XA system, an explanation of the
theory of operation, and a glossary of chromatograph terminology.
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1.1 Glossary
Auto zero The thermal conductivity detector (TCD) is auto zeroed at the start of

a new analysis. The operator can also configure automatic zeroing of
the TCD amplifier to take place at any time during the analysis if the
component is not eluting or the baseline is steady. The flame
ionization detector (FID) will auto zero at each new analysis run and
can be configured to auto zero anytime during the analysis if the
component is not eluting or the baseline is steady.

Baseline Signal output when there is only carrier gas going across the
detectors. In a chromatogram you should only see Baseline when
running an analysis without injecting a sample.

Carrier gas The gas used to push the sample through the system during an
analysis.

Chromatogram A permanent record of the detector output. A chromatogram is
obtained from a personal computer (PC) interfaced with the detector
output through the controller assembly. A typical chromatogram
displays all component peaks, and gain changes. It may be viewed in
color as it is processed on a PC display. Tick marks recorded on the
chromatogram by the controller assembly indicate where timed
events take place.

Component Any one of several different gases that may appear in a sample
mixture. For example, natural gas usually contains the following
components: nitrogen, carbon dioxide, methane, ethane, propane,
isobutane, normal butane, isopentane, normal pentane, and hexanes
plus.

CDT Component data table

CTS Clear to send.

DCD Data carrier detect.

DSR Data set ready.

DTR Data terminal ready.

FID Flame ionization detector. The optional FID may be used in place of a
TCD for the detection of trace compounds. The FID requires a
polarization voltage and its output is connected to the input to a high
impedance amplifier, an electrometer. The sample of gas to be
measured is injected into the burner with a mixture of hydrogen and
air to maintain the flame.

FPD Flame photometric detector. The FPD is used to analyze gas
compound impurities, such as sulfur, phosphorous, and metals. When
sample gas passes through the hydrogen/air flame the component's
wavelengths emitted are electrically measured. The micro FPD (µFPD)
is located in the analyzer's upper enclosure.

GC Gas ghromatograph. The GC is a user-configurable analyzer for various
process gas applications.

Overview Reference Manual
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LSIV Liquid sample injection valve. The optional LSIV is used to convert a
liquid sample to a gas sample by vaporizing the liquid in a heated
chamber, so the resulting gas sample can be analyzed.

Methanator The optional methanator, also known as a catalytic converter,
transforms the components that are undetectable by the FID, carbon
dioxide and/or carbon monoxide, into methane by adding hydrogen
and heat to the sample.

Note
Carbon dioxide and/or carbon monoxide components are detectable
by the TCD.

Response factor Correction factor for each component as determined by the following
calibration:

Retention time Time, in seconds, that elapses between the start of analysis and the
sensing of the maximum concentration of each component by the
detector.

RI Ring indicator.

RLSD Received line signal detect. A digital simulation of a carrier detect.

RTS Request to send.

RxD, RD, or Sin Receive data, or signal in.

TCD Thermal conductivity detector. A detector that uses the thermal
conductivity of the different gas components to produce an
unbalanced signal across the bridge of the preamplifier. The higher the
temperature, the lower the resistance on the detectors.

TxD, TD, or Sout Transmit data, or signal out.

1.2 System description
The Rosemount 700XA is a high-speed gas chromatograph (GC) system that is engineered
to meet specific field application requirements based on typical hydrocarbon stream
composition and anticipated concentration of selected components. In its standard
configuration, the analyzer can handle up to eight streams: seven sample streams and one
calibration stream.

The Rosemount 700XA system consists of two major parts: the analyzer assembly and the
electronics assembly. Depending upon the particular GC, there may also be a third,
optional, assembly called the sample conditioning system (SCS).

The electronics and hardware are housed in an explosion-proof enclosure that meets the
approval guidelines of various certification agencies for use in hazardous environments.
See the certification tag on the GC for specific details about agency approvals.
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1.2.1 Analyzer assembly
The analyzer assembly includes:

• Columns

• Thermal conductivity detectors (TCDs)

• Flame ionization detectors (FIDs)

• Flame photometric detector (FPD)

• Preamplifer

• Preamplifier power supply

• Stream switching valves

• Analytical valves

• Solenoids

Additionally, the Rosemount 700XA can be equipped with a liquid sample injection valve
(LSIV) or methanator.

For more information, see Upper compartment.

1.2.2 Electronics assembly
The electronics assembly includes the electronics and ports necessary for signal
processing, instrument control, data storage, personal computer (PC) interface, and
telecommunications.

The operator uses the electronics assembly and MON2020 to control the gas
chromatograph (GC). Refer to Electronics hardware for more details.

The GC-to-PC interface provides you with the greatest capability, ease-of-use, and
flexibility. You can use MON2020 to edit applications, monitor operations, calibrate
streams, and display analysis chromatograms and reports, which can then be stored as
files on the PC’s hard drive or printed from a printer connected to the PC.

 WARNING

HAZARDOUS AREA EXPLOSION HAZARD

Failure to follow this warning may result in injury or death to personnel.

Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial and Ethernet communication links to connect the analyzer to
the PC and to connect to other computers and printers in a safe area.

1.2.3 Sample conditioning system (SCS)
The optional sample conditioning system is located between the process stream and the
sample inlet, which is often mounted below the gas chromatograph (GC).

The standard SCS configuration includes a stream switching system and filters.
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1.3 Functional description
A sample probe installed in the process line takes a sample of the gas to be analyzed from
the process stream. The sample passes through a sample line to the sample conditioning
system (SCS) where it is filtered or otherwise conditioned. After conditioning, the sample
flows to the analyzer assembly for separation and detection of the gas components.

Figure 1-1: Gas Chromatography Process Model

A. Process line
B. Probe
C. Sample system
D. Chromatograph oven
E. Gas chromatograph (GC) controller
F. Sample return
G. Slip stream
H. Carrier gas

I. Reference vent
J. Detector vent

K. Analysis results

Separation and analysis

The GC separtes the sample gas into its components as follows:

1. A precise volume of sample gas is injected into one of the analytical columns. The
column contains a stationary phase (packing) that is either an active solid or an inert
solid support that is coated with a liquid phase (absorption partitioning).

2. A mobile phase (carrier gas) moves the sample gas through the column.

3. The selective retardation of the components takes place in the column, causing
each component to move through the column at a different rate. This separates the
sample into its constituent gases and vapors.
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4. A detector located at the outlet of the analytical column senses the elution of
components from the column and produces electrical outputs proportional to the
concentration of each component.

Output from the electronic assembly is normally displayed on a remotely located personal
computer (PC) or in a distributed control system (flow computer).

To connect the GC to a PC, use a direct serial line, an optional Ethernet cable, or a
Modbus®-compatible communication interface.

Several chromatograms may be displayed via MON2020 with separate color schemes,
allowing you to compare present and past data.

In most cases, it is essential to use MON2020 to configure and troubleshoot the GC. The
PC may be remotely connected via Ethernet, telephone, radio or satellite
communications. Once installed and configured, the GC can operate independently for
long periods of time.

1.4 Software description
The GC uses two distinct types of software. This enables total flexibility in defining the
calculation sequence, report content, format, type and amount of data for viewing,
control, and/or transmission to another computer or controller assembly. The two types
are:

• Embedded GC firmware

• MON2020 software

The application configuration is tailored to the customer’s process and shipped on a USB
stick. The hardware and software are tested together as a unit before the equipment
leaves the factory.

MON2020 communicates with the GC and can be used to initiate site system setup, i.e.,
operational parameters, application modifications, and maintenance.

1.4.1 Embedded GC firmware
The GC’s embedded firmware supervises operation of the Rosemount 700XA through its
internal microprocessor-based controller. All direct hardware interface is via this control
software. It consists of a multi-tasking program that controls separate tasks in system
operation, as well as hardware self-testing, user application downloading, startup, and
communications. Once configured, the Rosemount 700XA can operate as a stand alone
unit.
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1.4.2 MON2020
MON2020 provides operator control of the Rosemount 700XA, monitors analysis results,
and inspects and edits various parameters that affect the analyzer operation. It also
controls display and printout of the chromatograms and reports, and it stops and starts
automatic analysis cycling or calibration runs.

After the equipment/software has been installed and the operation stabilized, automatic
operation takes place over an Ethernet network.

MON2020 is a Windows™-based program that allows you to maintain, operate, and
troubleshoot a gas chromatograph (GC). Individual GC functions that can be initiated or
controlled by MON2020 include, but are not limited to, the following:

• Valve activations

• Timing adjustments

• Stream sequences

• Calibrations

• Baseline runs

• Analyses

• Halt operation

• Stream/detector/heater assignments

• Stream/component table assignments

• Stream/calculation assignments

• Diagnostics

• Alarm and event processing

• Event sequence changes

• Component table adjustments

• Calculation adjustments

• Alarm parameters adjustments

• Analog scale adjustments

• Local operator interface (LOI) variable assignments (optional)

Reports and logs that can be produced, depending upon the GC application in use,
include, but are not limited to, the following:

• Configuration report

• Parameter list

• Analysis chromatogram

• Chromatogram comparison

• Alarm log (unacknowledged and active alarms)

• Event log
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• Various analysis reports

For a complete list of the GC functions, reports, and logs available through MON2020,
consult the MON2020 for Gas Chromatographs Reference Manual (P/N 2-3-9000-745).

1.5 Theory of operation
The following sections discuss the theory of operation for the gas chromatograph,
including the engineering principles and concepts used.

Note
See Glossary for definitions of the terminology used in this document.

1.5.1 Thermal conductivity detector (TCD)
One of the detectors available on the gas chromatograph (GC) is a TCD, which consists of a
balanced bridge network with heat sensitive thermistors in each leg of the bridge. Each
thermistor is enclosed in a separate chamber of the detector block.

One thermistor is designated the reference element, and the other thermistor is
designated the measurement element. See Figure 1-2 for a schematic diagram of the TCD.
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Figure 1-2: Analyzer Assembly with TCD Bridge

A. Detector block (in heated upper section of analyzer)
B. Reference flow (carrier gas)
C. Measurement flow ("MV")
D. Signal out
E. Preamplifier (in analyzer electronics housing)
F. Detector bridge
G. DC power
H. Valves, columns, etc.

In the quiescent condition, prior to injecting a sample, both legs of the bridge are exposed
to pure carrier gas. In this condition, the bridge is balanced, and the bridge output is
electrically nulled.

The analysis begins when the sample valve injects a fixed volume of sample into the
column. The continuous flow of carrier gas moves the sample through the column. As
successive components elute from the column, the temperature of the measurement
element changes.

The temperature change unbalances the bridge and produces an electrical output
proportional to the component concentration.

The differential signal developed between the two thermistors is amplified by the
preamplifier. Figure 1-3 illustrates the change in detector electrical output during elution
of a component.
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Figure 1-3: Detector Output during Component Elution

A. Detector bridge balanced
B. Component begins to elute from column and is measured by thermistor.
C. Peak concentration of component

In addition to amplifying the differential signal developed between the two thermistors,
the preamplifier supplies drive current to the detector bridge.

The signal is proportional to the concentration of a component detected in the gas
sample. The preamplifier provides four different gain channels as well as compensation for
baseline drift.

The signals from the preamplifier are sent to the electronic assembly for component
concentration computation, recording, or viewing on a PC monitor with MON2020.

1.5.2 Flame ionization detector (FID)
Another detector available for the Rosemount 700XA is the flame ionization detector
(FID).

The FID requires a polarization voltage, and its output is connected to the input to a high
impedance amplifier that is called an electrometer. The burner uses a mixture of hydrogen
and air to maintain the flame. The sample of gas to be measured is also injected into the
burner. See Figure 1-4 for a schematic diagram of the FID.
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Figure 1-4: Analyzer Assembly with FID Detector Bridge

A. Polarizing voltage
B. Electrometer
C. Signal out
D. Sample/hydrogen (H2)
E. Air

1.5.3 Micro flame photometric detector (µFPD) burner
The flame photometric detector (FPD) is a very sensitive and selective detector for the
analysis of sulfur or organophosphorus containing compounds. The detector is very stable
and easy to use.

As the analyte is burned in a hydrogen and air flame, a characteristic wavelength of light is
emitted at 394 nm for sulfur. The emitted light is amplified by the photomultiplier tube
(PMT) and processed by the signal processor. The response to phosphorus is linear and
quadratic to sulfur.

The Emerson µFPD solution consists of three key parts: burner, fiber cable, and PMT
electronics. The hydrogen and air in the burner help to burn the sample containing sulfur
components. The light emitted from the chemical reaction is then transmitted using the
fiber cable from the oven assembly to the electronics module. The PMT electronics
module consists of a 394 nm filter, a photomultiplier tube (PMT), and all the necessary
electronics to digitize the signal. The digtial signal is then transmitted to the main central
processing unit (CPU) using CAN bus.
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Figure 1-5: µFPD Detector - Front View

A. µFPD burner
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Figure 1-6: µFPD Burner - Back View

A. µFPD burner
B. Fiber cable
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Figure 1-7: µFPD Burner - Side View

A. µFPD burner and cable
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Figure 1-8: µFPD PMT

A. µFPD PMT in the upper enclosure

The detection system in the µFPD uses the reactions of sulfur components in a
hydrogen/air flame as a source for analytical detection. The source of the µFPD's signal is
derived from the light produced by an excited molecule created in the flame's
combustion, that is, a photochemical process called chemiluminescence. A thermocouple
is fitted to the flame cell to ensure that the flame is present. If the flame is not detected,
the electrometer shuts off the hydrogen to the flame cell. It then supplies a voltage to the
igniter, waits five seconds, and opens the hydrogen shut off valve. The electrometer will
make between one and five ignition attempts if necessary. You can select the number of
ignition attempts on the Hardware → Detector screen. If the electrometer does not
succeed in igniting, then the GC shuts off the hydrogen, triggers an alarm, and waits for
attention from the operator.

Related information

Micro flame photometric detector (µFPD)

1.5.4 Micro flame photometric detector (µFPD) electronics
module
The electronics module contains two chambers. The internal chamber contains the photo
multiplier tube (PMT) to insulate it from outside temperature changes. The external
chamber is a thermo electric cooler (TEC) controlled chamber, which houses the interal
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chamber along with the electronic board that generates high voltage power through the
PMT.

Figure 1-9: Electronics Module, Exploded View

A. Apply thermal compound to both sides.
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Figure 1-10: Electronics Module, Detailed

A. Maier photonics filter
B. O-ring

On the outside of the external chamber is the electronics main board. This board is the
vital part of the µFPD electronics module. It controls the temperature of the TEC, provides
power to the igniter, monitors the flame temperature, and digitizes the PMT signal and
transmits to the main central processing unit (CPU) using CAN bus.
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1.5.5 Liquid sample injection valve (LSIV)
The optional LSIV converts a liquid sample into a gas sample for analysis.

Figure 1-11: Liquid Sample Injector Valve (LSIV)

1.5.6 Methanator
After all other components have been separated from the sample, carbon monoxide and
carbon dioxide, which are normally present in quantities too small to be detected by the
gas chromatograph (GC), can be sent through the optional methanator, where the two
gases are combined with hydrogen to make methane in a heat-generated catalytic
reaction. The methanator is also known as a methanizer or a catalytic converter.

1.5.7 Data acquisition
Every second, the controller assembly takes exactly 50 equally spaced data samples (i.e.,
one data sample every 20 milliseconds).

As a part of the data acquisition process, groups of incoming data samples are averaged
together before the result is stored for processing. Non-overlapping groups of 50 samples
are averaged and stored, and thus reduce the effective incoming data rate to 50/10
samples per second. For example, if N = 5, then a total of 40/5 or 8 (averaged) data
samples are stored every second.

The value for the variable N is determined by the selection of a peak width parameter
(PW). The relationship is

N = PW

where PW is given in seconds. Allowable values of N are 1 to 63; this range corresponds to
PW values of 2 to 63 seconds.

The variable N is known as the integration factor. This term is used because N determines
how many points are averaged, or integrated, to form a single value. The integration of
data upon input, before storing, serves two purposes:
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• The statistical noise on the input signal is reduced by the square root of N. In the case of
N = 4, a noise reduction of 2 would be realized.

• The integration factor controls the bandwidth of the chromatograph signal. It is
necessary to match the bandwidth of the input signal to that of the analysis algorithms
in the controller assembly. This prevents small, short-duration perturbations from
being recognized as true peaks by the program. It is therefore important to choose a
peak width that corresponds to the narrowest peak in the group under consideration.

1.5.8 Peak detection
For normal area or peak height concentration evaluation, the determination of a peak's
start point and end point is automatic.

The manual determination of start and end points is used only for area calculations in the
Forced Integration mode. Automatic determination of peak onset or start is initiated
whenever Integrate Inhibit is turned off. Analysis is started in a region of signal quiescence
and stability, such that the signal level and activity can be considered as baseline values.

Note
The controller assembly software assumes that a region of signal quiescence and stability
will exist.

Having initiated a peak search by turning Integrate Inhibit off, the controller assembly
performs a point by point examination of the signal slope. This is achieved by using a
digital slope detection filter, a combination low pass filter and differentiator. The output is
continually compared to a user-defined system constant called Slope Sensitivity. A default
value of 8 is assumed if no entry is made. Lower values make peak onset detection more
sensitive, and higher values make detection less sensitive. Higher values (20 to 100) would
be appropriate for noisy signals, (e.g., high amplifier gain).

Onset is defined where the detector output exceeds the baseline constant, but peak
termination is defined where the detector output is less than the same constant.

Sequences of fused peaks are also automatically handled. This is done by testing each
termination point to see if the region immediately following it satisfies the criteria of a
baseline. A baseline region must have a slope detector value less than the magnitude of
the baseline constant for a number of sequential points. When a baseline region is found,
this terminates a sequence of peaks.

A zero reference line for peak height and area determination is established by extending a
line from the point of the onset of the peak sequence to the point of the termination. The
values of these two points are found by averaging the four integrated points just prior to
the onset point and just after the termination points, respectively.

The zero reference line will, in general, be non-horizontal, and thus compensates for any
linear drift in the system from the time the peak sequence starts until it ends.

In a single peak situation, peak area is the area of the component peak between the curve
and the zero reference line. The peak height is the distance from the zero reference line to
the maximum point on the component curve. The value and location of the maximum
point is determined from quadratic interpolation through the three highest points at the
peak of the discrete value curve stored in the controller assembly.
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For fused peak sequences, this interpolation technique is used both for peaks, as well as
valleys (minimum points). In the latter case, lines are dropped from the interpolated valley
points to the zero reference line to partition the fused peak areas into individual peaks.

The use of quadratic interpolation improves both area and height calculation accuracy and
eliminates the effects of variations in the integration factor on these calculations.

For calibration, the controller assembly may average several analyses of the calibration
stream.

1.5.9 Basic analysis computations
Two basic analysis algorithms are included in the controller assembly:

Area Analysis Calculates area under component peak.

Peak Height Analysis Measures height of component peak.

Note
MON2020 can perform a variety of other calculations. For more information, see the
MON2020 Software for Gas Chromatographs Reference Manual.

Concentration analysis - response factor
Concentration calculations require a unique response factor for each component in an
analysis. These response factors may be manually entered by an operator or determined
automatically by the system through calibration procedures (with a calibration gas
mixture that has known concentrations).

The response factor calculation, using the external standard, is:

where

ARFn Area response factor for component n in area per mole percent

Arean Area associated with component n in calibration gas

Caln Amount of component n in mole percent in calibration gas

Htn Peak height associated with component n mole percent in calibration gas

HRFn Peak height response factor for component n

The controller assembly stores calculated response factors to use in the concentration
calculations; these response factors are printed out in the configuration and calibration
reports.

Average response factor is calculated as follows:
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where

RFAVGn Area or height average response factor for component n

RFi Area or height average response factor for component n from the calibration
run

k Number of calibration runs used to calculate the response factors

The percent deviation of new RF averages from old RF average is calculated in the following
manner:

where the absolute value of percent deviation has been previously entered by the
operator.
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Concentration calculation - mole percentage (without
normalization)
After response factors have been determined by the controller assembly or entered by the
operator, component concentrations are determined for each analysis by using the
following equations:

where:

ARFn Area response factor for component n in area per mole percent

Arean Area associated with component n in unknown sample

CONCn Concentration of component n in mole percent

Htn Peak height associated with component n mole percent in unknown sample

HRFn Peak height response factor for component n

Component concentrations may also be input through analog inputs 1 to 4 or may be
fixed. If a fixed value is used, the calibration for that component is the mole percent that
will be used for all analyses.

Concentration calculation in mole percentage (with
normalization)
The normalized concentration calculation is:

where:

CONCNn Normalized concentration of component n in percent of total gas
concentration

CONCi Non-normalized concentration of component n in mole percent for each k
component

CONCn Non-normalized concentration of component n in mole percent

k Number of components to be included in the normalization

Note
The average concentration of each component will also be calculated when data
averaging is requested.
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2 Equipment description and
specifications

2.1 Equipment description
The Rosemount 700XA consists of a copper-free aluminum explosion-proof chamber and
a front panel assembly. The chamber is divided into two compartments that together
house the gas chromatograph's (GC's) major components. This GC is designed for
hazardous locations.

Figure 2-1: Rosemount 700XA Gas Chromatograph

A. Upper compartment
B. Lower compartment
C. Front panel assembly
D. Mechanical regulators
E. Sampling system (optional)
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2.1.1 Front panel assembly
The front panel assembly is located on the front section of the lower enclosure and
consists of a removable, explosion-proof panel that shields either a switch panel or a local
operator interface (LOI).

Figure 2-2: 8-stream switch panel (left) and 18-stream switch panel (right)

Switch panel
The switch panel contains a network of on/off switches that allow you to manually control
the GC’s stream and analytical valves.

Figure 2-3: 8-stream Switch Panel

There are two types of switch panels: 8-stream and 18-stream. The 8-stream switch panel
is the standard panel, and is used when the GC has only one heater/solenoid board
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installed; if two heater/solenoid boards are installed, then the 18-stream switch panel is
used.

Figure 2-4: Stream Valves Switches

A valve has the following three operational modes:

• AUTO - The valve turns on and off according to the Timed Events table that is
accessible through MON2020. To set a valve to AUTO mode, set its switch on the switch
panel to the up position.

• OFF - The valve turns off and remains off until the operational mode is changed. To set
a valve to OFF mode, set its switch on the switch panel to the center position—that is,
the switch is neither flipped up nor down.

• ON - The valve turns on and remains on until the operational mode is changed. To set a
valve to ON mode, set its switch on the switch panel to the down position.

Figure 2-5: Status LEDs (Top of switch panel)

The switch panels also contain the following status lights that allow you to monitor the
GC’s condition:

• Working - Turns green when the GC is in analysis mode.

• Unack. Alarm - Turns yellow if there is an unacknowledged alarm.

• Active Alarm - Turns red if there is an active alarm.

• FID/FPD - status is detected by MON2020

— status is indicated in MON2020

— flame can be ignited remotely using MON2020 or manually lit

Figure 2-6: MON2020 Status Indicators
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• Figure 2-7: Status LEDs (Bottom of switch panel)

CPU - Green light blinks continuously while the GC is running.

• Valves - Turns green if the valves are functioning automatically; turns red if the valves’
automatic settings have been overridden.

Note
During GC start up, all LEDs turn on for approximately ten seconds.
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Local operator interface
The optional local operator interface (LOI) gives you in-depth control over the GC’s
functions. It has a high resolution color display that is touch key activated and allows you
to operate the GC without a laptop or a PC.

Figure 2-8: Local operator interface

The LOI includes the following features:

• Color LCD display with VGA (640 x 480 pixels) resolution

• ASCII text and graphics modes

• Adjustable auto-backlighting

• 8 infrared-activated touch screen keys that eliminate the requirement for a magnetic
pen

• Complete GC status, control, and diagnostics, including full chromatogram display

See Local operator interface (LOI) for more information about operating the LOI.
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2.1.2 Upper compartment
The upper compartment contains the following components:

Valves There are two types of XA valves: 6-port and 10-port. A GC can
have a maximum of six XA valves consisting of a maximum of
four 10-port valves.

Column module Either capillary or micro-packed.

Thermal conductivity
detector (TCD)

The GC has a maximum of two TCDs as well as a micro flame
photometric detector (µFPD), or a flame ionization detector
(FID).

Two heating
elements

A top hat heater and a column heater.

One temperature
switch for each
heating element

The switch turns off its heating element if the heating element
reaches 257 °F (160 °C).

Pressure switch The pressure switch activates when the carrier pressure falls
below a predetermined set point. When activated, the switch
triggers a general alarm that displays on the front panel or local
operator interface (LOI) and in MON2020.

Flame ionization
detector (FID)

The optional FID detects trace levels of hydrocarbons.

Micro flame
photometric detector
(µFPD)

The optional integral µFPD detects trace levels of sulfur
compounds. For more information, refer to Micro flame
photometric detector (µFPD).

Methanator The methanator, or catalytic converter, is an optional
component that converts otherwise undetectable carbon
dioxide and/or carbon monoxide into methane by adding
hydrogen and heat to the sample.

Liquid sample
injection valve (LSIV)

The optional LSIV can vaporize a liquid sample, thereby
expanding the GC’s capability to measure liquids.

Equipment description and specifications Reference Manual
July 2020 2-3-9000-744

36 Emerson.com/Rosemount



2.1.3 Lower compartment
The lower compartment consists of the following components:

• Backplane. The backplane is the GC’s central printed circuit board (PCB). Its main
function is as a connection point for the GC’s specialized plug-in PCBs. The backplane
also hosts connections for analog outputs and analog inputs, serial ports and an
Ethernet port.

• Card cage. The card cage holds the specialized PCBs that plug into the backplane. The
following PCBs are housed in the card cage:

— Preamp board

— CPU board

— Base I/O board

— Heater/Solenoid board
The card cage also has four additional slots for the following optional PCBs:

— A second preamp board

— A second heater/solenoid board

— Two optional communications boards

 WARNING

EXPLOSION
The explosion-proof housing should not be opened when the unit is exposed to an
explosive environment. If access to the explosion-proof housing is required, take
precautions to ensure that an explosive environment is not present. Failure to do so
may result in injury or death to personnel or cause damage to the equipment.

• Optional AC/DC power supply.

 WARNING

POWER
See power supply label prior to connection. Check the unit power design to determine
if it is equipped for AC or DC power. Applying 110/220 Vac to a DC power input unit
severely damages the unit. Failure to check the power supply label may result in injury
or death to personnel or cause damage to the equipment.

Note
The Rosemount 700XA CSA-certified unit is equipped with 3/4-inch NPT-thread
adapters.
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2.1.4 Mechanical pressure regulators
The mechanical pressure regulators and gauges are used to set and monitor the pressure
of the carrier gas flow through the GC's columns, as well as the pressure of the FID/FPD air
and fuel (H2), if installed.

The regulators and gauges are typically located on front of the analyzer below the
electronics enclosure.

Figure 2-9: Regulators and Gauges
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2.2 Specifications
Table 2-1: Utility Specifications

Type Specification

Dimensions (without sampling
system)

H x W x D: 50 x 40 x 24 in. (127 x 102 x 61 cm)

Weight (without sampling system) Approximately 150 lb. (68 kg)

Mounting • Wall mount (standard)

• Free-standing (optional)

Power • 115 Vac ±10 %

• 220 Vac ±10 %

• 50/60 Hz 400 watts running

• 250 watts start-up

Valve actuation • Sample gas: 90 psig (620.5 kPa) maximum

• Carrier gas: 90 psig (620.5 kPa) maximum

• Actuation gas: 110 psig (758.4 kPa) maximum

Environment Thermal conductivity detector (TCD): -4 to 140 °F (-20 to 60 °C)

Flame ionization detector (FID): 32 to 140 °F (0 to 60 °C)

Flame photometric detector (FPD): 32 to 122 °F (0 to 50 °C)

Hazardous area certifications
(hardware dependent)

USA and Canada

• Class I, Zone 1, Ex/AEx db IIC, Gb T6/T4/T3

• Class I, Division 1, Groups B, C, and D, IP66

EU ATEX and IECEx

• Ex db IIC Gb T6/T4/T3

• Ta = -20 ℃ to 60 ℃

• SIRA 08ATEX 1328X

• IECEx SIR 08.0093X

Consult factory for additional product certifications available.

Table 2-2: Approval Temperature Ratings

T6 Basic system; no alternative options included

T4 Liquid sample injection valve (LSIV) option included

T4 Heat trace option with a maximum 176 ° F (80 ⁰C) temperature switch setpoint

T3 Heat trace option with a maximum 230 °F (110 ⁰C) temperature switch setpoint
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2.2.1 Analyzer specifications
Type Specification

Dimensions • Basic unit envelope

Width: 15.2 in. (387 mm)
Height: 41.5 in. (1054 mm)
Depth: 19.2 in. (488 mm)

• Wall mount

Width: 18.2 in. (463 mm)
Height: 41.5 in.(1054 mm)
Depth: 19.2 in. (488 mm)

• Pole mount

Width: 18.2 in. (463 mm)
Height: 41.5 in. (1054 mm)
Depth: 25.0 in.(635 mm)

• Floor mount

Width: 18.2 in. (463 mm)
Height: 58.0 in. (1470 mm)
Depth: 19.2 in. (488 mm)

Note
Allow 14 in. (360 mm) additional clearance for removal of dome.

Weight • Wall mount : 110 lb. (59 kg)

• Pole mount: 135 lb. (61 kg)

• Floor mount: 180 lb. (82 kg)

Tubing • 316 stainless steel

• 316 stainless steel and Kapton® in contact with sample

• Sulfinert® steel (optional)

Mounting • Floor mount

• Pole mount:

— 2 in. (60.3 mm)

— 3 in. (89.0 mm)

— 4 in. (114.3 mm)

• Direct wall mount

Power • Standard: 24 Vdc (21-30 Vdc operating voltage range); maximum 150 watts

• Optional: 100-120/240 Vac; 50-60 Hz

Note
Voltage range includes line voltage variations.
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2.2.2 Electronics hardware
Type Specifications

Communications (standard) • Analog inputs:
— Two standard 4-20 mA inputs filtered with transient protection

• Analog outputs:
— Six isolated outputs, 4–20 mA

• Serial communication ports:
— Three termination blocks

— Configurable as RS-232, RS-422, or RS-485

— One D-sub (9-pin) port for PC connection

• Digital inputs:
— Five inputs, user assignable

— Optically isolated, rated to 30 Vdc at 0.5 A

• Digital outputs:
— Five outputs, user assignable

— Form C and electro-mechanically isolated, 24 Vdc

Communications (options) Four expansion slots available for additional communications. Each slot has the
capacity to add one of the following:
• Four analog inputs (isolated) card

• Four analog outputs (isolated) card

• Eight digital inputs (isolated) card

• Five digital outputs (isolated) card

• One RS-232, RS-422, or RS-485 serial connection card (up to two maximum)

Ethernet Two available connections
• one RJ45 port

• one four-wire termination – with 10/100 Mbps
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2.2.3 Airless analytical oven
Type Specification

Valves 6-port and 10-port XA valves; piston-operated diaphragms with pneumatic
actuation

Columns Maximum of 90 ft. (27.4 m) of micro-packed columns; 1/16-inch (1.6 mm) outside
diameter

or

300 ft (91.4 m) of capillary columns

Solenoid actuation • 24 Vdc

• Max 100 psig (6.9 bar)

Temperature control • 24 Vdc

• 2 heaters

• 2 optional heaters

• Maximum oven operating temperature of 302 °F (150 °C)

2.2.4 Software
Type Specification

Software Windows™-based MON2020™

Firmware Embedded firmware

Methods 8 timed event tables and 8 component data tables

Analysis clocks Multiple analysis clock configurations

Peak Integration • Fixed time or auto slope and peak identification

• Update retention time upon calibration or during analysis

Cyber security Encrypted SSL communication between gas chromatograph (GC) and MON2020

2.2.5 Corrosion protection
Type Specification

Enclosure material Copper-free and aluminum-coated with industrial grade powder coat suitable for
high humidity and salt-laden environments

Process wetted materials Stainless steel; if the function of an item excludes the use of stainless steel, such as
the glass rotameter tubes, materials that are resistant to corrosion are used

Electronics All electronic circuit boards are tropicalized with a clear conformal coating
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2.2.6 Archived data storage capabilities
Type Maximum number of records

Analysis results 86,464 (240 days with 4-minute cycle time)

Final calibration results 370

Calibration results 100 (per row in Analysis Configuration table)

Final validation results 370 (per row in Analysis Configuration table)

Validation results 100 (per row in Analysis Configuration table)

Analysis chromatograms 1,703

Final calibration chromatograms 370 (per row in Analysis Configuration table)(1)

Final validation chromatograms 370 (per row in Analysis Configuration table)(1)

Protected chromatograms 100

Hourly averages
(up to 256 variables(2))

2,400

Daily averages
(up to 256 variables) (2)

365

Weekly averages
(up to 256 variables)(2)

58

Monthly averages
(up to 256 variables)(2)

12

Variable averages
(up to 256 variables)(2)

2,360

Every run
(up to 256 variables)

2,360

Alarm logs 1,000

Event logs 1,000

(1) The gas chromatograph (GC) can store final calibration or final validation chromatograms for up to one year, provided
that no more than one calibration or validation is run per day, and the cycle time is less than 15 minutes. If the cycle
time exceeds 15 minutes, the oldest final calibration or validation chromatograms will be deleted to make room for
newer ones.

(2) A total of 256 averages, including hourly, daily, weekly, monthly, variable, and every run averages are archived.

2.2.7 Certifications and approvals
The Rosemount 700XA has the following certifications and approvals.

Refer to the Rosemount 700XA product pagefor product certificates and approvals. Follow
all safety markings on the analyzer.
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Type Specifications

Environment Operating temperature

• Thermal conductivity detector (TCD): 0 to 130 °F (-18 to 55 °C)

• Flame ionization detector (FID): 32 to 140 °F (0 to 60 °C)

• Micro flame photometric detector (µFPD): 32 to 122 °F (0 to 50 °C)

• Hazardous area certified: -4 to 140 °F (-20 to 60 °C)

• 0 to 95% relative humidity (non-condensing)

• Indoor/outdoor

• Pollution - degree 2 (The GC can withstand some non conductive
environmental pollutants, e.g., humidity.)

• Vibration: Conforms to ASTM D4169

Hazardous area certifications
(hardware dependent)

USA and Canada

• Class I, Zone 1, Ex/AEx db IIC, Gb T6/T4/T3

• Class I, Division 1, Groups B, C, and D, IP66

EU ATEX and IECEx

• Ex db IIC Gb T6/T4/T3

• Ta = -20 °C to 60 °C

• SIRA 08ATEX 1328X

• IECEx SIR 08.0093X

Consult factory for additional product certifications available.
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Type Specifications

Safety precautions  WARNING

EXPLOSION HAZARD

Do not open when energized or explosive atmosphere is present.
Keep cover tightly closed while circuits are energized.
Use cables or wires suitable for the marked "T" ratings.
Clean cover joints before replacing the cover.
Ensure that conduit runs have sealing fitting adjacent to enclosure.

NOTICE

The Rosemount 700XA is CSA-certified and ATEX-certified. See the certification
tag on the GC for specific details about its agency approvals.

NOTICE

When the vapor regulators and flow switches are fitted, they must be suitably
certified with the ratings Ex d IIC Gb T6/T4/
T3 and for a minimum ambient temperature range Ta = -20 °C to +60 °C (-4 °F
to 140 °F)-.

Table 2-3: Approval Temperature Ratings

T6 Basic system no alternative options included

T4 Liquid sample injection valve (LSIV) option included

T4 Heat trace option with a maximum 176 °F (80 ⁰C) temperature switch setpoint

T3 Heat trace option with a maximum 230 °F (110 ⁰C) temperature switch setpoint
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3 Getting started
Emerson started and inspected your gas chromatograph (GC) before it left the factory.
Emerson also installed program parameters and documented them in the GC Config
Report furnished with your GC.

3.1 Select site
The site you select for the gas chromatograph (GC) is important for measurement
accuracy.

Procedure

Install the GC as close as possible to the sample system, but allow for adequate access
space for maintenance tasks and adjustments.

 WARNING

HAZARDOUS AREA EXPLOSION HAZARD

Failure to follow this warning may result in injury or death to personnel.

Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial and Ethernet communication links to connect the analyzer to
the PC and to connect to other computers and printers in a safe area.

Allow a minimum of 3 ft. (0.9 m) in front of the GC for operator access. Ensure that
exposure to radio frequency interference (RFI) is minimal.

3.2 Unpack the gas chromatograph (GC)
Unpack and inspect the Rosemount 700XA gas chromatograph upon receipt.

 WARNING

LIFTING HAZARD

The Rosemount 700XA is heavy equipment. Failure to observe this warning may cause
serious injury to personnel.

Use two people to move the GC.
Observe all proper lifting methods as defined by your site operating procedures.

Procedure

1. Unpack the equipment.

a) Remove the Rosemount 700XA from the shipping crate.

b) Remove the USB memory stick containing the software, applications, Quick
Start Guide, and manuals.
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Note
The MON2020 version number is located on the back of the USB card.

2. Retain the shipping information.

3. Inspect all parts and assemblies for possible shipping damage.

4. If any parts or assemblies appear to have been damaged in shipment, first file a
claim with the carrier.

5. Next, complete a full report describing the nature and extent of the damage and
forward this report immediately to your Emerson Customer Care representative.

6. Include the GC's model number in the report.

Emerson will provide disposition instructions as soon as possible.

If you have any questions regarding the claim process, contact your Emerson
Customer Care representative for assistance.

Only proceed to install and start up the GC if all required materials are on hand and
free from obvious defects.

7. If your GC is configured with an flame ionization detector (FID) or micro flame
photometric detector (µFPD), remove the vent plug from the FID/µFPD outlet.

 CAUTION

The vent plug has a tag attached to it that reads REMOVE VENT PLUGS PRIOR
TO OPERATION.

Failure to remove the cap could result in a performance failure or damage to the
detector.
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3.3 Required tools and components
You will need the following tools and components to install the 700XA

• Zero grade carrier gas:

— 99.995% pure

— Less than 5 ppm water

— Less than 0.5 ppm hydrocarbons

• High pressure dual-stage regulator for the carrier gas cylinder

— High side up to 3000 psig (20684.3 kPa)

— Gauge (psig)

— Low side capable of controlling pressure up to 150 psig (1034.2 kPa)

• Calibration standard gas with correct number of components and concentrations

• Dual-stage regulator for the calibration gas cylinder with a low pressure side capable of
controlling pressure up to 30 psig (206.9 kPa)

• Sample probe regulator (fixture for procuring the stream or sample gas for
chromatographic analysis)

• Coalescing filter

• Membrane filter

• ⅛-in. stainless steel tubing

— For connecting calibration gas to the GC

— For connecting carrier gas to the GC

— For connecting stream gas to the GC

— Sulfinert tubing required if sulfur components are present in calibration gas

• Heat tracing, as required for sample transport and calibration lines

• Miscellaneous tube fittings, tubing benders, and tubing cutter

• 14 American wire gauage (AWG) (18 metric wire gauge [MWG]) or larger electrical
wiring and conduit to provide 120 or 240 Vac, single phase, 50 to 60 Hz, from an
appropriate circuit breaker and power disconnect switch. See guidelines in Gas
chromatograph wiring.

• Digital volt-ohm meter with probe-type leads

• Flow measuring device

• Open-end wrenches sized ¼-in., 5/16-in., 7/16-in., ½-in., 9/16-in., and ⅝-in.

• Torque wrench
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3.4 Supporting tools and components
 WARNING

Failure to follow this warning may result in injury or death to personnel or cause damage
to the equipment.

Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial port and Modbus® communciation links to connect the gas
chromatograph (GC) to the PC and to connect to other computers and printers in a
safe area.

• Use a Windows®-based PC and either a direct or remote communications connection
to interface with the GC. See the MON2020 Software for Gas Chromatographs
Reference Manual for more information on specific PC requirements.

• The GC comes with an Ethernet port on the back plane factory-wired with an RJ-45
connector. Refer to Connect directly to a personal computer (PC) using the gas
chromatograph's (GC’s) Ethernet1 port for more information.

Getting started Reference Manual
July 2020 2-3-9000-744

50 Emerson.com/Rosemount

https://www.emerson.com/documents/automation/manual-mon2020-software-for-gas-chromatographs-rosemount-en-105130.pdf
https://www.emerson.com/documents/automation/manual-mon2020-software-for-gas-chromatographs-rosemount-en-105130.pdf


4 Installation and start-up
Note
Because the Rosemount 700XA is available in different configurations, it is possible that
not all of the instructions in this section apply to your particular gas chromatograph (GC).
In most cases, however, to install and set up a Rosemount 700XA, Emerson recommends
that you follow the instructions in the same order as they are presented in this manual.

4.1 Installation considerations
Before installing the gas chromatograph (GC):

1.  WARNING

The GC is heavy and has a high potential of injuring personnel or damaging
equipment.

Anchor the GC solidly before making electrical connections. Several options for
mounting the GC are covered in Mounting arrangements.

2. Ensure that the connections to the enclosure meet local standards.

3. Use approved seals: either cable glands or conduit seals.
a. Install conduit seals within 3 in. (76.2 mm) of the enclosure.

b. Seal unused openings with approved blanks (plugs). Threads for these
openings are M32 x 1.5.

4. Remove any packing materials before powering up the GC.

5.  WARNING

Do not power up an open GC unless the surrounding area is certified non-
hazardous.

6.  WARNING

HAZARDOUS AREA EXPLOSION HAZARD

Failure to follow this warning may result in injury or death to personnel.

Do not use a personal computer (PC) or printer in a hazardous area.
Emerson provides serial and Ethernet communication links to connect the
analyzer to the PC and to connect to other computers and printers in a safe area.

4.2 Mounting arrangements
The Rosemount 700XA can be installed in one of the following mounting arrangements:
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• Wall mount

• Pole mount

• Floor mount

 WARNING

HEAVY EQUIPMENT

Due to the size, weight, and shape of the gas chromatograph (GC), at least two people
are required to safely mount it.
Ensure that you understand the installation procedur before handling the GC and
collect the appropriate tools beforehand.
When putting the GC into its final position, be careful to avoid damaging any of the
external components or their attachments.
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4.2.1 Wall mount
The simplest mounting arrangement is the wall mount.

If you specify Wall Mount on the sales order, Emerson will ship the gas chromatograph
(GC) with a wall mount installation kit. Four locations on the mounting ears are available
for support.

 WARNING

HEAVY EQUIPMENT

Until all bolts are tight, ensure that the GC is supported to prevent unforeseen accidents.

Figure 4-1: Wall Mount

Prerequisites

Pre-install a pair of 7/16-in. (10 mm) diameter bolts with washers on the wall before
installing the final pair of bolts.

The first pair of bolts should be approximately 41.625 in. (1055 mm) off the ground, and
13.625 in. (346 mm) apart. Each bolt should have ⅝ in. (16 mm) of bare length projecting.
Drill a second pair of holes 3.56 in. (90.5 mm) above the first.

Procedure

1. Maneuver the GC so that the notches in the mounting ears can be placed over the
bolts on the wall and then place the washers over the bolts.

2. Install the second pair of bolts with washers and then tighten all the bolts.
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4.2.2 Pole mount
Prerequisites

The pole mount arrangement uses an additional plate and spacers to allow the necessary
clearance for nuts.

If you specify Pole Mount on the sales order, Emerson will provide the necessary hardware.

 WARNING

HEAVY EQUIPMENT

Until all bolts are tight, ensure that the gas chromatograph (GC) is supported to prevent
unforeseen accidents.

Figure 4-2: Pole Mount

Procedure

1. Use the U-bolt to firmly install the large plate on the pole about 44 in. (1120 mm)
above the ground.

2. Install the long bolts and spacers.

3. Place nuts and washers on the lower bolts.

4. Install the small plate just tightly enough to hold its position, with the small plate’s
U-bolt about 6.875 in. (174.625 mm) below the large plate’s U-bolt.

5. Hold the matching spacer in place with the bolts installed loosely.

6. Orient the GC so that the notches in the mounting ears can be placed over the
lower bolts on the plate and then add the washers and nuts.

7. Place the nuts with washers on the upper bolts and then tighten all bolts.

8. Adjust the lower bracket to align the bolts with the plate. Tighten the bolts.
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4.2.3 Floor mount
If you specify Floor Mount in the sales order, Emerson sends the arrangement pre-
assembled with the gas chromatograph (GC).

The arrangement includes an additional support stand that is intended to be anchored to a
floor or an instrument pad. The base rails have holes that are 13.625 in. (346 mm) apart,
side to side, and 16.75 in. (425.5 mm) apart front to back. The holes are ½ in. (12.7 mm) in
diameter and will accept up to 7/16-in. (10 mm) bolts.

Figure 4-3: Floor Mount
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4.3 Gas chromatograph wiring

4.3.1 Wiring precautions
• All wiring, as well as circuit breaker or power disconnect switch locations, must

conform to the CEC or NEC; all local, state, or other jurisdictions; and company
standards and practices.

• Provide single-phase, three-wire power at 115 or 220 Vac, 50-60 Hz.

NOTICE

If you do not have a single phase, three-wire AC power source, you must purchase an
isolation transformer.

• Locate a power shut-off or disconnect switch in a safe area.

• Provide the gas chromatograph (GC) and any optionally installed devices with one 20-
amp circuit breaker for protection.

 CAUTION

POWER

15 amps is the maximum current for 14 American Wire Gauge (AWG).

• Use multi-stranded copper conductor wire according to the following
recommendations:

— For power feed distances up to 250 ft. (76 m), use 14 AWG (18 Metric Wire Gauge),
stranded.

— For power feed distances 250 to 500 ft. (76 to 152 m), use 12 AWG (25 Metric Wire
Gauge), stranded.

— For power feed distances 500 to 1000 ft. (152 to 305 m), use 10 AWG (30 Metric
Wire Gauge), stranded.

4.3.2 Signal wiring
Follow these general precautions for field wiring digital and analog input/output (I/O)
lines:

• Metal conduit or cable (according to local code) used for process signal wiring must be
grounded at conduit support points, because intermittent grounding helps prevent the
induction of magnetic loops between the conduit and cable shielding.

• All process signal wiring should be of a single, continuous length between field devices
and the gas chromatograph (GC). If, however, the length of the conduit runs require
that multiple wiring pulls be made, the individual conductors must be interconnected
with suitable terminal blocks.

• Use suitable lubrication for wire pulls in conduit to prevent wire stress.

• Use separate conduits for AC voltage and DC voltage circuits.
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• Do not place digital or analog I/O lines in the same conduit as AC power circuits.

• Use only shielded cable for digital I/O line connections.
— Ground the shield at only one end.

— Shield-drain wires must not be more than two American Wire Gauge (AWG) sizes
smaller than the conductors for the cable.

• When inductive loads (relay coils) are driven by digital output lines, the inductive
transients must be diode-clamped directly at the coil.

• Any auxiliary equipment wired to the GC must have its signal common isolated from
earth/chassis ground.

 CAUTION

SIGNAL INTERFERENCE

If you don't follow this precaution, the data and control signals to and from the GC could
be adversely affected.

Do not place any loop of extra cable left for service purposes inside the GC purged housing
near the conduit entry for AC power.

4.3.3 Grounding precautions
Follow these general precautions for grounding electrical and signal lines:

• For shielded signal conducting cables, shield-drain wires must not be more than two
American Wire Gauge (AWG) sizes smaller than the conductors for the cable. Shielding
is grounded at only one end.

• Metal conduit used for process signal wiring must be grounded at conduit support
points (intermittent grounding of conduit helps prevent induction of magnetic loops
between the conduit and cable shielding).

• A single-point ground must be connected to a copper-clad, 10-ft. long, ¾-in. diameter
(3 m long, 19.1 mm diameter) steel rod, which is buried, full-length, vertically into the
soil as close to the equipment as is practical.

Note
The grounding rod is not furnished.

• Resistance between the copper-clad steel ground rod and the earth ground must not
exceed 25 Ohms.

• On ATEX-certified units, the external ground lug must be connected to the customer’s
protective ground system via 9 AWG (6 mm2) ground wire. After the connection is
made, apply a non-acidic grease to the surface of the external ground lug to prevent
corrosion.

• The equipment-grounding conductors used between the gas chromatograph (GC) and
the copper-clad steel ground rod must be sized according to your local regulations.
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4.3.4 Electrical conduit installation precautions
• Conduit cutoffs must be cut at a 90-degree angle. Cutoffs must be made by a cold

cutting tool, hacksaw, or by some other approved means that does not deform the
conduit ends or leave sharp edges.

• All conduit fitting-threads, including factory-cut threads, must be coated with a metal-
bearing conducting grease prior to assembly.

• Temporarily cap the ends of all conduit runs immediately after installation to prevent
accumulation of water, dirt, or other contaminants. If necessary, swab out conduits
prior to installing the conductors.

• Install drain fittings at the lowest point in the conduit run; install seals at the point of
entry to the gas chromatograph (GC) to prevent vapor passage and accumulation of
moisture.

• Use liquid-tight conduit fittings for conduits exposed to moisture.

When a conduit is installed in hazardous areas, follow these general precautions for
conduit installation:

• All conduit runs must have a fitting, which contains explosion-proof sealing (potting)
located within 3 in. (76.2 mm) from the conduit entrance to the explosion-proof
housing. The seal should have a minimum IP rating of IP54 or equivalent NEMA®/Type
rating on the conduit sealing devices.

• The conduit installation must be vapor tight, with threaded hub fittings, sealed conduit
joints and gaskets on covers, or other approved vapor-tight conduit fittings.

 WARNING

Failure to observe precautionary signs may result in serious injury or death to personnel.

Observe all precautionary signs posted on the certified explosion-proof equipment.
Consult your company's polices and procedures and other applicable documents to
determine wiring and installation practices that are appropriate for hazardous areas.
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4.3.5 Sample system requirements
Line length If possible, avoid long sample lines. In long s, flow sample lines,

velocity can be increased by decreasing downstream pressure and
using by-pass flow via a fast loop.

 CAUTION

Stream switching requires a sample pressure of 20 psig (137.9 kPa).

Sample line tubing material • Use sulfur-inert tubing for H2S streams; for all other applications,
use stainless steel tubing.

• Ensure tubing is clean and free of grease.

Dryers and filters Use small sizes to minimize time lag and prevent back diffusion.

• Install a minimum of one filter to remove solid particles. Most
applications require fine-element filters upstream of the gas
chromatograph (GC). The GC includes a 2-micron filter.

• Use ceramic or porous metallic type filters. Do not use cork or felt
filters.

NOTICE

Install the probe/regulator first, immediately followed by the
coalescing filter and then the membrane filter. See Carrier gas
installation and maintenance for a recommended natural gas
installation.

Pressure regulators and
flow controllers

• Use stainless steel wetted materials.

• Parts should be rated for sample pressure and temperature.

Pipe threads and dressings Use PTFE tape. Do not use pipe thread compounds or pipe dope.

Valving • Install a block valve downstream of sample takeoff point for
maintenance and shutdown.

• The block valve should be a needle valve or cock valve type, of
proper material and packing, and rated for process line pressure.
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4.4 Electrical installation
NOTICE

Emerson switches off central processing unit (CPU) boards before shipping to preserve
their batteries. Before installing the CPU board, be sure to switch it on..

Figure 4-4: CPU Board

A. SW7 battery power ON

4.4.1 Connect power supply
 WARNING

ELECTRICAL HAZARD

Failure to follow this warning may result in injury or death to personnel or cause damage
to equipment.

Ensure that the 24 Vdc input power source is switched Off before connecting the wires.
Ensure that the 24 Vdc power supply is safety extra low voltage (SELV) compliant by
suitable electrical separation from other circuits.
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 CAUTION

EQUIPMENT DAMAGE

Failure to observe this precaution may damage equipment.

Check the GC prior to wiring to determine if it is equipped for DC power.

Procedure

1. Locate the plug-together termination block inside the electronics enclosure.

Figure 4-5: 24 Vdc power connection on the back plane
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2. Bring the two leads in through one of the two possible entries on the lower
compartment. Connect to the termination plug provided with the GC.

Figure 4-6: Wiring Entries on the Under Side of the Lower Enclosure

Attribute Wire Color

+ (positive) red

– (negative) black

Note
Do not disconnect the factory-installed ground wire.

The backplane board that connects to the 24 Vdc is protected from lead reversal by
the use of blocking diodes.

If the red (+) and black (-) leads are inadvertently reversed, no damage will occur;
however, the system will not have power.

3. Connect the DC power leads to the power disconnect switch that should be
properly fused.

The recommended fuse size is 8 amps.
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4.4.2 Connect optional AC/DC power converter
 WARNING

Failure to follow this warning may result in injury or death to personnel or cause damage
to equipment.

Check the gas chromatograph (GC) prior to wiring to determine if it is equipped for
optional AC power.

Procedure

1. Locate the plug-together termination block inside the electronics enclosure, atop
the power supply and adjacent to the card cage.

Figure 4-7: AC/DC Termination Block

 WARNING

Failure to follow this warning may result in injury or death to personnel or cause
damage to equipment.

Do not connect the AC power leads without first ensuring that the AC power source
is switched Off.

 CAUTION

Failure to observe this precaution may cause damage to equipment.

Do not apply electrical power to the GC until all interconnections and external signal
connections have been verified and proper grounds have been made.

AC wiring is usually color coded as:

Label Wire color

Hot (H) Brown or black

Neutral (N) Blue or white
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Label Wire color

Ground (G) Green with yellow tracer or green

2. Bring the power leads in through the left entry on the bottom of the enclosure.

3. If necessary at remote locations, connect the GC chassis ground wire to an external
copper ground rod.

See Grounding precautions regarding electrical and signal grounding.

4.4.3 Connect gas lines

Procedure

1. Remove the plug from the 1/16 in. sample vent tubing marked SV1 that is located
on the flow panel assembly.

• If desired, connect the sample vent lines to an external, ambient pressure vent. If
the vent line is terminated in an area exposed to wind, protect the exposed vent
with a metal shield.

• Use ¼-in. or ⅜-in. tubing for vent lines longer than 10 ft. (3 m).

At this stage in the installation, the measure vent (MV) lines (labeled on the side of
the gas chromatograph [GC]) should remain plugged until the GC has been checked
for leaks. For regular operation, however, the MV lines must be unplugged.

Note
Do not discard the vent line plugs. They are useful when leak-checking the GC and
its sample or gas line connections.

2. Connect the carrier gas to the GC. The carrier gas inlet is labeled Carrier In and is a
¼-in. T-fitting.

 WARNING

EXPLOSION HAZARD

Failure to follow this warning may result in injury or death to personnel.

Do not turn on sample gas until you have completely checked the carrier lines for
leaks.

• Use stainless steel tubing to convey carrier gas.

• Use a dual-stage regulator with high-side capacity of 3,000 psig (20,684.3 kPa)
and low-side capacity of 150 psig (1,034.2 kPa).

• Carrier gas is fed from two bottles (see Carrier gas installation and maintenance)
for carrier gas plumbing.

3. Connect calibration standard gas to the GC.

When installing the calibration standard gas line, ensure that the correct tubing
connection is made.
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• Use ⅛-in. stainless steel tubing to connect calibration standard gas unless the
application requires treated tubing.

• Use a dual-stage regulator with low-side capacity of up to 30 psig (206.8 kPa).

4. Connect sample gas stream(s) to the GC.

• Use ⅛-in. stainless steel tubing, as appropriate, to connect sample gas.

• Unless stated otherwise in the product documentation, ensure that the pressure
of the calibration and sample line is regulated at 15 psig to 20 psig (103.4 to
137.9 kPa).

Postrequisites

After all lines have been installed, proceed with leak-checking the carrier and sample lines.
See Leak checking and purging for first calibration.

4.4.4 Maximum effective distance by communication
protocol type
The table below lists the maximum distance at which the indicated protocol can transmit
data without losing effectiveness. If longer runs are required, the use of a repeater or other
type of extender will be necessary to maintain the protocol's efficiency.

Communication protocol Maximum distance

RS-232 50 ft. (15.24 m)

RS-422/RS-485 4,000 ft. (1,219.2 m)

Ethernet (CAT5) 300 ft. (91.44 m)

4.4.5 RS-485 serial port terminating resistors
To ensure correct communication with all hosts, place a 120-ohm terminating resistor
across the GC serial port terminals on the RS-485 link. On a multi-dropped link, install the
terminating resistor on the last controller link only.

4.4.6 Connect directly to a personal computer (PC) using the
gas chromatograph's (GC’s) Ethernet1 port
Procedure

1. Plug one end of the Ethernet cable into the PC’s Ethernet port and the other end
into the GC’s RJ45 socket on on the backplane.

2. Locate switch at SW1 on the backplane. Place SW1 in the On position.

Note
The GC can be connected (or remain connected) to the local network on Ethernet2
on the backplane while the DHCP feature on Ethernet1 is being used.
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This starts the GC’s DHCP server feature. The server typically takes approximately
20 seconds to initialize and start up.

3. Wait for 20 seconds and then do the following to ensure that the server has
provided an IP address to the PC:

a) From the PC, go to Start → Control Panel → Network Connections....
The Network Connections window lists all dial-up and local area network
(LAN)/high-speed Internet connections installed on the PC.

b) In the list of LAN / high speed Internet connections, find the icon that
corresponds to the PC-to-GC connection and check the status that displays
beneath the Local Area Connection.
It should show the status as Connected. The PC is now capable of connecting
to the GC. See Connect to the gas chromatograph (GC) using MON2020.

If the status is Disconnected, it may be that the PC is not configured to
accept IP addresses; therefore, do the following:

4. Right-click the Properties icon.
The Local Area Connection Properties window displays.

5. Scroll to the bottom of the Connection list box and select Internet Protocol (TCP/
IP).

6. To configure the PC to accept IP addresses issued from the GC, select the Obtain an
IP address automatically and Obtain DNS server address automatically check
boxes.

7. Click OK to save the changes and to close the Internet Protocol (TCP/IP) Properties
window.

8. Click OK to close the Local Area Connection Properties window.

9. Return to the Network Connections window and confirm that the appropriate icon’s
status reads Connected.

If the icon still reads Disconnected refer to Troubleshoot DHCP connectivity issues.

NOTICE

If you power cycle the GC, then you will lose connectivity. After the GC initializes
completely, refer to Troubleshoot DHCP connectivity issues to learn how to repair
the connection.

4.4.7 Connect to the gas chromatograph (GC) using
MON2020
To connect to the GC using the RJ45 Ethernet1 connection, do the following:

Procedure

1. Start MON2020.
The Connect to GC window displays.

2. Locate the default Direct-DHCP under the GC Name column.
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This GC directory is created automatically when MON2020 is installed. You can
rename the GC, but do not change the IP address that it references,
192.168.135.100.

3. Click the associated Ethernet button.
MON2020 prompts you to enter a user name and password.

4. Enter your user name and password.

5. MON2020 connects you to the GC.
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4.4.8 Troubleshoot DHCP connectivity issues
Use the following tips to troubleshoot server connectivity issues:

Procedure

1. Ensure that the gas chromatograph (GC) is up and running.

2. Check that the SW1 switch is in the On position.

3. Check the following connections:

a) If you are using a Ethernet straight-through cable, ensure that the personal
computer (PC) has an Ethernet network interface card with auto-MDIX.

b) If your Ethernet network interface card does not support auto-MDIX, ensure
that you are using an Ethernet crossover patch cable.

c) Check to see if the GC's central processing unit (CPU) board link lights are on.

see Figure 4-8. The three Ethernet1 light-emitting diodes (LEDs) are located
on the front bottom edge of the card. If link lights are off, then check your
connections. (see Figure 4-8).
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Figure 4-8: CPU Board Link Lights

A. CPU board
B. Ethernet link lights

4. Do the following to ensure that your network adapter is enabled:

a) Go to Start → Control Panel → Network Connections....

b) Check the status of the Local Area Connection icon. If the status appears as
Disabled, right-click the icon and select Enable from the context menu.

5. Do the following to try to repair the network connection:

a) Go to Start → Control Panel → Network Connections....

b) Right-click the Local Area Connection icon and select Repair from the
context menu.
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4.4.9 Connect directly to a personal computer (PC) using the
gas chromatograph's (GC's) serial port
The GC’s serial port at J23 on the backplane allows a PC with the same type of port to
connect directly to the GC. This is a useful feature for a GC that is located in an area
without Internet access; all that is needed is a PC running Microsoft Windows®, a notebook
computer, and a straight-through serial cable.

To set up the PC for the direct connection, do the following:

Procedure

1. Install the communications cable between two computers:

a) Navigate to Start → Control Panel and select the Phones and Modem
Options icon.
The Phones and Modem Options dialog window displays.

b) Select the Modem tab and click Add….
The Add Hardware Wizard displays.

c) Select the Don’t detect my modem; I will select it from a list check box and
then click Next.

d) Click Have Disk.
The Install from Disk dialog window appears.

e) Click Browse
The Browse dialog window displays.

f) Navigate to the MON2020 install directory (typically C:\Program Files
(x86)\Emerson Process Management\MON2020) and select Daniel Direct
Connection.inf.

g) Click Open.
You return to the Install from Disk dialog window.

h) Click OK.
You return to the Add Hardware Wizard.

i) Click Next.

j) Select an available serial port and click Next.
The Hardware Installation dialog window displays.

k) Click Continue Anyway.
After the driver is installed, you return to the Add Hardware Wizard.

l) Click Finish.
You return to the Phones and Modems dialog window. The Daniel Direct
Connect modem should be listed in the Modem column.

2. Start MON2020 and do the following to create a GC connection for the Daniel
Direct Connection modem:

a) Select GC Directory from the File menu.
The GC Directory window displays.
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b) Select Add from the GC Directory window’s File menu.
A New GC row is added to the bottom of the table.

c) Select the New GC text and type a new name for the GC connection.

d) Select the new GC’s Direct check box.

e) Click the Direct button located at the bottom of the GC Directory window.
The Direct Connection Properties window displays.

f) Select Communications cable between two computers (COM n) from the
Port dropdown menu.

Note
The letter n stands for the COM port number.

g) Select 57600 from the Baud Rate dropdown menu.

h) Click OK to save the settings.
You return to the GC Directory window.

i) Click OK to save the new GC connection and to close the GC Directory
window.

3. Connect one end of the direct connect cable to the GC’s serial port at J23 on the
backplane.

4. Connect the other end of the direct connect cable to the PC’s corresponding serial
port.

5. Select Connect… from the Chromatograph menu.
The Connect to GC window displays.

6. Click Direct to connect to the GC using the serial cable connection.

4.4.10 Connect directly to a personal computer (PC) using the
gas chromatograph's (GC’s) wired Ethernet terminal
The Rosemount 700XA has a wired Ethernet terminal at TB11 on the backplane that you
can connect to with a static IP address. All that is needed is a PC, typically a notebook
computer, and a two-wire, twisted pair, CAT5 Ethernet cable with one of its plugs
removed to expose the wires.

Figure 4-9: Crimped CAT5 Cable

Note
The GC can be connected (or remain connected) to the local network on Ethernet2 on the
backplane while the DHCP feature is being used.
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Figure 4-10: Wired Ethernet Terminal Block on the Backplane

Procedure

1. Use the following schematics as a guide to wiring the GC via its four wire connector
at TB11.

Figure 4-11 shows the traditional wiring scheme. Figure 4-12 shows how to wire a
CAT5 cable without the RJ45 plug.

Figure 4-11: Field Wiring to TB11
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Figure 4-12: CAT5 Wiring to TB11

2. Once you have wired the cable to the Ethernet terminal, plug the other end into a
PC or a wall jack.

See Assign a static IP address to the gas chromatograph (GC) to continue
configuring the GC.

4.4.11 Assign a static IP address to the gas chromatograph (GC)
Procedure

1. Start MON2020 and log in to the GC using a direct Ethernet connection.

For more information, refer to Connect directly to a personal computer (PC) using
the gas chromatograph's (GC’s) Ethernet1 port.

2. Select Application → Ethernet ports....
The Ethernet Ports window displays.

3. Depending upon the Ethernet port to which you want to assign a static IP address,
do the following:

a) The Ethernet port at TB11: Enter the appropriate values in the Ethernet2 IP
Address, the Ethernet 2 Subnet, and the Default Gateway fields.

b) The RJ45 Ethernet port at J22: Enter the appropriate values in the Ethernet1
IP Address, the Ethernet1 Subnet, and the Default Gateway fields.

Note
See your information technology (IT) staff to obtain IP, subnet, and gateway
addresses.

Important
To configure a Ethernet IP address using the local operator interface (LOI),
refer to Figure A-54.

4. Click OK.
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5. Log off the GC.

6. Access the backplane, which is located in the GC’s lower enclosure.

Figure 4-13: Port Locations on the Backplane

7. If you are setting up a static IP address for the Ethernet1 port at J22, and you also
intend to connect to your company’s local area network, do the following:

a) Locate the set of dip switches, labeled 1 and 2 , at SW1 on the backplane.

SW1 is located directly beneath the Ethernet port at J22 .

b) Move dip switch 1 to its left position (Off).

This disables the DHCP server.

8. To connect to the GC, do the following:

a) Start MON2020 and select File → GC Directory....
The GC Directory window displays.

b) Select Add.
MON2020 adds a new GC profile to the end of the table.

Note
You can name the GC’s profile as well as add a short description.

c) Select the new profile and click Ethernet... Enter the GC’s static IP address in
the IP address field.

d) Click OK.
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The Ethernet Connection Properties for New GC window closes.

9. Click Save to save the new profile.

10. Click OK to close the GC Directory window.

11. Select Chromatograph → Connect... to connect to the GC or click .
The Connect to GC window displays. The newly created GC profile should be listed in
the table.

12. Locate the new GC profile and click the Ethernet button that is associated with it.
The Login window displays.

13. Enter a User Name and User Pin and click OK.

4.4.12 Wiring the discrete digital inputs and outputs
The GC’s backplane has five discrete outputs and five discrete inputs.

If more than five digital outputs are required, see Wire a ROC800 digital output (DO)
module to add the ROC800 Digital Output Module.

Wire the discrete digital inputs

 DANGER

ELECTRIC SHOCK

Failure to observe this precaution will cause serious personal injury or death.

The equipment operates using mains voltage that is dangerous to life. Make sure that the
circuit breakers are set to OFF and tagged off before

 WARNING

EXPLOSION HAZARD

Failure to de-energize the analyzer may cause an explosion and severly injure personnel.

Do not open the enclosure unless the area is known to be non-hazardous or unless all
devices within the enclosure have been de-energized.

To connect digital signal input lines to the GC, see Engineering drawings and do the
following:

Procedure

1. Disconnect power to the analyzer and allow the components to cool for at least five
minutes.

2. Open the electronics enclosure door and access the backplane.

3. Make the digital input wiring connections on the backplane at TB7.
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Note
The discrete digital input terminals on the backplane are self-powered. Devices
connected to the digital input will be powered by the gas chromatograph's (GC's)
dedicated isolated 24 V power supply.

Note
The discrete digital input terminals are optically isolated from the GC's other
circuitry.

4. Route digital in/out (I/O) lines away from the sensitive detector lines (on the left
side of the backplane) and away from the analog inputs and outputs.

There are connections for five digital inputs on the backplane at TB7, as indicated in
the following table.

Table 4-1: Discrete Digital Inputs TB7

TB7 Function

Pin 1 DI1

Pin 2 DI-RTN

Pin 3 DI2

Pin 4 DI-RTN

Pin 5 DI3

Pin 6 DI-RTN

Pin 7 DI4

Pin 8 DI-RTN

Pin 9 DI5

Pin 10 DI-RTN

Wire a ROC800 digital input (DI) module
To connect the ROC800 DI module to a field device, do the following:

Procedure

1. Expose the end of the wire to a maximum length of ¼-in. (6.4 mm).

Note
Twisted-pair cables are recommended for in/out (I/O) signal wiring. The module’s
terminal blocks accept wire sizes between 12 and 22 American wire gauge (AWG).
Allow some slack when making connections to prevent strain.

 CAUTION

Failure to follow this precaution may cause a short circuit and damage equipment.

Allow only a minimum exposure of bare wires to prevent short circuits.
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2. Insert the exposed end into the clamp beneath the termination screw.

3. Tighten the screw.

Figure 4-14: Typical Wiring

Table 4-2: ROC800 Discrete digital wiring

Terminal Label Definition

1 1 CH 1 Positive

2 2 CH 2 Positive

3 3 CH 3 Positive

4 4 CH 4 Positive

5 5 CH 5 Positive

6 6 CH 6 Positive

7 7 CH 7 Positive

8 8 CH 8 Positive

9 COM Common

10 COM Common
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Wiring the discrete digital outputs
The discrete outputs are located on TB3, which is a 15-pin connector, and have five Form-
C relays on the back plane. All contact outputs have a rating of 1A at 30 Vdc.

Refer to drawing BE-22175 in List of engineering drawings - Rosemount 700XA

Figure 4-15: TB3 on the Backplane

Table 4-3 lists the discrete digital output function for each pin on the TB3 connector.

Table 4-3: Discrete Digital Outputs - TB3

TB3 Function

Pin 1 NC1

DIG_OUT NC1

Pin 2 ARM1

DIG_OUT ARM1

Pin 3 NO1

DIG_OUT NO1

Pin 4 NC2

DIG_OUT NC2

Pin 5 ARM 2

DIG_OUT ARM2

Pin 6 NO2

DIG_OUT NO2

Pin 7 NC3

DIG_OUT NC3
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Table 4-3: Discrete Digital Outputs - TB3 (continued)

TB3 Function

Pin 8 ARM3

DIG_OUT ARM3

Pin 9 NO3

DIG_OUT NO3

Pin 10 NC4

DIG_OUT NC4

Pin 11 ARM4

DIG_OUT ARM4

Pin 12 NO4

DIG_OUT NO4

Pin 13 NC5

DIG_OUT NC5

Pin 14 ARM5

DIG_OUT ARM5

Pin 15 NO5

DIG_OUT NO5

Note
Form-C relays are single-pole double-throw (SPDT) relays that have three positions:
normally closed (NC); an intermediate position, also called the make-before-break position
(ARM); and normally open (NO).

Optional discrete digital inputs (DI)
When plugged into one of the optional card slots in the card cage, the Emerson ROC800
DI card provides eight additional discrete digital inputs. The discrete digital inputs can
monitor the status of relays, open-collector or open-drain type solid-state switches, and
other two-state devices. For more information, see ROC800-Series Discrete Input Module at
Emerson’s ROC 800-Series website at Emerson.com/en-us/catalog/emerson-roc800-series
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Figure 4-16: Optional Digital in/out (I/O) Modules

Wire a ROC800 digital output (DO) module

Figure 4-17: Discrete Digital Output Wiring

CONTROL

DO

1+

2+

3+

4+

5+

COM

COM

COM

COM

COM

5 CHAN

DISCRETE DEVICE 

EXTERNALLY POWERED

Terminal Label Definition

1 1+ Positive discrete output
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Terminal Label Definition

2 COM Discrete output return

3 2+ Positive discrete output

4 COM Discrete output return

5 3+ Positive discrete output

6 COM Discrete output return

7 4+ Positive discrete output

8 COM Discrete output return

9 5+ Positive discrete output

10 COM Discrete output return

To connect the ROC800 DO module to a field device:

Procedure

1. Expose the end of the wire to a maximum length of ¼ in. (6.4 mm).

Note
Twisted-pair cables are recommended for I/O signal wiring. The module’s terminal
blocks accept wire sizes between 12 and 22 American wire gauge (AWG). Allow
some slack when making connections to prevent strain.

 CAUTION

ELECTRICAL HAZARD

Failure to follow this precaution may cause a short circuit and damage equipment.

Allow only a minimum exposure of bare wires to prevent short circuits.

2. Insert the exposed end into the clamp beneath the termination screw.

3. Tighten the screw.

4.4.13 Wiring the analog inputs
All Rosemount 700XA gas chromatographs (GCs) have at least two analog inputs. An
additional four analog inputs are available with a ROC800 AI-16 card (see Wire a ROC800
digital output (DO) module) that can be installed into one of the optional slots in the card
cage.

Analog inputs on the backplane
There are two analog input connections on the backplane at terminal block 10 (TB10).
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Table 4-4: Analog Inputs TB10

TB10 Function

Pin 1 +AI_1

Pin 2 -AI_1

Pin 3 +AI_2

Pin 4 -AI_2
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Analog inputs settings
Figure 4-18 shows how to wire two analog inputs (TB10).

Figure 4-18: Customer Wiring for Analog Inputs

A. Backplane
B. Analog inputs
C. Analog input 1
D. Analog input ground
E. Analog input 2
F. Cable
G. Customer devices
H. Customer 4-20 mA outputs

Use the Hardware → Analog Inputs menu in MON2020 to configure the analog inputs.

Select the input type for an analog input
You can set an analog input to either voltage (0-10 V) or current (4-20 mA) .

Procedure

1. Select Hardware → Analog Inputs....
The Analog Inputs window displays.

2. To set the analog input to current, select mA from the mA/Volts drop-down list for
the appropriate analog input; to set the analog input to voltage, select Volts from
the mA/Volts drop-down list for the appropriate analog input.

3. Click Save to save the changes and keep the window open, or click OK to save the
changes and close the window.

Typical wiring for line-powered transmitters
The following drawing shows the most common wiring plan for supplying power to two
4-20 mA transmitters, such as pressure sensor transmitters.

Reference Manual Installation and start-up
2-3-9000-744 July 2020

Rosemount 700XA 83



Figure 4-19: Typical Wiring for Line-Powered Transmitters

A. Back plane
B. Customer transmitter
C. Analog inputs
D. Transmitter 4-20 mA output

Optional analog inputs (AI)
When plugged into one of the optional card slots on the card cage, the ROC800 AI-16 card
provides four additional analog inputs.

The AI channels are scalable, but are typically used to measure either a 4-20 mA analog
signal or a 1-5 Vdc signal. If required, the low end of the AI module’s analog signal can be
calibrated to zero. For more information, see Analog Input Modules (ROC800-Series at
Emerson's ROC800-Series website.

Wire an ROC800 AI-16 module

 CAUTION

ELECTROSTATIC DISCHARGE (ESD)

Operators and technicians must wear an electrostatic wrist strap when handling printed
circuit cards to prevent shorting the boards through static electricity.
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Figure 4-20: Typical ROC800 Wiring

A. 1-5 volt device, externally powered
B. 1-5 volt device, ROC800 powered
C. Current loop device 4-20 mA, ROC800 powered

To connect the ROC800 AI-16 module to a device:

Procedure

1. Expose the end of the wire to a maximum length of ¼ in. (6.4 mm).

Note
Twisted-pair cables are recommended for in/out (I/O) signal wiring. The module’s
terminal blocks accept wire sizes between 12 and 22 American wire gauge (AWG).
Allow some slack when making connections to prevent strain.

 CAUTION

ELECTRICAL HAZARD

Exposing bare wires may cause a short circuit and damage equipment.

Only allow a minimum exposure of bare wires.

2. Insert the exposed end into the clamp beneath the termination screw.

3. Tighten the screw.

There are two dip switches on the terminal block side of the module that can be
used to set a 250 Ω resistor in or out of circuit for each analog input.

To put an analog input’s resistor in circuit, flip the appropriate dip switch to I; to put
an analog input’s resistor out of circuit, flip the appropriate dip switch to V.
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Calibrate a ROC800 AI-16 module

Prerequisites

To calibrate the ROC800 AI-16 module you must have a personal computer (PC) with the
ROCLINK™ 800 Configuration software installed and open.

See Emerson’s ROC 800-Series for details, downloads and manuals.

Procedure

1. Go to Configure → I/O → RTD Points → Calibration.

2. Select an analog input.

3. Click Update to request one value update from the input.

4. Click Freeze to stop the values of the input from being updated during calibration.

Note
If you are calibrating a temperature input, disconnect the resistance temperature
device (RTD) sensor and connect a decade box or comparable equipment to the
RTD terminals of the ROC card.

5. Click Calibrate.

6. Enter a value for Set Zero after stabilization.

7. Enter a value for Set Span after stabilization.

8. Enter values for up to three Midpoints one at a time or click Done if you are not
configuring midpoints.

9. Click OK to close the main calibration window and unfreeze the associated inputs.
To calibrate the inputs for another analog input, return to Step 1.

4.4.14 Analog output wiring
The Rosemount 700XA has at least six analog outputs. An additional four analog inputs are
available with an ROC800 AO card that can be installed into one of the optional slots in the
card cage.
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Factory settings for analog output switches
Figure 4-21 shows how to wire up to six devices to the analog outputs that are located on
the backplane. It also shows how to wire up to two analog inputs.

Figure 4-21: Wiring for Six Analog Outputs

Wire customer externally-powered analog outputs
It is possible to furnish power to each analog output while maintaining isolation between
channels.

Consult Figure 4-22 before wiring a customer-powered device:

Procedure

1. Use Figure 4-22 to provide power wiring to each analog output while maintaining
isolation between channels.
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Figure 4-22: Wiring for Customer-Powered Analog Outputs

2. The settings for the analog outputs connections, located on the backplane are
necessary to provide power to each analog output while maintaining isolation
between channels.

Optional analog outputs
When plugged into one of the optional card slots on the card cage, the ROC800 AO card
provides four additional analog outputs. Each channel provides a 4 to 20 mA current signal
for controlling analog current loop devices.

For more information, see Emerson's ROC 800-Series website.

Connect ROC800 analog output (AO) module to a field device

Procedure

1. Expose the end of the wire to a maximum length of ¼ in. (6.4 mm).
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Note
Emerson recommends using twisted-pair cables for in/out (I/O) signal wiring. The
module’s terminal blocks accept wire sizes between 12 and 22 American wire
gauge (AWG). Expose minimal bare wire to prevent short circuits. Allow some slack
when making connections to prevent strain.

2. Insert the exposed end into the clamp beneath the termination screw.

3. Tighten the screw.

4. Close the electronics enclosure door and apply power to the gas chromatograph
(GC).

5. Run MON2020 and connect to the GC.

4.4.15 Configure analytical train
Use the Analytical Train Configuration window for multiple analysis clocks to assign the
valve, digital outputs (DO), and detectors to each train and then assign each train to its
respective analysis clock.

Procedure

1. Assign the usage of valves and DO to Analyzer# on Hardware → Valves, Hardware
→ Detectors and Hardware → Discrete Outputs screens.

2. Open the Application → Analytical Train Configuration screen.

3. Click Discrete Output and Valves. Assign the respective DOs, valves, and detectors
to each analytical train.

The valves and DOs are assigned with Usage as Analyzer# displayed on this screen.
All available detectors are also displayed on this screen. You cannot configure the
same detector, valve or DO to multiple trains.

4. On the Application → Timed Event screen, filter the configured events as per train
selection by selecting the Train# checkbox.

4.4.16 Configure analysis clock
Use this feature to configure a single analysis or multiple analyses.

One analysis can be considered as one virtual gas chromatograph (G) that has
independent Sample Loop, Analytical Path, and Timed Event tables.

Multiple analyses can run independently to analyze multiple streams at the same time.
The number of analyses are set at factory per the mechanical configurations.

Mechanical
configurations

Description

Trains 1 - 6 The configured trains that are used by the analysis

Default Stream
Sequence

Sets the default sequence to be used by the indicated analysis during auto-
sequencing. To create a new stream sequence or to edit an already-created
sequence, click Stream Sequence .
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Mechanical
configurations

Description

Purge Duration The amount of time, in seconds, to purge the stream before starting an
analysis, calibration, or validation run. The default value is 60 SEC. Purging
allows sample gas to flow through the sample loop prior to beginning the
run.

Energy Value
Check

If enabled, the GC analyzes the calibration gas as an unknown stream and
computes its energy value. The GC then compares this value to the Cal Gas
Cert CV and determines if the calibration gas's energy value is within the CV
Check Allowed Deviation. If it isn't, the GC triggers the Energy Value Invalid
alarm. The following conditions must be met before the GC can perform a EV
Check:
• The EV Check flag in the System window must be enabled.

• At least one stream must be set up in the Streams window as a calibration
stream, and the Auto flag for this stream must be enabled.

The EV Check is performed under any of the following circumstances:
• During a warm start that follows a power failure during normal operation.

The GC waits for the heater and electronic pressure controller to reach
their respective set points and stabilize. It then analyzes the calibration
gas as an unknown stream and identifies the peaks. If all the component
peaks are identified, the GC computes the calibration gas' energy value
and performs the EV Check.

• After a successful calibration, the GC computes the gas' energy value with
the new response factors and performs the EV Check

1. Press Insert to add a new analysis.

2. Press Delete to delete an analysis.

Related information

Configure analytical train

4.5 Leak checking and purging for first calibration
 CAUTION

EQUIPMENT DAMAGE

Failure to clean and dry the tubing may compromise the integrity of the analyzer or its
warranty.

Make sure all tubing is clean and dry internally.
Prior to installation, blow the tubing free of internal moisture, dust, or other
contaminants.

Verify that all electrical connections are correct and safe and then turn the gas
chromatograph (GC) on.
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4.5.1 Check the gas chromatograph (GC) for leaks
Prerequisites

Leak checking carrier and calibration gas lines requires power and a personal computer
(PC) connected to the GC.

Note
Refer to the analyzer's drawing documentation package that shipped with the GC for leak
checking and identifying vents.

Emerson tested the GC and fittings for leaks at the factory prior to shipment.

Procedure

1. Plug the measure vent (labeled MV) vent line if it is open.

Leave the SV or sample vent line open or unplugged.

2. Slowly pressurize each line in turn; then block-in the line, making sure the pressure
holds.

For example, the carrier gas line should be slowly brought up to 100 psig (689.5
kPa) ± two percent with the dual-stage regulator at the carrier gas cylinder, and the
actuation pressure should be 100 psig (689.5 kPa) maximum.

3. After two minutes, shut the carrier gas bottle valve and observe the high side
regulator gauge on the carrier gas bottle.

a. The gauge should not bleed down more than 100 psig in ten minutes.

b. If helium is lost at a faster rate, leaks are usually found between the carrier
gas bottle and the analyzer. Check and tighten all connections, as well as the
dual-stage regulator.

4. When the leak check is complete, reopen the helium bottle valve. Remove the plug
from the MV line.

5. Shut the metering valve below the rotameter on the front of the flow panel.

Leave the metering valve shhut for now; you will reopen it later during initial
purging and the analyzer's first calibration.

6. Repeat the procedure with sample gas and stream gas.

Note
Do not use a liquid leak detector, such as Snoop®, on the valves or components in
the oven.

Note
Refer to the Flow Configuration schematic in the documentation packet that
shipped with the GC for detailed instructions on plugging the flame ionization
detector (FID) and flame photometric detector (FPD) vents..
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4.5.2 Plugged lines, columns, and valves
If the lines, columns, or valves are plugged, check the gas flow at valve ports.

For a reference, use the flow diagram in the drawing package that shipped with your gas
chromatograph (GC), and remember these points about flow diagrams:

• Port-to-port flow paths are indicated by solid or dashed lines on the valve symbol in the
drawing.

• A dashed line indicates flow direction when the valve is On, i.e., energized.

• A solid line indicates flow direction when the valve is Off, i.e., not energized.

4.5.3 Purge carrier gas lines
Prerequisites

Purging carrier and calibration gas lines requires power and a personal computer (PC)
connected to the gas chromatograph (GC).

Procedure

1. Ensure that the vent line plugs have been removed and the vent lines are open.

2. Ensure that the carrier gas bottle valve is open.

3. Set the GC side of the carrier gas to 115 psig (792.9 kPa).

4. Turn on the GC and the PC.

5. Start MON2020 and connect to the GC.

NOTICE

Consult the MON2020 Software for Gas Chromatographs Reference Manual for
information about connecting to a GC.

6. Select Hardware → Heaters....
The Heaters window displays.
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Figure 4-23: Heaters Window

7. Allow the GC system temperature to stabilize and the carrier gas lines to become
fully purged with carrier gas, which usually takes at least an hour.

The temperature values for the heaters should indicate that the GC is warming up.

The Status column displays OK.

8. Select Control → Auto Sequence....

For more information about this function, refer to the MON2020 Software for Gas
Chromatographs Reference Manual.

Note
You can also performStep 6 through Step 8 with the local operator interface (LOI).

Important
A continuous operation without sample gas for a period of four to eight hours (or
overnight) is recommended, during which no changes should be made to the
settings described in Step 1 through Step 7.

4.5.4 Purge calibration gas lines
Prerequisites

Purging calibration gas lines requires power and a personal computer (PC) connected to
the gas chromatograph (GC).

Procedure

1. Ensure that the carrier gas lines have been fully purged and that the sample vent
plugs have been removed.

2. Close the calibration gas bottle valve.

3. Fully open the block valve associated with the calibration gas feed.

Refer to the MON2020 Software for Gas Chromatographs Reference Manual for
instructions on selecting streams.
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4. Open the calibration gas bottle valve.

5. Increase the outlet pressure to 15 psig (103.4 kPa), plus or minus five percent, at
the calibration gas bottle regulator.

6. Close the calibration gas bottle valve.

7. Let both gauges on the calibration gas bottle valve bleed down to 0 psig (0 kPa).

8. Repeat Step 4 through Step 7 five times.

9. Open the calibration gas bottle valve.

Note
This applies to vapor calibration standard.

 WARNING

Failure to follow the safety instructions may cause injury to personnel.

Observe all safety precauations defined in the calibration gas Safety Data Sheet
(SDS), especially for hazardous locations.

4.6 Start up the system
Procedure

1. For system startup, run a single-stream analysis of the calibration gas.

a) Verify the calibration stream is set to Auto.

b) Use MON2020 to run a single stream analysis on the calibration stream. Once
proper operation of the GC is verified, halt the analysis by selecting Control
→ Halt....

Note
Example - use the MON2020 → Control → Single Stream → Calibrate menu
path and select the associated analysis stream.

Unless stated otherwise in the product documentation, ensure that the
pressure of the calibration and sample line is regulated at 10 to 30 psig (68.9
to 206.8 kPa). 15 psig (103.4 kPa) is recommended.

c) Validate calibration gas and retention times and run a manual calibration.

d) Go to MON2020  → Application → Component Data and select the
associated stream. Check the Component Data table for calibration gas
validation information and retention times.

e) Go to MON2020 → Control → Calibration and select the analysis stream to
run a manual calibration. Select the Purge stream for 60 seconds checkbox
and Normal calibration type radio button; then click OK.

Refer to the MON2020 Software for Gas Chromatographs Reference Manual for
more information.
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2. Select Control → Auto Sequence... to start auto sequencing of the line gas
stream(s).

Refer to the MON2020 Software for Gas Chromatographs Reference Manual for more
information.

The gas chromatograph (GC) begins the auto sequence analysis.
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5 Operation and maintenance

5.1 Warning and precautions
 WARNING

Failure to observe the precautionary signs posted on the Rosemount 700XA can result in
injury or death to personnel or cause damage to the equipment.

Observe all precautionary signs posted on the GC.

 CAUTION

Failure to follow this precaution can result in damage to the card.

Turn off the gas chromatograph (GC) before removing a card from the card cage
assembly.

5.2 Start a 2-point calibration
The 2-point calibration process calculates an exponential power fit that the gas
chromatograph (GC) uses to accurately analyze a sample stream with a flame photometric
detector (FPD).

Prerequisites

The 2-Point calibration process requires two calibration gases that will be used to generate
the data for the exponential power fit calculation. While both calibration gases should
have the same components, one of the calibrations gases, called the low calibration gas
(LCG), should have a lower concentration of the components than the other calibration
gas, which is called the high calibration gas (HCG). The GC can then compute the
coefficients for the 2-point (2-Pt) exponential power fit by doing a single-level calibration
on these individual LCG and HCG streams.

Procedure

1. Start MON2020 and press F6 to open the Component Data window.

2. Change the Calib Type for the target component to 2 pt Calib.

3. For the target component, select the component data table (CDT) that is associated
with the LCG from the 2 Pt Calib High CDT drop-down list.

4. For the target component, select the CDT that is associated with the HCG from the
2 Pt Calib High CDT drop-down list.

5. Run a single stream analysis on the stream associated with the LCG until the
readings stabilize.

6. Run a forced calibration on the stream associated with the LCG.

7. Run a normal calibration on the stream associated with the LCG.
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8. Run a single stream analysis on the stream associated with the HCG until the
readings stabilize.

9. Run a forced calibration on the stream associated with the HCG.

10. Run a normal calibration on the stream associated with the HCG.
The GC is ready to analyze the sample or validation stream using the 2 Pt Exp with
the response factor that was calculated during the LCG and HCG runs.
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5.3 Troubleshooting and repair
The most efficient method for maintaining and repairing the Rosemount 700XA is a
component-replacement concept that allows you to return the system to operation as
quickly as possible.

Use troubleshooting test procedures to identify sources of trouble, such as printed-circuit
assemblies, valves, etc., and replace them with parts in known good working order.

5.4 Routine maintenance
The Rosemount 700XA will perform accurately for long periods with very little attention
(except for maintaining the carrier gas cylinders).

It helps to keep a bi-monthly record of certain parameters to assure that the gas
chromatograph (GC) is operating to specifications. Fill out the maintenance checklist
should be filled out bi-monthly, date it, and keep it on file for access by maintenance
technicians as necessary. This gives a historical record of the operation of the Rosemount
700XA, enables a maintenance technician to schedule replacement of gas cylinders at a
convenient time, and allows quick troubleshooting and repair when necessary.

Also, create a diagnostic file, which contains calibration and analysis chromatograms,
alarm and event logs, analysis reports, and the complete configuration file, and file it with
the checklist, furnishing a positive dated record of the Rosemount 700XA. You can
compare these chromatograms and reports to the chromatograms and reports run during
the troubleshooting process.

Before contacting Customer Care, connect to your GC and save the diagnostics data file.
From MON2020 → Tools → Save Diagnostic Data, save the diagnostic data file.

MON2020 prompts you to send an email to Customer Care (at gc.csc@emerson.com) with
the diagnostic data file.

5.4.1 Maintenance checklist
Print the sample maintenance checklist in Figure 5-1 for your records.

If you have a problem, please complete the checklist first and have the results available, as
well as the sales order number, when calling your Emerson Customer Care representative
for technical assistance. The sales order number is on the nameplate located on the front
of the Rosemount 700XA. Emerson files the chromatograms and reports archived when
your gas chromatograph (GC) left the factory by this number.

Note
To find the default measurements for the parameters on the checklist, use MON2020 to
view the GC’s parameter list.
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Figure 5-1: Sample Maintenance Checklist
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5.4.2 Routine maintenance procedures
At least bi-monthly, create and save a diagnostic data file and check carrier and calibration
gas supplies.

Diagnostic data file

The diagnostic data file is a small data file that contains the last chromatogram from each
stream, the final calibration chromatogram, calibration reports, validation reports,
protected chromatograms, the maintenance log, and the event log. To create the
diagnostic data file in MON2020, go to Tools → Save Diagnostic Data... and save the file
to your computer.

5.4.3 Service programs
Rosemount Lifecycle Services offers maintenance service programs that are tailored to fit
specific requirements.

Contracts for service and repair can be arranged by contacting Lifecycle Services at the
address or telephone number on the back of this manual or visiting the website at:
Lifecycle Services

5.4.4 Precautions for handling printed circuit (PC) assemblies
Printed circuit assemblies contain complementary metal-oxide-semiconductor (CMOS)
integrated circuits, which can be damaged if the assemblies are not properly handled.

 CAUTION

EQUIPMENT DAMAGE

Do not install or remove the printed circuit assemblies while power is applied to the gas
chromatograph (GC).
Keep electrical components and assemblies in their protective (conductive) carriers or
wrapping until ready for use.
Use the protective carrier as a glove when installing or removing printed circuit
assemblies.
Wear an electrostatic discharge (ESD) strap to prevent static discharge when installing
or removing printed circuit assemblies.
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Figure 5-2: SW7 on the Central Processing Unit (CPU) Board

A. SW7 switch (ON is towards the dot.)

5.4.5 Flame ionization detector (FID) configuration
When connected to the gas chromatograph (GC) via MON2020, select Hardware →
Detectors to access the Detectors dialog.

Refer to the MON2020 Software for Gas Chromatographs Reference Manual for additional
configuration details.
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Figure 5-3: MON2020 - Detectors Window

Halt the analysis: Control → Halt (F3).

Configure the following fields from the Detectors dialog:

• FID Ignition - Manual or Automatic

• Ignition Attempts

• Wait Time Bet (between) Tries

• Igniter On duration

• Flame On Sense Temp

• Flame Out Sense Temp

• Electrometer Voltage

Note
If the FID does not appear in the Detectors window your GC may not be fitted with an FID.

5.4.6 Replace the central processing unit (CPU)
Procedure

1. Save the gas chromatograph (GC) configuration file. In MON2020, go to File →
Save Configuration (to PC).

2. Power down the GC.

3. Open the GC cover.

4. Remove the clear plastic cover that holds the boards in place.

5. Remove the CPU board.
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 CAUTION

ELECTROSTATIC DISCHARGE (ESD) HANDLING PRECAUTIONS REQUIRED

CPU boards are sensitive electronic devices.

Do not ship or store near strong electrostatic, electromagnetic, or radioactive
fields.
Use an antistatic wrist strap (or ESD wrist strap) when handling the boards.
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6. On the new CPU board, set up switches as shown in the following image:

Figure 5-4: CPU Switch Settings

A. Turn SW7 ON (toward the dot).
B. Turn SW3 OFF (away from the dot).
C. Turn SW4 OFF (away from the dot).
D. Turn SW6 OFF (away from the dot).

Note
Rosemount 700XA GCs are tagged with CPU board part number 7A00555G02.

7. Install the new CPU board in the card cage.

Ensure the board is seated firmly in place.

8. Place the clear plastic cover back over the boards.

9. Close the GC cover.
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10. Power up the GC and connect to it through MON2020.

11. In MON2020, go to Chromatograph → View/Set Date_Time. Set the date and time
for the GC.

See the MON2020 Software for Gas Chromatographs Reference Manual for more
information.

12. In MON2020, go to Tools → Cold Boot. Cold boot the GC.
The GC reboots automatically and disconnects from MON2020.

13. Wait for the GC to reboot.

14. Reconnect to the GC using MON2020.

15. In MON2020, go to File → Restore Configuration (to GC). Use the configuration
file you saved in Step 1 or use the last known good configuration.

16. Wait for the heaters to stabilize.

17. Go to Control → Auto Sequence to auto sequence the GC.

5.4.7 Repairing and maintaining the valves
Only minimal valve repair and maintenance is required (e.g., replacing the diaphragms).

Required tools for valve maintenance
The tools required for performing repair and general maintenance on the Rosemount XA
Series valve assemblies are:

• Torque wrench, scaled in foot-pounds

• ½-in. socket for 10-port valves

• 7/16-in. socket for 6-port valves

• ¼-in. open-ended wrench

• 5/16-in. open-ended wrench

• 5/32-in. Allen wrench

Valve replacement parts
Replacement parts required for each Rosemount XA Series valves consist of the following
parts:

• Diaphragm kit 6-port XA valve (PN 2-4-0710-248)

• Diaphragm kit 10-port XA valve (PN 2-4-0710-171)
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Figure 5-5: XA Series Valves

Overhaul a valve
Note
Rosemount valves have a lifetime warranty. Replacement factory-built XA Series valves are
available. Call your local Emerson Customer Care representative for more information.

If you are overhauling a 6-port valve, refer to drawing #CE-22260; If you are overhauling a
10-port valve, refer to drawing #CE-22300. Both drawings are available in Engineering
drawings.

Procedure

1. Shut off the carrier and sample gas streams entering the unit.

 WARNING

HOT SURFACES

Failure to allow the analyzer to cool may cause burns from hot surfaces in the
enclosure.

Power down the GC and allow it to cool for at least five minutes.

2. Disconnect tubing and fittings that attach to the valve from other locations.
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3. Loosen the valve’s torque bolt.

Figure 5-6: Valve

A. Torque bolt

4. Holding the lower piston plate, pull the valve straight off the block.

The alignment pins may stick slightly.

5. Remove and discard the old valve diaphragms and gaskets.

6. Clean the sealing surface as required using a non-lint-forming cloth and isopropyl
alcohol. Blow the sealing surface with clean, dry instrument air or carrier gas.

Note
Dirt, including dust and lint, can cause troublesome leakage.
Do not use an oil-based cleaner on the valve.

7. Replace the old diaphragms and gaskets, in the same order, with the new ones
supplied.

8. Reassemble the valve using the following steps:

a) Align the pins with holes in the block and push the valve assembly into place.

b) Tighten the valve’s torque bolt.

The 6-port valve requires 20 ft./lb. of torque; the 10-port valve requires 30
ft./lb. of torque.

c) Reinstall the valve using the two mounting screws and reconnect all fittings
and tubing.
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Replace solenoids
You can replace the oven system solenoids and/or the stream switching solenoids.

 WARNING

EXPLOSION

Failure to follow this warning may result in injury or death to personnel or cause damage
to equipment.

Disconnect all electrical power to the gas chromatogaph (GC) and ensure the area is free
of explosive gases.

Procedure

1. Remove the thermal cover from the upper enclosure.

2. Loosen the ultem thumb screw and tilt the oven on its side to gain access to the
solenoids that are located on the underside of the ultem.

3. Loosen the screws holding the solenoid in place and remove the solenoid.

4. Place a small amount of silicone grease on the target device (pneumatic block, four-
way stream block, etc.) where the solenoid is to be placed.

The grease ensures a tight seal.

5. Tighten the screws to hold the solenoid in place.

6. Place the oven upright.

7. Tighten the ultem thumb screw.

5.4.8 Repairing and maintaining the detectors
When a thermal conductivity detector (TCD) fails to perform normally, you may need to
replace it.

Signs that a TCD may be faulty include, but are not limited to, the following:

• A chromatogram with a wandering or drifting baseline

• A chromatogram with a noisy baseline

• A chromatogram with a no peaks

• No chromatogram

A test for a faulty TCD involves measuring the resistance of each filament using a
multimeter. A pair of thermistors should give the same resistance reading; therefore, if a
thermistor reading is significantly different from the reading of its mate, replace the pair.
Otherwise, the TCD bridge will be unbalanced, noisy, and drifty.

Required tools for thermal conductivity detector (TCD)
maintenance
A flat-head screwdriver is required for removing and replacing TCDs. Use a multimeter to
test the thermistor pair.
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Thermal conductivity detector (TCD) replacement parts
Consult the parameter list that was provided with the gas chromatograph (GC) for the
thermistor kit required to replace one TCD. A new thermistor seal (2-6-5000-084) is also
required.

Figure 5-7: TCD

A. Gas connector
B. TCD block
C. TCD 1 and TCD 2 retainer nuts and thermistor leads

Replace a thermal conductivity detector (TCD)
See drawing DE-22143 in List of engineering drawings - Rosemount 700XA.
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 WARNING

EXPLOSION HAZARD

Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Do not open the enclosure unless the area is known to be non-hazardous or unless all
devices within the enclosure have been de-energized.

 WARNING

Failure to follow this warning may result in injury or death to personnel or cause damage
to the equipment.

Disconnect all electrical power to the gas chromatograph (GC) and ensure the area is free
of explosive gases.

Procedure

1. Disconnect all power to the GC.

2. If you have not already done so, remove the explosion-proof dome and the thermal
cover.
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3. Unscrew and remove the TCDs from the TCD block and the gas connectors.

Figure 5-8: Components of a TCD

A. Gas tubing connector
B. TCD block
C. TCD 1 and TCD 2 retaainer nuts and thermistor leads

4. Loosen the two retainer nuts.

5. Use a flat head screw driver and remove the four TCD termination block screws.

6. The TCD thermistors are held within the TCD block by the retainer nut. To replace
the thermistor, do the following:

a) Unscrew and release the thermistor leads from the termination block.

b) Unscrew the retainer nut from the TCD block.

c) Remove the PTFE seals as well as the thermistor and its wires from the
retainer nut.

d) Remove the PTFE shields from the old thermistor wires and install on the new
thermistor wires.
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e) Insert a new PTFE seal into the TCD block.

f) Thread the thermistor through the retainer nut.

g) Screw the retainer nut back into the TCD block.

Ensure a tight fit (quarter turn after finger tight); otherwise a potential leak
path might open.

h) Reconnect the thermistor leads to the termination block, taking care to
reconnect the thermistor leads to the corresponding terminal block screws.

Note
The thermistors are a matched pair (2-5-1611-003) and must be replaced as such.
Repeat Step 6 for each thermistor in a pair.

Note
Tighten the block screws with a torque wrench to 20 in.-oz.

7. Reconnect the gas tubings.

Make sure tubing is properly seated and reattach the TCD housing with the four
screws.

8. Replace the thermal cover and explosion-proof dome.

9. Apply power to the GC.

5.4.9 Remove the flame ionization detector (FID)
The FID has no replaceable parts. If it has damage (such as as broken resistance
temperature device [RTD] or igniter coil) you will need to remove and replace the FID.

 WARNING

EXPLOSION HAZARD

Failure to de-energize the analyzer may cause serious injury or death to personnel.

Do not open when energized or when an explosive atmosphere may be present.
Keep cover tight while circuits are live.
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Figure 5-9: FID

A. Termination board
B. Cap
C. Ground shield cover
D. Mounting bracket
E. Vent connector
F. Exhaust tube

Procedure

1. Disconnect all power to the gas chromatograph (GC).

Allow at least 10 minutes for the components to cool down.

2. Remove the explosion-proof dome and the thermal hood.

3. Remove the screw connecting the termination board to the FID cap.

4. Remove the two screws from the mounting bracket.

5. Unscrew and remove the vent connector.

Note
Use a backing wrench on the bolt fronting the FID cap when removing the vent
connector.

6. Remove the screw from the top of the FID assembly.

Operation and maintenance Reference Manual
July 2020 2-3-9000-744

114 Emerson.com/Rosemount



 CAUTION

ELECTROSTATIC DISCHARGE (ESD)

Operators and technicians must wear an electrostatic wrist strap when handling
printed circuit cards to prevent shorting the boards through static electricity.

Postrequisites

To reassemble the FID, refer to Reassemble the flame ionization detector (FID). The final
step is to flip the FID switch to the ON position.

5.4.10 Reassemble the flame ionization detector (FID)
Procedure

1. Insert the FID into the mounting bracket and secure with the two block screws.

2. Grasp the edges of the FID board and align with the six socket tubes that extend
into the pins in the cap.

3. Replace the screw at the top of the FID assembly.

4. Tighten the tubing nut connector, securing the FID exhaust tube.

5. Screw in the tubing nut connectors located at the base of the FID.

6. Install the explosion-proof cover over the FID assembly and secure to the base with
eight bolts.
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5.4.11 Replace igniter/thermocouple assembly

Figure 5-10: Igniter/Thermocouple Assembly Front View

A. Bulkhead nut
B. Screws and washers
C. Fitting
D. Bulkhead nut
E. Igniter/thermocouple assembly
F. Igniter connector
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Figure 5-11: Igniter Side View

A. Fitting
B. Screws and washers
C. Bulkhead nut
D. Black plastic edge
E. Igniter/thermocouple assembly
F. Port A
G. Port H
H. Port S

Procedure

1. Loosen the bulkhead nut (Figure 5-10, A).

2. Detach the igniter connector (Figure 5-10, F).

3. Remove the screws and washers (B) from the plastic bracket.

4. Rotate the micro flame photometric detector (µFPD) burner around the bulkhead
nut (Figure 5-10, A) until there is enough room to remove the igniter/thermocouple
assembly.

5. Loosen the nut (Figure 5-10, D); then slide the igniter/thermocouple assembly and
ferrule (not shown here) out of the µFPD burner through the fitting.

6. Slide the bulkhead nut (Figure 5-10, D) and a new ferrule on the new igniter/
thermocouple assembly. Then slide the µFPD burner through the fitting (Figure
5-10, C).

7. Align the black plastic edge of the igniter (Figure 5-11, D) with the end of the nut
(Figure 5-10, D) and gradually tighten the nut (Figure 5-10, D) to the fitting (Figure
5-10, C). Keep pushing the ignitor toward the burner while tightening the nut
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(Figure 5-10, D). The back edge has to be flush with the end of nut (Figure 5-10, D)
when secured. Tighten the nut (Figure 5-10, D) to 4 in.-lb.

Do not overtighten the nut (Figure 5-10, D).

8. Rotate the µFPD burner back to its original position. Finger tighten the screws and
washers (B).

9. Tighten the bulkhead nut (Figure 5-10, A) to 20-in. lb.

10. Secure the screws and washers (B).

11. Reconnect the ignitor connector (Figure 5-10, C).

5.4.12 Troubleshoot igniter/thermocouple assembly

Figure 5-12: Igniter/Thermocouple Assembly Drawing

A. Purple, igniter
B. Black, igniter
C. White, thermocouple
D. Red, thermocouple
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Figure 5-13: Igniter/Thermocouple Assembly Photo

A. Back plate
B. Connectors

• Resistances measured between pins 1 and 2 shall be 0.5 - 1.2 ohms.

• Resistances measured between pins 3 and 4 shall be less than 4 ohms.

Recommended actions

1. Detach connectors.

Voltage between pins 1 and 2 on extension cable end shall measure 3.0 to 3.3
Vdc while igniting. You can manually ignite with the Detectors pop-up window.

If no voltage is measured, you may need to replace the photomultiplier tube
(PMT) module or extension cable.

2. Remove black plate.

Igniter shall glow red while igniting or if you apply 3 Vdc to pins 1 and 2 on
burner end. Do not apply more than 3.3. Vdc to igniter. Do not apply voltage to
igniter for more than 20 seconds.
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5.4.13 Remove the flame photometric detector (µFPD) burner
Use this procedure and refer to assembly drawing DE-22143 to replace the µFPD burner.

 WARNING

EXPLOSION HAZARD

Failure to de-energize the analyzer may cause serious injury or death to personnel.

Do not open when energized or when an explosive atmosphere may be present.
Keep cover tight while circuits are live.

 WARNING

BURN HAZARD

Internal components may be hot. Failure to allow the GC to cool down may result in injury
to personnel.

Allow the GC to cool down before disassembling any components.
Always wear proper personal protective equipment (PPE) when disassembling the
analyzer.

Tools required

• 7 ⁄64-in. Allen wrench

• Phillips screwdriver

• Flathead screwdriver

Procedure

1. Disconnect all power to the unit. Allow at least 10 minutes for the components to
cool-down.

2. Remove the explosion-proof dome and the thermal hood.
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3. Use a 7⁄64-in. Allen wrench and remove the fiber cable screws from the µFPD burner
mounting plate to disconnect the cable.

Figure 5-14: µFPD Burner Disassembly Back View

A. µFPD burner
B. µFPD fiber cable clamp
C. Screws µFPD burner
D. µFPD fiber cable
E. Thumb screw
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4. Affix electrical tape to the end of the disconnected fiber cable to prevent debris or
moisture contamination.

Figure 5-15: µFPD Fiber Cable Disassembled

5. Remove the two screws from the µFPD burner housing.
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6. Remove the fiber cable clamp screws and O-ring. Set aside for reassembly.

Figure 5-16: µFPD Fiber Cable Clamp Dissassembly
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7. Disconnect the air intake, helium intake, and sample lines.

Figure 5-17: µFPD Ignitor and Intake Lines

A. Igniter/thermocouple (TC)
B. Air intake port
C. Helium intake port
D. Sample intake port

Operation and maintenance Reference Manual
July 2020 2-3-9000-744

124 Emerson.com/Rosemount



8. Loosen the top bulkhead nut and remove the µFPD burner assembly.

Figure 5-18: µFPD Burner Bulkhead

A. Bulkhead nut

5.4.14 Install the micro flame photometric detector (µFPD)
burner
Use this procedure and refer to assembly drawing DE-22143 to install the µFPD burner.

 WARNING

EXPLOSION HAZARD

Failure to de-energize the analyzer may cause serious injury or death to personnel.

Do not open when energized or when an explosive atmosphere may be present.
Keep cover tight while circuits are live.
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 WARNING

BURN HAZARD

Internal components may be hot. Failure to allow the gas chromatograph (GC) to cool
down may result in injury to personnel.

Allow the GC to cool down before disassembling any components.
Always wear proper personal protective equipment (PPE) when disassembling the
analyzer.

Tools required

• 7 ⁄64-in. Allen wrench

• Phillips screwdriver

• Flathead screwdriver

Procedure

1. Disconnect all power to the unit.

Allow at least 10 minutes for the components to cool-down.

2. Remove the explosion-proof dome and the thermal hood.
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3. Attach the male fitting of the µFPD burner to the bulkhead nut on the GC. Finger
tighten the bulkhead nut.

Figure 5-19: µFPD Burner Installation

A. µFPD burner

4. Attach and finger tighten two screws/washers on the plastic bracket to center post.
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5. Tighen the bulkhead connector with torque of 20 in. lb.

Figure 5-20: µFPD Fiber Cable Clamp Assembly

6. Install the fiber cable to the µFPD burner connector and secure with cable clamp.
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7. Install the two screws in the rear of the µFPD burner housing.

Figure 5-21: µFPD Burner Assembly

A. µFPD burner
B. µFPD cable clamp
C. Screws µFPD burner
D. µFPD fiber cable
E. Thumb screw
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8. Connect the ignitor, air intake, helium intake, and sample lines.

 WARNING

BURN HAZARD

Internal components may be hot. Failure to allow the GC to cool down may result in
injury to personnel.

Allow the GC to cool down before disassembling any components.
Always wear proper personal protective equipment (PPE) when disassembling
the analyzer.

Figure 5-22: µFPD Ignitor and Intake Lines

A. Igniter/TC
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B. Air intake port
C. Helium intake port
D. Sample intake port

9. Replace the thermal hood and the explosion-proof dome.

10. Apply power to the GC.

5.4.15 Remove the micro flame photometric detector
photomultiplier tube (µFPD PMT) module

 WARNING

EXPLOSION HAZARD

Failure to de-energize the analyzer may cause serious injury or death to personnel.

Do not open when energized or when an explosive atmosphere may be present.
Keep cover tight while circuits are live.

 WARNING

BURN HAZARD

Internal components may be hot. Failure to allow the GC to cool down may result in injury
to personnel.

Allow the GC to cool down before disassembling any components.
Always wear proper personal protective equipment (PPE) when disassembling the
analyzer.

Tools required

• 7 ⁄64-in. Allen wrench

• Phillips screwdriver

• Flathead screwdriver

Procedure

1. Disconnect all power to the unit. Allow at least 10 minutes for the components to
cool-down.

2. Remove the explosion-proof dome and the thermal hood.
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3. Use a 7⁄64-in. Allen wrench and loosen the fiber cable screws from the µFPD burner
mounting plate to disconnect the cable.

Figure 5-23: µFPD Burner Disassembly

A. µFPD burner
B. Fiber cable clamp
C. Screws µFPD burner
D. µFPD fiber cable
E. Thumb screw
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4. Affix electrical tape to the end of the disconnected fiber cable to prevent debris or
moisture contamination.

Figure 5-24: µFPD Fiber Cable Disassembled
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5. Loosen the screws holding the fiber cable bottom clamp. Slide the bottom clamp
up.

Figure 5-25: µFPD Fiber Cable Clamp Dissassembly
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6. Loosen the thumb screw and carefully lift and tilt the Ultem plate and upper
assembly.

Figure 5-26: Upper Assembly Tilted
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7. Loosen the fiber cable clamp screws and disconnect the fiber cable from the PMT.

Figure 5-27: Fiber Cable Disconnected from the µFPD PMT Module

A. Fiber cable
B. Cable clamp
C. Cable clamp screws
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8. Disconnect the wire terminals for J6, J10, and J2.

Figure 5-28: µFPD PMT Module Connections

A. J6 - CAN and power signals
B. J10 - igniter
C. J2 - thermocouple
D. USB connector
E. PMT module bracket screws
F. Stream manifold screws
G. Stream manifold

9. Loosen the two Phillips screws from the stream solenoid manifold.

10. Move the entire manifold away from the µFPD PMT module.

11. Use a large flat head screwdriver to loosen the two µFPD PMT module bracket
screws.

12. Move the 1/16-in. stainless steel tubing away and pull the µFPD PMT module out of
the enclosure.

5.4.16 Install the micro flame photometric detector (µFPD)
photo multiplier tube (PMT) module
Tools required

• 7 ⁄ 64-in. Allen wrench

• Phillips screwdriver

• Flathead screwdriver

Procedure

1. Lower the µFPD PMT module into the enclosure.
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2. Use a large flathead screwdriver to tighten the two µFPD PMT module bracket
screws.

3. Use a Phillips head screwdriver and tighten the two screws to attach the stream
solenoid manifold.

4. Attach the J6, J10, and J2 wire terminals to the µFPD PMT module.

Figure 5-29: µFPD PMT Module Connections

A. J6 - CAN and power signals
B. J10 - igniter
C. J2 - thermocouple
D. USB connector
E. PMT module bracket screws
F. Stream manifold screws
G. Stream manifold
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5. Connect the fiber cable to the µFPD PMT module and tighten the two cable clamp
Allen screws.

The shoulder of fiber cable shall be flush with clamp surface to ensure fiber cable is
fully inserted into PMT module.

Figure 5-30: Fiber Cable Connected to the µFPD PMT Module

A. Fiber cable
B. Cable clamp
C. Cable clamp screws
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6. Carefully tilt and lower the Ultem plate and upper assembly. Tighten the thumb
screw.

Figure 5-31: Upper Assembly Tilted
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7. Remove electrical tape on the end of the fiber cable.

Figure 5-32: µFPD Fiber Cable Assembly
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8. Insert the fiber cable into the µFPD burner.

Figure 5-33: µFPD Fiber Cable Assembly

A. µFPD burner
B. Fiber cable clamp
C. Screws µFPD burner
D. µFPD fiber cable
E. Thumb screw

9. Tighten the burner fiber cable clamp screws.
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10. Tighten the fiber cable upper clamp screws.

Figure 5-34: µFPD Fiber Cable Clamp Assembly

11. Replace the insulated cover and the explosion-proof dome.

12. Apply power to the gas chromatograph (GC).

5.4.17 Liquid sample injection valve (LSIV) maintenance
The following procedures detail how to remove and install an LSIV, as well as how to
replace an LSIV’s seals.

Install a MAT liquid sample injection valve (LSIV)
You can maintain the LSIV while it is attached to the enclosure. However, it may be easier
to perform maintenance with the LSIV removed from the upper enclosure.

 WARNING

This unit operates at high temperature. Failure to follow this precaution may result in
injury or death to personnel.

Allow a cool down period of at least ten minutes after shutting down the gas
chromatograph (GC) and handle it carefully.
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Figure 5-35: MAT LSIV Components

A. Union coupling
B. Actuation section
C. Liquid sample connector
D. Thermal barrier adapter

For a detailed view of the MAT LSIV’s components, see Figure 5-38.

Prerequisites

Although, for the most part, you can remove and disassemble the LSIV with traditional
tools, such as a wrench or pliers, the following tools ar eshipped with your LSIV-mounted
gas chromatograph (GC).

Figure 5-36: LSIV Tools

A. Two 10 mm wrenches
B. Union coupling wrench
C. Two 3 mm Allen wrenches
D. Union coupling spacer
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Procedure

1. Install new MAT valve by doing the following:

a) Attach the retaining ring to the MAT LSIV.

b) Slide the MAT LSIV into the mounting hole in the gas chromatograph (GC).
Refer to Drawing #DE-20990 in Engineering drawings.

c) Tighten the retaining ring by twisting it clockwise to secure the MAT LSIV to
the GC.

2. Connect the following internal GC gas lines to the MAT LSIV:

a) Connect the carrier gas line to the MAT LSIV.

b) Connect the sample gas line to the MAT LSIV.

3. Place the insulation sleeve around the flash chamber as shown in Drawing
#DE-20990.

4. Connect the following external GC gas lines to the MAT LSIV:

a) Liquid Sample IN

b) Liquid Sample Out

c) Air Actuator Inject

d) Air Actuator Retract

5. Install air solenoid items.

Refer to Drawing #DE-20990.

6. Perform a standard system leak test.

7. Restart the sample flow.

You can now return the GC to service.

Remove the MAT liquid sample injection valve
Inside the upper compartment of the gas chromatograph (GC), there are two insulation
covers, which open like clam shells that slide off of the end of the LSIV, to be removed.

Procedure

1. Disconnect the carrier and sample tubing from the LSIV.

2. Remove the heater and resistance temperature device (RTD) from the heater block.

3. Disconnect sample and air tubing from the outer portions of the LSIV.

4. Unscrew the retaining ring, using a pin spanner wrench or other tool.

With the retaining ring loose, the LSIV assembly is free to be pulled out of the upper
enclosure.
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Figure 5-37: Rosemount 700XA after LSIV (A) has been eRmoved

A. Union coupling
B. Actuation section
C. Liquid sample connector
D. Thermal barrier adapter

Replace liquid sample injection valve (LSIV) seals
Due to the possible damage caused by the presence of solids in the sample stream,
combined with the regular, repeated motion of the injection valve stem, LSIV seals may
require annual replacement.

Note
Specific application conditions should dictate the frequency of the seals replacement;
monitor analytical performance to determine appropriate replacement intervals.

Note
ID numbers listed in parentheses refer to “LSIV - Exploded View” in Figure 5-38.
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Figure 5-38: LSIV Exploded View

Procedure

1. Halt sample flow and allow time for the LSIV to cool.

2. Remove the actuation portion (26) of the valve by unscrewing the union coupling
(19) from the heater section (11), which should remain attached to the gas
chromatograph (GC).

Emerson has provided a union coupling wrench for this purpose.

This will expose the sample flow chamber and the old seals that ride the metering
rod (25), which should be treated with great care to prevent bending or scratching.

3. Pull the sample flow chamber assembly (13) off the metering rod. Remove the two
seals (14).

To do this, you may need to push from the opposite sidw with a rod smaller than ⅛
in. (9.5 mm).

Reference Manual Operation and maintenance
2-3-9000-744 July 2020

Rosemount 700XA 147



4. Place new seals on the sample flow chamber assembly. Press the chamber and seals
back over the metering rod.

5. Place the actuation section in position on the heater section’s headpiece.

6. Use the union coupling spacer to ensure that the union coupling is properly aligned
with the heater section’s headpiece.

7. Use the union coupling wrench to retighten the union coupling over the heater
section.

8. Restart the sample flow.

Postrequisites

Return the GC to service.
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5.4.18 Maintain the methanator
The optional methanator, which is a catalytic converter, converts otherwise undetectable
CO2 and/or CO into methane by adding hydrogen and heat to the sample. The methanator
requires little maintenance.

Order Rosemount Kit PN 2-3-0710-265 for the methanator replacement parts.

 WARNING

BURN HAZARD

Enclosure contains hot internal parts. Failure to allow the components to cool down may
cause thermal injuries to personnel.

Do not open the enclosure unless the area atmosphere is known to below the ignitable
concentration of combustible materials or unless all equipment has been de-energized for
35 minutes.

Note
Insulate the methanator assembly to prevent heat loss.
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Figure 5-39: Methanator Assembly

A. Methanator housing cover
B. Heater insulator (2)
C. Heater insulator, split
D. Heater block, methanator bottom
E. Methanator column
F. Resistance temperature device (RTD)
G. Cartridge heater
H. Heater block, methanator top

I. Methanator housing

The RTD is replaceable. When replacing it, take care to anchor the RTD cable to the tubing
to prevent loosening over time.

To replace the RTD, consult drawing #CE-22715 (see Engineering drawings).

5.4.19 Measure vent flow
Prerequisites

You will need an accurate flow meter for this measurement.
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Procedure

1. Consult the parameter list that was provided with the gas chromatograph (GC) to
learn the appropriate flow rate.

2. Attach a flow meter to each measurement vent output on the side of the GC that is
labeled MVn, where n is for each vent.

The flow should match the value displayed in the parameter list.

5.4.20 Access electrical components
Emerson designed the gas chromatograph (GC) to operate for long periods of time
without needing preventative or regularly scheduled maintenance.

The enclosure is explosion-proof, dust-proof, water-proof, and flame-proof.

 WARNING

EXPLOSION HAZARD

Failure to de-energize the analyzer may cause an explosion and severly injure personnel.

Do not open the enclosure unless the area is known to be non-hazardous or unless all
devices within the enclosure have been de-energized.

Prior to opening the GC, use MON2020 to ensure that there are no configuration or
parameter errors.

Procedure

1. Ensure electrical power is disconnected from the GC and the environment is safe.

2. Allow the GC to cool.

3. Unscrew and remove the front panel.

4. Note the location and direction of any board removed. Release the catch(es) and
remove/replace the circuit board(s) as necessary.

5. Close and latch the electronics enclosure door.

6. Apply power to the GC.

Replace AC/DC power supply
The AC/DC power supply is mounted on the left wall of the lower enclosure adjacent to the
card cage. To access it, remove the front panel and the switch panel or local operator
interface (LOI) from the lower enclosure.

 WARNING

Failure to follow this warning may result in injury or death to personnel or cause damage
to equipment.

Disconnect all electrical power to the gas chromatograph (GC) and ensure the area is free
of explosive gases.
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Figure 5-40: AC/DC Power Supply in Lower Compartment

Prerequisites

A Cross point #2 Phillips screw driver is required to remove and replace the AC/DC power
supply.

Procedure

1. Remove power to the GC.
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2. Unscrew and remove the front panel.

Figure 5-41: Removing the Front Panel

3. Unscrew and remove the switch panel or LOI to allow access to the card cage.

Figure 5-42: Removing the Switch Panel or LOI
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4. If present, remove the clear cover from the card cage.

Figure 5-43: Card Cage

5. Unplug all the cards in the card cage but do not remove them.

6. Unscrew the three switch panel connector posts. Remove the washers as well.

7. Lift the card cage with the boards and remove it from the lower enclosure.

8. Unscrew and remove the post closest to the power supply.

9. Unplug the connector at the top of the power supply on the left.

10. Unplug the low voltage cable connected along the lower edge of the backplane.

11. Disconnect the ground lead from the power supply at the chassis ground
immediately inside the lower enclosure opening.

12. Remove the nut just above the power supply. Twist the power supply free of the
attaching stud and lift it from its cradle. Remove the power supply carefully to avoid
damage due to wire interferences.

13. Maneuver the new power supply into the cradle, ensuring that the wires are free to
be connected.
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5.4.21 Communications
The Rosemount 700XA has four serial communication ports: Port 0, Port 1, Port 2, and
Port 3, which is a dedicated personal computer (PC) to gas chromatograph (GC) port.

You can set the mode for each of the first three ports to RS232, RS422, or RS485.
Normally, the customer specifies these port configurations at the time of order, and
Emerson sets them at the factory. However, the customer can use MON2020 to change
them at any time.

Note
The backplane has two switches located at SW1. The first switch is used for starting the
DHCP server. See Connect directly to a personal computer (PC) using the gas
chromatograph's (GC’s) Ethernet1 port for more information. The second switch is
reserved for future use.

The backplane has two Ethernet ports:

Name Location Connector type

ETHERNET1 J22 RJ45 (DHCP-enabled)

ETHERNET2 TB11 4-wire terminal block

Maximum distance by communication type

Communication Type Maximum length

RS-232 50 ft. (15.2 m)

RS-422/RS-485 4000 ft. (1219.2 m)

Ethernet (CAT5) 300 ft. (91.4 m)
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Change the line drivers
The following table lists the relevant traits of the gas chromatograph's (GC's) serial ports.

Port name Port mode
Terminal block
location on the
backplane

Communication
modes supported

Port 0 RS232 TB1

Modbus® ASCII/RTU

RS422, RS485 TB2

Port 1 RS232 TB5

Port 2 RS232 TB8

RS422, RS485 TB9

Port 3
(DB9 connector)

RS232 J23 (Laptop-PC) Modbus ASCII/RTU
Direct Connection
through MON2020

Note
You can use Port 3 to connect directly to the personal computer (PC).

 WARNING

EXPLOSION HAZARD

Failure to de-energize the analyzer may cause an explosion and severely injure personnel.

Do not open the enclosure unless the area is known to be non-hazardous or unless all
devices within the enclosure have been de-energized.

 WARNING

HOT SURFACES

Failure to allow the analyzer to cool may cause burns from hot surfaces in the enclosure.

Power down the GC and allow it to cool for at least five minutes.

The factory setting for each port is RS232. To change the setting of a serial portL

Procedure

1. Start MON2020 and connect to the GC.

2. Select Applications → Communication.
The Communication window displays.
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3. Select the appropriate mode from the Port drop-down list for the appropriate serial
port.

The options are:

• RS232

• RS485

• RS422

Figure 5-44: MON2020 Communication Settings

4. Click OK.

5. Close MON2020.

6. Locate and remove the base in/out (I/O) board, which is located in the card cage in
the GC’s lower enclosure.

7. Consult Figure 5-45, which shows the correct switch settings.
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Figure 5-45: Base I/O Board (PN 7A00403G01/G02)

A. SW10 - ON position - factory setting

8. To enable line termination for a serial port, set the appropriate port switch on SW10
to the bottom position.

9. Replace the Base I/O board in the card cage.

10. Consult Table 5-1, which shows the correct termination block wiring for each mode
and port.

Table 5-1: Port Configurations

The first column lists the port number; the first row lists the communications mode. The table cell at which the desired
port and the desired mode intersect contains the appropriate wiring for that configuration.

RS232 RS422 (full duplex/4-wire) RS485 (half duplex/2-wire)

Port 0
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Table 5-1: Port Configurations (continued)

RS232 RS422 (full duplex/4-wire) RS485 (half duplex/2-wire)

Port 1 N/A N/A

Port 2
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11. Access the backplane and see Figure 5-46 to locate the appropriate terminal blocks:

Figure 5-46: RS232 and RS485, TB1 and TB2 on the Backplane

A. TB1, Serial Port 0, RS232
B. TB2, Serial Port 0, RS422/485
C. TB5, Serial Port 1, RS232
D. TB8, Serial Port 2, RS232
E. TB9, Serial Port 2, RS422/485

12. Once the appropriate termination blocks are wired correctly, close and secure the
electronics enclosure door, and apply power to the GC.

Install optional RS232 serial ports
You can install an optional RS232 board in one or both of the expansion in/out (I/O) slots
provided on the gas chromatograph's (GC's) card cage in the electronics enclosure.

You can use this extra port for Modbus® ASCII/RTU communications or to connect directly
to a computer installed with MON2020.
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Figure 5-47: RS232 Connections

Terminal Label Definition

1 RX Receive

2 TX Transmit

3 RTS Request to send

4 DTR Data termininal ready

5 GND Ground

Procedure

1. Start MON2020 and connect to the GC.

2. Select Tools → I/O Cards.

3. Identify the appropriate card slot under the Label column and then select
Communications module - RS232 from the appropriate Card Type drop-down list.

4. Click OK.

5. Turn off the GC.

6. Install the RS232 board into the appropriate I/O card slot in the GC’s card cage.

7. Close and secure the electronics enclosure door.

8. Apply power to start the GC.
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Install an optional RS485/RS422 serial port card
You can install an optional RS485 board in one or both of the expansion in/out (I/O) slots
provided with the gas chromatograph's (GC's) card cage in the electronics enclosure. You
can configure this card to RS422 (four-wire) or RS485 (two-wire) mode.

RS485 mode is the default setting; to configure the card for RS422 mode, see Configuring
the optional RS485 serial port to function as an RS422 serial port. Also see Emerson.com/
ROC800-Series.

Procedure

1. Start MON2020 and connect to the GC.

2. Select I/O Cards from the Tools menu.
The I/O Cards window displays.

3. Identify the appropriate card slot under the Label column and then select
Communications module - RS422/485 from the appropriate Card Type drop-down
list.

Figure 5-48: MON2020 I/O Cards

4. Click OK.

5. Turn off the GC.

6. Install the RS485/RS422 serial port card into the appropriate expansion slot in the
GC’s card cage.

7. Replace the card cage cover, local operator interface (LOI) board, and enclosure
cover. Start the GC.

Configuring the optional RS485 serial port to function as an
RS422 serial port
See Table 5-2 for the correct jumper settings to configure the optional RS485 serial port to
function as an RS422 serial port:
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Table 5-2: Configuring the Serial Connections for RS485/RS422 Serial
Communications

Jumpers RS485 (half duplex/2-wire) RS422 (full duplex/4-wire)

J3 Half Full

J5 Half Full

Termination IN Termination OUT

J4 In Out

J6 In Out

TB1 wire terminals RS485 (half duplex/2-wire) RS422 (full duplex/4-wire)

A RxTx+ Rx+

B RxTx- Rx-

Y NC Tx+

Z NC Tx-

5.4.22 Analog inputs and outputs
Use MON2020 to calibrate or adjust the analog outputs.

However, make sure to measure these outputs with a calibrated digital meter upon initial
installation at zero scale and full scale. Then use MON2020 to set the sapn so that it
represents values from 0 to 100 percent of the user-defined units in use.

Nominally, calibration is made within a range of 4-20 milliamperes (mA) output from each
analog channel. To set a reference point to trigger an alarm condition, configure zero scale
calibration with a 0 mA output and full scale calibration set up to 22.5 mA output.

If there is reason to suspect that the span on any particular channel might be off after a
period of time and heavy use, then recalibrate the analog output for that channel.
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Analog output adjustment
Emerson sets the initial analog output adjustments at the factory before shipment at
standard values (4-20 mA). You many need to check and/or adjust these values depending
on output cabling/impedance.

The adjustment may require two people if the units are some distance apart. It requires a
calibrated digital meter to check the zero and full scale values at the receiving end. You
can use MON2020 to adjust the scale or span value.

You can use different engineering units, volts, and percentages to calibrate the analog
outputs.

5.4.23 Upgrading the embedded software
The base GC firmware performs functions similar to operating systems such as DOS,
Windows™, or Linux®. The base GC firmware provides the basic resources and interfaces to
run the customer's applications. There is no direct user-level interface to the firmware.

If you need to upgrade the firmware to your system, refer to the MON2020 Software for
Gas Chromatographs Reference Manual for additional information.

The GC’s applications use the tools provided by firmware to perform the desired gas
chromatograph applications for the user. There are different applications to facilitate
different gas chromatographic needs. To load a new application or to upgrade an existing
application, refer to the MON2020 Software for Gas Chromatographs Reference Manual
for details.
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6 Troubleshooting
The information is arranged either by major subsystems or by major functions of the gas
chromatograph (GC).

Note
Correct all alarms before recalibrating.

6.1 Hardware alarms
Use LTLOI Failure through Flame Photometric Detector Board 1 Comm Failure to identify
the alarm, potential cause, and solution for the problem.

6.1.1 LTLOI Failure
Recommended actions

1. Power the gas chromatograph (GC) down completely.

2. Check that the local operator interface (LOI) is connected to the backplane
board at one end and the LOI board at the other end.

3. Power up the GC.

4. If the message appears again, replace the board.

6.1.2 Maintenance Mode
A technician has put the gas chromatograph (GC) into Maintenance mode for servicing.

Recommended action

To disable Maintenance mode, deselect the Maintenance Mode check box in the
System dialog.

6.1.3 Power Failure
Potential cause

The gas chromatograph (GC) has experienced a restart, caused by a power failure, since
alarms were last cleared.

Recommended action

Allow the GC to automatically restart in Warm Start mode.

During Warm Start mode, the GC does the following:

a. Waits for the heaters to stabilize.

b. Purges the sample loop.

c. Actuates the valves for two cycles.

After completing these actions, the GC switches to auto-sequence mode.
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6.1.4 User Calculation Failure
The gas chromatograph (GC) has detected one or more errors while parsing a user-defined
calculation.

Potential cause

This usually happens when a user-defined calculation attempts to use a system variable
that does not exist.

Recommended action

Fix the calculation that is referring to the undefined system variable.

6.1.5 Low Battery Voltage
The gas chromatograph (GC) has detected a low battery voltage on the central processing
unit (CPU) board.

Recommended actions

Replace the CPU board immediately to avoid losing GC configuration data.

a) Save the diagnostic data file. In MON2020, go to Tools → Save Diagnostic
Data.

b) Power down the GC.

c) Ensure that SW7 on the CPU board is in the On position.

d) Replace the CPU board.

e) Restore configuration back to the GC. In MON2020, go to File → Restore
Configuration to GC..

6.1.6 Preamp Board 1 or Preamp Board 2 Comm Failure
The gas chromatograph (GC) cannot detect the preamp board.

Recommended actions

1. Power the GC down completely.

2. Check that the board is properly seated in the correct slot (Preamp1 or
Preamp2) on the backplane.

In MON2020, select Hardware → Installed Hardware for hardware slot
locations.

3. Power up the GC.

4. If the message appears again, replace the preamp board.
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6.1.7 Flame ionization detector (FID), flame photometric
detector (FPD), or µFPDG2 (FPDG2) Failure
Alert message identifies FID/FPD or FPD G2 hardware. The FID/FPD or µFPD is not
detected.

Recommended actions

1. Power the gas chromatograph (GC) down completely.

2. Check that the board is properly seated in the correct slot (Preamp 2) on the
backplane.

3. Power up the GC.

4. If the message appears again, for the FID, replace the electrometer. For the
µFPD, replace the photomultiplier tube (PMT) module.

6.1.8 Heater Solenoid Board (1 or 2) Comm Failure
Heater/solenoid board not detected.

Recommended actions

1. Power the gas chromatograph (GC) down completely.

2. Check that the board is properly seated in the correct slot (Heater Solenoid 1 or
Heater Solenoid 2) on the backplane.

3. Power up the GC.

4. If message appears again, replace the heater/solenoid board.

6.1.9 Base in/out (IO) Board Comm Failure
Base I/O (multifunction I/O) board not detected.

Recommended actions

1. Power the gas chromatograph (GC) down completely.

2. Check that the board is properly seated in the correct slot on the backplane.

3. Power up the GC.

4. If message appears again, replace the base I/O board.

6.1.10 Stream Skipped
One or more streams in the stream sequence cannot be analyzed, because their Usage
option is set to Unused.

Recommended actions

In MON2020, do one of the following:
• Remove the unused stream(s) from the stream sequence.

• Change the Usage option of the stream(s) in the Streams dialog to something
other than Unused.
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6.1.11 GC Idle
Potential cause

The gas chromatograph (GC) has been placed in Idle mode and is not running an analysis.

6.1.12 Heater (1-8) Out of Range
The gas chromatograph (GC) has failed to regulate heater zone temperatures for the
indicated heater to within preset limits.

Recommended actions

1. Check temperatures within the GC, using MON2020 or the local operator
interface (LOI).

Be aware that the GC may generate this alarm following start-up or if the set
point has been changed.

2. Check wiring, looking for splits or loose connections at the termination board
(for both the heaters and the resistance temperature devices [RTDs]).

3. If necessary, replace the defective heater and/or RTD.

6.1.13 Flame Out
Detector 1 Flame Out

The flame ionization detector (FID) or flame photometric detector (FPD) will not light or
has extinguished.

Potential cause

The FID is out.

Recommended actions

1. Use the front switch panel or MON2020 to ignite the flame.

2. If unable to sustain the flame, confirm that both fuel and air cylinders are
connected and contain sufficient pressure.

3. Confirm that the fuel and set points are set to achieve the factory-desired
mixture.

4. Confirm that there is no blockage at the FID exhaust outlet, such as a cap or ice.

5. Check that the wiring connections are secure for the FID, both on the FID cap
and at the termination board.

6. If necessary, replace the FID module.

To ignite the flame manually:

1. Connect the air to the inlet and slowly bring the pressure to 60 psig (413.7 kPa).

2. Connect hydrogen to the inlet and slowly bring the inlet pressure to 60 psig
(413.7 kPa).
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3. Remove tubing from the flame cell exhaust and use a digital flow meter to
adjust the air control valve until you obtain a reading of 160 cc/min.

4. Turn off the air supply.

5. Set the auto relight switch (S1) on the electrometer PCB to the OVERRIDE
position.

6. Use the digital flow meter to adjust the hydrogen control valve until you obtain
a reading of 100 cc/min.

7. Turn on the air supply.

8. Set the auto relight switch (S1) on the electrometer PCB to the RUN position.
The auto relight sequence begins as follows:

a. The light-emitting diode (LED) on the electrometer comes on after 10
seconds, and the glow plug fitted to the side of the flame cell is supplied
a voltage.

b. After another five seconds, the hydrogen shut-off valve operates.

c. The gas mixture ignites.

d. If the flame does not light in five seconds, the electrometer de-energizes
the hydrogen shut-off valve to stop the flow into the flame cell.

e. The flame cell is purged with air and nitrogen carrier gas.

f. The process starts again (up to 10 times) until the flame stays lit.

g. If the flame does not stay let, the LED flashes. If the alarm output is linked
to the 2350A controller discrete input, an alarm is present on the
controller.

h. Set the auto relight switch (S1) on the electrometer PCB to the RESET
position and then back to the RUN position.

i. The relight sequence restarts.

Potential cause

The FPD is out.

Recommended actions

1. In MON2020, click Open H2 Valve.
The H2 Valve Cur State field changes to Open.

2. Click Ignite.
The Flame Status field changes when the internal temperature exceeds the
value set in the Flame On Sense Temp field.

Note
If the Flame Ignition field is set to Auto, the GC will automatically restart the
flow if it goes out.

3. If the GC fails to light after resetting the electrometer, recheck the air and
hydrogen flow.
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For more information on the FPD, see Micro flame photometric detector
(µFPD).

6.1.14 Flame Over Temperature
Detector 1 flame over temperature.

The flame ionization detector (FID) flame temperature is above safe limits set at the
factory. The FID flame has been extinguished, the fuel supply valve closed, and automatic
analyses halted.

Recommended actions

1. Confirm that both fuel and air cylinders are connected and contain sufficient
pressure.

2. Confirm that fuel and air set points are set to achieve desired mixture.

3. Use the local operator interface (LOI) or MON2020 to ignite the FID.

6.1.15 Detector (1-3) Scaling Factor Failure
The gas chromatograph (GC) detected an excess scaling factor deviation for the detector.

Recommended action

Replace the preamp board.

The preamp boards for detectors 1 and 2 are located in Preamp 1.

The preamp board for detector 3 is located in Preamp 2.

6.1.16 No sample flow (1 or 2)
This alarm applies to the optional sample flow switch. The corresponding flow switch
indicates that there is no sample flow in the gas chromatograph (GC).

Recommended actions

Check the sample gas rotameter in the sample conditioning system for flow.
• If no gas flow or no rotameter is present:

a. Confirm that there is gas flow at the sample point location.

b. Ensure that the sample valves in the sample conditioning system are open.

c. Ensure that the bypass return vent path is free of obstruction.

d. Confirm that the sample line is connected from the sample point to the GC's
sample conditioning system and is free of obstructions.

e. Close the valve at the sample tap, remove pressure from the line, and check
the filters at the probe, the sample conditioning system, or both. If they are
filled with liquids or particulates, replace the filtering elements.

• If automatic stream selection valves are present, confirm that they are operating
properly.
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• If a slight sample gas flow is present at the rotameter in the sample conditioning
system, drain or replace all filters.

• If you observe flow in the rotameter, replace the sample flow switch.

6.1.17 Low Carrier Pressure (1-4)
Input carrier pressure for the detector is below the preset limit.

Recommended actions

1. Check that the carrier cylinder pressure is at least 10 psig (68.9 kPa) above the
mechanical regulator set point.

2. If input carrier pressure is low, check the carrier cylinder pressure.

3. Replace the carrier gas cylinder if required.

6.1.18 Analog Input (1-10) High Signal
Measured value for the indicated analog input is greater than the user-defined full scale
range.

6.1.19 Analog Input (1-10) Low Signal
Measured value for the indicated analog input is lower than the user-defined full scale
range.

6.1.20 Analog Output (1-10) High Signal
Measured value for the indicated analog output is greater than the user-defined full scale
range.

6.1.21 Analog Output (1-10) Low Signal
Measured value for the analog output is lower than the user-defined zero range.

6.1.22 Stream (1-20) Validation Failure
The most recent validation sequence for the indicated stream failed.

Recommended actions

1. Ensure that the validation gas cylinder isolation valves are open.

2. Ensure that the validation gas regulators are set properly.

3. If the validation gas regulator pressure is below the set point, replace the gas
bottle with a full one.

4. If the gas used for validation is the same as the gas that is used for calibration,
ensure that the cylinder gas composition value listed on the cylinder's tag or on
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the certificate of analysis received from the supplier matches the value
displayed in MON2020's Component Data table.

6.1.23 Stream (1-20) RF Deviation
The most recent calibration sequence failed.

Recommended actions

1. Ensure that the calibration gas cylinder isolation valves are open.

2. Ensure that the calibration gas regulators' pressures are set properly and that
the cylinder is not below the set point. If the cylinder is below the set point,
replace it with a full cylinder

3. Verify that the calibration cylinder gas composition value listed on the cylinder
tag or on the certificate of analysis received from supplier matches the
calibration cylinder gas composition value displayed in MON2020's Component
Data table. If there is a mismatch, edit the Component Data table to reflect the
correct value. Re-run the calibration sequence.

4. If the calibration is still unsuccessful, contact your Emerson representative.

6.1.24 Energy Value Invalid
For each configured analysis (Analysis n label added if it is a concurrent analysis
configuration), perform a check of the analyzed energy value of the calibration gas against
the known value as part of the warm start sequence.

The Energy Value Invalid alarm is raised to instruct the associated DCS that the analyzer has
failed and all data should be ignored until a successful calibration run has been performed
to verify the analysis of the gas chromatograph (GC).

On completing warm-up, the GC performs a single analysis of the calibration stream.
Using results of the analysis, the GC calculates the energy value and compares it against
the previously entered value stored in the tables.

If the calculated energy value is within the allowable limits set up by the operator, the
Energy Value Invalid alarm is cleared, and the GC returns to normal operation; otherwise,
the Energy Value Invalid alarm remains active.

Recommended actions

1. Ensure that correct Calibration Gas Energy Value and limits have been entered
in the Component Data Table → Edit Energy Value dialog window.

2. Ensure the calibration gas bottle is open and not low or empty.

3. Check analyzed concentration results for each individual component versus
calibration gas concentrations in the Component Data table.

4. Adjust timed events if necessary.

6.1.25 Calibration Energy Check Fail
After completing a calibration sequence, the gas chromatograph (GC) performs a
calibration gas energy value check.
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If the calculated energy value fails the check, the software automatically runs the
calibration again.

If the second calibration also fails this check, the GC raises a system alarm, Calibration
Energy Value Check Fail.

Recommended actions

1. Ensure the calibration gas bottle is open and not low or empty.

2. Check analyzed concentration results for each individual component versus
calibration gas concentrations in the Component Data table.

3. Adjust timed events if necessary.

6.1.26 Stored Data Integrity Failure
Archived results, event logs, and alarm logs are stored as records in the instrument
database along with a CRC16 checksum. When the data is retrieved, the gas
chromatograph (GC) recomputes the checksum and checks the stored checksum against
the calculated checksum. If they don't match, the GC raises a Stored Data Integrity Failure
alarm.

Recommended actions

1. Reset archives using the dialog box under MON2020 → Logs/Reports Menu.

Note
All archived data in the GC will be lost.

2. Replace the central processing unit (CPU) board.

6.1.27 ROM Checksum Failure
The gas chromatograph (GC) recomputes the firmware checksum at periodic intervals. If
the calculated checksum varies from the original value, the GC raises a ROM Checksum
Failure alarm.

Recommended actions

1. Re-flash the GC controller firmware in MON2020 Tools → Upgrade Firmware.

Note
All archived data in the GC will be lost.

2. Replace the central processing unit (CPU) board.

6.1.28 Sample Fluid Unavailable
The stream switching sequence defined in the Custom Logic configuration failed to
successfully execute. <Analysis n Label> is added for concurrent analysis configurations.

Recommended action

Confirm proper operation of all sample system components and ability to provide
adequate sample flow.
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6.1.29 Flame Photometric Detector Board 1 Comm Failure
The gas chromatograph (GC) cannot detect the micro flame photometric detector (µFPD).

Recommended actions

1. Power the GC down completely.

2. Check that all cables are securely connected to the FPD interface module.

3. Power up the GC.

4. If the message appears again, replace the FPD photomultiplier tube (PMT)
module.

6.2 No power to flame photometric detector (FPD)
Recommended actions

1. Check cable (7A00454G01), connectors, and terminals.

2. Check flex cable.

3. Check that the voltage from the lower terminal is 25 Vdc.

6.3 Can't ignite flame photometric detector (FPD)
Recommended actions

1. Check the flow.

Gas flow rates are measured at exhaust while oven reaches to set temperature.
The air flow should be 150 cc/min, and the H2 flow should be 100 cc/min.

2. Check igniter resistance in ohms.

The resistance should be 0.6 to 1 ohms.

3. Ensure that the flame temperature is > 493.1 °F (220 °C) when the ignitor is first
turned on and then goes down to 413.1 °F (140 °C).

4. Ensure that there are no restrictions at the exhaust line.

6.4 No peaks showing
Recommended actions

1. Ensure that the flame is on.

2. Ensure that the sample gas has been injected.

3. Check carrier gas flow.

4. Check sample flow.

5. Check columns.
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6.5 Small peaks
Recommended actions

1. Clean the burner windows with isopropyl alcohol (IPA).

2. Adjust the air to H2 flow rate to between 1.3 and 1.7.

3. Ensure that the flame photometric detector (FPD) high voltage is 800 Vdc for
side cart option of FPD.

6.6 No temperature readings
Recommended action

Check the thermocouple.

The thermocouple's resistance should be less than 3.5 ohms.

6.7 Noisy baseline
Recommended action

Click Autozero to adjust the baseline.

6.8 Peak clipping
Recommended action

Click Autozero to adjust the baseline.

6.9 Test points
The backplane has a set of test points that allow you to measure the voltage output of the
base in/out (I/O) card.

Each test point is labeled with a voltage value that, when measured with a voltmeter,
should give a measurement equal to what is displayed on the label. A reading that does
not match this label may indicate a faulty base I/O card. Try swapping out the suspect card
with a different one, and take another measurement. To get a measurement for a test
point, touch the voltmeter’s negative probe to the DGND test point and touch the
voltmeter’s positive probe to the desired test point.

The test points are associated with the following gas chromatograph (GC) components:

Table 6-1: Backplane Test Points and Associated GC Components

Test Point GC Component Tolerances

VIN Voltage in N/A

I RTN Isolated return N/A
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Table 6-1: Backplane Test Points and Associated GC Components (continued)

Test Point GC Component Tolerances

I 24V (Regulated) Isolated voltage (loop power) 24 V (±2.4 V)

24V (Regulated) GC power 24 V (±2.4 V)

17V5 Preamp (input for the bridge circuit) 17.5 V ±0.5 V

12V Optional I/O cards 12 V ±0.6 V

5V1 System chips 5.1 V ±0.25 V

3V4 System chips 3.4 V ±0.15 V

FVIN Field voltage input 0 V ± 3 V

FVGND Field voltage ground 21 V ± 30 V

The input voltage range for the DC/DC power supply is between 21 and 30 volts. The input
range for AC/DC power supply is 90 - 264 volts (auto-ranging).

6.10 Voltage light-emitting diodes (LEDs)
A set of LEDs can be found above the test points .

These LEDs are a quick way to visually inspect the voltage status of some of the gas
chromatograph's (GC's) electrical components.

The following LEDs are associated with the following GC components:

VIN (fuse open) Glows red when the fuse has blown or been removed;
otherwise, it is not lit.

1 RTN - 24 loop
(Power)

Glows green when the power supply for the analog
outputs is functioning properly; otherwise it is not lit.

24V regulated (GC
power)

Glows green when the GC power is functioning properly;
otherwise, it is not lit.

17V (Input for the
preamp)

Glows green when the power supply for the preamp is
functioning properly; otherwise, it is not lit.

12V (Input for the
I/O cards0

Glows green when thee optional ROC expansion card's
power supply is functioning properly; otherwise, it is not
lit.

5V1 Glows greeen when the system chip's 5.1 V power supply
is functioning properly; otherwise, it is not lit.

3V4 Glows green when the 3.4 V power supply for the system
chips is functioning properly; otherwise, it is not lit.

Note
Some boards have different shades of green for this LED.

Power ON Glows green when the GC is on; otherwise, it is not lit.
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6.11 Monitoring the detector(s) and columns
temperature
Use MON2020 to monitor the temperature of the detector(s) and columns to determine if
the GC is thermally stable.

When connected to the GC via MON2020, select Hardware → Heaters to access this
function.

When viewing the Heater window, the typical heater configuration is as follows:

The Temperature column on the Heaters window displays the current temperature; the
Current PWM column displays the percentage of power being used to run the heater.

The settings and values shown in the Heaters window and described below, are preset at
the factory and are based on the specific customer application. Do not change these
values unless application engineering or or customer service personnel recommend it or
as part of a factory application requirement.

Function Typical setting

Detector(s) or analytical block temperature 176 °F (80 °C)

Oven temperature 176 °F (80 °C)

Spare

Or, Methanator

Or, LSIV

N/A

572 °F (300 °C)

302 °F (150 °C)
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A Local operator interface (LOI)

A.1 Local operator interface (LOI) for displaying
and entering data
The LOI has multiple components that you can use to interact with the unit.

Figure A-1: LOI Components

A. LCD display screen
B. Keypads
C. Light emitting diode (LED) indicators
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A.1.1 Light emitting diode (LED) indicators
There are three LED status indicators on the local operator interface (LOI) that show the
overall status of the gas chromatograph (GC). These LEDs are positioned to the right of the
display screen. Each LED, when lit, indicates a specific condition.

The GC is currently running an analysis.

The GC has at least one unacknowledged alarm.

The GC has an out-of-tolerance or alarm condition that requires
an operator action.

A.1.2 LCD display screen
The LCD display screen measures 4.4 by 3.3 in. (111.4 x 83.5 mm) and is capable of 640 by
480 VGA pixel resolution, supporting both text and full graphics.

The backlighting, boost, and brightness are all under software control. The boost and
brightness levels are user-adjustable.

A.1.3 Keypad
The keypad consists of eight infrared keys.

Command keys
The four keys located above the LCD display screen are command keys. See Navigating the
screens for more information.

Arrow keys
The four keys below the LCD display screen are arrow keys that allow you to navigate
within the screen by scrolling or moving the cursor from field to field. These keys function
in the same way as a computer keyboard’s arrow keys.

Left Up Down Right
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Pressing a key
To press a key, place a finger on the glass over the associated key hole and then remove
the finger.

Holding a finger over the key hole will cause that key to repeat until the finger is removed.

A.2 Using the local operator interface (LOI)

A.2.1 Start-up
When the gas chromatograph (GC) starts, the local operator interface (LOI) automatically
runs in Status Display mode. Each analyzer's information is displayed in rows. The GC may
have from one to four analyzers.

Only the description and values section of the LOI status variables are scrolled manually
between the configured analyzers for the GC.

Screen Description

Status Displays information about the operational state of the analyzer, including a
manually-scrolling list of up to 25 user-selectable parameters that can be defined or
modified using the MON2020 software.

Note
There is more than one Live Chromatogram screen if the GC is configured with more
than one analysis/cycle clock.
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Screen Description

Live Chromatogram Displays the chromatogram for the current analysis in real time.

Note
There is more than one Live Chromatogram screen if the GC is configured with more
than one analysis/cycle clock. Four detectors are supported for a single analysis.

If there is more than one detector for one analysis (ex. Det 1, Det 3, Det 5), D1/3/5
displays on the title bar.

If there are four live analyses for the GC, the Analysis screen displays for each clock.

Note
This screen does not display if the GC is not currently analyzing a sample.

Active Alarms Lists active alarms, if any.
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Screen Description

Heater Displays information about the PID temperature control loops.

Valves Displays the settings and states of the stream and analyzer valves.

In Status Display mode, pressing the RIGHT key takes you to the next available non-idle
analysis live CGM screen. If all the cycle clocks are idle, then press RIGHT on the Status
screen to go to the Alarm screen. Press LEFT on the Alarm screen to go to the Status screen.
When you press RIGHT, the LOI displays each screen in succession and then loops back to
the Status screen.

Figure A-2: LOI Status Screen

This screen displays the Analysis names and all the four cycle clocks in the Status table. The
LOI status variables are shown for one cycle clock every 15 seconds as depicted in Figure
A-2. For the next 15 seconds, the LOI automatically scrolls and displays the next cycle
clock’s variables.

Press F1 when MOVE is displayed in the green box below to foucs inside the screen, so that
you can navigate through the controls of the screen using the LEFT, RIGHT, UP, and
DOWN keys. Press EXIT to return focus to the top level (outside of the screen). Press LEFT
or RIGHT at the top level to resume automatic scrolling in addition to moving to the
previous or next screen.

At any time, while in Status Display mode, you can press ENTER or F2 to enter the Main
Menu. Use the EXIT key to leave the Main Menu and return the LOI to Status Display mode.
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If you log onto the GC from the Main Menu to perform operations or edit data, when you
exit the menu you will automatically be logged off the LOI.

A.2.2 Navigating menus
The Status screen is now the default home screen. This screen lists information from the
four analyzers as well as the local operator interface (LOI) variables.

You can also access the Status screen from the Application menu. This Status screen
displays the same list of items as the Home Status screen but, the F1 key has works
differently here. The Move label displays as soon as you select the Status screen from the
Application menu.

When the user presses F1 then, the Move label changes to Next, indicating that the LOI
status variables for the next analyzer are displayed at the bottom of the page. If you press
F1 again, the status variables for next analyzer displays. These LOI status variables keep
revolving between the analyzers in order every time you press F1.

Figure A-3: Local Operator Interface - Home Screen (Status)

At any time while in Status Display mode, you can press ENTER or F2 to enter the Main
Menu.

Use the UP or DOWN keys to navigate between fields or controls within each drop-down
menu. Pressing DOWN while focus is on the last field of a drop-down menu moves the
focus to the first field on a screen. Alternatively, pressing UP while focus is on the first field
of the drop down menu causes the focus to move to the last field.
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Use the ENTER key from the Main Menu to activate submenus and individual menu items.

Press EXIT to leave the Main Menu and return the LOI to Status Display mode if no menu is
dropped down. If a menu is dropped down, then pressing EXIT closes that menu.

If you log in to the gas chromatograph (GC) from the Main Menu to perform operations or
edit data, when you exit the menu you will automatically be logged off the LOI.

The Main Menu allows you access to all of the available LOI screens; however, you must be
logged on to make changes. If you are not logged on and you attempt to edit a field, the
Login screen will appear first.

After a period of fifteen minutes of inactivity, the LOI automatically logs you off.

A.2.3 Navigating the screens
Local operator interface (LOI) screen have several functions. They can display data for
review or edit and initiate activities.

Figure A-4: Local Operator Interface - Home Screen

Within any given screen, the function of the ENTER key depends upon the context. You
can use it to validate and save changes or to initiate an action.

If the gas chromatograph (GC) finds a validation error after you press ENTER, an Invalid
Entry message displays. Press ENTER again to close the message and then re-enter your
data.

Reference Manual Local operator interface (LOI)
2-3-9000-744 July 2020

Rosemount 700XA 185



Press EXIT to close the currently open screen. If you have made changes to the screen, the
LOI will display a confirmation message asking if you want to save your changes. Use the
arrow keys to select the appropriate button and press ENTER. If you select No, your
changes will be discarded and the Main Menu will display; if you select Cancel, the message
window will close and you will be returned to the current screen; if you select Yes, your
changes will be validated and saved and then you will be returned to the Main Menu.

The F1 and F2 keys are context dependent. A one-word description of the function of each
of these keys displays in a green prompt box directly under the key in the title bar of the
top-level full-sized screen.

In some cases, F1 acts as a toggle between scrolling either a line or a page at a time. When
this is true, the currently selected option (LN or PG) displays with a green background and
black text, while the non-selected option displays with a black background and green text.
The table below lists the possible functions of the F1 key:

Press F1 to move the cursor around within the boundary of the
screen.

Press F1 to open the edit dialog for the field that contains the cursor.
The type of dialog that displays depends upon the type of field to be
edited. See Editing numeric fields and Editing non-numeric fields for
more information.

Press F1 to select the field to be edited.

Press F1 to delete the character to the left of the cursor.

Press F1 to scroll line by line within a screen.

Press F1 to scroll page by page within a screen.

Press F1 to click the button and execute the command

Note
Throughout this appendix, when referring to the F1 key, the key’s current valid function
will be indicated in parenthesis—for instance, F1 (MOVE) or F1 (SELECT).

The F2 key, when MAIN is displayed in the prompt box, closes all screens and goes back to
the Main Menu.

There is a navigation icon in the upper right corner of the screen that indicates which
navigation keys are active for the currently displayed screen.
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When you press a key, a green check will flash in the upper left corner if the key is valid; if
the key is not valid, a red cross (X) will flash in the upper left corner.

A.2.4 Editing numeric fields
When the focus is on an editable field, pressing F1 (EDIT) will display the Edit dialog
containing the field’s original text.

Use the LEFT or RIGHT keys to move through the individual characters within the field and
to select the character to be changed. Use the UP or DOWN keys to select the value of
each digit. The possible values are 1, 2, 3, 4, 5, 6, 7, 8, 9, 0, "-” (minus), “.” (period), and E.

Special characters supported are: @, !, #, $, %, , &, *, _, = , and ?

The “-” value is available for signed numbers.

The “.” and the E values are available for floating-point numbers, except for retention
times and timed event values.

The following rules apply when entering a floating-point value:

• More than one E is not allowed.

• More than one “.” is not allowed.

• If the previous position is an E, then a “.” and a 0 are not allowed.

• A “-” is allowed only after an E or at the first position.

• If the previous position is “.”, then an E is not allowed.

• If the first character is a “-” and the current index is 1, then a “.” is not allowed.

• If the previous position is a “-”, then a 0 is not allowed.

• If the next character is an E, then a “.” is not allowed at the previous location.

The DOWN key moves backward in the list from the current value of the selected digit.

The UP key moves forward in the list from the current value of the selected digit.

The F1 (BACKSP) key acts as a backspace and deletes the digit immediately to the left of
the current position.

The ENTER key validates and saves the entry and then closes the Edit dialog. The new entry
will display in the field.

The EXIT key cancels any changes that were entered and closes the Edit dialog, restoring
the previous value to the field.
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A.2.5 Editing non-numeric fields
The function of the keys when editing non-numeric data is context-dependent.

Editing alphanumeric fields
Alphanumeric fields take numbers (0 - 9) and letters (a - z, A - Z).

Select check boxes

Figure A-5: Selecting a Check Box

Procedure

Press F1 (SELECT) to select or deselect a check box.

Click buttons

Procedure

Press F1 (EXECUTE) to click a button and execute a command.

Select radio buttons

Procedure

1. Press F1 (SELECT) to select a group of radio buttons.

2. Use the UP/DOWN or LEFT/RIGHT keys to move through the various radio buttons
within the group.

3. Press ENTER to accept the current selection or press EXIT to abort any changes and
to restore the previous selection.

Local operator interface (LOI) Reference Manual
July 2020 2-3-9000-744

188 Emerson.com/Rosemount



Select an item from a list box

Procedure

1. Press F1 (SELECT) while focused on the list box to switch it to Edit mode.

Figure A-6: Selecting a List Box

2. Use the UP and DOWN keys to move between the values within the list box.

3. Press ENTER to accept the current selection or press EXIT to abort the new
selection, and the list box will revert to the previous selection.
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Select an item from a combo box

Procedure

1. Press F1 (SELECT) while focused on the combo field.
A Combo dialog opens and displays a list of available selections.

Figure A-7: Selecting a Combo Box

2. Use the UP and DOWN keys to move between the selections.

3. Press ENTER to select the desired value or press EXIT to restore the combo box’s
initial value.
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Enter a date and time

Procedure

1. Press F1 (SELECT) while focused on the Date and Time field
The Enter the Date and Time dialog displays. By default, the focus is set on the Month
unit.

Figure A-8: Entering a Date and Time

2. Use the UP and DOWN keys to change the value of the unit—that is, to go from
January to February, or from 1 to 2.

3. Use the LEFT and RIGHT arrow keys to change units—that is, to go from months to
years or hours to minutes.

Note
If the focus is on the leftmost section, the LEFT key will be inactive, and similarly if
the focus is on the rightmost section, the RIGHT key will be inactive.

4. Press ENTER to save the change or press EXIT to discard the change and restore the
original value.

Set the time

Procedure

1. Press F1 (SELECT) while focused on the Time field
The Enter the Time dialog displays. By default, the focus is set on the Hour unit.

2. Use the UP and DOWN keys to change the value of the unit.

3. Use the LEFT and RIGHT arrow keys to change units—to go from hours to minutes,
for example.
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Note
If the focus is on the leftmost section, the LEFT key will be inactive, and similarly if
the focus is on the rightmost section, the RIGHT key will be inactive.

4. Press ENTER to save the change or press EXIT to discard the change and restore the
original value.

A.3 Navigate and interact with the screen
This tutorial, which guides you through the procedure for editing data on a screen, will
incorporate all of the preceding information to demonstrate the typical method of
navigating and interacting with the local operator interface (LOI).

You will learn how to perform the following actions:

• Open and close screens.

• Navigate through tables.

• Select fields for editing.

• Save data.

Procedure

1. From the Main Menu, click the RIGHT key enough times to navigate to the
Application menu.

The System submenu, as it is the first item in the list, is already selected.

Note
In this instance, the term click means to tap the glass on the spot directly above the
arrow’s keyhole.

Figure A-9: Navigate to the Application Menu
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Note
Notice the navigation icon in the upper right corner, which indicates that all four
arrow keys are active. This allows you to navigate to all of the menu items and sub
menu items.

Note
Notice that the green prompt boxes are empty. This means that the F1 and F2 keys
are inactive from the Main Menu.

2. Click ENTER.
The System screen displays.

Figure A-10: System Screen

Note
Notice the navigation icon in the upper right corner, which indicates that no arrow
keys are active.

Notice that the green prompt boxes now display function keywords. MAIN means
that if you click F2, the LOI will close the current screen and return you to the Main
Menu. MOVE means that if you click F1, the arrow keys are enabled for navigation
within the System screen.

3. Click F1.
The LOI switches to Edit mode. Notice that the navigation icon in the upper right
corner of the screen indicates that the DOWN key is active.

4. Click the DOWN key once.
Now the navigation icon indicates that both the UP and DOWN keys are active.

5. Click the UP arrow once to return to the previous cell.
The navigation icon again indicates that only the DOWN key is active.

Notice that the green F1 prompt box reads EDIT.
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6. Click F1.
You must be logged in to the gas chromatograph (GC) to make a change to any
screen. If you try to edit a field before logging in—as you just did, the LOI displays
the Login dialog to prompt you to log in.

Figure A-11: Login Screen (Edit Mode Prompt)

Note
Notice that there is also a navigation icon on the Login dialog.

7. Click F1 (SELECT) and navigate up or down the list to highlight your user name.

Note
For the remainder of this tutorial, when referring to the F1 key, the key’s current
valid function will be indicated in parenthesis—for instance, F1 (MOVE) or F1
(SELECT).

8. Click ENTER.

9. Navigate to the Password field, press F1 (EDIT), and enter your password.

Important
The password security policy requires a login name and password. Security levels
include:
• High - password policy level includes following parameters:

— Ensure minimum eight characters length and maximum of 12 characters.

— Ensure at least one upper case character.

— Ensure at least one lower case character.

— Ensure at least one digit.

— Ensure at least one special character:
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• At symbol, exclamation mark, percent symbol, Caret symbol, Ampersand
symbol, Asterisk symbol, underscore, equals, plus, question mark, colon,
or dash

• @, !, #, $, %, ^, &, *, _, =, +, ?, :, -‸

• Immediate reuse of a password will not be allowed. This will avoid setting
same password as new password repetitively

• Ensure password doesn’t contain user name

• There will not be any kind of password expiration after certain time

• Medium password policy level includes the following parameters:
— Ensure minimum eight characters length and maximum of 12 characters.

— Ensure at least one upper case character.

— Ensure at least one digit.

— Ensure password doesn’t contain user name.

— There will not be any kind of password expiration after certain time.

:

• Low password policy level include the following rules:
— Ensure minimum eight characters length and maximum of 12 characters

— Password should contain any alphanumeric character combination (i.e.,
numbers, small letters, capital letters, special characters).

— There will not be any kind of password expiration after certain time

10. Click ENTER twice.
Now that you are logged in, you can edit the fields on the screen.
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11. Click F1 (EDIT).
The Enter the data dialog displays.

The Enter the data dialog allows you to edit the selected field.

Figure A-12: Enter the Data Dialog

12. To delete a character, press F1 (BACKSP). To enter new data, use the UP and DOWN
keys to cycle through the available characters, and use the RIGHT key to add a new
character to the field.
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13. When you are finished entering data, press ENTER to validate and save the new
information. To discard the information, press EXIT.

Figure A-13: New Data Displayed

Note
If a validation error is found after pressing ENTER, an Invalid Entry message displays.
Press ENTER to close the message and then re-enter your data.

14. Use the DOWN arrow to move to the Allow Multiple Writers check box.

Figure A-14: Allow Multiple Writers Check Box Selected
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15. Press F1 (SELECT).
This clears the check box.

Figure A-15: Allow Multiple Writers Checkbox Unselected

16. Click F1 (SELECT) again to reselect the check box.

17. Navigate to the Time Format field.

Figure A-16: Time Format Field

Local operator interface (LOI) Reference Manual
July 2020 2-3-9000-744

198 Emerson.com/Rosemount



18. Press F1 (SELECT).
The Select an Item combo box displays.

Figure A-17: Select an Item Combo Box

19. Use the DOWN key to scroll down to the last item in the combo box. Press ENTER.

20. Press ENTER a second time to save all the changes that were made to the table.

Note
If you neglect to press ENTER at this point, all of your changes will be lost.

21. Press F2 (MAIN) to return to the Main Menu.
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A.4 Local operator interface (LOI) screens
The Main Menu has six top-level submenus: Chromatogram, Hardware, Application, Control,
Logs/Reports, and Tools.

Refer to the MON2020 Software for Gas Chromatographs Reference Manual for detailed
information regarding the commands in Table A-1 through Table A-4.

Table A-1 through Table A-4 list the submenus and commands that are available from the
Main Menu.

Table A-1: Chromatogram Menu

Submenu Command Subcommands Reference

Chromatogram Chromatogram menu

View N/A Chromatogram menu

Live Chromatogram View screen (Status Mode) Figure A-20

Live Chromatogram screen (Advanced Mode) Figure A-21

Archived Chromatogram screen (Advanced Mode) Figure A-26

Live & Archived Chromatogram Viewer Options menu Figure A-27

CGM Scaling screen Figure A-28

Select Detector screen Figure A-29

Chromatogram TEV table Figure A-30

Chromatogram CDT table Figure A-31

Chromatogram Raw Data table Figure A-32

Table A-2: Hardware and Application Menus

Submenu Command Subcommands Reference

Hardware Hardware menu

Heaters N/A Figure A-34

Valves N/A Figure A-35

Detectors N/A Figure A-33

Discrete Inputs N/A Figure A-38

Discrete
Outputs

N/A Figure A-39

Analog Inputs N/A Figure A-40

Analog Outputs N/A Figure A-41

Installed
Hardware

N/A Figure A-42

Application Application menu

System N/A Figure A-44

Component Figure A-45
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Table A-2: Hardware and Application Menus (continued)

Submenu Command Subcommands Reference

Data CDT 1

CDT 2

CDT 3

CDT 4

Timed Events Figure A-46
TEV 1

TEV 2

TEV 3

TEV 4

Streams N/A #unique_78/
unique_78_Connect_42_
c_TheApplicationMenu-
figA-42

Status N/A Figure A-53

Ethernet Ports N/A Figure A-54

Table A-3: Logs/Reports and Control Menus

Submenu Command Reference

Logs/Reports Logs/Reports menu

Maintenance Log Figure A-57

Event Log Figure A-58

Alarm Log Figure A-59

Unack Alarms Figure A-60

Active Alarms Figure A-62

Report Display Figure A-64

Control Control menu

Auto Sequence Figure A-66

Single Stream Figure A-68

Halt Figure A-69

Calibration Figure A-70

Validation Figure A-71

Stop Now Figure A-72

Table A-4: Tools Menu

Submenu Command Reference

Tools Tools menu
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Table A-4: Tools Menu (continued)

Submenu Command Reference

Screen Control Figure A-74

Diagnostics Figure A-75

Logout No screen

A.4.1 Chromatogram menu
The Chromatogram menu enables you to view live and archived chromatograms and their
associated component data tables (CDTs) and timed event (TEV) tables, as well as to edit
the display properties if the chromatogram screens.

Refer to the Using the chromatograph functions section of the MON2020 Software for Gas
Chromatographs Reference Manual for detailed information regarding the Chromatogram
menu screens.

Figure A-18: Chromatogram Menu
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Figure A-19: Select Chromatogram Screen

• After selecting the live chromatogram, select Options and view and select the
detectors associated with that cycle clock.

• All the detectors that are associated with a cycle clock are shown with a radio button.
The other detectors that are not associated with that cycle clock are grayed out as
shown in Figure A-20

Figure A-20: Live Chromatogram View (Status Mode) Screen

Note
The blue box displays the current analysis time.
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Figure A-21: Live Chromatogram View (Advanced Mode) Screen

Note
The blue box displays the current analysis time.

Figure A-22: Live Chromatogram - Analysis 1
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Figure A-23: Live Chromatogram - Analysis 2

Figure A-24: Live Chromatogram - Analysis 3
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Figure A-25: Live Chromatogram - Analysis 4

Figure A-26: Archived Chromatogram (Advanced Mode) Screen
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Figure A-27: Live and Archived Chromatogram Viewer Options Screen

Note
The blue box displays the cursor’s X- (analysis time) and Y- (amplitude) coordinates.

Figure A-28: CGM Scaling Screen

After selecting the live CGM, select the Options menu to view and select the detectors
associated with that cycle clock.
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Figure A-29: Detector Selection Via Options Menu

Figure A-30: Chromatogram TEV Table Screen

Local operator interface (LOI) Reference Manual
July 2020 2-3-9000-744

208 Emerson.com/Rosemount



Figure A-31: Chromatogram CDT Screen

Figure A-32: Chromatogram Raw Data Table Screen
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A.4.2 Hardware menu
The Hardware menu enables you to view and manage the GC’s hardware components.

Refer to the Using the hardware functions section of the MON2020 Software for Gas
Chromatographs Reference Manual for detailed information regarding the Hardware
menu screens.

Figure A-33: Hardware Menu

Figure A-34: Heaters Screen
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Figure A-35: Valves Screen

Note
The usage (Sample/BF1, Dual Column), mode (Auto, Off), and state (green = on, black =
off, red = error) of each valve is displayed. See the Configuring the valves section of the
MON2020 Software for Gas Chromatographs Reference Manual for more information.

Figure A-36: Detectors Screen
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Figure A-37: Detectors Screen Continued

Table A-5: Detector Screen Field Labels

Detector Screen G1 Board G2 Board

Field Names
Flame ionization
detector (FID)

Flame
photometric
detector (FPD) FID FPD

FID Temp RTD Selectable Blank Blank Blank

H2 Valve Selectable Blank Selectable Selectable

Flame Ignition Selectable Blank Selectable Selectable

Ignition Attempts Editable Blank Editable Editable

Wait Time Bet Tries Editable Blank Editable Editable

Igniter On Duration Editable Blank Editable Editable

Flame On Sense Temp Editable Blank Editable Editable

Flame Out Sense Temp Editable Blank Editable Editable

FPD Flame Status DI Blank Selectable Blank Blank

Scaling Factor Read only Read only Read only Blank

Flame Temp Read only Blank Read only Read only

The Detector screen field label names and their respective field statuses are described as
editable or non-editable depending on G1/G2 board types.

When you select one of the buttons on G1 boards (for example, Auto-zero), then since FID
and µFPD are both enabled for Auto-zero, when that button is selected a combo box
displays for you to select either FID or µFPD detector (if both detector types are configured
with the gas chromatograph [GC]). After selecting one of the detectors, the Auto-zero
event is triggered for that detector.
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For G2 boards, since the µFPD is disabled for Auto-zero no combo box displays for you to
select the detector. Only one detector is a valid selection for Auto-zero in the available
detectors on that GC, so the Auto-zero selection triggers the event for the FID detector. If
the button option is valid for more than one detector type, only then does the combo box
display. If only one detector type is valid for that specific button, then the combo box does
not display and the selection triggers that specific event on the only workable detector.

Table A-6: Detector Screen Auto-zero Buttons

Button Name G1 Board G2 Board

FID FPD FID FPD

Auto-Zero Enabled Enabled Enabled Disabled
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Figure A-38: Discrete Inputs Screen

Figure A-39: Discrete Outputs Screen
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Figure A-40: Analog Inputs Screen

Figure A-41: Analog Outputs Screen
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Figure A-42: Installed Hardware Screen
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A.4.3 Application menu
The Application menu allows you to view the Component Data, Timed Events, and Streams
tables for the GC. The System, Status, and Ethernet Ports screens are also accessible from
this menu.

Refer to the Using the application functions section of the MON2020 Software for Gas
Chromatographs Reference Manual for detailed information regarding the Application
menu screens.

Figure A-43: Application Menu

Figure A-44: System Screen
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Figure A-45: Component Data Table (CDT) Screen

Figure A-46: Timed Events (TEV) - Valve Events Screen
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Figure A-47: TEV - Integration Events Screen

Figure A-48: TEV - Spectrum Gain Events Screen
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Figure A-49: TEV - Analysis Time Screen

Figure A-50: Streams Screen

The Streams screen shows the different streams configured for the specific cycle clock.
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Figure A-51: Single Stream Analysis

• All four Analyses are listed in this screen.

• For the selected Analysis, the streams are displayed.

Figure A-52: Single Stream Analysis (Continued)
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Figure A-53: Status Screen

Figure A-54: Ethernet Ports Screen
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A.4.4 Logs/Reports menu
The Logs/Reports menu enables you to view the various reports that are available from the
gas chromatograph (GC).

Refer to the Logs/Reports section of the MON2020 Software for Gas Chromatographs
Reference Manual for detailed information regarding the Logs/Reports menu screens.

Figure A-55: Logs/Reports Menu

Figure A-56: Logs/Reports Menu - Report Display

The Report Display screen shows the analysis names for Cycle Clock 3 and 4. It also shows
all the streams associated with cycle clocks.
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Figure A-57: Maintenance Log Screen

Figure A-58: Event Logs Screen
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Figure A-59: Alarm Logs Screen

Figure A-60: Unack Alarms Screen
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Figure A-61: Unack Alarm Screen

Analysis Cycle Clocks 3 and 4 Unacked alarms when Idle.

Figure A-62: Active Alarms Screen
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Figure A-63: Active Alarm Screen With Multiple Analysis Clocks

Note
Analysis Cycle Clocks 3 and 4 - alarms when Idle.

Figure A-64: Report Display Screen

The right side of the Report Display screen shows the analysis names for the four analysis
clocks and all the streams associated with cycle clocks
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A.4.5 Control menu
The Control menu enables you to stop, calibrate, or place on automatic control a sample
stream from the analyzer.

Refer to the Control menu section of the MON2020 Software for Gas Chromatographs
Reference Manual for detailed information regarding the Control menu screens.

Figure A-65: Control Menu

Figure A-66: Auto Sequence Screen
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Figure A-67: Auto Sequence Screen

The Auto Sequence screen provides selections for the four Analysis options or ALL. Select
the radio button and press ENTER to begin auto sequencing. Press EXIT to abort the
process.

Figure A-68: Single Stream Screen

The Single Stream screen provides selections for the four Analysis options. Select the radio
button and press ENTER to begin the analysis. Press EXIT to abort the process. The stream
for the selected analysis is indicated in the field below the analysis.
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Figure A-69: Halt Screen

The Halt screen provides selections to halt the analysis for the four Analysis options or All.
Select the radio button and press ENTER to halt the current analysis. Press EXIT to abort
the process.

Figure A-70: Calibration Screen
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The Calibration screen provides selections for provides selections for the four Analysis
options or ALL.

1. Select the radio button and press ENTER.

2. Select the Calibration Type, Normal or Forced.

3. Press ENTER to begin the calibration.

4. Press EXIT to abort the process.

Figure A-71: Validation Screen

The Validation screen provides selections for the four Analysis options or All. Select the
radio button and press ENTER to begin the validation. Press EXIT to abort the process.
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Figure A-72: Stop Now Screen

Important
Do not perform a Stop Now unless absolutely necessary. Whenever possible, use the Halt
function.

This function forces the system into Idle mode. If Stop Now is performed while an analysis
clock run is in progress, the components may continue to elute from the columns. No
analysis data will be generated. To immediately stop an analysis run, do the following:

A. Select Control  → Stop Now. A confirmation message displays.
B. Select the Analysis Clock radio button and press ENTER to stop the analysis.
C. Click Yes and the current analysis clock run stops.
D. Press EXIT to abort the process to stop.

A.4.6 Tools menu
The Tools menu enables you to change the screen control, change a user’s password, and
log off of the gas chromatograph (GC) to which you are connected.

Refer to the menu section of the MON2020 Software for Gas Chromatographs Reference
Manual for detailed information regarding the Tools menu screens.
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Figure A-73: Tools Menu

Use the Tools → Screen Control menu to adjust screen brightness Up or Down.

Use the Boost Up or Down command to increase or decrease the contrast intensity.

Figure A-74: Screen Control Screen
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Figure A-75: Diagnostic Screen
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A.5 Troubleshoot a blank local operator interface
(LOI) display screen
If the LOI is powered up but the LCD display screen is blank, do the following:

Procedure

1. Power down the gas chromatograph and allow to cool before opening the upper
enclosure door.

2. Unscrew and remove the LOI board.

3. Flip the LOI over to expose its motherboard and associated electronics. Make sure
the J12 connector is tightly connected to the motherboard via ribbon cable.

If the screen is still blank, replace the board.
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B Carrier gas installation and
maintenance
This appendix provides a description of the optional carrier manifold (P/N 2-3-5000-050)
that permits the connection of two carrier gas bottles, or cylinders, to a gas
chromatograph (GC) system.

B.1 Carrier gas
The benefits of this manifold are as follows:

Note
The illustration and information in this appendix are adapted from drawing AE-10098.

• When one bottle is nearly empty (i.e., 110 psig [758.4 kPa] remaining), the other bottle
becomes the primary supply.

• You can disconnect each bottle for refilling without interrupting GC operation.

Figure B-1: Manifold for Two Carrier Gas Bottles to GC System

A. Analyzer
B. Carrier cylinder
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Valve Carrier gas cylinder Valve description

V-1 Carrier Cylinder 1 Bleed valve

V-2 Carrier Cylinder 1 Block valve

V-3 Carrier Cylinder 2 Block valve

V-4 Carrier Cylinder 2 Bleed valve

B.2 Install manifold and purge line
To install and purge the dual-bottle carrier gas manifold, proceed as follows:

Procedure

1. Install manifold as shown in Figure B-1. Close all valves and tighten all fittings. Run
tubing to the gas chromatograph (GC), but do not connect.

2. Back off pressure regulator (counter clockwise) fully.

3. Open cylinder valve for Carrier Cylinder 1.
The pressure indicator will read the cylinder pressure.

4. Open the shut-off valve attached to the carrier regulator.

5. Regulate pressure out of the cylinder to 20 psig (137.9 kPa); then close the cylinder
valve.

6. Open V-1 (bleed valve) and let the carrier gas bleed to atmosphere until both
gauges read 0 psig; then close V-1.

7. Repeat Step 4 and Step 5 twice to purge the line to V-2.

8. Purge the line to V-3 by repeating Step 2 through Step 6; but this time, use bleed
valve V-4 and Carrier Cylinder 2.

9. With valves 1-4 closed, open both cylinder valves and regulate both carriers to
approximately 10 psig (68.9 kPa).

10. Open V-2 and V-3 simultaneously; then turn both cylinder valves off and let the
carrier gasses bleed through the line to the GC until all gauges read 0 psig.

11. Repeat Step 8 and Step 9 twice to purge the line to the GC.

12. Close V-3; leave V-2 open.

13. Open the cylinder valve of Carrier Cylinder 1 and, with carrier gas flowing at 10 psig
(68.9 kPa) or below, connect the carrier line to the GC.

14. Slowly regulate Carrier Cylinder 1 to 110 psig (6.9 to 758.4 kPa).

15. Open V-3 and slowly regulate Carrier Cylinder 2 to 100 psig (689.4 kPa).
By doing this, all but 100 pounds of Carrier Cylinder 1 will be used before any of
Carrier Cylinder 2 is used. When Carrier Cylinder 1 gets to 100 pounds, replace the
cylinder.

16. Leak-check all of the fittings carefully.

17. Let the GC run overnight before calibrating.

Carrier gas installation and maintenance Reference Manual
July 2020 2-3-9000-744

238 Emerson.com/Rosemount



B.3 Replace carrier cylinder
To replace one carrier cylinder without interrupting gas chromatograph (GC) operation:

Procedure

1. Turn cylinder valve off.

2. Back off on cylinder pressure regulator until handle turns freely.

3. Remove cylinder.

4. Attach new cylinder to regulator and repeat Step 3 through Step 7 of Install
manifold and purge line, using appropriate bleed valve to purge line.

5. Leak-check the fitting.

6. Open the appropriate block valve to the analyzer (V-2 or V-3) and regulate outlet
pressure to appropriate level.

See Step 14 and Step 15 of Install manifold and purge line.

B.4 Calibration gas for BTU analysis
The calibration gas used for BTU analysis should be blended of gases specified as primary
standards. Primary standard gases are blended using weights that are traceable to the
National Institute of Standards and Technology (NIST). For other applications, blend the
calibration gas to the specifications detailed in the analyzer’s Application Data Sheets.

The calibration gas should not have any component that could drop out at the coldest
temperature to which the gas will be subjected. A typical blend for a temperature of 0 °F
(-17.7 °C) is listed in the following table. No dropout will occur in this calibration gas if it is
blended at a pressure below 250 psig (1723.7 kPa).

Gas Mole Percent

Nitrogen 2.5

Carbon Dioxide 0.5

Methane Balance

Propane 1.0

Isobutane 0.3

N-butane 0.3

Neopentane 0.1

Isopentane 0.1

N-pentane 0.1

N-hexane 0.03

Carefully plan the sampling system for the best chromatographic analyses.
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C Micro flame photometric detector
(µFPD)
The latest version of the Rosemount 700XA is now designed with an integral µFPD. In
previous versions of the gas chromatograph (GC), side-car design was the only option for
the FPD. The new design reduces the gas chromatograph's footprint and eliminates the
side-car.

Figure C-1: Rosemount 700XA µFPD

A. µFPD burner assembly

The µFPD photo multiplier tube (PMT) is located in the upper enclosure beneath the oven
assembly ULTEM base plate.
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Figure C-2: µFPD PMT

C.1 Configure the micro flame photometric
detector (µFPD)
Procedure

1. Open MON2020 and select Hardware → Detectors.
If your gas chromatograph (GC) has an integral FPD, FPD G2 displays in Slot 1 or Slot
2.

Note
Before making any modifications to this window, halt the analysis.

2. Select Hardware → Detectors.

3. Select Manual if you want to control the burner ignition; select Auto if you want the
GC to control the burner ignition.

The following data displays for each detector:

Name Description

Det # Numerical identifier for the detector to which the following data applies.

Detector Options, which depend on your GC's configuration, are:
• TCD (thermal conductivity detector)

• FPD G2 (µFPD)

• FID (flame ionization detector)

• FID G2

H2 Valve Optional hydrogen carrier shut-off valve

Flame Temp RTD Select the appropriate resistance temperature device (RTD) from the drop-down
list. The RTD measures the temperature of the flame.
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Name Description

Flame Ignition Select Manual if you want to control the burner ignition; select Auto if you want the
GC to control the burner ignition.

Ignition Attempts Indicates the number of times the GC will try to light the flame. If an Auto ignition
sequence fails to light the flame after the specified number of attempts, the GC will
close the hydrogen valve, switch the ignition parameter to Manual, and set an active
alarm.

Wait Time Bet Tries Indicates the amount of time, in seconds, the GC will wait between ignition
attempts.

Igniter On Duration Indicates the length of time that the igniter will remain on.

Flame On Sense Temp The flame ignites when the internal temperature exceeds the value set in this field.

Flame Out Sense Temp The flame is extinguished when the internal burner temperature falls below the
value set below the Flame On Sense Temp.

FPD Flame Status DI Applies to FPDs only. Allows you to select from a list of available digital inputs (DIs).
The DI that is selected will receive the FPD's flame status value.

Preamp Val Detector count. Read-only.

Flame Temperature Temperature of the flame as read by the RTD. Read-only.

Flame Status Options are: Off, On, and Over Temperature. Read-only.

H2 Valve Cur State Options are: Open and Closed. Read-only.

Scaling Factor Preamp calibration factor.

Igniter Status Options are: Off and On. Read-only.

Electrometer Voltage(1) Output at first stage of FID preamp. Read-only.

Pre Amplifier Voltage(1) Output at second stage of FID preamp. Read-only.

Polarizing Voltage(1) Igniter voltage. Read-only.

Gain Status Options are: Low and High.

Status Options are: Ok, Not Installed, and Internal Error. Read-only.

(1) Not used with µFPD.

4. If the Flame Ignition field is set to Manual, and if the Flame Status field is set to Off,
do the following to restart the flame:

a) Click Ignite.
The Flame Status field changes to On when the internal temperature
exceeds the value set in the Flame On Sense Temp field.
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D Recommended spare parts

D.1 Recommended spare parts for Rosemount
700XA thermal conductivity detector (TCD)
analyzers

Quantity Description Part Number

1-5 GCs 6 or more GCs or Critical
Installations

1 1 Kit, fuse, XA 2-3-0710-074

1 2 Solenoid, 4-way, MAC, 24
Vdc

2-4-0710-224

Note 1 Note 1 Solenoid, 3-way, 24 Vdc 2-4-0700-124

1 1 Thermistor seals, package of
10

2-3-0500-391

1 per valve 1 per valve Kit diaphragm, 10-port XA 2-4-0710-171

1 per valve 1 per valve Kit, diaphragm, 6-port XA 2-4-0710-248

1 1 Column set Note 2

1 per stream 1 per stream Filter element 2 micron 2-4-5000-113

1 per stream 1 per stream Membrane kit, 120 filter 2-4-5000-938

0 1 PCA detector preamp 7A00401G01

0 1 PCA solenoid/heater driver 9A00402G01

0 1 PCA base in/out (I/O) 7A00403G01

0 1 PCA backplane 7A00420G01

0 1 PCA main central processing
unit (CPU)

7A00555G01

0 Note 3 Assembly, power supply
(AC)

7C00086-001

0 Note 4 Pressure switch carrier 2-4-0710-266

0 1 per detector Kit, thermistors, thermal
conductivity detector (TCD)

Note 2

0 1 per carrier Carrier dryer assembly 2-3-0500-180

1. If a GC has a stream internal switching assembly, Emerson recommends one spare.

2. Application dependent. Please contact your Rosemount Customer Care
representative and provide the GC's sales order number for recommended part
number and description.

3. If the GCs are powered with an AC lin, Emerson recommends one spare.
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4. If the GCs have a pressure switch installed, Emerson recommends one spare.

D.2 Recommended spare parts for Rosemount
700XA flame ionization detector (FID)/thermal
conductivity detector (TCD) analyzers

Quantity Description Part number

1-5 gas
chromatograp

hs (GCs)

6 or more GCs
or critical

installations

1 1 Kit, fuse, XA 2-3-0710-074

1 2 Solenoid, 4-way, MAC, 24 Vdc 2-4-0710-224

Note 1 Note 1 Solenoid, 3-way, 24 Vdc 2-4-0700-124

1 1 Thermistor seals, package of 10 2-3-0500-391

1 per valve 1 per valve Kit diaphragm, 10-port XA 2-4-0710-171

1 per valve 1 per valve Kit diaphragm, 6-port XA 2-4-0710-248

1 1 Column set Note 2

1 per stream 1 per stream Filter element, 2 micron 2-4-5000-113

1 per stream 1 per stream Membrane kit, 120 filter 2-4-5000-938

0 1 PCA detector preamp 7A00401G01

0 1 PCA solenoid/heater driver 9A00402G01

0 1 PCA base in/out (I/O) 7A00403G01

0 1 PCA backplane 7A00420G01

0 1 PCA main central porcessing unit (CPU) 7A00555G01

0 1 PCA flame ionization detector (FID)
electrometer

2-3-0710-014

0 Note 3 Assembly, power supply (AC) 7C00086-001

0 1 Assmembly, micro FID, XA 2-3-0710-077

0 Note 4 Kit, field methanator replacement 2-3-0710-700

0 Note 4 Pressure switch, carrier 2-4-0710-266

0 1 per detector Kit, thermistors, thermal conductivity
detector (TCD)

Note 2

0 1 per carrier Carrier dryer assembly 2-3-0500-180

1. If a GC has a stream internal switching assembly, Emerson recommends one spare.

2. Application dependent. Please contact your Emerson Customer Care representative
and provide the GC's sales order number for recommended part number and
description.
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3. If the GCs are powered with an AC line, Emerson recommends one spare.

4. If the GCs have this option installed, Emerson recommends one spare.

D.3 Recommended spare parts for Rosemount
700XA flame ionization detector (FID)
analyzers

Quantity Description Part number

1-5 gas
chromatogr
aphs (GCs)

6 or more
GCs or
critical

installations

1 1 Kit, fuse, XA 2-3-0710-074

1 2 Solenoid, 4-way, MAC, 24 Vdc 2-4-0710-224

Note 1 Note 1 Solenoid, 3-way, 24 Vdc 2-4-0700-124

1 per valve 1 per valve Kit, diaphragm, 10-port XZ 2-4-0710-171

1 per valve 1 per valve Kit, diaphragm, 6-port XA 2-4-0710-248

1 1 Column set Note 2

1 per stream 1 per stream Filter element, 2 micron 2-4-5000-113

1 per stream 1 per stream Membrane kit, 120 filter 2-4-5000-938

0 1 PCA detector preamp 7A00401G01

0 1 PCA solenoid/heater driver 9A00402G01

0 1 PCA base in/out (I/O) 7A00403G01

0 1 PCA backplane 7A00420G01

0 1 PCA main central processing
unit (CPU)

7A00555G01

0 1 PCA flame ionization detector
(FID) electrometer

2-3-0710-014

0 Note 3 Assembly, power supply (AC) 7C00086-001

0 1 Assmbly, micro FID, XA 2-3-0710-077

0 Note 4 Kit, field, methanator
replacement

2-3-0710-700

0 Note 4 Pressure switch, carrier 2-4-0710-266

0 1 per carrier Carrier dryer assembly 2-3-0500-180

Note
If a GC has a stream internal switching assembly, then one spare is recommended.
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Note
Application dependent. Please contact your Rosemount Analytical, Inc. representative and
provide the GC's sales order number for recommended part number and description.

Note
If the GCs are powered with an AC line, then one spare is recommended.

Note
If the GCs have this option installed, then one spare is recommended.

D.4 Recommended spare parts for µFPD analyzers
Description Part number Quantity

700XA, BURNER, µFPD 7A00233G01 0 (as needed)

700XA, FIBER CABLE, µFPD 7P00444H01 0 (as needed)

700XA µFPD ASSY, IGNITOR & THERMOCOUPLE 7A00232G01 1

700XA µFPD EDMOND OPTICS LEN, 25 MM OD 7C00319-001 2

700XA, FLAME CHAMBER, µFPD 7P00435H01 0 (as needed)

700XA, GAS MIXER, µFPD 7P00437H01 0 (as needed)

700XA µFPD SIDE ENTRY PMT MODULE 7A00234G01 0 (as needed)

700XA, µFPD O-Ring Kit 7A00243G01 1

700XA, uFPD Screws, Connectors, Washers Kit 7A00244G01 1
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E Shipping and long-term storage
recommendations
For applications equipped with special columns, e.g., mole sieve, read and follow the
additional instructions shipped with the analyzer and/or column set first. If you need
another copy, please contact customer service.

The following recommendations should be followed:

• For shipping purposes the gas chromatograph should be secured to a wooden pallet,
maintained in a vertical position and enclosed in a wood framework.

• Auxiliary equipment such as sample probes may be stored in the packaging in which it
was shipped. If this packaging material is no longer available, secure the equipment to
prevent excessive shaking and protect the accessories in a water proof enclosure.

• The gas chromatograph should be stored in a sheltered environment that is
temperature controlled between -30 °C (-22° F) and 60° C (140 ° F) to keep the gas
chromatograph’s protective coatings from deteriorating from exposure to rain or
caustic or corrosive environments. Humidity in the sheltered environment should be
non-condensing. Be especially cautious of humidity if the conduit has been potted.
Temporary caps and desiccant may be necessary.

• The configuration of the analyzer may be retained through battery back-up on the CPU
for at least two years. If lost for some reason, a custom program for downloading the
appropriate GC application is included on the USB shipped with the system
documentation.

• If the gas chromatograph has been in operation, the system should be purged with
carrier gas before powering the gas chromatograph down, especially when heavy
hydrocarbons or components that tend to polymerize are present. Allowing the gas
chromatograph to perform a few analysis cycles without sample gas is an acceptable
method of purging the system.

Note
To expedite the purge process, you may use 30 psig of a dry inert gas, such as nitrogen
or helium.

Monitor the results and halt the analyzer after component values fall to 0 or after peaks
are significantly reduced in size. Save a copy of the diagnostic data under Tools → Save
Diagnostic Data; once the file has been saved to a local PC, USB, or hard drive, you may
remove power.

• After removing power from the GC, remove the purge gas and immediately cap all
inlets and vents, including the carrier drier. These vents and inlets should be capped
with the fittings that were in place when the GC shipped from the factory or with
Swagelok® caps (not provided). This will protect the columns and filters and should
result in a trouble-free start up when the unit is returned to service.

• The sample conditioning system vents and inlets should also be capped with the
fittings that were in place when the system shipped from the factory. Additionally, all
vents should be closed.
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• Any remaining openings—such as conduit entries—should also have appropriate plugs
installed to prevent foreign material such as dust or water from entering the system.
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F Pre-defined Modbus® Map Files

F.1 Definitions of Terms
Register: Modbus register number

Data type: The following data types are supported:

1. INT - 16-bit integer value

2. FLOAT - 32-bit IEEE single precision floating point value

3. Bitmap (INT) - 16 Boolean values packed into a single 16-bit integer. Each bit
represents one Boolean value.

4. Long - 32-bit long integer value

5. Bitmap (long) - 32 Boolean values packed into a 32-bit long integer. Each bit
represents one Boolean value.

6. SCALED_FP_1 ... SCALED_FP_32 - Scaled floating point data type is also referred to
as Ranged Integers. A 32-bit floating point value is converted to a 16-bit integer. For
more details, refer to Edit Scales.

Variable: System variable that is mapped to a Modbus register.

Record #: This field is applicable only for Archive Average System Variables. The record #
tells the GC which historical average value to retrieve. For example, Record #1 refers to the
most recent average, Record #2 refers to the second most recent average and so on.

Access: Can either be Read only or Read-Write. A small fraction of GC system variables can
be updated from a Modbus Master. Writable registers have to be set to RD_WR in the
mapping before they can be written from a Modbus Master.

Format: This field is applicable for system variables that hold date/time. Date/time is
internally stored in a 32-bit Unix time_t format. The format field is used to convert the
date/time to human readable form. The available format modifiers are:

• MM - 2 digit month (1-12)

• DD - 2 digit day of the month (1-31)

• YY - 2 digit year (0-99)

• YYYY - 4 digit year (1970 - 2038)

• hh - 2 digit hour in 24 hour format (0-23)

• mm - 2 digit minutes (0-59)

• SS - 2 digit seconds (0-59)

• MMDDYY - 6 digit date. If the date is January 4, 2010, the register reads 010410. If the
date is November 7, 2012, the register reads 110712.

• DDMMYY - 6 digit date. If the date is January 4, 2010, the register reads 040110. If the
date is November 7, 2012, the register reads 071112.
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• YYMMDD - 6 digit date. If the date is April 17, 2007, the register reads 070417. If the
date is January 31, 2014, the register reads 140131.

• hhmmss - 6 digit time in 24 hour format

• hhmm - 4 digit time in 24 hour format

F.2 SIM_2251 map file (with GPA results)
Register # Data Type Variable Record # Access Format

3001 INT Last Analy_Component Code(US)[1 - Component 1] RD_ONLY

3002 INT Last Analy_Component Code(US)[2 - Component 2] RD_ONLY

3003 INT Last Analy_Component Code(US)[3 - Component 3] RD_ONLY

3004 INT Last Analy_Component Code(US)[4 - Component 4] RD_ONLY

3005 INT Last Analy_Component Code(US)[5 - Component 5] RD_ONLY

3006 INT Last Analy_Component Code(US)[6 - Component 6] RD_ONLY

3007 INT Last Analy_Component Code(US)[7 - Component 7] RD_ONLY

3008 INT Last Analy_Component Code(US)[8 - Component 8] RD_ONLY

3009 INT Last Analy_Component Code(US)[9 - Component 9] RD_ONLY

3010 INT Last Analy_Component Code(US)[10 - Component 10] RD_ONLY

3011 INT Last Analy_Component Code(US)[11 - Component 11] RD_ONLY

3012 INT Last Analy_Component Code(US)[12 - Component 12] RD_ONLY

3013 INT Last Analy_Component Code(US)[13 - Component 13] RD_ONLY

3014 INT Last Analy_Component Code(US)[14 - Component 14] RD_ONLY

3015 INT Last Analy_Component Code(US)[15 - Component 15] RD_ONLY

3016 INT Last Analy_Component Code(US)[16 - Component 16] RD_ONLY

3017 INT Last Analy_Component Code(US)[1 - Component 1] RD_ONLY

3018 INT Last Analy_Component Code(US)[2 - Component 2] RD_ONLY

3019 INT Last Analy_Component Code(US)[3 - Component 3] RD_ONLY

3020 INT Last Analy_Component Code(US)[4 - Component 4] RD_ONLY

3021 INT Last Analy_Component Code(US)[5 - Component 5] RD_ONLY

3022 INT Last Analy_Component Code(US)[6 - Component 6] RD_ONLY

3023 INT Last Analy_Component Code(US)[7 - Component 7] RD_ONLY

3024 INT Last Analy_Component Code(US)[8 - Component 8] RD_ONLY

3025 INT Last Analy_Component Code(US)[9 - Component 9] RD_ONLY

3026 INT Last Analy_Component Code(US)[10 - Component 10] RD_ONLY

3027 INT Last Analy_Component Code(US)[11 - Component 11] RD_ONLY

3028 INT Last Analy_Component Code(US)[12 - Component 12] RD_ONLY
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Register # Data Type Variable Record # Access Format

3029 INT Last Analy_Component Code(US)[13 - Component 13] RD_ONLY

3030 INT Last Analy_Component Code(US)[14 - Component 14] RD_ONLY

3031 INT Last Analy_Component Code(US)[15 - Component 15] RD_ONLY

3032 INT Last Analy_Component Code(US)[16 - Component 16] RD_ONLY

3033 INT Run Time(1/30th Sec) RD_ONLY

3034 INT Last Analy_Stream Number RD_ONLY

3035 INT Last Analy_CDT Stream Mask RD_ONLY

3036 INT Current Time (time_t) RD_WR MM

3037 INT Current Time(time_t) RD_WR DD

3038 INT Current Time (time_t) RD_WR YY

3039 INT Current Time (time_t) RD_WR hh

3040 INT Current Time (time_t) RD_WR mm

3041 INT Last Analy_Start Time RD_ONLY MM

3042 INT Last Analy_Start Time RD_ONLY DD

3043 INT Last Analy_Start Time RD_ONLY YY

3044 INT Last Analy_Start Time RD_ONLY hh

3045 INT Last Analy_Start Time RD_ONLY mm
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Register # Data Type Variable Record # Access Format

3046 Bitmap(INT) 0:Unused,

1:Unused,

2:System Alarm_Alarm On - Last Analysis_Analog Input 1
Low Signal,

3:System Alarm_Alarm On - Last Analysis_Analog Input 1
High Signal,

4:System Alarm_Alarm On - Last Analysis_Analog Input 2
Low Signal,

5:System Alarm_Alarm On - Last Analysis_Analog Input 2
High Signal,

6:Unused,

7:Unused,

8:System Alarm_Alarm On - Last Analysis_Analog Output 1
Low Signal,

9:System Alarm_Alarm On - Last Analysis_Analog Output 1
High Signal,

10:System Alarm_Alarm On - Last Analysis_Analog Output
2 Low Signal,

11:System Alarm_Alarm On - Last Analysis_Analog Output
2 High Signal,

12:System Alarm_Alarm On - Last Analysis_Analog Output
3 Low Signal,

13:System Alarm_Alarm On - Last Analysis_Analog Output
3 High Signal,

14:Analyzer Failure,

15:Unused

RD_ONLY

3047 Bitmap(INT) 0:System Alarm_Alarm On - Current Analysis_Power
Failure,

1:Calibration Failed,

2:Preamp Failure,

3:Unused,

4:Unused,

5:Unused,

6:Unused,

7:Unused,

8:Unused,

9:Unused,

10:Unused,

11:Unused,

12:Unused,

13:Unused,

14:Unused,

15:Unused

RD_ONLY

3048 INT 1 – Stream 1_Active Low Limit Alarms RD_ONLY

3049 INT 1 - Stream 1_Active High Limit Alarms RD_ONLY
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Register # Data Type Variable Record # Access Format

3050 INT 2 - Stream 2_Active Low Limit Alarms RD_ONLY

3051 INT 2 - Stream 2_Active High Limit Alarms RD_ONLY

3052 INT 3 - Stream 3_Active Low Limit Alarms RD_ONLY

3053 INT 3 - Stream 3_Active High Limit Alarms RD_ONLY

3054 INT 4 - Stream 4_Active Low Limit Alarms RD_ONLY

3055 INT 4 - Stream 4_Active High Limit Alarms RD_ONLY

3056 INT 5 - Stream 5_Active Low Limit Alarms RD_ONLY

3057 INT 5 - Stream 5_Active High Limit Alarms RD_ONLY

3058 INT New Data Flag RD_WR

3059 INT Analy/Calib Flag RD_ONLY

5001 LONG Last Analy_Cycle Time (1/30th sec) RD_ONLY

5002 LONG Last Cal_Cycle Time (1/30th sec) RD_ONLY

7001 FLOAT Last Analy_Mole %[1 - Component 1] RD_ONLY

7002 FLOAT Last Analy_Mole %[2 - Component 2] RD_ONLY

7003 FLOAT Last Analy_Mole %[3 - Component 3] RD_ONLY

7004 FLOAT Last Analy_Mole %[4 - Component 4] RD_ONLY

7005 FLOAT Last Analy_Mole %[5 - Component 5] RD_ONLY

7006 FLOAT Last Analy_Mole %[6 - Component 6] RD_ONLY

7007 FLOAT Last Analy_Mole %[7 - Component 7] RD_ONLY

7008 FLOAT Last Analy_Mole %[8 - Component 8] RD_ONLY

7009 FLOAT Last Analy_Mole %[9 - Component 9] RD_ONLY

7010 FLOAT Last Analy_Mole %[10 - Component 10] RD_ONLY

7011 FLOAT Last Analy_Mole %[11 - Component 11] RD_ONLY

7012 FLOAT Last Analy_Mole %[12 - Component 12] RD_ONLY

7013 FLOAT Last Analy_Mole %[13 - Component 13] RD_ONLY

7014 FLOAT Last Analy_Mole %[14 - Component 14] RD_ONLY

7015 FLOAT Last Analy_Mole %[15 - Component 15] RD_ONLY

7016 FLOAT Last Analy_Mole %[16 - Component 16] RD_ONLY

7017 FLOAT Last Analy_Weight %[1 - Component 1] RD_ONLY

7018 FLOAT Last Analy_Weight %[2 - Component 2] RD_ONLY

7019 FLOAT Last Analy_Weight %[3 - Component 3] RD_ONLY

7020 FLOAT Last Analy_Weight %[4 - Component 4] RD_ONLY

7021 FLOAT Last Analy_Weight %[5 - Component 5] RD_ONLY

7022 FLOAT Last Analy_Weight %[6 - Component 6] RD_ONLY
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Register # Data Type Variable Record # Access Format

7023 FLOAT Last Analy_Weight %[7 - Component 7] RD_ONLY

7024 FLOAT Last Analy_Weight %[8 - Component 8] RD_ONLY

7025 FLOAT Last Analy_Weight %[9 - Component 9] RD_ONLY

7026 FLOAT Last Analy_Weight %[10 - Component 10] RD_ONLY

7027 FLOAT Last Analy_Weight %[11 - Component 11] RD_ONLY

7028 FLOAT Last Analy_Weight %[12 - Component 12] RD_ONLY

7029 FLOAT Last Analy_Weight %[13 - Component 13] RD_ONLY

7030 FLOAT Last Analy_Weight %[14 - Component 14] RD_ONLY

7031 FLOAT Last Analy_Weight %[15 - Component 15] RD_ONLY

7032 FLOAT Last Analy_Weight %[16 - Component 16] RD_ONLY

7033 FLOAT Last Analy_HV Gross BTU Dry RD_ONLY

7034 FLOAT Last Analy_HV Gross BTU Sat RD_ONLY

7035 FLOAT Last Analy_GPA Real Rel Den Gas RD_ONLY

7036 FLOAT Last Analy_GPA Z Factor RD_ONLY

7037 FLOAT Last Analy_GPA Wobbe Index RD_ONLY

7038 FLOAT Last Analy_Total Unnormalized Conc RD_ONLY

7039 FLOAT Last Analy_Gal/1000 SCF C2+ RD_ONLY

7040 FLOAT Calc Result[1 - User Cal 01] RD_ONLY

7041 FLOAT Calc Result[2 - User Cal 02] RD_ONLY

7042 FLOAT Calc Result[3 - User Cal 03] RD_ONLY

7043 FLOAT Calc Result[4 - User Cal 04] RD_ONLY

7044 FLOAT Calc Result[5 - User Cal 05] RD_ONLY

7045 FLOAT Unused RD_ONLY

7046 FLOAT Unused RD_ONLY

7047 FLOAT Unused RD_ONLY

7048 FLOAT Unused RD_ONLY

7049 FLOAT Unused RD_ONLY

7050 FLOAT Unused RD_ONLY

7051 FLOAT Unused RD_ONLY

7052 FLOAT Unused RD_ONLY

7053 FLOAT Unused RD_ONLY

7054 FLOAT Last Analy_HV Gross BTU Act RD_ONLY

7055 FLOAT Avg[1 - Average 1] RD_ONLY

7056 FLOAT Avg[2 - Average 2] RD_ONLY
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Register # Data Type Variable Record # Access Format

7057 FLOAT Avg[3 - Average 3] RD_ONLY

7058 FLOAT Avg[4 - Average 4] RD_ONLY

7059 FLOAT Avg[5 - Average 5] RD_ONLY

7060 FLOAT Avg[6 - Average 6] RD_ONLY

7061 FLOAT Avg[7 - Average 7] RD_ONLY

7062 FLOAT Avg[8 - Average 8] RD_ONLY

7063 FLOAT Avg[9 - Average 9] RD_ONLY

7064 FLOAT Avg[10 - Average 10] RD_ONLY

7065 FLOAT Avg[11 - Average 11] RD_ONLY

7066 FLOAT Avg[12 - Average 12] RD_ONLY

7067 FLOAT Avg[13 - Average 13] RD_ONLY

7068 FLOAT Avg[14 - Average 14] RD_ONLY

7069 FLOAT Avg[15 - Average 15] RD_ONLY

7070 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7071 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7072 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7073 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7074 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7075 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7076 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7077 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7078 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7079 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7080 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7081 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7082 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7083 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7084 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7085 FLOAT Current Value[1 - Analog Input 1] RD_ONLY

7086 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7087 FLOAT Last FCalib_HV Gross BTU Act RD_ONLY

7088 FLOAT Last FCalib_HV Gross BTU Dry RD_ONLY

7089 FLOAT Last FCalib_HV Gross BTU Sat RD_ONLY

7090 FLOAT Last FCalib_GPA Wobbe Index RD_ONLY
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Register # Data Type Variable Record # Access Format

7091 FLOAT Last FCalib_GPA Real Rel Den Gas RD_ONLY

7092 FLOAT Last FCalib_GPA Z Factor RD_ONLY

7093 FLOAT Last FCalib_Gal/1000 SCF C2+ RD_ONLY

7094 FLOAT Last FCalib_Total Unnormalized Conc RD_ONLY

7095 FLOAT Last Analy_Response Factor[1 - Component 1] RD_ONLY

7096 FLOAT Last Analy_Response Factor[2 - Component 2] RD_ONLY

7097 FLOAT Last Analy_Response Factor[3 - Component 3] RD_ONLY

7098 FLOAT Last Analy_Response Factor[4 - Component 4] RD_ONLY

7099 FLOAT Last Analy_Response Factor[5 - Component 5] RD_ONLY

7100 FLOAT Last Analy_Response Factor[6 - Component 6] RD_ONLY

7101 FLOAT Last Analy_Response Factor[7 - Component 7] RD_ONLY

7102 FLOAT Last Analy_Response Factor[8 - Component 8] RD_ONLY

7103 FLOAT Last Analy_Response Factor[9 - Component 9] RD_ONLY

7104 FLOAT Last Analy_Response Factor[10 - Component 10] RD_ONLY

7105 FLOAT Last Analy_Response Factor[11 - Component 11] RD_ONLY

7106 FLOAT Last Analy_Response Factor[12 - Component 12] RD_ONLY

7107 FLOAT Last Analy_Response Factor[13 - Component 13] RD_ONLY

7108 FLOAT Last Analy_Response Factor[14 - Component 14] RD_ONLY

7109 FLOAT Last Analy_Response Factor[15 - Component 15] RD_ONLY

7110 FLOAT Last Analy_Response Factor[16 - Component 16] RD_ONLY

7111 FLOAT Last Analy_Response Factor[1 - Component 1] RD_ONLY

7112 FLOAT Last Analy_Response Factor[2 - Component 2] RD_ONLY

7113 FLOAT Last Analy_Response Factor[3 - Component 3] RD_ONLY

7114 FLOAT Last Analy_Response Factor[4 - Component 4] RD_ONLY

7115 FLOAT Last Analy_Response Factor[5 - Component 5] RD_ONLY

7116 FLOAT Last Analy_Response Factor[6 - Component 6] RD_ONLY

7117 FLOAT Last Analy_Response Factor[7 - Component 7] RD_ONLY

7118 FLOAT Last Analy_Response Factor[8 - Component 8] RD_ONLY

7119 FLOAT Last Analy_Response Factor[9 - Component 9] RD_ONLY

7120 FLOAT Last Analy_Response Factor[10 - Component 10] RD_ONLY

7121 FLOAT Last Analy_Response Factor[11 - Component 11] RD_ONLY

7122 FLOAT Last Analy_Response Factor[12 - Component 12] RD_ONLY

7123 FLOAT Last Analy_Response Factor[13 - Component 13] RD_ONLY

7124 FLOAT Last Analy_Response Factor[14 - Component 14] RD_ONLY
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7125 FLOAT Last Analy_Response Factor[15 - Component 15] RD_ONLY

7126 FLOAT Last Analy_Response Factor[16 - Component 16] RD_ONLY

7127 FLOAT Avg[1 - Average 1] RD_ONLY

7128 FLOAT Avg[2 - Average 2] RD_ONLY

7129 FLOAT Avg[3 - Average 3] RD_ONLY

7130 FLOAT Avg[4 - Average 4] RD_ONLY

7131 FLOAT Avg[5 - Average 5] RD_ONLY

7132 FLOAT Avg[6 - Average 6] RD_ONLY

7133 FLOAT Avg[7 - Average 7] RD_ONLY

7134 FLOAT Avg[8 - Average 8] RD_ONLY

7135 FLOAT Avg[9 - Average 9] RD_ONLY

7136 FLOAT Avg[10 - Average 10] RD_ONLY

7137 FLOAT Avg[11 - Average 11] RD_ONLY

7138 FLOAT Avg[12 - Average 12] RD_ONLY

7139 FLOAT Avg[13 - Average 13] RD_ONLY

7140 FLOAT Avg[14 - Average 14] RD_ONLY

7141 FLOAT Avg[15 - Average 15] RD_ONLY

7142 FLOAT Avg[16 - Average 16] RD_ONLY

7143 FLOAT Avg[17 - Average 17] RD_ONLY

7144 FLOAT Avg[18 - Average 18] RD_ONLY

7145 FLOAT Avg[19 - Average 19] RD_ONLY

7146 FLOAT Avg[20 - Average 20] RD_ONLY

7147 FLOAT Avg[21 - Average 21] RD_ONLY

7148 FLOAT Avg[22 - Average 22] RD_ONLY

7149 FLOAT Avg[23 - Average 23] RD_ONLY

7150 FLOAT Avg[24 - Average 24] RD_ONLY

7151 FLOAT Avg[25 - Average 25] RD_ONLY

7152 FLOAT Avg[26 - Average 26] RD_ONLY

7153 FLOAT Avg[27 - Average 27] RD_ONLY

7154 FLOAT Avg[28 - Average 28] RD_ONLY

7155 FLOAT Avg[29 - Average 29] RD_ONLY

7156 FLOAT Avg[30 - Average 30] RD_ONLY

7157 FLOAT Avg[31 - Average 31] RD_ONLY

7158 FLOAT Avg[32 - Average 32] RD_ONLY
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7159 FLOAT Avg[33 - Average 33] RD_ONLY

7160 FLOAT Avg[34 - Average 34] RD_ONLY

7161 FLOAT Avg[35 - Average 35] RD_ONLY

7162 FLOAT Avg[36 - Average 36] RD_ONLY

7163 FLOAT Max[1 - Average 1] RD_ONLY

7164 FLOAT Max[2 - Average 2] RD_ONLY

7165 FLOAT Max[3 - Average 3] RD_ONLY

7166 FLOAT Max[4 - Average 4] RD_ONLY

7167 FLOAT Max[5 - Average 5] RD_ONLY

7168 FLOAT Max[6 - Average 6] RD_ONLY

7169 FLOAT Max[7 - Average 7] RD_ONLY

7170 FLOAT Max[8 - Average 8] RD_ONLY

7171 FLOAT Max[9 - Average 9] RD_ONLY

7172 FLOAT Max[10 - Average 10] RD_ONLY

7173 FLOAT Max[11 - Average 11] RD_ONLY

7174 FLOAT Max[12 - Average 12] RD_ONLY

7175 FLOAT Max[13 - Average 13] RD_ONLY

7176 FLOAT Max[14 - Average 14] RD_ONLY

7177 FLOAT Max[15 - Average 15] RD_ONLY

7178 FLOAT Max[16 - Average 16] RD_ONLY

7179 FLOAT Max[17 - Average 17] RD_ONLY

7180 FLOAT Max[18 - Average 18] RD_ONLY

7181 FLOAT Max[19 - Average 19] RD_ONLY

7182 FLOAT Max[20 - Average 20] RD_ONLY

7183 FLOAT Max[21 - Average 21] RD_ONLY

7184 FLOAT Max[22 - Average 22] RD_ONLY

7185 FLOAT Max[23 - Average 23] RD_ONLY

7186 FLOAT Max[24 - Average 24] RD_ONLY

7187 FLOAT Max[25 - Average 25] RD_ONLY

7188 FLOAT Max[26 - Average 26] RD_ONLY

7189 FLOAT Max[27 - Average 27] RD_ONLY

7190 FLOAT Max[28 - Average 28] RD_ONLY

7191 FLOAT Max[29 - Average 29] RD_ONLY

7192 FLOAT Max[30 - Average 30] RD_ONLY
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7193 FLOAT Max[31 - Average 31] RD_ONLY

7194 FLOAT Max[32 - Average 32] RD_ONLY

7195 FLOAT Max[33 - Average 33] RD_ONLY

7196 FLOAT Max[34 - Average 34] RD_ONLY

7197 FLOAT Max[35 - Average 35] RD_ONLY

7198 FLOAT Max[36 - Average 36] RD_ONLY

7199 FLOAT Min[1 - Average 1] RD_ONLY

7200 FLOAT Min[2 - Average 2] RD_ONLY

7201 FLOAT Min[3 - Average 3] RD_ONLY

7202 FLOAT Min[4 - Average 4] RD_ONLY

7203 FLOAT Min[5 - Average 5] RD_ONLY

7204 FLOAT Min[6 - Average 6] RD_ONLY

7205 FLOAT Min[7 - Average 7] RD_ONLY

7206 FLOAT Min[8 - Average 8] RD_ONLY

7207 FLOAT Min[9 - Average 9] RD_ONLY

7208 FLOAT Min[10 - Average 10] RD_ONLY

7209 FLOAT Min[11 - Average 11] RD_ONLY

7210 FLOAT Min[12 - Average 12] RD_ONLY

7211 FLOAT Min[13 - Average 13] RD_ONLY

7212 FLOAT Min[14 - Average 14] RD_ONLY

7213 FLOAT Min[15 - Average 15] RD_ONLY

7214 FLOAT Min[16 - Average 16] RD_ONLY

7215 FLOAT Min[17 - Average 17] RD_ONLY

7216 FLOAT Min[18 - Average 18] RD_ONLY

7217 FLOAT Min[19 - Average 19] RD_ONLY

7218 FLOAT Min[20 - Average 20] RD_ONLY

7219 FLOAT Min[21 - Average 21] RD_ONLY

7220 FLOAT Min[22 - Average 22] RD_ONLY

7221 FLOAT Min[23 - Average 23] RD_ONLY

7222 FLOAT Min[24 - Average 24] RD_ONLY

7223 FLOAT Min[25 - Average 25] RD_ONLY

7224 FLOAT Min[26 - Average 26] RD_ONLY

7225 FLOAT Min[27 - Average 27] RD_ONLY

7226 FLOAT Min[28 - Average 28] RD_ONLY
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7227 FLOAT Min[29 - Average 29] RD_ONLY

7228 FLOAT Min[30 - Average 30] RD_ONLY

7229 FLOAT Min[31 - Average 31] RD_ONLY

7230 FLOAT Min[32 - Average 32] RD_ONLY

7231 FLOAT Min[33 - Average 33] RD_ONLY

7232 FLOAT Min[34 - Average 34] RD_ONLY

7233 FLOAT Min[35 - Average 35] RD_ONLY

7234 FLOAT Min[36 - Average 36] RD_ONLY

7235 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7236 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7237 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7238 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7239 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7240 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7241 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7242 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7243 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7244 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7245 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7246 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7247 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7248 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7249 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7250 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

7251 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

7252 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

7253 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

7254 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

7255 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

7256 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY

7257 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

7258 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

7259 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

7260 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY
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7261 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

7262 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

7263 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

7264 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

7265 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

7266 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

7267 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY

7268 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

7269 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

7270 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

7271 FLOAT Archive_Max[1 - Average 1] 1 RD_ONLY

7272 FLOAT Archive_Max[2 - Average 2] 1 RD_ONLY

7273 FLOAT Archive_Max[3 - Average 3] 1 RD_ONLY

7274 FLOAT Archive_Max[4 - Average 4] 1 RD_ONLY

7275 FLOAT Archive_Max[5 - Average 5] 1 RD_ONLY

7276 FLOAT Archive_Max[6 - Average 6] 1 RD_ONLY

7277 FLOAT Archive_Max[7 - Average 7] 1 RD_ONLY

7278 FLOAT Archive_Max[8 - Average 8] 1 RD_ONLY

7279 FLOAT Archive_Max[9 - Average 9] 1 RD_ONLY

7280 FLOAT Archive_Max[10 - Average 10] 1 RD_ONLY

7281 FLOAT Archive_Max[11 - Average 11] 1 RD_ONLY

7282 FLOAT Archive_Max[12 - Average 12] 1 RD_ONLY

7283 FLOAT Archive_Max[13 - Average 13] 1 RD_ONLY

7284 FLOAT Archive_Max[14 - Average 14] 1 RD_ONLY

7285 FLOAT Archive_Max[15 - Average 15] 1 RD_ONLY

7286 FLOAT Archive_Max[16 - Average 16] 1 RD_ONLY

7287 FLOAT Archive_Max[17 - Average 17] 1 RD_ONLY

7288 FLOAT Archive_Max[18 - Average 18] 1 RD_ONLY

7289 FLOAT Archive_Max[19 - Average 19] 1 RD_ONLY

7290 FLOAT Archive_Max[20 - Average 20] 1 RD_ONLY

7291 FLOAT Archive_Max[21 - Average 21] 1 RD_ONLY

7292 FLOAT Archive_Max[22 - Average 22] 1 RD_ONLY

7293 FLOAT Archive_Max[23 - Average 23] 1 RD_ONLY

7294 FLOAT Archive_Max[24 - Average 24] 1 RD_ONLY
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7295 FLOAT Archive_Max[25 - Average 25] 1 RD_ONLY

7296 FLOAT Archive_Max[26 - Average 26] 1 RD_ONLY

7297 FLOAT Archive_Max[27 - Average 27] 1 RD_ONLY

7298 FLOAT Archive_Max[28 - Average 28] 1 RD_ONLY

7299 FLOAT Archive_Max[29 - Average 29] 1 RD_ONLY

7300 FLOAT Archive_Max[30 - Average 30] 1 RD_ONLY

7301 FLOAT Archive_Max[31 - Average 31] 1 RD_ONLY

7302 FLOAT Archive_Max[32 - Average 32] 1 RD_ONLY

7303 FLOAT Archive_Max[33 - Average 33] 1 RD_ONLY

7304 FLOAT Archive_Max[34 - Average 34] 1 RD_ONLY

7305 FLOAT Archive_Max[35 - Average 35] 1 RD_ONLY

7306 FLOAT Archive_Max[36 - Average 36] 1 RD_ONLY

7307 FLOAT Archive_Min[1 - Average 1] 1 RD_ONLY

7308 FLOAT Archive_Min[2 - Average 2] 1 RD_ONLY

7309 FLOAT Archive_Min[3 - Average 3] 1 RD_ONLY

7310 FLOAT Archive_Min[4 - Average 4] 1 RD_ONLY

7311 FLOAT Archive_Min[5 - Average 5] 1 RD_ONLY

7312 FLOAT Archive_Min[6 - Average 6] 1 RD_ONLY

7313 FLOAT Archive_Min[7 - Average 7] 1 RD_ONLY

7314 FLOAT Archive_Min[8 - Average 8] 1 RD_ONLY

7315 FLOAT Archive_Min[9 - Average 9] 1 RD_ONLY

7316 FLOAT Archive_Min[10 - Average 10] 1 RD_ONLY

7317 FLOAT Archive_Min[11 - Average 11] 1 RD_ONLY

7318 FLOAT Archive_Min[12 - Average 12] 1 RD_ONLY

7319 FLOAT Archive_Min[13 - Average 13] 1 RD_ONLY

7320 FLOAT Archive_Min[14 - Average 14] 1 RD_ONLY

7321 FLOAT Archive_Min[15 - Average 15] 1 RD_ONLY

7322 FLOAT Archive_Min[16 - Average 16] 1 RD_ONLY

7323 FLOAT Archive_Min[17 - Average 17] 1 RD_ONLY

7324 FLOAT Archive_Min[18 - Average 18] 1 RD_ONLY

7325 FLOAT Archive_Min[19 - Average 19] 1 RD_ONLY

7326 FLOAT Archive_Min[20 - Average 20] 1 RD_ONLY

7327 FLOAT Archive_Min[21 - Average 21] 1 RD_ONLY

7328 FLOAT Archive_Min[22 - Average 22] 1 RD_ONLY

Pre-defined Modbus® Map Files Reference Manual
July 2020 2-3-9000-744

264 Emerson.com/Rosemount



Register # Data Type Variable Record # Access Format

7329 FLOAT Archive_Min[23 - Average 23] 1 RD_ONLY

7330 FLOAT Archive_Min[24 - Average 24] 1 RD_ONLY

7331 FLOAT Archive_Min[25 - Average 25] 1 RD_ONLY

7332 FLOAT Archive_Min[26 - Average 26] 1 RD_ONLY

7333 FLOAT Archive_Min[27 - Average 27] 1 RD_ONLY

7334 FLOAT Archive_Min[28 - Average 28] 1 RD_ONLY

7335 FLOAT Archive_Min[29 - Average 29] 1 RD_ONLY

7336 FLOAT Archive_Min[30 - Average 30] 1 RD_ONLY

7337 FLOAT Archive_Min[31 - Average 31] 1 RD_ONLY

7338 FLOAT Archive_Min[32 - Average 32] 1 RD_ONLY

7339 FLOAT Archive_Min[33 - Average 33] 1 RD_ONLY

7340 FLOAT Archive_Min[34 - Average 34] 1 RD_ONLY

7341 FLOAT Archive_Min[35 - Average 35] 1 RD_ONLY

7342 FLOAT Archive_Min[36 - Average 36] 1 RD_ONLY

7343 FLOAT Archive_Avg[1 - Average 1] 2 RD_ONLY

7344 FLOAT Archive_Avg[2 - Average 2] 2 RD_ONLY

7345 FLOAT Archive_Avg[3 - Average 3] 2 RD_ONLY

7346 FLOAT Archive_Avg[4 - Average 4] 2 RD_ONLY

7347 FLOAT Archive_Avg[5 - Average 5] 2 RD_ONLY

7348 FLOAT Archive_Avg[6 - Average 6] 2 RD_ONLY

7349 FLOAT Archive_Avg[7 - Average 7] 2 RD_ONLY

7350 FLOAT Archive_Avg[8 - Average 8] 2 RD_ONLY

7351 FLOAT Archive_Avg[9 - Average 9] 2 RD_ONLY

7352 FLOAT Archive_Avg[10 - Average 10] 2 RD_ONLY

7353 FLOAT Archive_Avg[11 - Average 11] 2 RD_ONLY

7354 FLOAT Archive_Avg[12 - Average 12] 2 RD_ONLY

7355 FLOAT Archive_Avg[13 - Average 13] 2 RD_ONLY

7356 FLOAT Archive_Avg[14 - Average 14] 2 RD_ONLY

7357 FLOAT Archive_Avg[15 - Average 15] 2 RD_ONLY

7358 FLOAT Archive_Avg[16 - Average 16] 2 RD_ONLY

7359 FLOAT Archive_Avg[17 - Average 17] 2 RD_ONLY

7360 FLOAT Archive_Avg[18 - Average 18] 2 RD_ONLY

7361 FLOAT Archive_Avg[19 - Average 19] 2 RD_ONLY

7362 FLOAT Archive_Avg[20 - Average 20] 2 RD_ONLY
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7363 FLOAT Archive_Avg[21 - Average 21] 2 RD_ONLY

7364 FLOAT Archive_Avg[22 - Average 22] 2 RD_ONLY

7365 FLOAT Archive_Avg[23 - Average 23] 2 RD_ONLY

7366 FLOAT Archive_Avg[24 - Average 24] 2 RD_ONLY

7367 FLOAT Archive_Avg[25 - Average 25] 2 RD_ONLY

7368 FLOAT Archive_Avg[26 - Average 26] 2 RD_ONLY

7369 FLOAT Archive_Avg[27 - Average 27] 2 RD_ONLY

7370 FLOAT Archive_Avg[28 - Average 28] 2 RD_ONLY

7371 FLOAT Archive_Avg[29 - Average 29] 2 RD_ONLY

7372 FLOAT Archive_Avg[30 - Average 30] 2 RD_ONLY

7373 FLOAT Archive_Avg[31 - Average 31] 2 RD_ONLY

7374 FLOAT Archive_Avg[32 - Average 32] 2 RD_ONLY

7375 FLOAT Archive_Avg[33 - Average 33] 2 RD_ONLY

7376 FLOAT Archive_Avg[34 - Average 34] 2 RD_ONLY

7377 FLOAT Archive_Avg[35 - Average 35] 2 RD_ONLY

7378 FLOAT Archive_Avg[36 - Average 36] 2 RD_ONLY

7379 FLOAT Archive_Max[1 - Average 1] 2 RD_ONLY

7380 FLOAT Archive_Max[2 - Average 2] 2 RD_ONLY

7381 FLOAT Archive_Max[3 - Average 3] 2 RD_ONLY

7382 FLOAT Archive_Max[4 - Average 4] 2 RD_ONLY

7383 FLOAT Archive_Max[5 - Average 5] 2 RD_ONLY

7384 FLOAT Archive_Max[6 - Average 6] 2 RD_ONLY

7385 FLOAT Archive_Max[7 - Average 7] 2 RD_ONLY

7386 FLOAT Archive_Max[8 - Average 8] 2 RD_ONLY

7387 FLOAT Archive_Max[9 - Average 9] 2 RD_ONLY

7388 FLOAT Archive_Max[10 - Average 10] 2 RD_ONLY

7389 FLOAT Archive_Max[11 - Average 11] 2 RD_ONLY

7390 FLOAT Archive_Max[12 - Average 12] 2 RD_ONLY

7391 FLOAT Archive_Max[13 - Average 13] 2 RD_ONLY

7392 FLOAT Archive_Max[14 - Average 14] 2 RD_ONLY

7393 FLOAT Archive_Max[15 - Average 15] 2 RD_ONLY

7394 FLOAT Archive_Max[16 - Average 16] 2 RD_ONLY

7395 FLOAT Archive_Max[17 - Average 17] 2 RD_ONLY

7396 FLOAT Archive_Max[18 - Average 18] 2 RD_ONLY
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7397 FLOAT Archive_Max[19 - Average 19] 2 RD_ONLY

7398 FLOAT Archive_Max[20 - Average 20] 2 RD_ONLY

7399 FLOAT Archive_Max[21 - Average 21] 2 RD_ONLY

7400 FLOAT Archive_Max[22 - Average 22] 2 RD_ONLY

7401 FLOAT Archive_Max[23 - Average 23] 2 RD_ONLY

7402 FLOAT Archive_Max[24 - Average 24] 2 RD_ONLY

7403 FLOAT Archive_Max[25 - Average 25] 2 RD_ONLY

7404 FLOAT Archive_Max[26 - Average 26] 2 RD_ONLY

7405 FLOAT Archive_Max[27 - Average 27] 2 RD_ONLY

7406 FLOAT Archive_Max[28 - Average 28] 2 RD_ONLY

7407 FLOAT Archive_Max[29 - Average 29] 2 RD_ONLY

7408 FLOAT Archive_Max[30 - Average 30] 2 RD_ONLY

7409 FLOAT Archive_Max[31 - Average 31] 2 RD_ONLY

7410 FLOAT Archive_Max[32 - Average 32] 2 RD_ONLY

7411 FLOAT Archive_Max[33 - Average 33] 2 RD_ONLY

7412 FLOAT Archive_Max[34 - Average 34] 2 RD_ONLY

7413 FLOAT Archive_Max[35 - Average 35] 2 RD_ONLY

7414 FLOAT Archive_Max[36 - Average 36] 2 RD_ONLY

7415 FLOAT Archive_Min[1 - Average 1] 2 RD_ONLY

7416 FLOAT Archive_Min[2 - Average 2] 2 RD_ONLY

7417 FLOAT Archive_Min[3 - Average 3] 2 RD_ONLY

7418 FLOAT Archive_Min[4 - Average 4] 2 RD_ONLY

7419 FLOAT Archive_Min[5 - Average 5] 2 RD_ONLY

7420 FLOAT Archive_Min[6 - Average 6] 2 RD_ONLY

7421 FLOAT Archive_Min[7 - Average 7] 2 RD_ONLY

7422 FLOAT Archive_Min[8 - Average 8] 2 RD_ONLY

7423 FLOAT Archive_Min[9 - Average 9] 2 RD_ONLY

7424 FLOAT Archive_Min[10 - Average 10] 2 RD_ONLY

7425 FLOAT Archive_Min[11 - Average 11] 2 RD_ONLY

7426 FLOAT Archive_Min[12 - Average 12] 2 RD_ONLY

7427 FLOAT Archive_Min[13 - Average 13] 2 RD_ONLY

7428 FLOAT Archive_Min[14 - Average 14] 2 RD_ONLY

7429 FLOAT Archive_Min[15 - Average 15] 2 RD_ONLY

7430 FLOAT Archive_Min[16 - Average 16] 2 RD_ONLY
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7431 FLOAT Archive_Min[17 - Average 17] 2 RD_ONLY

7432 FLOAT Archive_Min[18 - Average 18] 2 RD_ONLY

7433 FLOAT Archive_Min[19 - Average 19] 2 RD_ONLY

7434 FLOAT Archive_Min[20 - Average 20] 2 RD_ONLY

7435 FLOAT Archive_Min[21 - Average 21] 2 RD_ONLY

7436 FLOAT Archive_Min[22 - Average 22] 2 RD_ONLY

7437 FLOAT Archive_Min[23 - Average 23] 2 RD_ONLY

7438 FLOAT Archive_Min[24 - Average 24] 2 RD_ONLY

7439 FLOAT Archive_Min[25 - Average 25] 2 RD_ONLY

7440 FLOAT Archive_Min[26 - Average 26] 2 RD_ONLY

7441 FLOAT Archive_Min[27 - Average 27] 2 RD_ONLY

7442 FLOAT Archive_Min[28 - Average 28] 2 RD_ONLY

7443 FLOAT Archive_Min[29 - Average 29] 2 RD_ONLY

7444 FLOAT Archive_Min[30 - Average 30] 2 RD_ONLY

7445 FLOAT Archive_Min[31 - Average 31] 2 RD_ONLY

7446 FLOAT Archive_Min[32 - Average 32] 2 RD_ONLY

7447 FLOAT Archive_Min[33 - Average 33] 2 RD_ONLY

7448 FLOAT Archive_Min[34 - Average 34] 2 RD_ONLY

7449 FLOAT Archive_Min[35 - Average 35] 2 RD_ONLY

7450 FLOAT Archive_Min[36 - Average 36] 2 RD_ONLY

7451 FLOAT Archive_Avg[1 - Average 1] 3 RD_ONLY

7452 FLOAT Archive_Avg[2 - Average 2] 3 RD_ONLY

7453 FLOAT Archive_Avg[3 - Average 3] 3 RD_ONLY

7454 FLOAT Archive_Avg[4 - Average 4] 3 RD_ONLY

7455 FLOAT Archive_Avg[5 - Average 5] 3 RD_ONLY

7456 FLOAT Archive_Avg[6 - Average 6] 3 RD_ONLY

7457 FLOAT Archive_Avg[7 - Average 7] 3 RD_ONLY

7458 FLOAT Archive_Avg[8 - Average 8] 3 RD_ONLY

7459 FLOAT Archive_Avg[9 - Average 9] 3 RD_ONLY

7460 FLOAT Archive_Avg[10 - Average 10] 3 RD_ONLY

7461 FLOAT Archive_Avg[11 - Average 11] 3 RD_ONLY

7462 FLOAT Archive_Avg[12 - Average 12] 3 RD_ONLY

7463 FLOAT Archive_Avg[13 - Average 13] 3 RD_ONLY

7464 FLOAT Archive_Avg[14 - Average 14] 3 RD_ONLY
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7465 FLOAT Archive_Avg[15 - Average 15] 3 RD_ONLY

7466 FLOAT Archive_Avg[16 - Average 16] 3 RD_ONLY

7467 FLOAT Archive_Avg[17 - Average 17] 3 RD_ONLY

7468 FLOAT Archive_Avg[18 - Average 18] 3 RD_ONLY

7469 FLOAT Archive_Avg[19 - Average 19] 3 RD_ONLY

7470 FLOAT Archive_Avg[20 - Average 20] 3 RD_ONLY

7471 FLOAT Archive_Avg[21 - Average 21] 3 RD_ONLY

7472 FLOAT Archive_Avg[22 - Average 22] 3 RD_ONLY

7473 FLOAT Archive_Avg[23 - Average 23] 3 RD_ONLY

7474 FLOAT Archive_Avg[24 - Average 24] 3 RD_ONLY

7475 FLOAT Archive_Avg[25 - Average 25] 3 RD_ONLY

7476 FLOAT Archive_Avg[26 - Average 26] 3 RD_ONLY

7477 FLOAT Archive_Avg[27 - Average 27] 3 RD_ONLY

7478 FLOAT Archive_Avg[28 - Average 28] 3 RD_ONLY

7479 FLOAT Archive_Avg[29 - Average 29] 3 RD_ONLY

7480 FLOAT Archive_Avg[30 - Average 30] 3 RD_ONLY

7481 FLOAT Archive_Avg[31 - Average 31] 3 RD_ONLY

7482 FLOAT Archive_Avg[32 - Average 32] 3 RD_ONLY

7483 FLOAT Archive_Avg[33 - Average 33] 3 RD_ONLY

7484 FLOAT Archive_Avg[34 - Average 34] 3 RD_ONLY

7485 FLOAT Archive_Avg[35 - Average 35] 3 RD_ONLY

7486 FLOAT Archive_Avg[36 - Average 36] 3 RD_ONLY

7487 FLOAT Archive_Max[1 - Average 1] 3 RD_ONLY

7488 FLOAT Archive_Max[2 - Average 2] 3 RD_ONLY

7489 FLOAT Archive_Max[3 - Average 3] 3 RD_ONLY

7490 FLOAT Archive_Max[4 - Average 4] 3 RD_ONLY

7491 FLOAT Archive_Max[5 - Average 5] 3 RD_ONLY

7492 FLOAT Archive_Max[6 - Average 6] 3 RD_ONLY

7493 FLOAT Archive_Max[7 - Average 7] 3 RD_ONLY

7494 FLOAT Archive_Max[8 - Average 8] 3 RD_ONLY

7495 FLOAT Archive_Max[9 - Average 9] 3 RD_ONLY

7496 FLOAT Archive_Max[10 - Average 10] 3 RD_ONLY

7497 FLOAT Archive_Max[11 - Average 11] 3 RD_ONLY

7498 FLOAT Archive_Max[12 - Average 12] 3 RD_ONLY
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7499 FLOAT Archive_Max[13 - Average 13] 3 RD_ONLY

7500 FLOAT Archive_Max[14 - Average 14] 3 RD_ONLY

7501 FLOAT Archive_Max[15 - Average 15] 3 RD_ONLY

7502 FLOAT Archive_Max[16 - Average 16] 3 RD_ONLY

7503 FLOAT Archive_Max[17 - Average 17] 3 RD_ONLY

7504 FLOAT Archive_Max[18 - Average 18] 3 RD_ONLY

7505 FLOAT Archive_Max[19 - Average 19] 3 RD_ONLY

7506 FLOAT Archive_Max[20 - Average 20] 3 RD_ONLY

7507 FLOAT Archive_Max[21 - Average 21] 3 RD_ONLY

7508 FLOAT Archive_Max[22 - Average 22] 3 RD_ONLY

7509 FLOAT Archive_Max[23 - Average 23] 3 RD_ONLY

7510 FLOAT Archive_Max[24 - Average 24] 3 RD_ONLY

7511 FLOAT Archive_Max[25 - Average 25] 3 RD_ONLY

7512 FLOAT Archive_Max[26 - Average 26] 3 RD_ONLY

7513 FLOAT Archive_Max[27 - Average 27] 3 RD_ONLY

7514 FLOAT Archive_Max[28 - Average 28] 3 RD_ONLY

7515 FLOAT Archive_Max[29 - Average 29] 3 RD_ONLY

7516 FLOAT Archive_Max[30 - Average 30] 3 RD_ONLY

7517 FLOAT Archive_Max[31 - Average 31] 3 RD_ONLY

7518 FLOAT Archive_Max[32 - Average 32] 3 RD_ONLY

7519 FLOAT Archive_Max[33 - Average 33] 3 RD_ONLY

7520 FLOAT Archive_Max[34 - Average 34] 3 RD_ONLY

7521 FLOAT Archive_Max[35 - Average 35] 3 RD_ONLY

7522 FLOAT Archive_Max[36 - Average 36] 3 RD_ONLY

7523 FLOAT Archive_Min[1 - Average 1] 3 RD_ONLY

7524 FLOAT Archive_Min[2 - Average 2] 3 RD_ONLY

7525 FLOAT Archive_Min[3 - Average 3] 3 RD_ONLY

7526 FLOAT Archive_Min[4 - Average 4] 3 RD_ONLY

7527 FLOAT Archive_Min[5 - Average 5] 3 RD_ONLY

7528 FLOAT Archive_Min[6 - Average 6] 3 RD_ONLY

7529 FLOAT Archive_Min[7 - Average 7] 3 RD_ONLY

7530 FLOAT Archive_Min[8 - Average 8] 3 RD_ONLY

7531 FLOAT Archive_Min[9 - Average 9] 3 RD_ONLY

7532 FLOAT Archive_Min[10 - Average 10] 3 RD_ONLY
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7533 FLOAT Archive_Min[11 - Average 11] 3 RD_ONLY

7534 FLOAT Archive_Min[12 - Average 12] 3 RD_ONLY

7535 FLOAT Archive_Min[13 - Average 13] 3 RD_ONLY

7536 FLOAT Archive_Min[14 - Average 14] 3 RD_ONLY

7537 FLOAT Archive_Min[15 - Average 15] 3 RD_ONLY

7538 FLOAT Archive_Min[16 - Average 16] 3 RD_ONLY

7539 FLOAT Archive_Min[17 - Average 17] 3 RD_ONLY

7540 FLOAT Archive_Min[18 - Average 18] 3 RD_ONLY

7541 FLOAT Archive_Min[19 - Average 19] 3 RD_ONLY

7542 FLOAT Archive_Min[20 - Average 20] 3 RD_ONLY

7543 FLOAT Archive_Min[21 - Average 21] 3 RD_ONLY

7544 FLOAT Archive_Min[22 - Average 22] 3 RD_ONLY

7545 FLOAT Archive_Min[23 - Average 23] 3 RD_ONLY

7546 FLOAT Archive_Min[24 - Average 24] 3 RD_ONLY

7547 FLOAT Archive_Min[25 - Average 25] 3 RD_ONLY

7548 FLOAT Archive_Min[26 - Average 26] 3 RD_ONLY

7549 FLOAT Archive_Min[27 - Average 27] 3 RD_ONLY

7550 FLOAT Archive_Min[28 - Average 28] 3 RD_ONLY

7551 FLOAT Archive_Min[29 - Average 29] 3 RD_ONLY

7552 FLOAT Archive_Min[30 - Average 30] 3 RD_ONLY

7553 FLOAT Archive_Min[31 - Average 31] 3 RD_ONLY

7554 FLOAT Archive_Min[32 - Average 32] 3 RD_ONLY

7555 FLOAT Archive_Min[33 - Average 33] 3 RD_ONLY

7556 FLOAT Archive_Min[34 - Average 34] 3 RD_ONLY

7557 FLOAT Archive_Min[35 - Average 35] 3 RD_ONLY

7558 FLOAT Archive_Min[36 - Average 36] 3 RD_ONLY

7560 FLOAT Current Value[1 - Analog Input 1] RD_ONLY

7561 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7562 FLOAT Current Value[3] RD_ONLY

7563 FLOAT Current Value[4] RD_ONLY

7564 FLOAT Current Value[1 - Analog Input 1] RD_ONLY

7565 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7566 FLOAT Current Value[3] RD_ONLY

7567 FLOAT Current Value[4] RD_ONLY
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7621 FLOAT 1 - Stream 1_Start Time RD_ONLY YYMMDD

7622 FLOAT 1 - Stream 1_Start Time RD_ONLY hhmmss

7623 FLOAT 1 - Stream 1_Mole %[1 - Component 1] RD_ONLY

7624 FLOAT 1 - Stream 1_Mole %[2 - Component 2] RD_ONLY

7625 FLOAT 1 - Stream 1_Mole %[3 - Component 3] RD_ONLY

7626 FLOAT 1 - Stream 1_Mole %[4 - Component 4] RD_ONLY

7627 FLOAT 1 - Stream 1_Mole %[5 - Component 5] RD_ONLY

7628 FLOAT 1 - Stream 1_Mole %[6 - Component 6] RD_ONLY

7629 FLOAT 1 - Stream 1_Mole %[7 - Component 7] RD_ONLY

7630 FLOAT 1 - Stream 1_Mole %[8 - Component 8] RD_ONLY

7631 FLOAT 1 - Stream 1_Mole %[9 - Component 9] RD_ONLY

7632 FLOAT 1 - Stream 1_Mole %[10 - Component 10] RD_ONLY

7633 FLOAT 1 - Stream 1_Mole %[11 - Component 11] RD_ONLY

7634 FLOAT 1 - Stream 1_Mole %[12 - Component 12] RD_ONLY

7635 FLOAT 1 - Stream 1_Mole %[13 - Component 13] RD_ONLY

7636 FLOAT 1 - Stream 1_Mole %[14 - Component 14] RD_ONLY

7637 FLOAT 1 - Stream 1_Mole %[15 - Component 15] RD_ONLY

7638 FLOAT 1 - Stream 1_Mole %[16 - Component 16] RD_ONLY

7639 FLOAT 1 - Stream 1_Mole %[17 - Component 17] RD_ONLY

7640 FLOAT 1 - Stream 1_Mole %[18 - Component 18] RD_ONLY

7641 FLOAT 1 - Stream 1_Mole %[19 - Component 19] RD_ONLY

7642 FLOAT 1 - Stream 1_Mole %[20 - Component 20] RD_ONLY

7643 FLOAT 1 - Stream 1_HV Gross BTU Dry RD_ONLY

7644 FLOAT 1 - Stream 1_GPA Real Rel Den Gas RD_ONLY

7645 FLOAT 1 - Stream 1_GPA Z Factor RD_ONLY

7646 FLOAT 1 - Stream 1_Total Unnormalized Conc RD_ONLY

7647 FLOAT Unused RD_ONLY

7648 FLOAT Unused RD_ONLY

7649 FLOAT Unused RD_ONLY

7650 FLOAT Unused RD_ONLY

7651 FLOAT 2 - Stream 2_Start Time RD_ONLY YYMMDD

7652 FLOAT 2 - Stream 2_Start Time RD_ONLY hhmmss

7653 FLOAT 2 - Stream 2_Mole %[1 - Component 1] RD_ONLY

7654 FLOAT 2 - Stream 2_Mole %[2 - Component 2] RD_ONLY
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7655 FLOAT 2 - Stream 2_Mole %[3 - Component 3] RD_ONLY

7656 FLOAT 2 - Stream 2_Mole %[4 - Component 4] RD_ONLY

7657 FLOAT 2 - Stream 2_Mole %[5 - Component 5] RD_ONLY

7658 FLOAT 2 - Stream 2_Mole %[6 - Component 6] RD_ONLY

7659 FLOAT 2 - Stream 2_Mole %[7 - Component 7] RD_ONLY

7660 FLOAT 2 - Stream 2_Mole %[8 - Component 8] RD_ONLY

7661 FLOAT 2 - Stream 2_Mole %[9 - Component 9] RD_ONLY

7662 FLOAT 2 - Stream 2_Mole %[10 - Component 10] RD_ONLY

7663 FLOAT 2 - Stream 2_Mole %[11 - Component 11] RD_ONLY

7664 FLOAT 2 - Stream 2_Mole %[12 - Component 12] RD_ONLY

7665 FLOAT 2 - Stream 2_Mole %[13 - Component 13] RD_ONLY

7666 FLOAT 2 - Stream 2_Mole %[14 - Component 14] RD_ONLY

7667 FLOAT 2 - Stream 2_Mole %[15 - Component 15] RD_ONLY

7668 FLOAT 2 - Stream 2_Mole %[16 - Component 16] RD_ONLY

7669 FLOAT 2 - Stream 2_Mole %[17 - Component 17] RD_ONLY

7670 FLOAT 2 - Stream 2_Mole %[18 - Component 18] RD_ONLY

7671 FLOAT 2 - Stream 2_Mole %[19 - Component 19] RD_ONLY

7672 FLOAT 2 - Stream 2_Mole %[20 - Component 20] RD_ONLY

7673 FLOAT 2 - Stream 2_HV Gross BTU Dry RD_ONLY

7674 FLOAT 2 - Stream 2_GPA Real Rel Den Gas RD_ONLY

7675 FLOAT 2 - Stream 2_GPA Z Factor RD_ONLY

7676 FLOAT 2 - Stream 2_Total Unnormalized Conc RD_ONLY

7677 FLOAT Unused RD_ONLY

7678 FLOAT Unused RD_ONLY

7679 FLOAT Unused RD_ONLY

7680 FLOAT Unused RD_ONLY

7681 FLOAT 3 - Stream 3_Start Time RD_ONLY YYMMDD

7682 FLOAT 3 - Stream 3_Start Time RD_ONLY hhmmss

7683 FLOAT 3 - Stream 3_Mole %[1 - Component 1] RD_ONLY

7684 FLOAT 3 - Stream 3_Mole %[2 - Component 2] RD_ONLY

7685 FLOAT 3 - Stream 3_Mole %[3 - Component 3] RD_ONLY

7686 FLOAT 3 - Stream 3_Mole %[4 - Component 4] RD_ONLY

7687 FLOAT 3 - Stream 3_Mole %[5 - Component 5] RD_ONLY

7688 FLOAT 3 - Stream 3_Mole %[6 - Component 6] RD_ONLY
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7689 FLOAT 3 - Stream 3_Mole %[7 - Component 7] RD_ONLY

7690 FLOAT 3 - Stream 3_Mole %[8 - Component 8] RD_ONLY

7691 FLOAT 3 - Stream 3_Mole %[9 - Component 9] RD_ONLY

7692 FLOAT 3 - Stream 3_Mole %[10 - Component 10] RD_ONLY

7693 FLOAT 3 - Stream 3_Mole %[11 - Component 11] RD_ONLY

7694 FLOAT 3 - Stream 3_Mole %[12 - Component 12] RD_ONLY

7695 FLOAT 3 - Stream 3_Mole %[13 - Component 13] RD_ONLY

7696 FLOAT 3 - Stream 3_Mole %[14 - Component 14] RD_ONLY

7697 FLOAT 3 - Stream 3_Mole %[15 - Component 15] RD_ONLY

7698 FLOAT 3 - Stream 3_Mole %[16 - Component 16] RD_ONLY

7699 FLOAT 3 - Stream 3_Mole %[17 - Component 17] RD_ONLY

7700 FLOAT 3 - Stream 3_Mole %[18 - Component 18] RD_ONLY

7701 FLOAT 3 - Stream 3_Mole %[19 - Component 19] RD_ONLY

7702 FLOAT 3 - Stream 3_Mole %[20 - Component 20] RD_ONLY

7703 FLOAT 3 - Stream 3_HV Gross BTU Dry RD_ONLY

7704 FLOAT 3 - Stream 3_GPA Real Rel Den Gas RD_ONLY

7705 FLOAT 3 - Stream 3_GPA Z Factor RD_ONLY

7706 FLOAT 3 - Stream 3_Total Unnormalized Conc RD_ONLY

7707 FLOAT Unused RD_ONLY

7708 FLOAT Unused RD_ONLY

7709 FLOAT Unused RD_ONLY

7710 FLOAT Unused RD_ONLY

7711 FLOAT 4 - Stream 4_Start Time RD_ONLY YYMMDD

7712 FLOAT 4 - Stream 4_Start Time RD_ONLY hhmmss

7713 FLOAT 4 - Stream 4_Mole %[1 - Component 1] RD_ONLY

7714 FLOAT 4 - Stream 4_Mole %[2 - Component 2] RD_ONLY

7715 FLOAT 4 - Stream 4_Mole %[3 - Component 3] RD_ONLY

7716 FLOAT 4 - Stream 4_Mole %[4 - Component 4] RD_ONLY

7717 FLOAT 4 - Stream 4_Mole %[5 - Component 5] RD_ONLY

7718 FLOAT 4 - Stream 4_Mole %[6 - Component 6] RD_ONLY

7719 FLOAT 4 - Stream 4_Mole %[7 - Component 7] RD_ONLY

7720 FLOAT 4 - Stream 4_Mole %[8 - Component 8] RD_ONLY

7721 FLOAT 4 - Stream 4_Mole %[9 - Component 9] RD_ONLY

7722 FLOAT 4 - Stream 4_Mole %[10 - Component 10] RD_ONLY
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7723 FLOAT 4 - Stream 4_Mole %[11 - Component 11] RD_ONLY

7724 FLOAT 4 - Stream 4_Mole %[12 - Component 12] RD_ONLY

7725 FLOAT 4 - Stream 4_Mole %[13 - Component 13] RD_ONLY

7726 FLOAT 4 - Stream 4_Mole %[14 - Component 14] RD_ONLY

7727 FLOAT 4 - Stream 4_Mole %[15 - Component 15] RD_ONLY

7728 FLOAT 4 - Stream 4_Mole %[16 - Component 16] RD_ONLY

7729 FLOAT 4 - Stream 4_Mole %[17 - Component 17] RD_ONLY

7730 FLOAT 4 - Stream 4_Mole %[18 - Component 18] RD_ONLY

7731 FLOAT 4 - Stream 4_Mole %[19 - Component 19] RD_ONLY

7732 FLOAT 4 - Stream 4_Mole %[20 - Component 20] RD_ONLY

7733 FLOAT 4 - Stream 4_HV Gross BTU Dry RD_ONLY

7734 FLOAT 4 - Stream 4_GPA Real Rel Den Gas RD_ONLY

7735 FLOAT 4 - Stream 4_GPA Z Factor RD_ONLY

7736 FLOAT 4 - Stream 4_Total Unnormalized Conc RD_ONLY

7737 FLOAT Unused RD_ONLY

7738 FLOAT Unused RD_ONLY

7739 FLOAT Unused RD_ONLY

7740 FLOAT Unused RD_ONLY

7741 FLOAT 5 - Stream 5_Start Time RD_ONLY YYMMDD

7742 FLOAT 5 - Stream 5_Start Time RD_ONLY hhmmss

7743 FLOAT 5 - Stream 5_Mole %[1 - Component 1] RD_ONLY

7744 FLOAT 5 - Stream 5_Mole %[2 - Component 2] RD_ONLY

7745 FLOAT 5 - Stream 5_Mole %[3 - Component 3] RD_ONLY

7746 FLOAT 5 - Stream 5_Mole %[4 - Component 4] RD_ONLY

7747 FLOAT 5 - Stream 5_Mole %[5 - Component 5] RD_ONLY

7748 FLOAT 5 - Stream 5_Mole %[6 - Component 6] RD_ONLY

7749 FLOAT 5 - Stream 5_Mole %[7 - Component 7] RD_ONLY

7750 FLOAT 5 - Stream 5_Mole %[8 - Component 8] RD_ONLY

7751 FLOAT 5 - Stream 5_Mole %[9 - Component 9] RD_ONLY

7752 FLOAT 5 - Stream 5_Mole %[10 - Component 10] RD_ONLY

7753 FLOAT 5 - Stream 5_Mole %[11 - Component 11] RD_ONLY

7754 FLOAT 5 - Stream 5_Mole %[12 - Component 12] RD_ONLY

7755 FLOAT 5 - Stream 5_Mole %[13 - Component 13] RD_ONLY

7756 FLOAT 5 - Stream 5_Mole %[14 - Component 14] RD_ONLY
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7757 FLOAT 5 - Stream 5_Mole %[15 - Component 15] RD_ONLY

7758 FLOAT 5 - Stream 5_Mole %[16 - Component 16] RD_ONLY

7759 FLOAT 5 - Stream 5_Mole %[17 - Component 17] RD_ONLY

7760 FLOAT 5 - Stream 5_Mole %[18 - Component 18] RD_ONLY

7761 FLOAT 5 - Stream 5_Mole %[19 - Component 19] RD_ONLY

7762 FLOAT 5 - Stream 5_Mole %[20 - Component 20] RD_ONLY

7763 FLOAT 5 - Stream 5_HV Gross BTU Dry RD_ONLY

7764 FLOAT 5 - Stream 5_GPA Real Rel Den Gas RD_ONLY

7765 FLOAT 5 - Stream 5_GPA Z Factor RD_ONLY

7766 FLOAT 5 - Stream 5_Total Unnormalized Conc RD_ONLY

7767 FLOAT Unused RD_ONLY

7768 FLOAT Unused RD_ONLY

7769 FLOAT Unused RD_ONLY

7770 FLOAT Unused RD_ONLY

7771 FLOAT 6 - Stream 6_Start Time RD_ONLY YYMMDD

7772 FLOAT 6 - Stream 6_Start Time RD_ONLY hhmmss

7773 FLOAT 6 - Stream 6_Mole %[1 - Component 1] RD_ONLY

7774 FLOAT 6 - Stream 6_Mole %[2 - Component 2] RD_ONLY

7775 FLOAT 6 - Stream 6_Mole %[3 - Component 3] RD_ONLY

7776 FLOAT 6 - Stream 6_Mole %[4 - Component 4] RD_ONLY

7777 FLOAT 6 - Stream 6_Mole %[5 - Component 5] RD_ONLY

7778 FLOAT 6 - Stream 6_Mole %[6 - Component 6] RD_ONLY

7779 FLOAT 6 - Stream 6_Mole %[7 - Component 7] RD_ONLY

7780 FLOAT 6 - Stream 6_Mole %[8 - Component 8] RD_ONLY

7781 FLOAT 6 - Stream 6_Mole %[9 - Component 9] RD_ONLY

7782 FLOAT 6 - Stream 6_Mole %[10 - Component 10] RD_ONLY

7783 FLOAT 6 - Stream 6_Mole %[11 - Component 11] RD_ONLY

7784 FLOAT 6 - Stream 6_Mole %[12 - Component 12] RD_ONLY

7785 FLOAT 6 - Stream 6_Mole %[13 - Component 13] RD_ONLY

7786 FLOAT 6 - Stream 6_Mole %[14 - Component 14] RD_ONLY

7787 FLOAT 6 - Stream 6_Mole %[15 - Component 15] RD_ONLY

7788 FLOAT 6 - Stream 6_Mole %[16 - Component 16] RD_ONLY

7789 FLOAT 6 - Stream 6_Mole %[17 - Component 17] RD_ONLY

7790 FLOAT 6 - Stream 6_Mole %[18 - Component 18] RD_ONLY
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7791 FLOAT 6 - Stream 6_Mole %[19 - Component 19] RD_ONLY

7792 FLOAT 6 - Stream 6_Mole %[20 - Component 20] RD_ONLY

7793 FLOAT 6 - Stream 6_HV Gross BTU Dry RD_ONLY

7794 FLOAT 6 - Stream 6_GPA Real Rel Den Gas RD_ONLY

7795 FLOAT 6 - Stream 6_GPA Z Factor RD_ONLY

7796 FLOAT 6 - Stream 6_Total Unnormalized Conc RD_ONLY

7797 FLOAT Unused RD_ONLY

7798 FLOAT Unused RD_ONLY

7799 FLOAT Unused RD_ONLY

7800 FLOAT Unused RD_ONLY

7801 FLOAT 7 - Stream 7_Start Time RD_ONLY YYMMDD

7802 FLOAT 7 - Stream 7_Start Time RD_ONLY hhmmss

7803 FLOAT 7 - Stream 7_Mole %[1 - Component 1] RD_ONLY

7804 FLOAT 7 - Stream 7_Mole %[2 - Component 2] RD_ONLY

7805 FLOAT 7 - Stream 7_Mole %[3 - Component 3] RD_ONLY

7806 FLOAT 7 - Stream 7_Mole %[4 - Component 4] RD_ONLY

7807 FLOAT 7 - Stream 7_Mole %[5 - Component 5] RD_ONLY

7808 FLOAT 7 - Stream 7_Mole %[6 - Component 6] RD_ONLY

7809 FLOAT 7 - Stream 7_Mole %[7 - Component 7] RD_ONLY

7810 FLOAT 7 - Stream 7_Mole %[8 - Component 8] RD_ONLY

7811 FLOAT 7 - Stream 7_Mole %[9 - Component 9] RD_ONLY

7812 FLOAT 7 - Stream 7_Mole %[10 - Component 10] RD_ONLY

7813 FLOAT 7 - Stream 7_Mole %[11 - Component 11] RD_ONLY

7814 FLOAT 7 - Stream 7_Mole %[12 - Component 12] RD_ONLY

7815 FLOAT 7 - Stream 7_Mole %[13 - Component 13] RD_ONLY

7816 FLOAT 7 - Stream 7_Mole %[14 - Component 14] RD_ONLY

7817 FLOAT 7 - Stream 7_Mole %[15 - Component 15] RD_ONLY

7818 FLOAT 7 - Stream 7_Mole %[16 - Component 16] RD_ONLY

7819 FLOAT 7 - Stream 7_Mole %[17 - Component 17] RD_ONLY

7820 FLOAT 7 - Stream 7_Mole %[18 - Component 18] RD_ONLY

7821 FLOAT 7 - Stream 7_Mole %[19 - Component 19] RD_ONLY

7822 FLOAT 7 - Stream 7_Mole %[20 - Component 20] RD_ONLY

7823 FLOAT 7 - Stream 7_HV Gross BTU Dry RD_ONLY

7824 FLOAT 7 - Stream 7_GPA Real Rel Den Gas RD_ONLY
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7825 FLOAT 7 - Stream 7_GPA Z Factor RD_ONLY

7826 FLOAT 7 - Stream 7_Total Unnormalized Conc RD_ONLY

7827 FLOAT Unused RD_ONLY

7828 FLOAT Unused RD_ONLY

7829 FLOAT Unused RD_ONLY

7830 FLOAT Unused RD_ONLY

7831 FLOAT 8 - Stream 8_Start Time RD_ONLY YYMMDD

7832 FLOAT 8 - Stream 8_Start Time RD_ONLY hhmmss

7833 FLOAT 8 - Stream 8_Mole %[1 - Component 1] RD_ONLY

7834 FLOAT 8 - Stream 8_Mole %[2 - Component 2] RD_ONLY

7835 FLOAT 8 - Stream 8_Mole %[3 - Component 3] RD_ONLY

7836 FLOAT 8 - Stream 8_Mole %[4 - Component 4] RD_ONLY

7837 FLOAT 8 - Stream 8_Mole %[5 - Component 5] RD_ONLY

7838 FLOAT 8 - Stream 8_Mole %[6 - Component 6] RD_ONLY

7839 FLOAT 8 - Stream 8_Mole %[7 - Component 7] RD_ONLY

7840 FLOAT 8 - Stream 8_Mole %[8 - Component 8] RD_ONLY

7841 FLOAT 8 - Stream 8_Mole %[9 - Component 9] RD_ONLY

7842 FLOAT 8 - Stream 8_Mole %[10 - Component 10] RD_ONLY

7843 FLOAT 8 - Stream 8_Mole %[11 - Component 11] RD_ONLY

7844 FLOAT 8 - Stream 8_Mole %[12 - Component 12] RD_ONLY

7845 FLOAT 8 - Stream 8_Mole %[13 - Component 13] RD_ONLY

7846 FLOAT 8 - Stream 8_Mole %[14 - Component 14] RD_ONLY

7847 FLOAT 8 - Stream 8_Mole %[15 - Component 15] RD_ONLY

7848 FLOAT 8 - Stream 8_Mole %[16 - Component 16] RD_ONLY

7849 FLOAT 8 - Stream 8_Mole %[17 - Component 17] RD_ONLY

7850 FLOAT 8 - Stream 8_Mole %[18 - Component 18] RD_ONLY

7851 FLOAT 8 - Stream 8_Mole %[19 - Component 19] RD_ONLY

7852 FLOAT 8 - Stream 8_Mole %[20 - Component 20] RD_ONLY

7853 FLOAT 8 - Stream 8_HV Gross BTU Dry RD_ONLY

7854 FLOAT 8 - Stream 8_GPA Real Rel Den Gas RD_ONLY

7855 FLOAT 8 - Stream 8_GPA Z Factor RD_ONLY

7856 FLOAT 8 - Stream 8_Total Unnormalized Conc RD_ONLY

7857 FLOAT Unused RD_ONLY

7858 FLOAT Unused RD_ONLY
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7859 FLOAT Unused RD_ONLY

7860 FLOAT Unused RD_ONLY

7861 FLOAT 9 - Stream 9_Start Time RD_ONLY YYMMDD

7862 FLOAT 9 - Stream 9_Start Time RD_ONLY hhmmss

7863 FLOAT 9 - Stream 9_Mole %[1 - Component 1] RD_ONLY

7864 FLOAT 9 - Stream 9_Mole %[2 - Component 2] RD_ONLY

7865 FLOAT 9 - Stream 9_Mole %[3 - Component 3] RD_ONLY

7866 FLOAT 9 - Stream 9_Mole %[4 - Component 4] RD_ONLY

7867 FLOAT 9 - Stream 9_Mole %[5 - Component 5] RD_ONLY

7868 FLOAT 9 - Stream 9_Mole %[6 - Component 6] RD_ONLY

7869 FLOAT 9 - Stream 9_Mole %[7 - Component 7] RD_ONLY

7870 FLOAT 9 - Stream 9_Mole %[8 - Component 8] RD_ONLY

7871 FLOAT 9 - Stream 9_Mole %[9 - Component 9] RD_ONLY

7872 FLOAT 9 - Stream 9_Mole %[10 - Component 10] RD_ONLY

7873 FLOAT 9 - Stream 9_Mole %[11 - Component 11] RD_ONLY

7874 FLOAT 9 - Stream 9_Mole %[12 - Component 12] RD_ONLY

7875 FLOAT 9 - Stream 9_Mole %[13 - Component 13] RD_ONLY

7876 FLOAT 9 - Stream 9_Mole %[14 - Component 14] RD_ONLY

7877 FLOAT 9 - Stream 9_Mole %[15 - Component 15] RD_ONLY

7878 FLOAT 9 - Stream 9_Mole %[16 - Component 16] RD_ONLY

7879 FLOAT 9 - Stream 9_Mole %[17 - Component 17] RD_ONLY

7880 FLOAT 9 - Stream 9_Mole %[18 - Component 18] RD_ONLY

7881 FLOAT 9 - Stream 9_Mole %[19 - Component 19] RD_ONLY

7882 FLOAT 9 - Stream 9_Mole %[20 - Component 20] RD_ONLY

7883 FLOAT 9 - Stream 9_HV Gross BTU Dry RD_ONLY

7884 FLOAT 9 - Stream 9_GPA Real Rel Den Gas RD_ONLY

7885 FLOAT 9 - Stream 9_GPA Z Factor RD_ONLY

7886 FLOAT 9 - Stream 9_Total Unnormalized Conc RD_ONLY

7887 FLOAT Unused RD_ONLY

7888 FLOAT Unused RD_ONLY

7889 FLOAT Unused RD_ONLY

7890 FLOAT Unused RD_ONLY

7891 FLOAT 10 - Stream 10_Start Time RD_ONLY YYMMDD

7892 FLOAT 10 - Stream 10_Start Time RD_ONLY hhmmss
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7893 FLOAT 10 - Stream 10_Mole %[1 - Component 1] RD_ONLY

7894 FLOAT 10 - Stream 10_Mole %[2 - Component 2] RD_ONLY

7895 FLOAT 10 - Stream 10_Mole %[3 - Component 3] RD_ONLY

7896 FLOAT 10 - Stream 10_Mole %[4 - Component 4] RD_ONLY

7897 FLOAT 10 - Stream 10_Mole %[5 - Component 5] RD_ONLY

7898 FLOAT 10 - Stream 10_Mole %[6 - Component 6] RD_ONLY

7899 FLOAT 10 - Stream 10_Mole %[7 - Component 7] RD_ONLY

7900 FLOAT 10 - Stream 10_Mole %[8 - Component 8] RD_ONLY

7901 FLOAT 10 - Stream 10_Mole %[9 - Component 9] RD_ONLY

7902 FLOAT 10 - Stream 10_Mole %[10 - Component 10] RD_ONLY

7903 FLOAT 10 - Stream 10_Mole %[11 - Component 11] RD_ONLY

7904 FLOAT 10 - Stream 10_Mole %[12 - Component 12] RD_ONLY

7905 FLOAT 10 - Stream 10_Mole %[13 - Component 13] RD_ONLY

7906 FLOAT 10 - Stream 10_Mole %[14 - Component 14] RD_ONLY

7907 FLOAT 10 - Stream 10_Mole %[15 - Component 15] RD_ONLY

7908 FLOAT 10 - Stream 10_Mole %[16 - Component 16] RD_ONLY

7909 FLOAT 10 - Stream 10_Mole %[17 - Component 17] RD_ONLY

7910 FLOAT 10 - Stream 10_Mole %[18 - Component 18] RD_ONLY

7911 FLOAT 10 - Stream 10_Mole %[19 - Component 19] RD_ONLY

7912 FLOAT 10 - Stream 10_Mole %[20 - Component 20] RD_ONLY

7913 FLOAT 10 - Stream 10_HV Gross BTU Dry RD_ONLY

7914 FLOAT 10 - Stream 10_GPA Real Rel Den Gas RD_ONLY

7915 FLOAT 10 - Stream 10_GPA Z Factor RD_ONLY

7916 FLOAT 10 - Stream 10_Total Unnormalized Conc RD_ONLY

7917 FLOAT Unused RD_ONLY

7918 FLOAT Unused RD_ONLY

7919 FLOAT Unused RD_ONLY

7920 FLOAT Unused RD_ONLY

7921 FLOAT 11 - Stream 11_Start Time RD_ONLY YYMMDD

7922 FLOAT 11 - Stream 11_Start Time RD_ONLY hhmmss

7923 FLOAT 11 - Stream 11_Mole %[1 - Component 1] RD_ONLY

7924 FLOAT 11 - Stream 11_Mole %[2 - Component 2] RD_ONLY

7925 FLOAT 11 - Stream 11_Mole %[3 - Component 3] RD_ONLY

7926 FLOAT 11 - Stream 11_Mole %[4 - Component 4] RD_ONLY
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7927 FLOAT 11 - Stream 11_Mole %[5 - Component 5] RD_ONLY

7928 FLOAT 11 - Stream 11_Mole %[6 - Component 6] RD_ONLY

7929 FLOAT 11 - Stream 11_Mole %[7 - Component 7] RD_ONLY

7930 FLOAT 11 - Stream 11_Mole %[8 - Component 8] RD_ONLY

7931 FLOAT 11 - Stream 11_Mole %[9 - Component 9] RD_ONLY

7932 FLOAT 11 - Stream 11_Mole %[10 - Component 10] RD_ONLY

7933 FLOAT 11 - Stream 11_Mole %[11 - Component 11] RD_ONLY

7934 FLOAT 11 - Stream 11_Mole %[12 - Component 12] RD_ONLY

7935 FLOAT 11 - Stream 11_Mole %[13 - Component 13] RD_ONLY

7936 FLOAT 11 - Stream 11_Mole %[14 - Component 14] RD_ONLY

7937 FLOAT 11 - Stream 11_Mole %[15 - Component 15] RD_ONLY

7938 FLOAT 11 - Stream 11_Mole %[16 - Component 16] RD_ONLY

7939 FLOAT 11 - Stream 11_Mole %[17 - Component 17] RD_ONLY

7940 FLOAT 11 - Stream 11_Mole %[18 - Component 18] RD_ONLY

7941 FLOAT 11 - Stream 11_Mole %[19 - Component 19] RD_ONLY

7942 FLOAT 11 - Stream 11_Mole %[20 - Component 20] RD_ONLY

7943 FLOAT 11 - Stream 11_HV Gross BTU Dry RD_ONLY

7944 FLOAT 11 - Stream 11_GPA Real Rel Den Gas RD_ONLY

7945 FLOAT 11 - Stream 11_GPA Z Factor RD_ONLY

7946 FLOAT 11 - Stream 11_Total Unnormalized Conc RD_ONLY

7947 FLOAT Unused RD_ONLY

7948 FLOAT Unused RD_ONLY

7949 FLOAT Unused RD_ONLY

7950 FLOAT Unused RD_ONLY

7951 FLOAT 12 - Stream 12_Start Time RD_ONLY YYMMDD

7952 FLOAT 12 - Stream 12_Start Time RD_ONLY hhmmss

7953 FLOAT 12 - Stream 12_Mole %[1 - Component 1] RD_ONLY

7954 FLOAT 12 - Stream 12_Mole %[2 - Component 2] RD_ONLY

7955 FLOAT 12 - Stream 12_Mole %[3 - Component 3] RD_ONLY

7956 FLOAT 12 - Stream 12_Mole %[4 - Component 4] RD_ONLY

7957 FLOAT 12 - Stream 12_Mole %[5 - Component 5] RD_ONLY

7958 FLOAT 12 - Stream 12_Mole %[6 - Component 6] RD_ONLY

7959 FLOAT 12 - Stream 12_Mole %[7 - Component 7] RD_ONLY

7960 FLOAT 12 - Stream 12_Mole %[8 - Component 8] RD_ONLY
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7961 FLOAT 12 - Stream 12_Mole %[9 - Component 9] RD_ONLY

7962 FLOAT 12 - Stream 12_Mole %[10 - Component 10] RD_ONLY

7963 FLOAT 12 - Stream 12_Mole %[11 - Component 11] RD_ONLY

7964 FLOAT 12 - Stream 12_Mole %[12 - Component 12] RD_ONLY

7965 FLOAT 12 - Stream 12_Mole %[13 - Component 13] RD_ONLY

7966 FLOAT 12 - Stream 12_Mole %[14 - Component 14] RD_ONLY

7967 FLOAT 12 - Stream 12_Mole %[15 - Component 15] RD_ONLY

7968 FLOAT 12 - Stream 12_Mole %[16 - Component 16] RD_ONLY

7969 FLOAT 12 - Stream 12_Mole %[17 - Component 17] RD_ONLY

7970 FLOAT 12 - Stream 12_Mole %[18 - Component 18] RD_ONLY

7971 FLOAT 12 - Stream 12_Mole %[19 - Component 19] RD_ONLY

7972 FLOAT 12 - Stream 12_Mole %[20 - Component 20] RD_ONLY

7973 FLOAT 12 - Stream 12_HV Gross BTU Dry RD_ONLY

7974 FLOAT 12 - Stream 12_GPA Real Rel Den Gas RD_ONLY

7975 FLOAT 12 - Stream 12_GPA Z Factor RD_ONLY

7976 FLOAT 12 - Stream 12_Total Unnormalized Conc RD_ONLY

7977 FLOAT Unused RD_ONLY

7978 FLOAT Unused RD_ONLY

7979 FLOAT Unused RD_ONLY

7980 FLOAT Unused RD_ONLY

7981 FLOAT Unused RD_ONLY

7982 FLOAT Unused RD_ONLY

7983 FLOAT Unused RD_ONLY

7984 FLOAT Unused RD_ONLY

7985 FLOAT Unused RD_ONLY

7986 FLOAT Unused RD_ONLY

7987 FLOAT Unused RD_ONLY

7988 FLOAT Unused RD_ONLY

7989 FLOAT Unused RD_ONLY

7990 FLOAT Unused RD_ONLY

7991 FLOAT Unused RD_ONLY

7992 FLOAT Unused RD_ONLY

7993 FLOAT Unused RD_ONLY

7994 FLOAT Unused RD_ONLY
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7995 FLOAT Unused RD_ONLY

7996 FLOAT GC Control_Auto Sequence RD_WR

7997 FLOAT GC Control_Halt RD_WR

7998 FLOAT GC Control_Calibration RD_WR

7999 FLOAT GC Control_Single Stream RD_WR

8000 FLOAT Current Stream RD_ONLY

8001 FLOAT GC Calibrating RD_ONLY

8002 FLOAT GC Running RD_ONLY

8003 FLOAT Unused RD_ONLY

8004 FLOAT Run Time RD_ONLY

8005 FLOAT Current Analysis Mode RD_ONLY

8006 FLOAT GC Control_Validation RD_WR

8007 FLOAT Unused RD_ONLY

8008 FLOAT Unused RD_ONLY

8009 FLOAT Unused RD_ONLY

8010 FLOAT Unused RD_ONLY

8011 FLOAT Unused RD_ONLY

8012 FLOAT Unused RD_ONLY

8013 FLOAT Unused RD_ONLY

8014 FLOAT Unused RD_ONLY

8015 FLOAT Unused RD_ONLY

8016 FLOAT Unused RD_ONLY

8017 FLOAT Unused RD_ONLY

8018 FLOAT Unused RD_ONLY

8019 FLOAT Unused RD_ONLY

8020 FLOAT Unused RD_ONLY

8021 FLOAT Unused RD_ONLY

8022 FLOAT Unused RD_ONLY

8023 FLOAT Unused RD_ONLY

8024 FLOAT Unused RD_ONLY

8025 FLOAT Unused RD_ONLY

8026 FLOAT Unused RD_ONLY

8027 FLOAT Unused RD_ONLY

8028 FLOAT Unused RD_ONLY
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8029 FLOAT Unused RD_ONLY

8030 FLOAT Unused RD_ONLY

8031 FLOAT Unused RD_ONLY

8032 FLOAT Unused RD_ONLY

8033 FLOAT Unused RD_ONLY

8034 FLOAT Unused RD_ONLY

8035 FLOAT Unused RD_ONLY

8036 FLOAT Unused RD_ONLY

8037 FLOAT Unused RD_ONLY

8038 FLOAT Unused RD_ONLY

8039 FLOAT Unused RD_ONLY

8040 FLOAT Unused RD_ONLY

8041 FLOAT Unused RD_ONLY

8042 FLOAT Unused RD_ONLY

8043 FLOAT Unused RD_ONLY

8044 FLOAT Unused RD_ONLY

8045 FLOAT Unused RD_ONLY

8046 FLOAT Unused RD_ONLY

8047 FLOAT Unused RD_ONLY

8048 FLOAT Unused RD_ONLY

8049 FLOAT Unused RD_ONLY

8050 FLOAT Unused RD_ONLY

8051 FLOAT Unused RD_ONLY

8052 FLOAT Unused RD_ONLY

8053 FLOAT Unused RD_ONLY

8054 FLOAT Unused RD_ONLY

8055 FLOAT Unused RD_ONLY

8056 FLOAT Unused RD_ONLY

8057 FLOAT Unused RD_ONLY

8058 FLOAT Unused RD_ONLY

8059 FLOAT Unused RD_ONLY

8060 FLOAT Unused RD_ONLY

8061 FLOAT Unused RD_ONLY

8062 FLOAT Unused RD_ONLY
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8063 FLOAT Unused RD_ONLY

8064 FLOAT Unused RD_ONLY

8065 FLOAT Unused RD_ONLY

8066 FLOAT Unused RD_ONLY

8067 FLOAT Unused RD_ONLY

8068 FLOAT Unused RD_ONLY

8069 FLOAT Unused RD_ONLY

8070 FLOAT Unused RD_ONLY

8071 FLOAT Unused RD_ONLY

8072 FLOAT Unused RD_ONLY

8073 FLOAT Unused RD_ONLY

8074 FLOAT Unused RD_ONLY

8075 FLOAT Unused RD_ONLY

8076 FLOAT Unused RD_ONLY

8077 FLOAT Unused RD_ONLY

8078 FLOAT Unused RD_ONLY

8079 FLOAT Unused RD_ONLY

8080 FLOAT Unused RD_ONLY

8081 FLOAT Unused RD_ONLY

8082 FLOAT Unused RD_ONLY

8083 FLOAT Unused RD_ONLY

8084 FLOAT Unused RD_ONLY

8085 FLOAT Unused RD_ONLY

8086 FLOAT Unused RD_ONLY

8087 FLOAT Unused RD_ONLY

8088 FLOAT Unused RD_ONLY

8089 FLOAT Unused RD_ONLY

8090 FLOAT Unused RD_ONLY

8091 FLOAT Unused RD_ONLY

8092 FLOAT Unused RD_ONLY

8093 FLOAT Unused RD_ONLY

8094 FLOAT Unused RD_ONLY

8095 FLOAT Unused RD_ONLY

8096 FLOAT Unused RD_ONLY

Reference Manual Pre-defined Modbus® Map Files
2-3-9000-744 July 2020

Rosemount 700XA 285



Register # Data Type Variable Record # Access Format

8097 FLOAT Unused RD_ONLY

8098 FLOAT Unused RD_ONLY

8099 FLOAT Unused RD_ONLY

8100 FLOAT Unused RD_ONLY

8101 FLOAT Unused RD_ONLY

8102 FLOAT Unused RD_ONLY

8103 FLOAT Unused RD_ONLY

8104 FLOAT Unused RD_ONLY

8105 FLOAT Unused RD_ONLY

8106 FLOAT Unused RD_ONLY

8107 FLOAT Unused RD_ONLY

8108 FLOAT Unused RD_ONLY

8109 FLOAT Unused RD_ONLY

8110 FLOAT Unused RD_ONLY

8111 FLOAT Unused RD_ONLY

8112 FLOAT Unused RD_ONLY

8113 FLOAT Unused RD_ONLY

8114 FLOAT Unused RD_ONLY

8115 FLOAT Unused RD_ONLY

8116 FLOAT Unused RD_ONLY

8117 FLOAT Unused RD_ONLY

8118 FLOAT Unused RD_ONLY

8119 FLOAT Unused RD_ONLY

8120 FLOAT Unused RD_ONLY

8121 FLOAT Unused RD_ONLY

8122 FLOAT Unused RD_ONLY

8123 FLOAT Unused RD_ONLY

8124 FLOAT Unused RD_ONLY

8125 FLOAT Unused RD_ONLY

8126 FLOAT Unused RD_ONLY

8127 FLOAT Unused RD_ONLY

8128 FLOAT Unused RD_ONLY

8129 FLOAT Unused RD_ONLY

8130 FLOAT Unused RD_ONLY
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8131 FLOAT Unused RD_ONLY

8132 FLOAT Unused RD_ONLY

8133 FLOAT Unused RD_ONLY

8134 FLOAT Unused RD_ONLY

8135 FLOAT Unused RD_ONLY

8136 FLOAT Unused RD_ONLY

8137 FLOAT Unused RD_ONLY

8138 FLOAT Unused RD_ONLY

8139 FLOAT Unused RD_ONLY

8140 FLOAT Unused RD_ONLY

8141 FLOAT Unused RD_ONLY

8142 FLOAT Unused RD_ONLY

8143 FLOAT Unused RD_ONLY

8144 FLOAT Unused RD_ONLY

8145 FLOAT Unused RD_ONLY

8146 FLOAT Unused RD_ONLY

8147 FLOAT Unused RD_ONLY

8148 FLOAT Unused RD_ONLY

8149 FLOAT Unused RD_ONLY

8150 FLOAT Unused RD_ONLY

8151 FLOAT Unused RD_ONLY

8152 FLOAT Unused RD_ONLY

8153 FLOAT Unused RD_ONLY

8154 FLOAT Unused RD_ONLY

8155 FLOAT Unused RD_ONLY

8156 FLOAT Unused RD_ONLY

8157 FLOAT Unused RD_ONLY

8158 FLOAT Unused RD_ONLY

8159 FLOAT Unused RD_ONLY

8160 FLOAT Unused RD_ONLY

8161 FLOAT Unused RD_ONLY

8162 FLOAT Unused RD_ONLY

8163 FLOAT Unused RD_ONLY

8164 FLOAT Unused RD_ONLY
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8165 FLOAT Unused RD_ONLY

8166 FLOAT Unused RD_ONLY

8167 FLOAT Unused RD_ONLY

8168 FLOAT Unused RD_ONLY

8169 FLOAT Unused RD_ONLY

8170 FLOAT Unused RD_ONLY

8171 FLOAT Unused RD_ONLY

8172 FLOAT Unused RD_ONLY

8173 FLOAT Unused RD_ONLY

8174 FLOAT Unused RD_ONLY

8175 FLOAT Unused RD_ONLY

8176 FLOAT Unused RD_ONLY

8177 FLOAT Unused RD_ONLY

8178 FLOAT Unused RD_ONLY

8179 FLOAT Unused RD_ONLY

8180 FLOAT Unused RD_ONLY

8181 FLOAT Unused RD_ONLY

8182 FLOAT Unused RD_ONLY

8183 FLOAT Unused RD_ONLY

8184 FLOAT Unused RD_ONLY

8185 FLOAT Unused RD_ONLY

8186 FLOAT Unused RD_ONLY

8187 FLOAT Unused RD_ONLY

8188 FLOAT Unused RD_ONLY

8189 FLOAT Unused RD_ONLY

8190 FLOAT Unused RD_ONLY

8191 FLOAT Unused RD_ONLY

8192 FLOAT Unused RD_ONLY

8193 FLOAT Unused RD_ONLY

8194 FLOAT Unused RD_ONLY

8195 FLOAT Unused RD_ONLY

8196 FLOAT Unused RD_ONLY

8197 FLOAT Unused RD_ONLY

8198 FLOAT Unused RD_ONLY
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8199 FLOAT Unused RD_ONLY

8200 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

8201 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

8202 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

8203 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

8204 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

8205 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

8206 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

8207 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

8208 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

8209 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

8210 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

8211 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

8212 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

8213 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

8214 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

8215 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

8216 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

8217 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

8218 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

8219 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

8220 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

8221 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY

8222 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

8223 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

8224 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

8225 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY

8226 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

8227 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

8228 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

8229 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

8230 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

8231 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

8232 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY
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8233 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

8234 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

8235 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

8236 FLOAT Archive_Avg[37 - Average 37] 1 RD_ONLY

8237 FLOAT Archive_Avg[38 - Average 38] 1 RD_ONLY

8238 FLOAT Archive_Avg[39 - Average 39] 1 RD_ONLY

8239 FLOAT Archive_Avg[40 - Average 40] 1 RD_ONLY

8240 FLOAT Archive_Avg[41 - Average 41] 1 RD_ONLY

8241 FLOAT Archive_Avg[42 - Average 42] 1 RD_ONLY

8242 FLOAT Archive_Avg[43 - Average 43] 1 RD_ONLY

8243 FLOAT Archive_Avg[44 - Average 44] 1 RD_ONLY

8244 FLOAT Archive_Avg[45 - Average 45] 1 RD_ONLY

8245 FLOAT Archive_Avg[46 - Average 46] 1 RD_ONLY

8246 FLOAT Archive_Avg[47 - Average 47] 1 RD_ONLY

8247 FLOAT Archive_Avg[48 - Average 48] 1 RD_ONLY

8248 FLOAT Archive_Avg[49 - Average 49] 1 RD_ONLY

8249 FLOAT Archive_Avg[50 - Average 50] 1 RD_ONLY

8250 FLOAT Archive_Avg[51 - Average 51] 1 RD_ONLY

8251 FLOAT Archive_Avg[52 - Average 52] 1 RD_ONLY

8252 FLOAT Archive_Avg[53 - Average 53] 1 RD_ONLY

8253 FLOAT Archive_Avg[54 - Average 54] 1 RD_ONLY

8254 FLOAT Archive_Avg[55 - Average 55] 1 RD_ONLY

8255 FLOAT Archive_Avg[56 - Average 56] 1 RD_ONLY

8256 FLOAT Archive_Avg[57 - Average 57] 1 RD_ONLY

8257 FLOAT Archive_Avg[58 - Average 58] 1 RD_ONLY

8258 FLOAT Archive_Avg[59 - Average 59] 1 RD_ONLY

8259 FLOAT Archive_Avg[60 - Average 60] 1 RD_ONLY

8260 FLOAT Archive_Avg[61 - Average 61] 1 RD_ONLY

8261 FLOAT Archive_Avg[62 - Average 62] 1 RD_ONLY

8262 FLOAT Archive_Avg[63 - Average 63] 1 RD_ONLY

8263 FLOAT Archive_Avg[64 - Average 64] 1 RD_ONLY

8264 FLOAT Archive_Avg[65 - Average 65] 1 RD_ONLY

8265 FLOAT Archive_Avg[66 - Average 66] 1 RD_ONLY

8266 FLOAT Archive_Avg[67 - Average 67] 1 RD_ONLY
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8267 FLOAT Archive_Avg[68 - Average 68] 1 RD_ONLY

8268 FLOAT Archive_Avg[69 - Average 69] 1 RD_ONLY

8269 FLOAT Archive_Avg[70 - Average 70] 1 RD_ONLY

8270 FLOAT Archive_Avg[71 - Average 71] 1 RD_ONLY

8271 FLOAT Archive_Avg[72 - Average 72] 1 RD_ONLY

8272 FLOAT Archive_Avg[73 - Average 73] 1 RD_ONLY

8273 FLOAT Archive_Avg[74 - Average 74] 1 RD_ONLY

8274 FLOAT Archive_Avg[75 - Average 75] 1 RD_ONLY

8275 FLOAT Archive_Avg[76 - Average 76] 1 RD_ONLY

8276 FLOAT Archive_Avg[77 - Average 77] 1 RD_ONLY

8277 FLOAT Archive_Avg[78 - Average 78] 1 RD_ONLY

8278 FLOAT Archive_Avg[79 - Average 79] 1 RD_ONLY

8279 FLOAT Archive_Avg[80 - Average 80] 1 RD_ONLY

8280 FLOAT Archive_Avg[81 - Average 81] 1 RD_ONLY

8281 FLOAT Archive_Avg[82 - Average 82] 1 RD_ONLY

8282 FLOAT Archive_Avg[83 - Average 83] 1 RD_ONLY

8283 FLOAT Archive_Avg[84 - Average 84] 1 RD_ONLY

8284 FLOAT Archive_Avg[85 - Average 85] 1 RD_ONLY

8285 FLOAT Archive_Avg[86 - Average 86] 1 RD_ONLY

8286 FLOAT Archive_Avg[87 - Average 87] 1 RD_ONLY

8287 FLOAT Archive_Avg[88 - Average 88] 1 RD_ONLY

8288 FLOAT Archive_Avg[89 - Average 89] 1 RD_ONLY

8289 FLOAT Archive_Avg[90 - Average 90] 1 RD_ONLY

8290 FLOAT Archive_Avg[91 - Average 91] 1 RD_ONLY

8291 FLOAT Archive_Avg[92 - Average 92] 1 RD_ONLY

8292 FLOAT Archive_Avg[93 - Average 93] 1 RD_ONLY

8293 FLOAT Archive_Avg[94 - Average 94] 1 RD_ONLY

8294 FLOAT Archive_Avg[95 - Average 95] 1 RD_ONLY

8295 FLOAT Archive_Avg[96 - Average 96] 1 RD_ONLY

8296 FLOAT Archive_Avg[97 - Average 97] 1 RD_ONLY

8297 FLOAT Archive_Avg[98 - Average 98] 1 RD_ONLY

8298 FLOAT Archive_Avg[99 - Average 99] 1 RD_ONLY

8299 FLOAT Archive_Avg[100 - Average 100] 1 RD_ONLY

8300 FLOAT Archive_Avg[101 - Average 101] 1 RD_ONLY
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8301 FLOAT Archive_Avg[102 - Average 102] 1 RD_ONLY

8302 FLOAT Archive_Avg[103 - Average 103] 1 RD_ONLY

8303 FLOAT Archive_Avg[104 - Average 104] 1 RD_ONLY

8304 FLOAT Archive_Avg[105 - Average 105] 1 RD_ONLY

8305 FLOAT Archive_Avg[106 - Average 106] 1 RD_ONLY

8306 FLOAT Archive_Avg[107 - Average 107] 1 RD_ONLY

8307 FLOAT Archive_Avg[108 - Average 108] 1 RD_ONLY

8308 FLOAT Archive_Avg[109 - Average 109] 1 RD_ONLY

8309 FLOAT Archive_Avg[110 - Average 110] 1 RD_ONLY

8310 FLOAT Archive_Avg[111 - Average 111] 1 RD_ONLY

8311 FLOAT Archive_Avg[112 - Average 112] 1 RD_ONLY

8312 FLOAT Archive_Avg[113 - Average 113] 1 RD_ONLY

8313 FLOAT Archive_Avg[114 - Average 114] 1 RD_ONLY

8314 FLOAT Archive_Avg[115 - Average 115] 1 RD_ONLY

8315 FLOAT Archive_Avg[116 - Average 116] 1 RD_ONLY

8316 FLOAT Archive_Avg[117 - Average 117] 1 RD_ONLY

8317 FLOAT Archive_Avg[118 - Average 118] 1 RD_ONLY

8318 FLOAT Archive_Avg[119 - Average 119] 1 RD_ONLY

8319 FLOAT Archive_Avg[120 - Average 120] 1 RD_ONLY

8320 FLOAT Archive_Avg[121 - Average 121] 1 RD_ONLY

8321 FLOAT Archive_Avg[122 - Average 122] 1 RD_ONLY

8322 FLOAT Archive_Avg[123 - Average 123] 1 RD_ONLY

8323 FLOAT Archive_Avg[124 - Average 124] 1 RD_ONLY

8324 FLOAT Archive_Avg[125 - Average 125] 1 RD_ONLY

8325 FLOAT Archive_Avg[126 - Average 126] 1 RD_ONLY

8326 FLOAT Archive_Avg[127 - Average 127] 1 RD_ONLY

8327 FLOAT Archive_Avg[128 - Average 128] 1 RD_ONLY

8328 FLOAT Archive_Avg[129 - Average 129] 1 RD_ONLY

8329 FLOAT Archive_Avg[130 - Average 130] 1 RD_ONLY

8330 FLOAT Archive_Avg[131 - Average 131] 1 RD_ONLY

8331 FLOAT Archive_Avg[132 - Average 132] 1 RD_ONLY

8332 FLOAT Archive_Avg[133 - Average 133] 1 RD_ONLY

8333 FLOAT Archive_Avg[134 - Average 134] 1 RD_ONLY

8334 FLOAT Archive_Avg[135 - Average 135] 1 RD_ONLY
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8335 FLOAT Archive_Avg[136 - Average 136] 1 RD_ONLY

8336 FLOAT Archive_Avg[137 - Average 137] 1 RD_ONLY

8337 FLOAT Archive_Avg[138 - Average 138] 1 RD_ONLY

8338 FLOAT Archive_Avg[139 - Average 139] 1 RD_ONLY

8339 FLOAT Archive_Avg[140 - Average 140] 1 RD_ONLY

8340 FLOAT Archive_Avg[141 - Average 141] 1 RD_ONLY

8341 FLOAT Archive_Avg[142 - Average 142] 1 RD_ONLY

8342 FLOAT Archive_Avg[143 - Average 143] 1 RD_ONLY

8343 FLOAT Archive_Avg[144 - Average 144] 1 RD_ONLY

8344 FLOAT Archive_Avg[145 - Average 145] 1 RD_ONLY

8345 FLOAT Archive_Avg[146 - Average 146] 1 RD_ONLY

8346 FLOAT Archive_Avg[147 - Average 147] 1 RD_ONLY

8347 FLOAT Archive_Avg[148 - Average 148] 1 RD_ONLY

8348 FLOAT Archive_Avg[149 - Average 149] 1 RD_ONLY

8349 FLOAT Archive_Avg[150 - Average 150] 1 RD_ONLY

8350 FLOAT Archive_Avg[151 - Average 151] 1 RD_ONLY

8351 FLOAT Archive_Avg[152 - Average 152] 1 RD_ONLY

8352 FLOAT Archive_Avg[153 - Average 153] 1 RD_ONLY

8353 FLOAT Archive_Avg[154 - Average 154] 1 RD_ONLY

8354 FLOAT Archive_Avg[155 - Average 155] 1 RD_ONLY

8355 FLOAT Archive_Avg[156 - Average 156] 1 RD_ONLY

8356 FLOAT Archive_Avg[157 - Average 157] 1 RD_ONLY

8357 FLOAT Archive_Avg[158 - Average 158] 1 RD_ONLY

8358 FLOAT Archive_Avg[159 - Average 159] 1 RD_ONLY

8359 FLOAT Archive_Avg[160 - Average 160] 1 RD_ONLY

8360 FLOAT Archive_Avg[161 - Average 161] 1 RD_ONLY

8361 FLOAT Archive_Avg[162 - Average 162] 1 RD_ONLY

8362 FLOAT Archive_Avg[163 - Average 163] 1 RD_ONLY

8363 FLOAT Archive_Avg[164 - Average 164] 1 RD_ONLY

8364 FLOAT Archive_Avg[165 - Average 165] 1 RD_ONLY

8365 FLOAT Archive_Avg[166 - Average 166] 1 RD_ONLY

8366 FLOAT Archive_Avg[167 - Average 167] 1 RD_ONLY

8367 FLOAT Archive_Avg[168 - Average 168] 1 RD_ONLY

8368 FLOAT Archive_Avg[169 - Average 169] 1 RD_ONLY
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8369 FLOAT Archive_Avg[170 - Average 170] 1 RD_ONLY

8370 FLOAT Archive_Avg[171 - Average 171] 1 RD_ONLY

8371 FLOAT Archive_Avg[172 - Average 172] 1 RD_ONLY

8372 FLOAT Archive_Avg[173 - Average 173] 1 RD_ONLY

8373 FLOAT Archive_Avg[174 - Average 174] 1 RD_ONLY

8374 FLOAT Archive_Avg[175 - Average 175] 1 RD_ONLY

8375 FLOAT Archive_Avg[176 - Average 176] 1 RD_ONLY

8376 FLOAT Archive_Avg[177 - Average 177] 1 RD_ONLY

8377 FLOAT Archive_Avg[178 - Average 178] 1 RD_ONLY

8378 FLOAT Archive_Avg[179 - Average 179] 1 RD_ONLY

8379 FLOAT Archive_Avg[180 - Average 180] 1 RD_ONLY

8380 FLOAT Archive_Avg[181 - Average 181] 1 RD_ONLY

8381 FLOAT Archive_Avg[182 - Average 182] 1 RD_ONLY

8382 FLOAT Archive_Avg[183 - Average 183] 1 RD_ONLY

8383 FLOAT Archive_Avg[184 - Average 184] 1 RD_ONLY

8384 FLOAT Archive_Avg[185 - Average 185] 1 RD_ONLY

8385 FLOAT Archive_Avg[186 - Average 186] 1 RD_ONLY

8386 FLOAT Archive_Avg[187 - Average 187] 1 RD_ONLY

8387 FLOAT Archive_Avg[188 - Average 188] 1 RD_ONLY

8388 FLOAT Archive_Avg[189 - Average 189] 1 RD_ONLY

8389 FLOAT Archive_Avg[190 - Average 190] 1 RD_ONLY

8390 FLOAT Archive_Avg[191 - Average 191] 1 RD_ONLY

8391 FLOAT Archive_Avg[192 - Average 192] 1 RD_ONLY

8392 FLOAT Archive_Avg[193 - Average 193] 1 RD_ONLY

8393 FLOAT Archive_Avg[194 - Average 194] 1 RD_ONLY

8394 FLOAT Archive_Avg[195 - Average 195] 1 RD_ONLY

8395 FLOAT Archive_Avg[196 - Average 196] 1 RD_ONLY

8396 FLOAT Archive_Avg[197 - Average 197] 1 RD_ONLY

8397 FLOAT Archive_Avg[198 - Average 198] 1 RD_ONLY

8398 FLOAT Archive_Avg[199 - Average 199] 1 RD_ONLY

8399 FLOAT Archive_Avg[200 - Average 200] 1 RD_ONLY

8400 FLOAT Archive_Avg[201 - Average 201] 1 RD_ONLY

8401 FLOAT Archive_Avg[202 - Average 202] 1 RD_ONLY

8402 FLOAT Archive_Avg[203 - Average 203] 1 RD_ONLY
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8403 FLOAT Archive_Avg[204 - Average 204] 1 RD_ONLY

8404 FLOAT Archive_Avg[205 - Average 205] 1 RD_ONLY

8405 FLOAT Archive_Avg[206 - Average 206] 1 RD_ONLY

8406 FLOAT Archive_Avg[207 - Average 207] 1 RD_ONLY

8407 FLOAT Archive_Avg[208 - Average 208] 1 RD_ONLY

8408 FLOAT Archive_Avg[209 - Average 209] 1 RD_ONLY

8409 FLOAT Archive_Avg[210 - Average 210] 1 RD_ONLY

8410 FLOAT Archive_Avg[211 - Average 211] 1 RD_ONLY

8411 FLOAT Archive_Avg[212 - Average 212] 1 RD_ONLY

8412 FLOAT Archive_Avg[213 - Average 213] 1 RD_ONLY

8413 FLOAT Archive_Avg[214 - Average 214] 1 RD_ONLY

8414 FLOAT Archive_Avg[215 - Average 215] 1 RD_ONLY

8415 FLOAT Archive_Avg[216 - Average 216] 1 RD_ONLY

8416 FLOAT Archive_Avg[217 - Average 217] 1 RD_ONLY

8417 FLOAT Archive_Avg[218 - Average 218] 1 RD_ONLY

8418 FLOAT Archive_Avg[219 - Average 219] 1 RD_ONLY

8419 FLOAT Archive_Avg[220 - Average 220] 1 RD_ONLY

8420 FLOAT Archive_Avg[221 - Average 221] 1 RD_ONLY

8421 FLOAT Archive_Avg[222 - Average 222] 1 RD_ONLY

8422 FLOAT Archive_Avg[223 - Average 223] 1 RD_ONLY

8423 FLOAT Archive_Avg[224 - Average 224] 1 RD_ONLY

8424 FLOAT Archive_Avg[225 - Average 225] 1 RD_ONLY

8425 FLOAT Archive_Avg[226 - Average 226] 1 RD_ONLY

8426 FLOAT Archive_Avg[227 - Average 227] 1 RD_ONLY

8427 FLOAT Archive_Avg[228 - Average 228] 1 RD_ONLY

8428 FLOAT Archive_Avg[229 - Average 229] 1 RD_ONLY

8429 FLOAT Archive_Avg[230 - Average 230] 1 RD_ONLY

8430 FLOAT Archive_Avg[231 - Average 231] 1 RD_ONLY

8431 FLOAT Archive_Avg[232 - Average 232] 1 RD_ONLY

8432 FLOAT Archive_Avg[233 - Average 233] 1 RD_ONLY

8433 FLOAT Archive_Avg[234 - Average 234] 1 RD_ONLY

8434 FLOAT Archive_Avg[235 - Average 235] 1 RD_ONLY

8435 FLOAT Archive_Avg[236 - Average 236] 1 RD_ONLY

8436 FLOAT Archive_Avg[237 - Average 237] 1 RD_ONLY
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8437 FLOAT Archive_Avg[238 - Average 238] 1 RD_ONLY

8438 FLOAT Archive_Avg[239 - Average 239] 1 RD_ONLY

8439 FLOAT Archive_Avg[240 - Average 240] 1 RD_ONLY

8440 FLOAT Archive_Avg[241 - Average 241] 1 RD_ONLY

8441 FLOAT Archive_Avg[242 - Average 242] 1 RD_ONLY

8442 FLOAT Archive_Avg[243 - Average 243] 1 RD_ONLY

8443 FLOAT Archive_Avg[244 - Average 244] 1 RD_ONLY

8444 FLOAT Archive_Avg[245 - Average 245] 1 RD_ONLY

8445 FLOAT Archive_Avg[246 - Average 246] 1 RD_ONLY

8446 FLOAT Archive_Avg[247 - Average 247] 1 RD_ONLY

8447 FLOAT Archive_Avg[248 - Average 248] 1 RD_ONLY

8448 FLOAT Archive_Avg[249 - Average 249] 1 RD_ONLY

8449 FLOAT Archive_Avg[250 - Average 250] 1 RD_ONLY

8450 FLOAT Unused RD_ONLY

8451 FLOAT Unused RD_ONLY

8452 FLOAT Unused RD_ONLY

8453 FLOAT Unused RD_ONLY

8454 FLOAT Archive_Max[1 - Average 1] 1 RD_ONLY

8455 FLOAT Archive_Max[2 - Average 2] 1 RD_ONLY

8456 FLOAT Archive_Max[3 - Average 3] 1 RD_ONLY

8457 FLOAT Archive_Max[4 - Average 4] 1 RD_ONLY

8458 FLOAT Archive_Max[5 - Average 5] 1 RD_ONLY

8459 FLOAT Archive_Max[6 - Average 6] 1 RD_ONLY

8460 FLOAT Archive_Max[7 - Average 7] 1 RD_ONLY

8461 FLOAT Archive_Max[8 - Average 8] 1 RD_ONLY

8462 FLOAT Archive_Max[9 - Average 9] 1 RD_ONLY

8463 FLOAT Archive_Max[10 - Average 10] 1 RD_ONLY

8464 FLOAT Archive_Max[11 - Average 11] 1 RD_ONLY

8465 FLOAT Archive_Max[12 - Average 12] 1 RD_ONLY

8466 FLOAT Archive_Max[13 - Average 13] 1 RD_ONLY

8467 FLOAT Archive_Max[14 - Average 14] 1 RD_ONLY

8468 FLOAT Archive_Max[15 - Average 15] 1 RD_ONLY

8469 FLOAT Archive_Max[16 - Average 16] 1 RD_ONLY

8470 FLOAT Archive_Max[17 - Average 17] 1 RD_ONLY
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8471 FLOAT Archive_Max[18 - Average 18] 1 RD_ONLY

8472 FLOAT Archive_Max[19 - Average 19] 1 RD_ONLY

8473 FLOAT Archive_Max[20 - Average 20] 1 RD_ONLY

8474 FLOAT Archive_Max[21 - Average 21] 1 RD_ONLY

8475 FLOAT Archive_Max[22 - Average 22] 1 RD_ONLY

8476 FLOAT Archive_Max[23 - Average 23] 1 RD_ONLY

8477 FLOAT Archive_Max[24 - Average 24] 1 RD_ONLY

8478 FLOAT Archive_Max[25 - Average 25] 1 RD_ONLY

8479 FLOAT Archive_Max[26 - Average 26] 1 RD_ONLY

8480 FLOAT Archive_Max[27 - Average 27] 1 RD_ONLY

8481 FLOAT Archive_Max[28 - Average 28] 1 RD_ONLY

8482 FLOAT Archive_Max[29 - Average 29] 1 RD_ONLY

8483 FLOAT Archive_Max[30 - Average 30] 1 RD_ONLY

8484 FLOAT Archive_Max[31 - Average 31] 1 RD_ONLY

8485 FLOAT Archive_Max[32 - Average 32] 1 RD_ONLY

8486 FLOAT Archive_Max[33 - Average 33] 1 RD_ONLY

8487 FLOAT Archive_Max[34 - Average 34] 1 RD_ONLY

8488 FLOAT Archive_Max[35 - Average 35] 1 RD_ONLY

8489 FLOAT Archive_Max[36 - Average 36] 1 RD_ONLY

8490 FLOAT Archive_Max[37 - Average 37] 1 RD_ONLY

8491 FLOAT Archive_Max[38 - Average 38] 1 RD_ONLY

8492 FLOAT Archive_Max[39 - Average 39] 1 RD_ONLY

8493 FLOAT Archive_Max[40 - Average 40] 1 RD_ONLY

8494 FLOAT Archive_Max[41 - Average 41] 1 RD_ONLY

8495 FLOAT Archive_Max[42 - Average 42] 1 RD_ONLY

8496 FLOAT Archive_Max[43 - Average 43] 1 RD_ONLY

8497 FLOAT Archive_Max[44 - Average 44] 1 RD_ONLY

8498 FLOAT Archive_Max[45 - Average 45] 1 RD_ONLY

8499 FLOAT Archive_Max[46 - Average 46] 1 RD_ONLY

8500 FLOAT Archive_Max[47 - Average 47] 1 RD_ONLY

8501 FLOAT Archive_Max[48 - Average 48] 1 RD_ONLY

8502 FLOAT Archive_Max[49 - Average 49] 1 RD_ONLY

8503 FLOAT Archive_Max[50 - Average 50] 1 RD_ONLY

8504 FLOAT Archive_Max[51 - Average 51] 1 RD_ONLY
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8505 FLOAT Archive_Max[52 - Average 52] 1 RD_ONLY

8506 FLOAT Archive_Max[53 - Average 53] 1 RD_ONLY

8507 FLOAT Archive_Max[54 - Average 54] 1 RD_ONLY

8508 FLOAT Archive_Max[55 - Average 55] 1 RD_ONLY

8509 FLOAT Archive_Max[56 - Average 56] 1 RD_ONLY

8510 FLOAT Archive_Max[57 - Average 57] 1 RD_ONLY

8511 FLOAT Archive_Max[58 - Average 58] 1 RD_ONLY

8512 FLOAT Archive_Max[59 - Average 59] 1 RD_ONLY

8513 FLOAT Archive_Max[60 - Average 60] 1 RD_ONLY

8514 FLOAT Archive_Max[61 - Average 61] 1 RD_ONLY

8515 FLOAT Archive_Max[62 - Average 62] 1 RD_ONLY

8516 FLOAT Archive_Max[63 - Average 63] 1 RD_ONLY

8517 FLOAT Archive_Max[64 - Average 64] 1 RD_ONLY

8518 FLOAT Archive_Max[65 - Average 65] 1 RD_ONLY

8519 FLOAT Archive_Max[66 - Average 66] 1 RD_ONLY

8520 FLOAT Archive_Max[67 - Average 67] 1 RD_ONLY

8521 FLOAT Archive_Max[68 - Average 68] 1 RD_ONLY

8522 FLOAT Archive_Max[69 - Average 69] 1 RD_ONLY

8523 FLOAT Archive_Max[70 - Average 70] 1 RD_ONLY

8524 FLOAT Archive_Max[71 - Average 71] 1 RD_ONLY

8525 FLOAT Archive_Max[72 - Average 72] 1 RD_ONLY

8526 FLOAT Archive_Max[73 - Average 73] 1 RD_ONLY

8527 FLOAT Archive_Max[74 - Average 74] 1 RD_ONLY

8528 FLOAT Archive_Max[75 - Average 75] 1 RD_ONLY

8529 FLOAT Archive_Max[76 - Average 76] 1 RD_ONLY

8530 FLOAT Archive_Max[77 - Average 77] 1 RD_ONLY

8531 FLOAT Archive_Max[78 - Average 78] 1 RD_ONLY

8532 FLOAT Archive_Max[79 - Average 79] 1 RD_ONLY

8533 FLOAT Archive_Max[80 - Average 80] 1 RD_ONLY

8534 FLOAT Archive_Max[81 - Average 81] 1 RD_ONLY

8535 FLOAT Archive_Max[82 - Average 82] 1 RD_ONLY

8536 FLOAT Archive_Max[83 - Average 83] 1 RD_ONLY

8537 FLOAT Archive_Max[84 - Average 84] 1 RD_ONLY

8538 FLOAT Archive_Max[85 - Average 85] 1 RD_ONLY
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8539 FLOAT Archive_Max[86 - Average 86] 1 RD_ONLY

8540 FLOAT Archive_Max[87 - Average 87] 1 RD_ONLY

8541 FLOAT Archive_Max[88 - Average 88] 1 RD_ONLY

8542 FLOAT Archive_Max[89 - Average 89] 1 RD_ONLY

8543 FLOAT Archive_Max[90 - Average 90] 1 RD_ONLY

8544 FLOAT Archive_Max[91 - Average 91] 1 RD_ONLY

8545 FLOAT Archive_Max[92 - Average 92] 1 RD_ONLY

8546 FLOAT Archive_Max[93 - Average 93] 1 RD_ONLY

8547 FLOAT Archive_Max[94 - Average 94] 1 RD_ONLY

8548 FLOAT Archive_Max[95 - Average 95] 1 RD_ONLY

8549 FLOAT Archive_Max[96 - Average 96] 1 RD_ONLY

8550 FLOAT Archive_Max[97 - Average 97] 1 RD_ONLY

8551 FLOAT Archive_Max[98 - Average 98] 1 RD_ONLY

8552 FLOAT Archive_Max[99 - Average 99] 1 RD_ONLY

8553 FLOAT Archive_Max[100 - Average 100] 1 RD_ONLY

8554 FLOAT Archive_Max[101 - Average 101] 1 RD_ONLY

8555 FLOAT Archive_Max[102 - Average 102] 1 RD_ONLY

8556 FLOAT Archive_Max[103 - Average 103] 1 RD_ONLY

8557 FLOAT Archive_Max[104 - Average 104] 1 RD_ONLY

8558 FLOAT Archive_Max[105 - Average 105] 1 RD_ONLY

8559 FLOAT Archive_Max[106 - Average 106] 1 RD_ONLY

8560 FLOAT Archive_Max[107 - Average 107] 1 RD_ONLY

8561 FLOAT Archive_Max[108 - Average 108] 1 RD_ONLY

8562 FLOAT Archive_Max[109 - Average 109] 1 RD_ONLY

8563 FLOAT Archive_Max[110 - Average 110] 1 RD_ONLY

8564 FLOAT Archive_Max[111 - Average 111] 1 RD_ONLY

8565 FLOAT Archive_Max[112 - Average 112] 1 RD_ONLY

8566 FLOAT Archive_Max[113 - Average 113] 1 RD_ONLY

8567 FLOAT Archive_Max[114 - Average 114] 1 RD_ONLY

8568 FLOAT Archive_Max[115 - Average 115] 1 RD_ONLY

8569 FLOAT Archive_Max[116 - Average 116] 1 RD_ONLY

8570 FLOAT Archive_Max[117 - Average 117] 1 RD_ONLY

8571 FLOAT Archive_Max[118 - Average 118] 1 RD_ONLY

8572 FLOAT Archive_Max[119 - Average 119] 1 RD_ONLY
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8573 FLOAT Archive_Max[120 - Average 120] 1 RD_ONLY

8574 FLOAT Archive_Max[121 - Average 121] 1 RD_ONLY

8575 FLOAT Archive_Max[122 - Average 122] 1 RD_ONLY

8576 FLOAT Archive_Max[123 - Average 123] 1 RD_ONLY

8577 FLOAT Archive_Max[124 - Average 124] 1 RD_ONLY

8578 FLOAT Archive_Max[125 - Average 125] 1 RD_ONLY

8579 FLOAT Archive_Max[126 - Average 126] 1 RD_ONLY

8580 FLOAT Archive_Max[127 - Average 127] 1 RD_ONLY

8581 FLOAT Archive_Max[128 - Average 128] 1 RD_ONLY

8582 FLOAT Archive_Max[129 - Average 129] 1 RD_ONLY

8583 FLOAT Archive_Max[130 - Average 130] 1 RD_ONLY

8584 FLOAT Archive_Max[131 - Average 131] 1 RD_ONLY

8585 FLOAT Archive_Max[132 - Average 132] 1 RD_ONLY

8586 FLOAT Archive_Max[133 - Average 133] 1 RD_ONLY

8587 FLOAT Archive_Max[134 - Average 134] 1 RD_ONLY

8588 FLOAT Archive_Max[135 - Average 135] 1 RD_ONLY

8589 FLOAT Archive_Max[136 - Average 136] 1 RD_ONLY

8590 FLOAT Archive_Max[137 - Average 137] 1 RD_ONLY

8591 FLOAT Archive_Max[138 - Average 138] 1 RD_ONLY

8592 FLOAT Archive_Max[139 - Average 139] 1 RD_ONLY

8593 FLOAT Archive_Max[140 - Average 140] 1 RD_ONLY

8594 FLOAT Archive_Max[141 - Average 141] 1 RD_ONLY

8595 FLOAT Archive_Max[142 - Average 142] 1 RD_ONLY

8596 FLOAT Archive_Max[143 - Average 143] 1 RD_ONLY

8597 FLOAT Archive_Max[144 - Average 144] 1 RD_ONLY

8598 FLOAT Archive_Max[145 - Average 145] 1 RD_ONLY

8599 FLOAT Archive_Max[146 - Average 146] 1 RD_ONLY

8600 FLOAT Archive_Max[147 - Average 147] 1 RD_ONLY

8601 FLOAT Archive_Max[148 - Average 148] 1 RD_ONLY

8602 FLOAT Archive_Max[149 - Average 149] 1 RD_ONLY

8603 FLOAT Archive_Max[150 - Average 150] 1 RD_ONLY

8604 FLOAT Archive_Max[151 - Average 151] 1 RD_ONLY

8605 FLOAT Archive_Max[152 - Average 152] 1 RD_ONLY

8606 FLOAT Archive_Max[153 - Average 153] 1 RD_ONLY
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8607 FLOAT Archive_Max[154 - Average 154] 1 RD_ONLY

8608 FLOAT Archive_Max[155 - Average 155] 1 RD_ONLY

8609 FLOAT Archive_Max[156 - Average 156] 1 RD_ONLY

8610 FLOAT Archive_Max[157 - Average 157] 1 RD_ONLY

8611 FLOAT Archive_Max[158 - Average 158] 1 RD_ONLY

8612 FLOAT Archive_Max[159 - Average 159] 1 RD_ONLY

8613 FLOAT Archive_Max[160 - Average 160] 1 RD_ONLY

8614 FLOAT Archive_Max[161 - Average 161] 1 RD_ONLY

8615 FLOAT Archive_Max[162 - Average 162] 1 RD_ONLY

8616 FLOAT Archive_Max[163 - Average 163] 1 RD_ONLY

8617 FLOAT Archive_Max[164 - Average 164] 1 RD_ONLY

8618 FLOAT Archive_Max[165 - Average 165] 1 RD_ONLY

8619 FLOAT Archive_Max[166 - Average 166] 1 RD_ONLY

8620 FLOAT Archive_Max[167 - Average 167] 1 RD_ONLY

8621 FLOAT Archive_Max[168 - Average 168] 1 RD_ONLY

8622 FLOAT Archive_Max[169 - Average 169] 1 RD_ONLY

8623 FLOAT Archive_Max[170 - Average 170] 1 RD_ONLY

8624 FLOAT Archive_Max[171 - Average 171] 1 RD_ONLY

8625 FLOAT Archive_Max[172 - Average 172] 1 RD_ONLY

8626 FLOAT Archive_Max[173 - Average 173] 1 RD_ONLY

8627 FLOAT Archive_Max[174 - Average 174] 1 RD_ONLY

8628 FLOAT Archive_Max[175 - Average 175] 1 RD_ONLY

8629 FLOAT Archive_Max[176 - Average 176] 1 RD_ONLY

8630 FLOAT Archive_Max[177 - Average 177] 1 RD_ONLY

8631 FLOAT Archive_Max[178 - Average 178] 1 RD_ONLY

8632 FLOAT Archive_Max[179 - Average 179] 1 RD_ONLY

8633 FLOAT Archive_Max[180 - Average 180] 1 RD_ONLY

8634 FLOAT Archive_Max[181 - Average 181] 1 RD_ONLY

8635 FLOAT Archive_Max[182 - Average 182] 1 RD_ONLY

8636 FLOAT Archive_Max[183 - Average 183] 1 RD_ONLY

8637 FLOAT Archive_Max[184 - Average 184] 1 RD_ONLY

8638 FLOAT Archive_Max[185 - Average 185] 1 RD_ONLY

8639 FLOAT Archive_Max[186 - Average 186] 1 RD_ONLY

8640 FLOAT Archive_Max[187 - Average 187] 1 RD_ONLY
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8641 FLOAT Archive_Max[188 - Average 188] 1 RD_ONLY

8642 FLOAT Archive_Max[189 - Average 189] 1 RD_ONLY

8643 FLOAT Archive_Max[190 - Average 190] 1 RD_ONLY

8644 FLOAT Archive_Max[191 - Average 191] 1 RD_ONLY

8645 FLOAT Archive_Max[192 - Average 192] 1 RD_ONLY

8646 FLOAT Archive_Max[193 - Average 193] 1 RD_ONLY

8647 FLOAT Archive_Max[194 - Average 194] 1 RD_ONLY

8648 FLOAT Archive_Max[195 - Average 195] 1 RD_ONLY

8649 FLOAT Archive_Max[196 - Average 196] 1 RD_ONLY

8650 FLOAT Archive_Max[197 - Average 197] 1 RD_ONLY

8651 FLOAT Archive_Max[198 - Average 198] 1 RD_ONLY

8652 FLOAT Archive_Max[199 - Average 199] 1 RD_ONLY

8653 FLOAT Archive_Max[200 - Average 200] 1 RD_ONLY

8654 FLOAT Archive_Max[201 - Average 201] 1 RD_ONLY

8655 FLOAT Archive_Max[202 - Average 202] 1 RD_ONLY

8656 FLOAT Archive_Max[203 - Average 203] 1 RD_ONLY

8657 FLOAT Archive_Max[204 - Average 204] 1 RD_ONLY

8658 FLOAT Archive_Max[205 - Average 205] 1 RD_ONLY

8659 FLOAT Archive_Max[206 - Average 206] 1 RD_ONLY

8660 FLOAT Archive_Max[207 - Average 207] 1 RD_ONLY

8661 FLOAT Archive_Max[208 - Average 208] 1 RD_ONLY

8662 FLOAT Archive_Max[209 - Average 209] 1 RD_ONLY

8663 FLOAT Archive_Max[210 - Average 210] 1 RD_ONLY

8664 FLOAT Archive_Max[211 - Average 211] 1 RD_ONLY

8665 FLOAT Archive_Max[212 - Average 212] 1 RD_ONLY

8666 FLOAT Archive_Max[213 - Average 213] 1 RD_ONLY

8667 FLOAT Archive_Max[214 - Average 214] 1 RD_ONLY

8668 FLOAT Archive_Max[215 - Average 215] 1 RD_ONLY

8669 FLOAT Archive_Max[216 - Average 216] 1 RD_ONLY

8670 FLOAT Archive_Max[217 - Average 217] 1 RD_ONLY

8671 FLOAT Archive_Max[218 - Average 218] 1 RD_ONLY

8672 FLOAT Archive_Max[219 - Average 219] 1 RD_ONLY

8673 FLOAT Archive_Max[220 - Average 220] 1 RD_ONLY

8674 FLOAT Archive_Max[221 - Average 221] 1 RD_ONLY
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8675 FLOAT Archive_Max[222 - Average 222] 1 RD_ONLY

8676 FLOAT Archive_Max[223 - Average 223] 1 RD_ONLY

8677 FLOAT Archive_Max[224 - Average 224] 1 RD_ONLY

8678 FLOAT Archive_Max[225 - Average 225] 1 RD_ONLY

8679 FLOAT Archive_Max[226 - Average 226] 1 RD_ONLY

8680 FLOAT Archive_Max[227 - Average 227] 1 RD_ONLY

8681 FLOAT Archive_Max[228 - Average 228] 1 RD_ONLY

8682 FLOAT Archive_Max[229 - Average 229] 1 RD_ONLY

8683 FLOAT Archive_Max[230 - Average 230] 1 RD_ONLY

8684 FLOAT Archive_Max[231 - Average 231] 1 RD_ONLY

8685 FLOAT Archive_Max[232 - Average 232] 1 RD_ONLY

8686 FLOAT Archive_Max[233 - Average 233] 1 RD_ONLY

8687 FLOAT Archive_Max[234 - Average 234] 1 RD_ONLY

8688 FLOAT Archive_Max[235 - Average 235] 1 RD_ONLY

8689 FLOAT Archive_Max[236 - Average 236] 1 RD_ONLY

8690 FLOAT Archive_Max[237 - Average 237] 1 RD_ONLY

8691 FLOAT Archive_Max[238 - Average 238] 1 RD_ONLY

8692 FLOAT Archive_Max[239 - Average 239] 1 RD_ONLY

8693 FLOAT Archive_Max[240 - Average 240] 1 RD_ONLY

8694 FLOAT Archive_Max[241 - Average 241] 1 RD_ONLY

8695 FLOAT Archive_Max[242 - Average 242] 1 RD_ONLY

8696 FLOAT Archive_Max[243 - Average 243] 1 RD_ONLY

8697 FLOAT Archive_Max[244 - Average 244] 1 RD_ONLY

8698 FLOAT Archive_Max[245 - Average 245] 1 RD_ONLY

8699 FLOAT Archive_Max[246 - Average 246] 1 RD_ONLY

8700 FLOAT Archive_Max[247 - Average 247] 1 RD_ONLY

8701 FLOAT Archive_Max[248 - Average 248] 1 RD_ONLY

8702 FLOAT Archive_Max[249 - Average 249] 1 RD_ONLY

8703 FLOAT Archive_Max[250 - Average 250] 1 RD_ONLY

8704 FLOAT Unused RD_ONLY

8705 FLOAT Unused RD_ONLY

8706 FLOAT Unused RD_ONLY

8707 FLOAT Unused RD_ONLY

8708 FLOAT Archive_Min[1 - Average 1] 1 RD_ONLY
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8709 FLOAT Archive_Min[2 - Average 2] 1 RD_ONLY

8710 FLOAT Archive_Min[3 - Average 3] 1 RD_ONLY

8711 FLOAT Archive_Min[4 - Average 4] 1 RD_ONLY

8712 FLOAT Archive_Min[5 - Average 5] 1 RD_ONLY

8713 FLOAT Archive_Min[6 - Average 6] 1 RD_ONLY

8714 FLOAT Archive_Min[7 - Average 7] 1 RD_ONLY

8715 FLOAT Archive_Min[8 - Average 8] 1 RD_ONLY

8716 FLOAT Archive_Min[9 - Average 9] 1 RD_ONLY

8717 FLOAT Archive_Min[10 - Average 10] 1 RD_ONLY

8718 FLOAT Archive_Min[11 - Average 11] 1 RD_ONLY

8719 FLOAT Archive_Min[12 - Average 12] 1 RD_ONLY

8720 FLOAT Archive_Min[13 - Average 13] 1 RD_ONLY

8721 FLOAT Archive_Min[14 - Average 14] 1 RD_ONLY

8722 FLOAT Archive_Min[15 - Average 15] 1 RD_ONLY

8723 FLOAT Archive_Min[16 - Average 16] 1 RD_ONLY

8724 FLOAT Archive_Min[17 - Average 17] 1 RD_ONLY

8725 FLOAT Archive_Min[18 - Average 18] 1 RD_ONLY

8726 FLOAT Archive_Min[19 - Average 19] 1 RD_ONLY

8727 FLOAT Archive_Min[20 - Average 20] 1 RD_ONLY

8728 FLOAT Archive_Min[21 - Average 21] 1 RD_ONLY

8729 FLOAT Archive_Min[22 - Average 22] 1 RD_ONLY

8730 FLOAT Archive_Min[23 - Average 23] 1 RD_ONLY

8731 FLOAT Archive_Min[24 - Average 24] 1 RD_ONLY

8732 FLOAT Archive_Min[25 - Average 25] 1 RD_ONLY

8733 FLOAT Archive_Min[26 - Average 26] 1 RD_ONLY

8734 FLOAT Archive_Min[27 - Average 27] 1 RD_ONLY

8735 FLOAT Archive_Min[28 - Average 28] 1 RD_ONLY

8736 FLOAT Archive_Min[29 - Average 29] 1 RD_ONLY

8737 FLOAT Archive_Min[30 - Average 30] 1 RD_ONLY

8738 FLOAT Archive_Min[31 - Average 31] 1 RD_ONLY

8739 FLOAT Archive_Min[32 - Average 32] 1 RD_ONLY

8740 FLOAT Archive_Min[33 - Average 33] 1 RD_ONLY

8741 FLOAT Archive_Min[34 - Average 34] 1 RD_ONLY

8742 FLOAT Archive_Min[35 - Average 35] 1 RD_ONLY
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8743 FLOAT Archive_Min[36 - Average 36] 1 RD_ONLY

8744 FLOAT Archive_Min[37 - Average 37] 1 RD_ONLY

8745 FLOAT Archive_Min[38 - Average 38] 1 RD_ONLY

8746 FLOAT Archive_Min[39 - Average 39] 1 RD_ONLY

8747 FLOAT Archive_Min[40 - Average 40] 1 RD_ONLY

8748 FLOAT Archive_Min[41 - Average 41] 1 RD_ONLY

8749 FLOAT Archive_Min[42 - Average 42] 1 RD_ONLY

8750 FLOAT Archive_Min[43 - Average 43] 1 RD_ONLY

8751 FLOAT Archive_Min[44 - Average 44] 1 RD_ONLY

8752 FLOAT Archive_Min[45 - Average 45] 1 RD_ONLY

8753 FLOAT Archive_Min[46 - Average 46] 1 RD_ONLY

8754 FLOAT Archive_Min[47 - Average 47] 1 RD_ONLY

8755 FLOAT Archive_Min[48 - Average 48] 1 RD_ONLY

8756 FLOAT Archive_Min[49 - Average 49] 1 RD_ONLY

8757 FLOAT Archive_Min[50 - Average 50] 1 RD_ONLY

8758 FLOAT Archive_Min[51 - Average 51] 1 RD_ONLY

8759 FLOAT Archive_Min[52 - Average 52] 1 RD_ONLY

8760 FLOAT Archive_Min[53 - Average 53] 1 RD_ONLY

8761 FLOAT Archive_Min[54 - Average 54] 1 RD_ONLY

8762 FLOAT Archive_Min[55 - Average 55] 1 RD_ONLY

8763 FLOAT Archive_Min[56 - Average 56] 1 RD_ONLY

8764 FLOAT Archive_Min[57 - Average 57] 1 RD_ONLY

8765 FLOAT Archive_Min[58 - Average 58] 1 RD_ONLY

8766 FLOAT Archive_Min[59 - Average 59] 1 RD_ONLY

8767 FLOAT Archive_Min[60 - Average 60] 1 RD_ONLY

8768 FLOAT Archive_Min[61 - Average 61] 1 RD_ONLY

8769 FLOAT Archive_Min[62 - Average 62] 1 RD_ONLY

8770 FLOAT Archive_Min[63 - Average 63] 1 RD_ONLY

8771 FLOAT Archive_Min[64 - Average 64] 1 RD_ONLY

8772 FLOAT Archive_Min[65 - Average 65] 1 RD_ONLY

8773 FLOAT Archive_Min[66 - Average 66] 1 RD_ONLY

8774 FLOAT Archive_Min[67 - Average 67] 1 RD_ONLY

8775 FLOAT Archive_Min[68 - Average 68] 1 RD_ONLY

8776 FLOAT Archive_Min[69 - Average 69] 1 RD_ONLY
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8777 FLOAT Archive_Min[70 - Average 70] 1 RD_ONLY

8778 FLOAT Archive_Min[71 - Average 71] 1 RD_ONLY

8779 FLOAT Archive_Min[72 - Average 72] 1 RD_ONLY

8780 FLOAT Archive_Min[73 - Average 73] 1 RD_ONLY

8781 FLOAT Archive_Min[74 - Average 74] 1 RD_ONLY

8782 FLOAT Archive_Min[75 - Average 75] 1 RD_ONLY

8783 FLOAT Archive_Min[76 - Average 76] 1 RD_ONLY

8784 FLOAT Archive_Min[77 - Average 77] 1 RD_ONLY

8785 FLOAT Archive_Min[78 - Average 78] 1 RD_ONLY

8786 FLOAT Archive_Min[79 - Average 79] 1 RD_ONLY

8787 FLOAT Archive_Min[80 - Average 80] 1 RD_ONLY

8788 FLOAT Archive_Min[81 - Average 81] 1 RD_ONLY

8789 FLOAT Archive_Min[82 - Average 82] 1 RD_ONLY

8790 FLOAT Archive_Min[83 - Average 83] 1 RD_ONLY

8791 FLOAT Archive_Min[84 - Average 84] 1 RD_ONLY

8792 FLOAT Archive_Min[85 - Average 85] 1 RD_ONLY

8793 FLOAT Archive_Min[86 - Average 86] 1 RD_ONLY

8794 FLOAT Archive_Min[87 - Average 87] 1 RD_ONLY

8795 FLOAT Archive_Min[88 - Average 88] 1 RD_ONLY

8796 FLOAT Archive_Min[89 - Average 89] 1 RD_ONLY

8797 FLOAT Archive_Min[90 - Average 90] 1 RD_ONLY

8798 FLOAT Archive_Min[91 - Average 91] 1 RD_ONLY

8799 FLOAT Archive_Min[92 - Average 92] 1 RD_ONLY

8800 FLOAT Archive_Min[93 - Average 93] 1 RD_ONLY

8801 FLOAT Archive_Min[94 - Average 94] 1 RD_ONLY

8802 FLOAT Archive_Min[95 - Average 95] 1 RD_ONLY

8803 FLOAT Archive_Min[96 - Average 96] 1 RD_ONLY

8804 FLOAT Archive_Min[97 - Average 97] 1 RD_ONLY

8805 FLOAT Archive_Min[98 - Average 98] 1 RD_ONLY

8806 FLOAT Archive_Min[99 - Average 99] 1 RD_ONLY

8807 FLOAT Archive_Min[100 - Average 100] 1 RD_ONLY

8808 FLOAT Archive_Min[101 - Average 101] 1 RD_ONLY

8809 FLOAT Archive_Min[102 - Average 102] 1 RD_ONLY

8810 FLOAT Archive_Min[103 - Average 103] 1 RD_ONLY
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8811 FLOAT Archive_Min[104 - Average 104] 1 RD_ONLY

8812 FLOAT Archive_Min[105 - Average 105] 1 RD_ONLY

8813 FLOAT Archive_Min[106 - Average 106] 1 RD_ONLY

8814 FLOAT Archive_Min[107 - Average 107] 1 RD_ONLY

8815 FLOAT Archive_Min[108 - Average 108] 1 RD_ONLY

8816 FLOAT Archive_Min[109 - Average 109] 1 RD_ONLY

8817 FLOAT Archive_Min[110 - Average 110] 1 RD_ONLY

8818 FLOAT Archive_Min[111 - Average 111] 1 RD_ONLY

8819 FLOAT Archive_Min[112 - Average 112] 1 RD_ONLY

8820 FLOAT Archive_Min[113 - Average 113] 1 RD_ONLY

8821 FLOAT Archive_Min[114 - Average 114] 1 RD_ONLY

8822 FLOAT Archive_Min[115 - Average 115] 1 RD_ONLY

8823 FLOAT Archive_Min[116 - Average 116] 1 RD_ONLY

8824 FLOAT Archive_Min[117 - Average 117] 1 RD_ONLY

8825 FLOAT Archive_Min[118 - Average 118] 1 RD_ONLY

8826 FLOAT Archive_Min[119 - Average 119] 1 RD_ONLY

8827 FLOAT Archive_Min[120 - Average 120] 1 RD_ONLY

8828 FLOAT Archive_Min[121 - Average 121] 1 RD_ONLY

8829 FLOAT Archive_Min[122 - Average 122] 1 RD_ONLY

8830 FLOAT Archive_Min[123 - Average 123] 1 RD_ONLY

8831 FLOAT Archive_Min[124 - Average 124] 1 RD_ONLY

8832 FLOAT Archive_Min[125 - Average 125] 1 RD_ONLY

8833 FLOAT Archive_Min[126 - Average 126] 1 RD_ONLY

8834 FLOAT Archive_Min[127 - Average 127] 1 RD_ONLY

8835 FLOAT Archive_Min[128 - Average 128] 1 RD_ONLY

8836 FLOAT Archive_Min[129 - Average 129] 1 RD_ONLY

8837 FLOAT Archive_Min[130 - Average 130] 1 RD_ONLY

8838 FLOAT Archive_Min[131 - Average 131] 1 RD_ONLY

8839 FLOAT Archive_Min[132 - Average 132] 1 RD_ONLY

8840 FLOAT Archive_Min[133 - Average 133] 1 RD_ONLY

8841 FLOAT Archive_Min[134 - Average 134] 1 RD_ONLY

8842 FLOAT Archive_Min[135 - Average 135] 1 RD_ONLY

8843 FLOAT Archive_Min[136 - Average 136] 1 RD_ONLY

8844 FLOAT Archive_Min[137 - Average 137] 1 RD_ONLY
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8845 FLOAT Archive_Min[138 - Average 138] 1 RD_ONLY

8846 FLOAT Archive_Min[139 - Average 139] 1 RD_ONLY

8847 FLOAT Archive_Min[140 - Average 140] 1 RD_ONLY

8848 FLOAT Archive_Min[141 - Average 141] 1 RD_ONLY

8849 FLOAT Archive_Min[142 - Average 142] 1 RD_ONLY

8850 FLOAT Archive_Min[143 - Average 143] 1 RD_ONLY

8851 FLOAT Archive_Min[144 - Average 144] 1 RD_ONLY

8852 FLOAT Archive_Min[145 - Average 145] 1 RD_ONLY

8853 FLOAT Archive_Min[146 - Average 146] 1 RD_ONLY

8854 FLOAT Archive_Min[147 - Average 147] 1 RD_ONLY

8855 FLOAT Archive_Min[148 - Average 148] 1 RD_ONLY

8856 FLOAT Archive_Min[149 - Average 149] 1 RD_ONLY

8857 FLOAT Archive_Min[150 - Average 150] 1 RD_ONLY

8858 FLOAT Archive_Min[151 - Average 151] 1 RD_ONLY

8859 FLOAT Archive_Min[152 - Average 152] 1 RD_ONLY

8860 FLOAT Archive_Min[153 - Average 153] 1 RD_ONLY

8861 FLOAT Archive_Min[154 - Average 154] 1 RD_ONLY

8862 FLOAT Archive_Min[155 - Average 155] 1 RD_ONLY

8863 FLOAT Archive_Min[156 - Average 156] 1 RD_ONLY

8864 FLOAT Archive_Min[157 - Average 157] 1 RD_ONLY

8865 FLOAT Archive_Min[158 - Average 158] 1 RD_ONLY

8866 FLOAT Archive_Min[159 - Average 159] 1 RD_ONLY

8867 FLOAT Archive_Min[160 - Average 160] 1 RD_ONLY

8868 FLOAT Archive_Min[161 - Average 161] 1 RD_ONLY

8869 FLOAT Archive_Min[162 - Average 162] 1 RD_ONLY

8870 FLOAT Archive_Min[163 - Average 163] 1 RD_ONLY

8871 FLOAT Archive_Min[164 - Average 164] 1 RD_ONLY

8872 FLOAT Archive_Min[165 - Average 165] 1 RD_ONLY

8873 FLOAT Archive_Min[166 - Average 166] 1 RD_ONLY

8874 FLOAT Archive_Min[167 - Average 167] 1 RD_ONLY

8875 FLOAT Archive_Min[168 - Average 168] 1 RD_ONLY

8876 FLOAT Archive_Min[169 - Average 169] 1 RD_ONLY

8877 FLOAT Archive_Min[170 - Average 170] 1 RD_ONLY

8878 FLOAT Archive_Min[171 - Average 171] 1 RD_ONLY
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8879 FLOAT Archive_Min[172 - Average 172] 1 RD_ONLY

8880 FLOAT Archive_Min[173 - Average 173] 1 RD_ONLY

8881 FLOAT Archive_Min[174 - Average 174] 1 RD_ONLY

8882 FLOAT Archive_Min[175 - Average 175] 1 RD_ONLY

8883 FLOAT Archive_Min[176 - Average 176] 1 RD_ONLY

8884 FLOAT Archive_Min[177 - Average 177] 1 RD_ONLY

8885 FLOAT Archive_Min[178 - Average 178] 1 RD_ONLY

8886 FLOAT Archive_Min[179 - Average 179] 1 RD_ONLY

8887 FLOAT Archive_Min[180 - Average 180] 1 RD_ONLY

8888 FLOAT Archive_Min[181 - Average 181] 1 RD_ONLY

8889 FLOAT Archive_Min[182 - Average 182] 1 RD_ONLY

8890 FLOAT Archive_Min[183 - Average 183] 1 RD_ONLY

8891 FLOAT Archive_Min[184 - Average 184] 1 RD_ONLY

8892 FLOAT Archive_Min[185 - Average 185] 1 RD_ONLY

8893 FLOAT Archive_Min[186 - Average 186] 1 RD_ONLY

8894 FLOAT Archive_Min[187 - Average 187] 1 RD_ONLY

8895 FLOAT Archive_Min[188 - Average 188] 1 RD_ONLY

8896 FLOAT Archive_Min[189 - Average 189] 1 RD_ONLY

8897 FLOAT Archive_Min[190 - Average 190] 1 RD_ONLY

8898 FLOAT Archive_Min[191 - Average 191] 1 RD_ONLY

8899 FLOAT Archive_Min[192 - Average 192] 1 RD_ONLY

8900 FLOAT Archive_Min[193 - Average 193] 1 RD_ONLY

8901 FLOAT Archive_Min[194 - Average 194] 1 RD_ONLY

8902 FLOAT Archive_Min[195 - Average 195] 1 RD_ONLY

8903 FLOAT Archive_Min[196 - Average 196] 1 RD_ONLY

8904 FLOAT Archive_Min[197 - Average 197] 1 RD_ONLY

8905 FLOAT Archive_Min[198 - Average 198] 1 RD_ONLY

8906 FLOAT Archive_Min[199 - Average 199] 1 RD_ONLY

8907 FLOAT Archive_Min[200 - Average 200] 1 RD_ONLY

8908 FLOAT Archive_Min[201 - Average 201] 1 RD_ONLY

8909 FLOAT Archive_Min[202 - Average 202] 1 RD_ONLY

8910 FLOAT Archive_Min[203 - Average 203] 1 RD_ONLY

8911 FLOAT Archive_Min[204 - Average 204] 1 RD_ONLY

8912 FLOAT Archive_Min[205 - Average 205] 1 RD_ONLY
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8913 FLOAT Archive_Min[206 - Average 206] 1 RD_ONLY

8914 FLOAT Archive_Min[207 - Average 207] 1 RD_ONLY

8915 FLOAT Archive_Min[208 - Average 208] 1 RD_ONLY

8916 FLOAT Archive_Min[209 - Average 209] 1 RD_ONLY

8917 FLOAT Archive_Min[210 - Average 210] 1 RD_ONLY

8918 FLOAT Archive_Min[211 - Average 211] 1 RD_ONLY

8919 FLOAT Archive_Min[212 - Average 212] 1 RD_ONLY

8920 FLOAT Archive_Min[213 - Average 213] 1 RD_ONLY

8921 FLOAT Archive_Min[214 - Average 214] 1 RD_ONLY

8922 FLOAT Archive_Min[215 - Average 215] 1 RD_ONLY

8923 FLOAT Archive_Min[216 - Average 216] 1 RD_ONLY

8924 FLOAT Archive_Min[217 - Average 217] 1 RD_ONLY

8925 FLOAT Archive_Min[218 - Average 218] 1 RD_ONLY

8926 FLOAT Archive_Min[219 - Average 219] 1 RD_ONLY

8927 FLOAT Archive_Min[220 - Average 220] 1 RD_ONLY

8928 FLOAT Archive_Min[221 - Average 221] 1 RD_ONLY

8929 FLOAT Archive_Min[222 - Average 222] 1 RD_ONLY

8930 FLOAT Archive_Min[223 - Average 223] 1 RD_ONLY

8931 FLOAT Archive_Min[224 - Average 224] 1 RD_ONLY

8932 FLOAT Archive_Min[225 - Average 225] 1 RD_ONLY

8933 FLOAT Archive_Min[226 - Average 226] 1 RD_ONLY

8934 FLOAT Archive_Min[227 - Average 227] 1 RD_ONLY

8935 FLOAT Archive_Min[228 - Average 228] 1 RD_ONLY

8936 FLOAT Archive_Min[229 - Average 229] 1 RD_ONLY

8937 FLOAT Archive_Min[230 - Average 230] 1 RD_ONLY

8938 FLOAT Archive_Min[231 - Average 231] 1 RD_ONLY

8939 FLOAT Archive_Min[232 - Average 232] 1 RD_ONLY

8940 FLOAT Archive_Min[233 - Average 233] 1 RD_ONLY

8941 FLOAT Archive_Min[234 - Average 234] 1 RD_ONLY

8942 FLOAT Archive_Min[235 - Average 235] 1 RD_ONLY

8943 FLOAT Archive_Min[236 - Average 236] 1 RD_ONLY

8944 FLOAT Archive_Min[237 - Average 237] 1 RD_ONLY

8945 FLOAT Archive_Min[238 - Average 238] 1 RD_ONLY

8946 FLOAT Archive_Min[239 - Average 239] 1 RD_ONLY

Pre-defined Modbus® Map Files Reference Manual
July 2020 2-3-9000-744

310 Emerson.com/Rosemount



Register # Data Type Variable Record # Access Format

8947 FLOAT Archive_Min[240 - Average 240] 1 RD_ONLY

8948 FLOAT Archive_Min[241 - Average 241] 1 RD_ONLY

8949 FLOAT Archive_Min[242 - Average 242] 1 RD_ONLY

8950 FLOAT Archive_Min[243 - Average 243] 1 RD_ONLY

8951 FLOAT Archive_Min[244 - Average 244] 1 RD_ONLY

8952 FLOAT Archive_Min[245 - Average 245] 1 RD_ONLY

8953 FLOAT Archive_Min[246 - Average 246] 1 RD_ONLY

8954 FLOAT Archive_Min[247 - Average 247] 1 RD_ONLY

8955 FLOAT Archive_Min[248 - Average 248] 1 RD_ONLY

8956 FLOAT Archive_Min[249 - Average 249] 1 RD_ONLY

8957 FLOAT Archive_Min[250 - Average 250] 1 RD_ONLY

8958 FLOAT Unused RD_ONLY

8959 FLOAT Unused RD_ONLY

8960 FLOAT Unused RD_ONLY

8961 FLOAT Unused RD_ONLY

8962 FLOAT Unused RD_ONLY

8963 FLOAT Clear All Alarms RD_WR

8964 FLOAT Acknowledge All Alarms RD_WR

9006 INT Current Time(time_t) RD_WR MM

9007 INT Current Time(time_t) RD_WR DD

9008 INT Current Time(time_t) RD_WR YYYY

9009 INT Current Time(time_t) RD_WR hh

9010 INT Current Time(time_t) RD_WR mm

9011 INT Current Time(time_t) RD_WR ss

9012 INT Unused RD_ONLY

9013 INT Modbus Id[1 - Port 0] RD_ONLY

9014 INT Site Id RD_WR

9022 INT Analysis Time RD_ONLY

9023 INT Unused RD_ONLY

9024 INT Cycle Time RD_ONLY

9025 INT Unused RD_ONLY

9026 INT Run Time RD_ONLY

9027 INT Unused RD_ONLY

9028 INT Current Stream RD_ONLY
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9029 INT Unused RD_ONLY

9030 INT GC Control_Analyser Control (Write Reg 9030) RD_WR

9031 INT Unused RD_ONLY

9032 INT GC Calibrating RD_ONLY

9033 INT Unused RD_ONLY

9034 INT Active Alarm Flag RD_ONLY

9035 INT UnAck Alarm Flag RD_ONLY

9036 INT Hourly Average Reset time RD_ONLY YY

9037 INT Hourly Average Reset time RD_ONLY MM

9038 INT Hourly Average Reset time RD_ONLY DD

9039 INT Hourly Average Reset time RD_ONLY hh

9040 INT Hourly Average Reset time RD_ONLY mm

9041 INT Daily Average Reset time RD_ONLY YY

9042 INT Daily Average Reset time RD_ONLY MM

9043 INT Daily Average Reset time RD_ONLY DD

9044 INT Daily Average Reset time RD_ONLY hh

9045 INT Daily Average Reset time RD_ONLY mm

9046 INT Weekly Average Reset time RD_ONLY YY

9047 INT Weekly Average Reset time RD_ONLY MM

9048 INT Weekly Average Reset time RD_ONLY DD

9049 INT Weekly Average Reset time RD_ONLY hh

9050 INT Weekly Average Reset time RD_ONLY mm

9051 INT Monthly Average Reset time RD_ONLY YY

9052 INT Monthly Average Reset time RD_ONLY MM

9053 INT Monthly Average Reset time RD_ONLY DD

9054 INT Monthly Average Reset time RD_ONLY hh

9055 INT Monthly Average Reset time RD_ONLY mm

9056 INT Variable Average Reset time RD_ONLY YY

9057 INT Variable Average Reset time RD_ONLY MM

9058 INT Variable Average Reset time RD_ONLY DD

9059 INT Variable Average Reset time RD_ONLY hh

9060 INT Variable Average Reset time RD_ONLY mm

3001..3016/3017..3032 (Component Code): Component Codes for components whose
mole % results are available in Registers 7001..7016.
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3033 (Run Time in 1/30th Sec): Current GC Run Time. If Run Time = 200 seconds, then
this register reads 6000.

3034 (Last Analy_Stream Number): Stream that was analyzed last.

3035 (Last Analy_CDT Stream Mask):

• Bit 0: Holds 1 if Stream 1 uses CDT1, 0 otherwise

• Bit 1: Holds 1 if Stream 2 uses CDT1, 0 otherwise

• Bit 2: Holds 1 if Stream 3 uses CDT1, 0 otherwise

• ...

• Bit 15: Holds 1 if Stream 16 uses CDT1, 0 otherwise

3036..3040 (Current GC Time): Holds the current GC Time. Can be written to update GC
date/time.

3041..3045 (Last Analy_Start Time): Sample inject time for the stream that was analyzed
last.

3046..3047 (Alarm Bitmaps): Boolean alarm conditions. 1 – Alarm Active, 0 – Alarm
Inactive.

3046 Bit 14 (Analyzer Failure): This bit is set to 1 if any of the Carrier Pressure/Low
Pressure Limit Switch alarms are active.

3048 (Stream 1 Active Low Limit Alarms):

• Bit 0: Holds 1 if, User Limit Alarm 1 is associated with Stream 1 and if a Low Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 1 is not
associated with Stream 1 or no Low Limit alarm condition exists.

• Bit 1: Holds 1 if, User Limit Alarm 2 is associated with Stream 1 and if a Low Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 2 is not
associated with Stream 1 or no Low Limit alarm condition exists.

• ...

• Bit 15: Holds 1 if, User Limit Alarm 16 is associated with Stream 1 and if a Low Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 16 is not
associated with Stream 1 or no Low Limit alarm condition exists.

3049 (Stream 1 Active High Limit Alarms):

• Bit 0: Holds 1 if, User Limit Alarm 1 is associated with Stream 1 and if a High Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 1 is not
associated with Stream 1 or no High Limit alarm condition exists.

• Bit 1: Holds 1 if, User Limit Alarm 2 is associated with Stream 1 and if a High Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 2 is not
associated with Stream 1 or no High Limit alarm condition exists.

• ...

• Bit 15: Holds 1 if, User Limit Alarm 16 is associated with Stream 1 and if a High Limit
condition is currently active. This bit holds 0 if either User Limit Alarm 16 is not
associated with Stream 1 or no High Limit alarm condition exists.
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3050 .. 3057 (Stream 2..5 Active High/Low Limit Alarms): These registers hold limit
alarm status for Streams 2 through 5. The implementation of these registers is similar to
the Stream 1 Active Low/High Alarms (Registers 3048/3049).

3058 (New Data Flag): This flag is set to 1 when new data is available in the Last Analysis
Results registers. This is a read-write register, so a Modbus Master can clear the flag once
the new results are read.

3059 (Anly/Calib Flag): This flag is set to 1 to indicate the last analysis results were from
an Analysis run. This flag is set to 0 to indicate the last analysis results were from a
Calibration run. A Modbus Master can use Registers 3058 and 3059 to determine when
new analysis results are available on the GC.

5001 (Last Analy_Cycle Time (1/30th sec)): Cycle time for last analysis in 1/30th seconds.
For example, if cycle time is 300 seconds, this register reads 9000.

5002 (Last Cal_Cycle Time (1/30th sec)): Cycle time for last calibration run in 1/30th
seconds. For example, if cycle time is 300 seconds, this register reads 9000.

7001..7016 (Last Analy Mole %): These registers hold the mole % Results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001..3016 which contain the component codes.

7017..7032 (Last Analy Weight %): These registers hold the weight % results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001..3016 which contain the component codes.

7033..7039, 7054: Last analysis stream results

7040..7044: User calculation results 1..5

7055..7069: Current running average for Averages 1 through 15

7070..7084: Most recent archive average for Averages 1 through 15

7085..7086: Current analog input values for Analog Input 1 and 2

7087..7094: Last Calibration Stream Results

7095..7110/7111..7126: Response factors used for last analysis run

7127..7162: Current running average for Averages 1 through 36

7163..7198: Maximum sample value during current averaging period for Averages 1
through 36

7199..7234: Minimum sample value during current averaging period for Averages 1
through 36

7235..7270: Most recent archived average for Averages 1 through 36

7271..7306: Maximum sample value in the most recent archived average for Averages 1
through 36.

7307..7342: Minimum sample value in the most recent archived average for Averages 1
through 36.

7343..7378: Second most recent archived average for Averages 1 through 36
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7379..7414: Maximum sample value in the second most recent archived average for
Averages 1 through 36.

7415..7450: Minimum sample value in the second most recent archived average for
Averages 1 through 36.

7451..7486: Third most recent archived average for Averages 1 through 36

7487..7522: Maximum sample value in the third most recent archived average for
Averages 1 through 36.

7523..7558: Minimum sample value in the third most recent archived average for
Averages 1 through 36.

7560..7563/7564..7567: Analog Input Current Value for AI 1 through 4.

7621..7646: Stream 1 results

7651..7676: Stream 2 results

7681..7706: Stream 3 results

7711..7736: Stream 4 results

7741..7766: Stream 5 results

7771..7796: Stream 6 results

7801..7826: Stream 7 results

7831..7856: Stream 8 results

7861..7886: Stream 9 results

7891..7916: Stream 10 results

7921..7946: Stream 11 results

7951..7976: Stream 12 results

7996..8006: Remote control registers

8200..8449: Most recent archived average for Averages 1 through 250.

8454..8703: Maximum sample value in the most recent archived average for Averages 1
through 250.

8708..8957: Minimum sample value in the most recent archived average for Averages 1
through 250.

8963 (Clear All Alarms): Write 1 to this register to clear all active alarms.

8964 (Acknowledge All Alarms): Write 1 to this register to acknowledge all alarms.

9006..9011: GC System Date/Time Read/Write Registers.

9013 (Modbus Id[ Port 0]): Modbus ID for Serial Port 0.

9014 (Site ID): GC Site ID read/write register.

9022 (Analysis Time): Analysis time

9024 (Cycle Time): Cycle time
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9026 (Run Time): Run rime

9028 (Current Stream): Stream number

9030 (Analyzer Control): Read-write remote control register (9030)

9032 (GC Calibrating): Tells you if the GC is calibrating. A value of 1 means GC is
calibrating, 0 otherwise.

9034 (Active Alarm Flag): Tells you if the GC has any active alarms. A value of 1 indicates
that there are active alarms, 0 otherwise.

9035 (UnAck Alarm Flag): Tells you if the GC has any unacknowledged alarms. A value of
1 indicates that there are unacknowledged alarms, 0 otherwise.

9036..9040 (Hourly Average Reset Time): Date/time when hourly average results were
archived.

9041..9045 (Daily Average Reset Time): Date/time when daily average results were
archived.

9046..9047 (Weekly Average Reset Time): Date/time when weekly average results were
archived.

9051..9055 (Monthly Average Reset Time): Date/time when monthly average results
were archived.

9056..9060 (Variable Average Reset Time): Date/time when variable average results
were archived.
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F.3 SIM_2251 C9 + Hydrocarbon Dew point map
This map file is an extension of the SIM2251 map file with the following additional
registers.

Register # Data type Variable Access

3101 INT 1 - Stream 1_Dew Status 1 RD_ONLY

3102 INT 1 - Stream 1_Dew Status 2 RD_ONLY

3103 INT 1 - Stream 1_Dew Status 3 RD_ONLY

3104 INT 1 - Stream 1_Dew Status 4 RD_ONLY

3105 INT 1 - Stream 1_Cri Status RD_ONLY

3106 INT 2 - Calibration_Dew Status 1 RD_ONLY

3107 INT 2 - Calibration_Dew Status 2 RD_ONLY

3108 INT 2 - Calibration_Dew Status 3 RD_ONLY

3109 INT 2 - Calibration_Dew Status 4 RD_ONLY

3110 INT 2 - Calibration_Cri Status RD_ONLY

3111 INT 3 - Stream 3_Dew Status 1 RD_ONLY

3112 INT 3 - Stream 3_Dew Status 2 RD_ONLY

3113 INT 3 - Stream 3_Dew Status 3 RD_ONLY

3114 INT 3 - Stream 3_Dew Status 4 RD_ONLY

3115 INT 3 - Stream 3_Cri Status RD_ONLY

3116 INT 4 - Stream 4_Dew Status 1 RD_ONLY

3117 INT 4 - Stream 4_Dew Status 2 RD_ONLY

3118 INT 4 - Stream 4_Dew Status 3 RD_ONLY

3119 INT 4 - Stream 4_Dew Status 4 RD_ONLY

3120 INT 4 - Stream 4_Cri Status RD_ONLY

3121 INT 5 - Stream 5_Dew Status 1 RD_ONLY

3122 INT 5 - Stream 5_Dew Status 2 RD_ONLY

3123 INT 5 - Stream 5_Dew Status 3 RD_ONLY

3124 INT 5 - Stream 5_Dew Status 4 RD_ONLY

3125 INT 5 - Stream 5_Cri Status RD_ONLY

3126 INT 6 - Stream 6_Dew Status 1 RD_ONLY

3127 INT 6 - Stream 6_Dew Status 2 RD_ONLY

3128 INT 6 - Stream 6_Dew Status 3 RD_ONLY

3129 INT 6 - Stream 6_Dew Status 4 RD_ONLY

3130 INT 6 - Stream 6_Cri Status RD_ONLY

3131 INT 7 - Stream 7_Dew Status 1 RD_ONLY
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Register # Data type Variable Access

3132 INT 7 - Stream 7_Dew Status 2 RD_ONLY

3133 INT 7 - Stream 7_Dew Status 3 RD_ONLY

3134 INT 7 - Stream 7_Dew Status 4 RD_ONLY

3135 INT 7 - Stream 7_Cri Status RD_ONLY

3136 INT 8 - Stream 8_Dew Status 1 RD_ONLY

3137 INT 8 - Stream 8_Dew Status 2 RD_ONLY

3138 INT 8 - Stream 8_Dew Status 3 RD_ONLY

3139 INT 8 - Stream 8_Dew Status 4 RD_ONLY

3140 INT 8 - Stream 8_Cri Status RD_ONLY

8100 FLOAT Dew point Configuration 1_Pressure 1 RD_WR

8101 FLOAT Dew point Configuration 1_Pressure 2 RD_WR

8102 FLOAT Dew point Configuration 1_Pressure 3 RD_WR

8103 FLOAT Dew point Configuration 1_Pressure 4 RD_WR

8104 FLOAT Dewpoint Configuration 2_Pressure 1 RD_WR

8105 FLOAT Dew point Configuration 2_Pressure 2 RD_WR

8106 FLOAT Dew point Configuration 3_Pressure 1 RD_WR

8107 FLOAT Dew point Configuration 3_Pressure 2 RD_WR

8108 FLOAT Dew point Configuration 4_Pressure 1 RD_WR

8109 FLOAT Dew point Configuration 4_Pressure 2 RD_WR

8110 FLOAT 1 - Stream 1_Dewpoint Temp 1 RD_ONLY

8111 FLOAT 1 - Stream 1_Dewpoint Temp 2 RD_ONLY

8112 FLOAT 1 - Stream 1_Dewpoint Temp 3 RD_ONLY

8113 FLOAT 1 - Stream 1_Dewpoint Temp 4 RD_ONLY

8114 FLOAT 1 - Stream 1_Dewpoint Pres 1 RD_ONLY

8115 FLOAT 1 - Stream 1_Dewpoint Pres 2 RD_ONLY

8116 FLOAT 1 - Stream 1_Dewpoint Pres 3 RD_ONLY

8117 FLOAT 1 - Stream 1_Dewpoint Pres 4 RD_ONLY

8118 FLOAT 1 - Stream 1_CricondenTherm Temp RD_ONLY

8119 FLOAT 1 - Stream 1_CricondenTherm Pres RD_ONLY

8120 FLOAT 2 - Calibration_Dewpoint Temp 1 RD_ONLY

8121 FLOAT 2 - Calibration_Dewpoint Temp 2 RD_ONLY

8122 FLOAT 2 - Calibration_Dewpoint Temp 3 RD_ONLY

8123 FLOAT 2 - Calibration_Dewpoint Temp 4 RD_ONLY

8124 FLOAT 2 - Calibration_Dewpoint Pres 1 RD_ONLY
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Register # Data type Variable Access

8125 FLOAT 2 - Calibration_Dewpoint Pres 2 RD_ONLY

8126 FLOAT 2 - Calibration_Dewpoint Pres 3 RD_ONLY

8127 FLOAT 2 - Calibration_Dewpoint Pres 4 RD_ONLY

8128 FLOAT 2 - Calibration_CricondenTherm Temp RD_ONLY

8129 FLOAT 2 - Calibration_CricondenTherm Pres RD_ONLY

8130 FLOAT 3 - Stream 3_Dewpoint Temp 1 RD_ONLY

8131 FLOAT 3 - Stream 3_Dewpoint Temp 2 RD_ONLY

8132 FLOAT 3 - Stream 3_Dewpoint Temp 3 RD_ONLY

8133 FLOAT 3 - Stream 3_Dewpoint Temp 4 RD_ONLY

8134 FLOAT 3 - Stream 3_Dewpoint Pres 1 RD_ONLY

8135 FLOAT 3 - Stream 3_Dewpoint Pres 2 RD_ONLY

8136 FLOAT 3 - Stream 3_Dewpoint Pres 3 RD_ONLY

8137 FLOAT 3 - Stream 3_Dewpoint Pres 4 RD_ONLY

8138 FLOAT 3 - Stream 3_CricondenTherm Temp RD_ONLY

8139 FLOAT 3 - Stream 3_CricondenTherm Pres RD_ONLY

8140 FLOAT 4 - Stream 4_Dewpoint Temp 1 RD_ONLY

8141 FLOAT 4 - Stream 4_Dewpoint Temp 2 RD_ONLY

8142 FLOAT 4 - Stream 4_Dewpoint Temp 3 RD_ONLY

8143 FLOAT 4 - Stream 4_Dewpoint Temp 4 RD_ONLY

8144 FLOAT 4 - Stream 4_Dewpoint Pres 1 RD_ONLY

8145 FLOAT 4 - Stream 4_Dewpoint Pres 2 RD_ONLY

8146 FLOAT 4 - Stream 4_Dewpoint Pres 3 RD_ONLY

8147 FLOAT 4 - Stream 4_Dewpoint Pres 4 RD_ONLY

8148 FLOAT 4 - Stream 4_CricondenTherm Temp RD_ONLY

8149 FLOAT 4 - Stream 4_CricondenTherm Pres RD_ONLY

8150 FLOAT 5 - Stream 5_Dewpoint Temp 1 RD_ONLY

8151 FLOAT 5 - Stream 5_Dewpoint Temp 2 RD_ONLY

8152 FLOAT 5 - Stream 5_Dewpoint Temp 3 RD_ONLY

8153 FLOAT 5 - Stream 5_Dewpoint Temp 4 RD_ONLY

8154 FLOAT 5 - Stream 5_Dewpoint Pres 1 RD_ONLY

8155 FLOAT 5 - Stream 5_Dewpoint Pres 2 RD_ONLY

8156 FLOAT 5 - Stream 5_Dewpoint Pres 3 RD_ONLY

8157 FLOAT 5 - Stream 5_Dewpoint Pres 4 RD_ONLY

8158 FLOAT 5 - Stream 5_CricondenTherm Temp RD_ONLY
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Register # Data type Variable Access

8159 FLOAT 5 - Stream 5_CricondenTherm Pres RD_ONLY

8160 FLOAT 6 - Stream 6_Dewpoint Temp 1 RD_ONLY

8161 FLOAT 6 - Stream 6_Dewpoint Temp 2 RD_ONLY

8162 FLOAT 6 - Stream 6_Dewpoint Temp 3 RD_ONLY

8163 FLOAT 6 - Stream 6_Dewpoint Temp 4 RD_ONLY

8164 FLOAT 6 - Stream 6_Dewpoint Pres 1 RD_ONLY

8165 FLOAT 6 - Stream 6_Dewpoint Pres 2 RD_ONLY

8166 FLOAT 6 - Stream 6_Dewpoint Pres 3 RD_ONLY

8167 FLOAT 6 - Stream 6_Dewpoint Pres 4 RD_ONLY

8168 FLOAT 6 - Stream 6_CricondenTherm Temp RD_ONLY

8169 FLOAT 6 - Stream 6_CricondenTherm Pres RD_ONLY

8170 FLOAT 7 - Stream 7_Dewpoint Temp 1 RD_ONLY

8171 FLOAT 7 - Stream 7_Dewpoint Temp 2 RD_ONLY

8172 FLOAT 7 - Stream 7_Dewpoint Temp 3 RD_ONLY

8173 FLOAT 7 - Stream 7_Dewpoint Temp 4 RD_ONLY

8174 FLOAT 7 - Stream 7_Dewpoint Pres 1 RD_ONLY

8175 FLOAT 7 - Stream 7_Dewpoint Pres 2 RD_ONLY

8176 FLOAT 7 - Stream 7_Dewpoint Pres 3 RD_ONLY

8177 FLOAT 7 - Stream 7_Dewpoint Pres 4 RD_ONLY

8178 FLOAT 7 - Stream 7_CricondenTherm Temp RD_ONLY

8179 FLOAT 7 - Stream 7_CricondenTherm Pres RD_ONLY

8180 FLOAT 8 - Stream 8_Dewpoint Temp 1 RD_ONLY

8181 FLOAT 8 - Stream 8_Dewpoint Temp 2 RD_ONLY

8182 FLOAT 8 - Stream 8_Dewpoint Temp 3 RD_ONLY

8183 FLOAT 8 - Stream 8_Dewpoint Temp 4 RD_ONLY

8184 FLOAT 8 - Stream 8_Dewpoint Pres 1 RD_ONLY

8185 FLOAT 8 - Stream 8_Dewpoint Pres 2 RD_ONLY

8186 FLOAT 8 - Stream 8_Dewpoint Pres 3 RD_ONLY

8187 FLOAT 8 - Stream 8_Dewpoint Pres 4 RD_ONLY

8188 FLOAT 8 - Stream 8_CricondenTherm Temp RD_ONLY

8189 FLOAT 8 - Stream 8_CricondenTherm Pres RD_ONLY
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3101...3140 (Dew point status): Dew point calculation status for Streams 1 to 8 (read
only). Here are the possible values for these registers and their descriptions.

8100...8109 (Dew point pressure setpoints): Pressure setpoints at which dewpoint
calculation results are performed (read-write). The setpoint can be changed through a
Modbus Master.

8110...8189 (Dew point results): Dew point temperature and pressure, cricondentherm
temperature and pressure.

Value Description Remarks

0 OK Calculation is valid

1 Error 1 No valid solution to gas equation found

2 Error 2 Mole% values are all zero – if analysis is OK check Numeric data

3 Error 3 Calculated fugacities too large – probably unrealistic composition

4 Error 4 Single phase – no liquid phase at this pressure

5 Error 5 Pressure value (from operator or Modbus) is negative

6 Error 6 (Cricondentherm only) – no maximum found – next analysis
normally OK

7 Error 7 Single phase – no gas phase at this pressure

F.4 User Modbus mapping template
Register # Data type Variable Access Format

1 BOOLEAN Unused RD_ONLY

2 BOOLEAN Unused RD_ONLY

3 BOOLEAN Unused RD_ONLY

4 BOOLEAN Unused RD_ONLY

5 BOOLEAN Unused RD_ONLY

6 BOOLEAN Unused RD_ONLY

7 BOOLEAN Unused RD_ONLY

8 BOOLEAN Unused RD_ONLY

9 BOOLEAN Unused RD_ONLY

10 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 1 Out
Of Range

RD_ONLY

11 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 2 Out
Of Range

RD_ONLY

12 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 3 Out
Of Range

RD_ONLY

13 BOOLEAN System Alarm_Alarm On - Current Analysis_Heater 4 Out
Of Range

RD_ONLY
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Register # Data type Variable Access Format

14 BOOLEAN Unused RD_ONLY

15 BOOLEAN Unused RD_ONLY

16 BOOLEAN System Alarm_Alarm On - Current Analysis_Flame Out RD_ONLY

17 BOOLEAN System Alarm_Alarm On - Current Analysis_Warm Start
Failed

RD_ONLY

18 BOOLEAN Unused RD_ONLY

19 BOOLEAN Calibration Failed RD_ONLY

20 BOOLEAN System Alarm_Alarm On - Current Analysis_Low Carrier
Pressure 1

RD_ONLY

21 BOOLEAN System Alarm_Alarm On - Current Analysis_Low Carrier
Pressure 2

RD_ONLY

22 BOOLEAN System Alarm_Alarm On - Current Analysis_No Sample
Flow 1

RD_ONLY

23 BOOLEAN System Alarm_Alarm On - Current Analysis_No Sample
Flow 2

RD_ONLY

24 BOOLEAN System Alarm_Alarm On - Current Analysis_Maintenance
Mode

RD_ONLY

25 BOOLEAN Calibration Failed RD_ONLY

26 BOOLEAN Unused RD_ONLY

27 BOOLEAN Unused RD_ONLY

28 BOOLEAN Unused RD_ONLY

29 BOOLEAN Unused RD_ONLY

30 BOOLEAN Unused RD_ONLY

31 BOOLEAN System Alarm_Alarm On - Current Analysis_Detector 1
Scaling Factor Failure

RD_ONLY

32 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
1 High Signal

RD_ONLY

33 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
2 High Signal

RD_ONLY

34 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
3 High Signal

RD_ONLY

35 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
4 High Signal

RD_ONLY

36 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
5 High Signal

RD_ONLY

37 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
6 High Signal

RD_ONLY

38 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
7 High Signal

RD_ONLY
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Register # Data type Variable Access Format

39 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
8 High Signal

RD_ONLY

40 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
9 High Signal

RD_ONLY

41 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
10 High Signal

RD_ONLY

42 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
11 High Signal

RD_ONLY

43 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
12 High Signal

RD_ONLY

44 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
13 High Signal

RD_ONLY

45 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
14 High Signal

RD_ONLY

46 BOOLEAN Unused RD_ONLY

47 BOOLEAN Unused RD_ONLY

48 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
1 Low Signal

RD_ONLY

49 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
2 Low Signal

RD_ONLY

50 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
3 Low Signal

RD_ONLY

51 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
4 Low Signal

RD_ONLY

52 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
5 Low Signal

RD_ONLY

53 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
6 Low Signal

RD_ONLY

54 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
7 Low Signal

RD_ONLY

55 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
8 Low Signal

RD_ONLY

56 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
9 Low Signal

RD_ONLY

57 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
10 Low Signal

RD_ONLY

58 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
11 Low Signal

RD_ONLY

59 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
12 Low Signal

RD_ONLY

60 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
13 Low Signal

RD_ONLY
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Register # Data type Variable Access Format

61 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Output
14 Low Signal

RD_ONLY

62 BOOLEAN Unused RD_ONLY

63 BOOLEAN Unused RD_ONLY

64 BOOLEAN Analyzer Failure RD_ONLY

65 BOOLEAN System Alarm_Alarm On - Current Analysis_Power Failure RD_ONLY

66 BOOLEAN Unused RD_ONLY

67 BOOLEAN System Alarm_Alarm On - Current Analysis_Low Battery
Voltage

RD_ONLY

68 BOOLEAN System Alarm_Alarm On - Current Analysis_GC Idle RD_ONLY

69 BOOLEAN Unused RD_ONLY

70 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 1
High Signal

RD_ONLY

71 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 2
High Signal

RD_ONLY

72 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 3
High Signal

RD_ONLY

73 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 4
High Signal

RD_ONLY

74 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 1
Low Signal

RD_ONLY

75 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 2
Low Signal

RD_ONLY

76 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 3
Low Signal

RD_ONLY

77 BOOLEAN System Alarm_Alarm On - Current Analysis_Analog Input 4
Low Signal

RD_ONLY

78 BOOLEAN Unused RD_ONLY

79 BOOLEAN Unused RD_ONLY

80 BOOLEAN Unused RD_ONLY

81 BOOLEAN Unused RD_ONLY

82 BOOLEAN Unused RD_ONLY

83 BOOLEAN Unused RD_ONLY

84 BOOLEAN Unused RD_ONLY

85 BOOLEAN Alarm On[1 - Alarm 1] RD_ONLY

86 BOOLEAN Alarm On[2 - Alarm 2] RD_ONLY

87 BOOLEAN Alarm On[3 - Alarm 3] RD_ONLY

88 BOOLEAN Alarm On[4 - Alarm 4] RD_ONLY
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Register # Data type Variable Access Format

89 BOOLEAN Alarm On[5 - Alarm 5] RD_ONLY

90 BOOLEAN Alarm On[6 - Alarm 6] RD_ONLY

91 BOOLEAN Alarm On[7 - Alarm 7] RD_ONLY

92 BOOLEAN Alarm On[8 - Alarm 8] RD_ONLY

93 BOOLEAN Alarm On[9 - Alarm 9] RD_ONLY

94 BOOLEAN Alarm On[10 - Alarm 10] RD_ONLY

95 BOOLEAN Alarm On[11 - Alarm 11] RD_ONLY

96 BOOLEAN Alarm On[12 - Alarm 12] RD_ONLY

97 BOOLEAN Alarm On[13 - Alarm 13] RD_ONLY

98 BOOLEAN Alarm On[14 - Alarm 14] RD_ONLY

99 BOOLEAN Alarm On[15 - Alarm 15] RD_ONLY

100 BOOLEAN Alarm On[16 - Alarm 16] RD_ONLY

101 BOOLEAN Alarm On[17 - Alarm 17] RD_ONLY

102 BOOLEAN Alarm On[18 - Alarm 18] RD_ONLY

103 BOOLEAN Alarm On[19 - Alarm 19] RD_ONLY

104 BOOLEAN Alarm On[20 - Alarm 20] RD_ONLY

105 BOOLEAN 1 - Stream 1_Stream Toggle RD_ONLY

106 BOOLEAN 2 - Stream 2_Stream Toggle RD_ONLY

107 BOOLEAN 3 - Stream 3_Stream Toggle RD_ONLY

108 BOOLEAN 4 - Stream 4_Stream Toggle RD_ONLY

109 BOOLEAN 5 - Stream 5_Stream Toggle RD_ONLY

110 BOOLEAN 6 - Stream 6_Stream Toggle RD_ONLY

111 BOOLEAN 7 - Stream 7_Stream Toggle RD_ONLY

112 BOOLEAN 8 - Stream 8_Stream Toggle RD_ONLY

113 BOOLEAN Current Value[1 - Discrete Output 1] RD_ONLY

114 BOOLEAN Current Value[2 - Discrete Output 2] RD_ONLY

115 BOOLEAN Current Value[3 - Discrete Output 3] RD_ONLY

116 BOOLEAN Current Value[4 - Discrete Output 4] RD_ONLY

117 BOOLEAN Current Value[5 - Discrete Output 5] RD_ONLY

118 BOOLEAN Switch[1 - Discrete Output 1] RD_WR

119 BOOLEAN Switch[2 - Discrete Output 2] RD_WR

120 BOOLEAN Switch[3 - Discrete Output 3] RD_WR

121 BOOLEAN Switch[4 - Discrete Output 4] RD_WR

122 BOOLEAN Switch[5 - Discrete Output 5] RD_WR
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Register # Data type Variable Access Format

123 INT Switch[1 - Discrete Output 1] RD_WR

124 INT Switch[2 - Discrete Output 2] RD_WR

125 INT Switch[3 - Discrete Output 3] RD_WR

126 INT Switch[4 - Discrete Output 4] RD_WR

127 INT Switch[5 - Discrete Output 5] RD_WR

9006 INT Current Time(time_t) RD_WR MM

9007 INT Current Time(time_t) RD_WR DD

9008 INT Current Time(time_t) RD_WR YYYY

9009 INT Current Time(time_t) RD_WR hh

9010 INT Current Time(time_t) RD_WR mm

9011 INT Current Time(time_t) RD_WR ss

9012 INT Unused RD_ONLY

9013 INT Modbus Id[1 - Port 0] RD_ONLY

9014 INT Site Id RD_WR

9022 INT Analysis Time RD_ONLY

9023 INT Unused RD_ONLY

9024 INT Cycle Time RD_ONLY

9025 INT Unused RD_ONLY

9026 INT Run Time RD_ONLY

9027 INT Unused RD_ONLY

9028 INT Current Stream RD_ONLY

9029 INT Unused RD_ONLY

9030 INT GC Control_Analyzer Control (Write Reg 9030) RD_WR

9031 INT Unused RD_ONLY

9032 INT GC Calibrating RD_ONLY

9033 INT Unused RD_ONLY

9034 INT Active Alarm Flag RD_ONLY

9035 INT UnAck Alarm Flag RD_ONLY

9036 INT Hourly Average Reset time RD_ONLY YY

9037 INT Hourly Average Reset time RD_ONLY MM

9038 INT Hourly Average Reset time RD_ONLY DD

9039 INT Hourly Average Reset time RD_ONLY hh

9040 INT Hourly Average Reset time RD_ONLY mm

9041 INT Daily Average Reset time RD_ONLY YY

Pre-defined Modbus® Map Files Reference Manual
July 2020 2-3-9000-744

326 Emerson.com/Rosemount



Register # Data type Variable Access Format

9042 INT Daily Average Reset time RD_ONLY MM

9043 INT Daily Average Reset time RD_ONLY DD

9044 INT Daily Average Reset time RD_ONLY hh

9045 INT Daily Average Reset time RD_ONLY mm

9046 INT Weekly Average Reset time RD_ONLY YY

9047 INT Weekly Average Reset time RD_ONLY MM

9048 INT Weekly Average Reset time RD_ONLY DD

9049 INT Weekly Average Reset time RD_ONLY hh

9050 INT Weekly Average Reset time RD_ONLY mm

9051 INT Monthly Average Reset time RD_ONLY YY

9052 INT Monthly Average Reset time RD_ONLY MM

9053 INT Monthly Average Reset time RD_ONLY DD

9054 INT Monthly Average Reset time RD_ONLY hh

9055 INT Monthly Average Reset time RD_ONLY mm

9056 INT Variable Average Reset time RD_ONLY YY

9057 INT Variable Average Reset time RD_ONLY MM

9058 INT Variable Average Reset time RD_ONLY DD

9059 INT Variable Average Reset time RD_ONLY hh

9060 INT Variable Average Reset time RD_ONLY mm

10...13 (Heater 1...4 out of range): 1 if heater is out of range, 0 otherwise

16 (FID flame out): 1 if FID flame has gone out, 0 otherwise

17 (Warmstart failed): 1 if GC warmstart was unable to stabilize temperature/pressure in
analytical oven within pre-defined warmstart duration, 0 otherwise

19 (Calibration failed): 1 if last calibration sequence failed, 0 otherwise

20...21 (Low carrier pressure 1...2): 1 if the carrier pressure is low, 0 otherwise

22...23 (No sample flow 1...2): 1 if there is no sample flow in the sample conditioning
system, 0 otherwise

24 (Maintenance mode): 1 if a technician has put the GC into Maintenance mode to
perform repairs, 0 otherwise

25 (Calibration failed): 1 if last calibration sequence failed, 0 otherwise

31 (Preamp scaling factor): 1 if there is an electronics failure on the preamp board, 0
otherwise

32...45 (Analog output high signal 1...14): 1 if the variable associated with analog output
has a value that is greater than the zero scale value assigned to the analog output, 0
otherwise
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48...61 (Analog output low signal 1...14): 1 if the variable associated with analog output
has a value that is lesser than the zero scale value assigned to the analog output, 0
otherwise

64 (Analyzer failure): 1 indicates that the carrier pressure is either too low or the GC
cannot control the carrier pressure to the desired setpoint, 0 otherwise

65 (Power failure): 1 indicates that the GC lost power and is currently executing the
warmstart sequence, 0 otherwise

67 (Low battery voltage): 1 indicates that the battery used to back up configuration and
real-time clock on the main CPU board is low, 0 otherwise

68 (GC idle): 1 indicates that the GC is not performing an analysis, 0 otherwise

Note
If the GC is halted by the operator using MON2020, then the Idle alarm is not raised. It is
raised only if the GC goes into the Idle state due to alarm condition that has the Halt on
Alarm flag enabled.

Note
If the GC is halted by the operator using MON2020 and if he disconnects from the GC
without restarting normal operation, then the GC Idle alarm is raised.

70...77 (Analog input low signal 1...8): 1 indicates that the analog input is sensing a
current that is lower than 4 mA, 0 otherwise

85...104 (User limit alarm 1...20): 1 indicates that the user limit alarm is active, 0
otherwise

105...112 (Stream toggle 1...5): Each time new results are available for a particular
stream, this flag is toggled.

113...117 (Discrete output 1...5 current value): Current state of the discrete output, 1
indicates that it is On; 0 indicates it is Off.

118...122 (Switch discrete output 1...5): Read/write register for changing the state of the
discrete output. Write 1 to this register to set output state to On, 0 to set output state to
Off.

123...127 (Switch discrete output 1...5): Read/write register for changing the state of the
discrete output. Write 1 to this register to set output state to On, 0 to set output state to
Off, and 2 to set the register to Auto mode.

9006...9011: GC system date/time read-write registers

9013 (Modbus ID [Port 0]): Modbus ID for serial port 0

9014 (Site ID): GC site ID read/write register

9022 (Analysis time): Analysis time

9024 (Cycle time): Cycle time

9026 (Run time): Run time

9028 (Current stream): Stream number

9030 (Analyzer control): User Modbus mapping template
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9032 (GC calibrating): Tells you if the GC is calibrating. A value of 1 means GC is
calibrating, 0 otherwise.

9034 (Active alarm flag): Tells you if the GC has any active alarms. A value of 1 indicates
that there are active alarms, 0 otherwise.

9035 (UnAck alarm flag): Tells you if the GC has any unacknowledged alarms. A value of 1
indicates that there are unacknowledged alarms, 0 otherwise.

9036...9040 (Hourly average reset time): Date/time when hourly average results was
archived

9041...9045 (Daily average reset time): Date/time when daily average results was
archived

9046...9047 (Weekly average reset time): Date/time when weekly average result was
archived

9051...9055 (Monthly average reset time): Date/time when monthly average results was
archived

9056...9060 (Variable average reset time): Date/time when variable average results was
archived

F.5 SIM_2251 UK (with ISO results)
Register # Data type Variable Record # Access Format

1001 BOOLEAN Current Value[1 - Discrete Output 1] RD_ONLY

1002 BOOLEAN Current Value[2 - Discrete Output 2] RD_ONLY

1003 BOOLEAN Current Value[3 - Discrete Output 3] RD_ONLY

1004 BOOLEAN Current Value[4 - Discrete Output 4] RD_ONLY

1005 BOOLEAN Current Value[5 - Discrete Output 5] RD_ONLY

1006 BOOLEAN Current Value[1 - Discrete Input 1] RD_ONLY

1007 BOOLEAN Current Value[2 - Discrete Input 2] RD_ONLY

1008 BOOLEAN Current Value[3 - Discrete Input 3] RD_ONLY

1009 BOOLEAN Current Value[4 - Discrete Input 4] RD_ONLY

1010 BOOLEAN Current Value[5 - Discrete Input 5] RD_ONLY

3001 INT Last Analy_Component Code(UK)[1 - Component 1] RD_ONLY

3002 INT Last Analy_Component Code(UK)[2 - Component 2] RD_ONLY

3003 INT Last Analy_Component Code(UK)[3 - Component 3] RD_ONLY

3004 INT Last Analy_Component Code(UK)[4 - Component 4] RD_ONLY

3005 INT Last Analy_Component Code(UK)[5 - Component 5] RD_ONLY

3006 INT Last Analy_Component Code(UK)[6 - Component 6] RD_ONLY

3007 INT Last Analy_Component Code(UK)[7 - Component 7] RD_ONLY

3008 INT Last Analy_Component Code(UK)[8 - Component 8] RD_ONLY
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Register # Data type Variable Record # Access Format

3009 INT Last Analy_Component Code(UK)[9 - Component 9] RD_ONLY

3010 INT Last Analy_Component Code(UK)[10 - Component 10] RD_ONLY

3011 INT Last Analy_Component Code(UK)[11 - Component 11] RD_ONLY

3012 INT Last Analy_Component Code(UK)[12 - Component 12] RD_ONLY

3013 INT Last Analy_Component Code(UK)[13 - Component 13] RD_ONLY

3014 INT Last Analy_Component Code(UK)[14 - Component 14] RD_ONLY

3015 INT Last Analy_Component Code(UK)[15 - Component 15] RD_ONLY

3016 INT Last Analy_Component Code(UK)[16 - Component 16] RD_ONLY

3017 INT Last Analy_Component Code(UK)[1 - Component 1] RD_ONLY

3018 INT Last Analy_Component Code(UK)[2 - Component 2] RD_ONLY

3019 INT Last Analy_Component Code(UK)[3 - Component 3] RD_ONLY

3020 INT Last Analy_Component Code(UK)[4 - Component 4] RD_ONLY

3021 INT Last Analy_Component Code(UK)[5 - Component 5] RD_ONLY

3022 INT Last Analy_Component Code(UK)[6 - Component 6] RD_ONLY

3023 INT Last Analy_Component Code(UK)[7 - Component 7] RD_ONLY

3024 INT Last Analy_Component Code(UK)[8 - Component 8] RD_ONLY

3025 INT Last Analy_Component Code(UK)[9 - Component 9] RD_ONLY

3026 INT Last Analy_Component Code(UK)[10 - Component 10] RD_ONLY

3027 INT Last Analy_Component Code(UK)[11 - Component 11] RD_ONLY

3028 INT Last Analy_Component Code(UK)[12 - Component 12] RD_ONLY

3029 INT Last Analy_Component Code(UK)[13 - Component 13] RD_ONLY

3030 INT Last Analy_Component Code(UK)[14 - Component 14] RD_ONLY

3031 INT Last Analy_Component Code(UK)[15 - Component 15] RD_ONLY

3032 INT Last Analy_Component Code(UK)[16 - Component 16] RD_ONLY

3033 INT Run Time(1/30th Sec) RD_ONLY

3034 INT Last Analy_Stream Number RD_ONLY

3035 INT Last Analy_CDT Stream Mask RD_ONLY

3036 INT Current Time(time_t) RD_WR MM

3037 INT Current Time(time_t) RD_WR DD

3038 INT Current Time(time_t) RD_WR YY

3039 INT Current Time(time_t) RD_WR hh

3040 INT Current Time(time_t) RD_WR mm

3041 INT Last Analy_Start Time RD_ONLY MM

3042 INT Last Analy_Start Time RD_ONLY DD
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Register # Data type Variable Record # Access Format

3043 INT Last Analy_Start Time RD_ONLY YY

3044 INT Last Analy_Start Time RD_ONLY hh

3045 INT Last Analy_Start Time RD_ONLY mm

3046 Bitmap(INT) 0:Unused, 1:Unused, 2:System Alarm_Alarm On - Last
Analysis_Analog Input 1 Low Signal, 3:System
Alarm_Alarm On - Last Analysis_Analog Input 1 High
Signal, 4:System Alarm_Alarm On - Last Analysis_Analog
Input 2 Low Signal, 5:System Alarm_Alarm On - Last
Analysis_Analog Input 2 High Signal, 6:Unused, 7:Unused,
8:System Alarm_Alarm On - Last Analysis_Analog Output 1
Low Signal, 9:System Alarm_Alarm On - Last
Analysis_Analog Output 1 High Signal, 10:System
Alarm_Alarm On - Last Analysis_Analog Output 2 Low
Signal, 11:System Alarm_Alarm On - Last Analysis_Analog
Output 2 High Signal, 12:System Alarm_Alarm On - Last
Analysis_Analog Output 3 Low Signal, 13:System
Alarm_Alarm On - Last Analysis_Analog Output 3 High
Signal, 14:Analyzer Failure, 15:Unused

RD_ONLY

3047 Bitmap(INT) 0:System Alarm_Alarm On - Current Analysis_Power
Failure, 1:Calibration Failed, 2:Preamp Failure, 3:Unused,
4:Unused, 5:Unused, 6:Unused, 7:Unused, 8:Unused,
9:Unused, 10:Unused, 11:Unused, 12:Unused, 13:Unused,
14:Unused, 15:Unused

RD_ONLY

3048 INT 1 - Stream 1_Active Low Limit Alarms RD_ONLY

3049 INT 1 - Stream 1_Active High Limit Alarms RD_ONLY

3050 INT 2 - Stream 2_Active Low Limit Alarms RD_ONLY

3051 INT 2 - Stream 2_Active High Limit Alarms RD_ONLY

3052 INT 3 - Stream 3_Active Low Limit Alarms RD_ONLY

3053 INT 3 - Stream 3_Active High Limit Alarms RD_ONLY

3054 INT 4 - Stream 4_Active Low Limit Alarms RD_ONLY

3055 INT 4 - Stream 4_Active High Limit Alarms RD_ONLY

3056 INT 5 - Stream 5_Active Low Limit Alarms RD_ONLY

3057 INT 5 - Stream 5_Active High Limit Alarms RD_ONLY

3058 INT New Data Flag RD_WR

3059 INT Analy/Calib Flag RD_ONLY

3060 INT Daily Avg Updated RD_WR

3061 INT Last Stream RD_ONLY

3062 INT 2 - Stream 2_New Data Available RD_WR

3063 INT 3 - Stream 3_New Data Available RD_WR

3064 INT 4 - Stream 4_New Data Available RD_WR

3065 INT 5 - Stream 5_New Data Available RD_WR
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Register # Data type Variable Record # Access Format

3066 INT Component Data 1_Reference Code[1] RD_ONLY

3067 INT Component Data 1_Reference Code[2] RD_ONLY

3068 INT Component Data 1_Reference Code[3] RD_ONLY

3069 INT Component Data 1_Reference Code[4] RD_ONLY

3070 INT Component Data 1_Reference Code[5] RD_ONLY

3071 INT Component Data 1_Reference Code[6] RD_ONLY

3072 INT Component Data 1_Reference Code[7] RD_ONLY

3073 INT Component Data 1_Reference Code[8] RD_ONLY

3074 INT Component Data 1_Reference Code[9] RD_ONLY

3075 INT Component Data 1_Reference Code[10] RD_ONLY

3076 INT Component Data 1_Reference Code[11] RD_ONLY

3077 INT Component Data 1_Reference Code[12] RD_ONLY

3078 INT Component Data 1_Reference Code[13] RD_ONLY

3079 INT Component Data 1_Reference Code[14] RD_ONLY

3080 INT Component Data 1_Reference Code[15] RD_ONLY

3081 INT Component Data 1_Reference Code[16] RD_ONLY

3082 INT Component Data 2_Reference Code[1] RD_ONLY

3083 INT Component Data 2_Reference Code[2] RD_ONLY

3084 INT Component Data 2_Reference Code[3] RD_ONLY

3085 INT Component Data 2_Reference Code[4] RD_ONLY

3086 INT Component Data 2_Reference Code[5] RD_ONLY

3087 INT Component Data 2_Reference Code[6] RD_ONLY

3088 INT Component Data 2_Reference Code[7] RD_ONLY

3089 INT Component Data 2_Reference Code[8] RD_ONLY

3090 INT Component Data 2_Reference Code[9] RD_ONLY

3091 INT Component Data 2_Reference Code[10] RD_ONLY

3092 INT Component Data 2_Reference Code[11] RD_ONLY

3093 INT Component Data 2_Reference Code[12] RD_ONLY

3094 INT Component Data 2_Reference Code[13] RD_ONLY

3095 INT Component Data 2_Reference Code[14] RD_ONLY

3096 INT Component Data 2_Reference Code[15] RD_ONLY

3097 INT Component Data 2_Reference Code[16] RD_ONLY

3098 INT Calculations Configuration_Primary CV Units RD_ONLY

3099 INT Last Run Data Valid 1 RD_WR
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3100 INT Last Run Data Valid 2 RD_WR

3101 INT Last Run Data Valid 3 RD_WR

3102 INT Last Run Data Valid 4 RD_WR

3103 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3104 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3105 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3106 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3107 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY

3108 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3109 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3110 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY

3111 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3112 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3113 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY

3114 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3115 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3116 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3117 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3118 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3119 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3120 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3121 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3122 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

3123 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3124 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3125 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3126 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3127 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY

3128 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3129 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3130 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY

3131 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3132 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3133 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY
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3134 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3135 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3136 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3137 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3138 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3139 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3140 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3141 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3142 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

3143 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3144 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3145 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3146 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3147 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY

3148 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3149 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3150 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY

3151 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3152 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3153 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY

3154 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3155 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3156 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3157 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3158 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3159 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3160 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3161 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3162 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

3163 INT Last FCalib_New RF Update Flag[1 - Component 1] RD_ONLY

3164 INT Last FCalib_New RF Update Flag[2 - Component 2] RD_ONLY

3165 INT Last FCalib_New RF Update Flag[3 - Component 3] RD_ONLY

3166 INT Last FCalib_New RF Update Flag[4 - Component 4] RD_ONLY

3167 INT Last FCalib_New RF Update Flag[5 - Component 5] RD_ONLY
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Register # Data type Variable Record # Access Format

3168 INT Last FCalib_New RF Update Flag[6 - Component 6] RD_ONLY

3169 INT Last FCalib_New RF Update Flag[7 - Component 7] RD_ONLY

3170 INT Last FCalib_New RF Update Flag[8 - Component 8] RD_ONLY

3171 INT Last FCalib_New RF Update Flag[9 - Component 9] RD_ONLY

3172 INT Last FCalib_New RF Update Flag[10 - Component 10] RD_ONLY

3173 INT Last FCalib_New RF Update Flag[11 - Component 11] RD_ONLY

3174 INT Last FCalib_New RF Update Flag[12 - Component 12] RD_ONLY

3175 INT Last FCalib_New RF Update Flag[13 - Component 13] RD_ONLY

3176 INT Last FCalib_New RF Update Flag[14 - Component 14] RD_ONLY

3177 INT Last FCalib_New RF Update Flag[15 - Component 15] RD_ONLY

3178 INT Last FCalib_New RF Update Flag[16 - Component 16] RD_ONLY

3179 INT Last FCalib_New RF Update Flag[17 - Component 17] RD_ONLY

3180 INT Last FCalib_New RF Update Flag[18 - Component 18] RD_ONLY

3181 INT Last FCalib_New RF Update Flag[19 - Component 19] RD_ONLY

3182 INT Last FCalib_New RF Update Flag[20 - Component 20] RD_ONLY

5001 LONG Last Analy_Cycle Time (1/30th sec) RD_ONLY

5002 LONG Last Calib_Calib Time(1/30th sec) RD_ONLY

7001 FLOAT Last Analy_Mole %[1 - Component 1] RD_ONLY

7002 FLOAT Last Analy_Mole %[2 - Component 2] RD_ONLY

7003 FLOAT Last Analy_Mole %[3 - Component 3] RD_ONLY

7004 FLOAT Last Analy_Mole %[4 - Component 4] RD_ONLY

7005 FLOAT Last Analy_Mole %[5 - Component 5] RD_ONLY

7006 FLOAT Last Analy_Mole %[6 - Component 6] RD_ONLY

7007 FLOAT Last Analy_Mole %[7 - Component 7] RD_ONLY

7008 FLOAT Last Analy_Mole %[8 - Component 8] RD_ONLY

7009 FLOAT Last Analy_Mole %[9 - Component 9] RD_ONLY

7010 FLOAT Last Analy_Mole %[10 - Component 10] RD_ONLY

7011 FLOAT Last Analy_Mole %[11 - Component 11] RD_ONLY

7012 FLOAT Last Analy_Mole %[12 - Component 12] RD_ONLY

7013 FLOAT Last Analy_Mole %[13 - Component 13] RD_ONLY

7014 FLOAT Last Analy_Mole %[14 - Component 14] RD_ONLY

7015 FLOAT Last Analy_Mole %[15 - Component 15] RD_ONLY

7016 FLOAT Last Analy_Mole %[16 - Component 16] RD_ONLY

7017 FLOAT Last Analy_Weight %[1 - Component 1] RD_ONLY
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7018 FLOAT Last Analy_Weight %[2 - Component 2] RD_ONLY

7019 FLOAT Last Analy_Weight %[3 - Component 3] RD_ONLY

7020 FLOAT Last Analy_Weight %[4 - Component 4] RD_ONLY

7021 FLOAT Last Analy_Weight %[5 - Component 5] RD_ONLY

7022 FLOAT Last Analy_Weight %[6 - Component 6] RD_ONLY

7023 FLOAT Last Analy_Weight %[7 - Component 7] RD_ONLY

7024 FLOAT Last Analy_Weight %[8 - Component 8] RD_ONLY

7025 FLOAT Last Analy_Weight %[9 - Component 9] RD_ONLY

7026 FLOAT Last Analy_Weight %[10 - Component 10] RD_ONLY

7027 FLOAT Last Analy_Weight %[11 - Component 11] RD_ONLY

7028 FLOAT Last Analy_Weight %[12 - Component 12] RD_ONLY

7029 FLOAT Last Analy_Weight %[13 - Component 13] RD_ONLY

7030 FLOAT Last Analy_Weight %[14 - Component 14] RD_ONLY

7031 FLOAT Last Analy_Weight %[15 - Component 15] RD_ONLY

7032 FLOAT Last Analy_Weight %[16 - Component 16] RD_ONLY

7033 FLOAT Last Analy_ISO CV Sup Dry - Pri RD_ONLY

7034 FLOAT Last Analy_ISO CV Sup Sat - Pri RD_ONLY

7035 FLOAT Last Analy_ISO Real Rel Den Gas - Pri RD_ONLY

7036 FLOAT Last Analy_ISO Z Factor - Pri RD_ONLY

7037 FLOAT Last Analy_ISO Wobbe Index Sup - Pri RD_ONLY

7038 FLOAT Last Analy_Total Unnormalized Conc RD_ONLY

7039 FLOAT Last Analy_ISO Avg Molar Mass RD_ONLY

7040 FLOAT Calc Result[1 - User Cal 1] RD_ONLY

7041 FLOAT Calc Result[2 - User Cal 2] RD_ONLY

7042 FLOAT Calc Result[3 - User Cal 3] RD_ONLY

7043 FLOAT Calc Result[4 - User Cal 4] RD_ONLY

7044 FLOAT Calc Result[5 - User Cal 5] RD_ONLY

7045 FLOAT Unused RD_ONLY

7046 FLOAT Last Analy_ISO CV Sup Dry - Sec RD_ONLY

7047 FLOAT Last Analy_ISO CV Sup Sat - Sec RD_ONLY

7048 FLOAT Last Analy_ISO CV Inf Dry - Sec RD_ONLY

7049 FLOAT Last Analy_ISO CV Inf Sat - Sec RD_ONLY

7050 FLOAT Last Analy_ISO Z Factor - Sec RD_ONLY

7051 FLOAT Last Analy_ISO Real Rel Den Gas - Sec RD_ONLY
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7052 FLOAT Last Analy_ISO Gas Den kg/m3 - Sec RD_ONLY

7053 FLOAT Last Analy_ISO Wobbe Index Sup - Sec RD_ONLY

7054 FLOAT Last Analy_ISO Wobbe Index Inf - Sec RD_ONLY

7055 FLOAT Avg[1 - Average 1] RD_ONLY

7056 FLOAT Avg[2 - Average 2] RD_ONLY

7057 FLOAT Avg[3 - Average 3] RD_ONLY

7058 FLOAT Avg[4 - Average 4] RD_ONLY

7059 FLOAT Avg[5 - Average 5] RD_ONLY

7060 FLOAT Avg[6 - Average 6] RD_ONLY

7061 FLOAT Avg[7 - Average 7] RD_ONLY

7062 FLOAT Avg[8 - Average 8] RD_ONLY

7063 FLOAT Avg[9 - Average 9] RD_ONLY

7064 FLOAT Avg[10 - Average 10] RD_ONLY

7065 FLOAT Avg[11 - Average 11] RD_ONLY

7066 FLOAT Avg[12 - Average 12] RD_ONLY

7067 FLOAT Avg[13 - Average 13] RD_ONLY

7068 FLOAT Avg[14 - Average 14] RD_ONLY

7069 FLOAT Avg[15 - Average 15] RD_ONLY

7070 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7071 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7072 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7073 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7074 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7075 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7076 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7077 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7078 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7079 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7080 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7081 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7082 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7083 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7084 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7085 FLOAT Current Value[1 - Analog Input 1] RD_ONLY
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7086 FLOAT Current Value[2 - Analog Input 2] RD_ONLY

7087 FLOAT Last Analy_ISO CV Inf Dry - Pri RD_ONLY

7088 FLOAT Last Analy_ISO CV Inf Sat - Pri RD_ONLY

7089 FLOAT Last Analy_ISO Wobbe Index Inf - Pri RD_ONLY

7090 FLOAT Last Analy_ISO Gas Den kg/m3 - Pri RD_ONLY

7091 FLOAT Last FCalib_Total Calibration Runs RD_ONLY

7092 FLOAT Last FCalib_Total Average Runs RD_ONLY

7093 FLOAT Auto Calibration Start Time RD_ONLY hhmm

7094 FLOAT GC Control_Stream Sequence Select RD_WR

7095 FLOAT Last Analy_Response Factor[1 - Component 1] RD_ONLY

7096 FLOAT Last Analy_Response Factor[2 - Component 2] RD_ONLY

7097 FLOAT Last Analy_Response Factor[3 - Component 3] RD_ONLY

7098 FLOAT Last Analy_Response Factor[4 - Component 4] RD_ONLY

7099 FLOAT Last Analy_Response Factor[5 - Component 5] RD_ONLY

7100 FLOAT Last Analy_Response Factor[6 - Component 6] RD_ONLY

7101 FLOAT Last Analy_Response Factor[7 - Component 7] RD_ONLY

7102 FLOAT Last Analy_Response Factor[8 - Component 8] RD_ONLY

7103 FLOAT Last Analy_Response Factor[9 - Component 9] RD_ONLY

7104 FLOAT Last Analy_Response Factor[10 - Component 10] RD_ONLY

7105 FLOAT Last Analy_Response Factor[11 - Component 11] RD_ONLY

7106 FLOAT Last Analy_Response Factor[12 - Component 12] RD_ONLY

7107 FLOAT Last Analy_Response Factor[13 - Component 13] RD_ONLY

7108 FLOAT Last Analy_Response Factor[14 - Component 14] RD_ONLY

7109 FLOAT Last Analy_Response Factor[15 - Component 15] RD_ONLY

7110 FLOAT Last Analy_Response Factor[16 - Component 16] RD_ONLY

7111 FLOAT Last FCalib_ISO CV Sup Dry - Pri RD_ONLY

7112 FLOAT Last FCalib_ISO CV Sup Sat - Pri RD_ONLY

7113 FLOAT Last FCalib_ISO CV Inf Dry - Pri RD_ONLY

7114 FLOAT Last FCalib_ISO CV Inf Sat - Pri RD_ONLY

7115 FLOAT Last FCalib_ISO Z Factor - Pri RD_ONLY

7116 FLOAT Last FCalib_ISO Real Rel Den Gas - Pri RD_ONLY

7117 FLOAT Last FCalib_ISO Gas Den kg/m3 - Pri RD_ONLY

7118 FLOAT Last FCalib_ISO Wobbe Index Sup - Pri RD_ONLY

7119 FLOAT Last FCalib_ISO Wobbe Index Inf - Pri RD_ONLY
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7120 FLOAT Last FCalib_ISO Avg Molar Mass RD_ONLY

7121 FLOAT Last FCalib_Total Unnormalized Conc RD_ONLY

7122 FLOAT Last Calib_Stream Number RD_ONLY

7123 FLOAT Last Analy_GS(M)R Incomp Combustion Factor RD_ONLY

7124 FLOAT Last Analy_GS(M)R Soot Index RD_ONLY

7125 FLOAT Last Analy_Ratio of Latent Heat Cap RD_ONLY

7126 FLOAT Avg[1 - Average 1] RD_ONLY

7127 FLOAT Avg[2 - Average 2] RD_ONLY

7128 FLOAT Avg[3 - Average 3] RD_ONLY

7129 FLOAT Avg[4 - Average 4] RD_ONLY

7130 FLOAT Avg[5 - Average 5] RD_ONLY

7131 FLOAT Avg[6 - Average 6] RD_ONLY

7132 FLOAT Avg[7 - Average 7] RD_ONLY

7133 FLOAT Avg[8 - Average 8] RD_ONLY

7134 FLOAT Avg[9 - Average 9] RD_ONLY

7135 FLOAT Avg[10 - Average 10] RD_ONLY

7136 FLOAT Avg[11 - Average 11] RD_ONLY

7137 FLOAT Avg[12 - Average 12] RD_ONLY

7138 FLOAT Avg[13 - Average 13] RD_ONLY

7139 FLOAT Avg[14 - Average 14] RD_ONLY

7140 FLOAT Avg[15 - Average 15] RD_ONLY

7141 FLOAT Avg[16 - Average 16] RD_ONLY

7142 FLOAT Avg[17 - Average 17] RD_ONLY

7143 FLOAT Avg[18 - Average 18] RD_ONLY

7144 FLOAT Avg[19 - Average 19] RD_ONLY

7145 FLOAT Avg[20 - Average 20] RD_ONLY

7146 FLOAT Avg[21 - Average 21] RD_ONLY

7147 FLOAT Avg[22 - Average 22] RD_ONLY

7148 FLOAT Avg[23 - Average 23] RD_ONLY

7149 FLOAT Avg[24 - Average 24] RD_ONLY

7150 FLOAT Avg[25 - Average 25] RD_ONLY

7151 FLOAT Avg[26 - Average 26] RD_ONLY

7152 FLOAT Avg[27 - Average 27] RD_ONLY

7153 FLOAT Avg[28 - Average 28] RD_ONLY
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7154 FLOAT Avg[29 - Average 29] RD_ONLY

7155 FLOAT Avg[30 - Average 30] RD_ONLY

7156 FLOAT Avg[31 - Average 31] RD_ONLY

7157 FLOAT Avg[32 - Average 32] RD_ONLY

7158 FLOAT Avg[33 - Average 33] RD_ONLY

7159 FLOAT Avg[34 - Average 34] RD_ONLY

7160 FLOAT Avg[35 - Average 35] RD_ONLY

7161 FLOAT Avg[36 - Average 36] RD_ONLY

7162 FLOAT Max[1 - Average 1] RD_ONLY

7163 FLOAT Max[2 - Average 2] RD_ONLY

7164 FLOAT Max[3 - Average 3] RD_ONLY

7165 FLOAT Max[4 - Average 4] RD_ONLY

7166 FLOAT Max[5 - Average 5] RD_ONLY

7167 FLOAT Max[6 - Average 6] RD_ONLY

7168 FLOAT Max[7 - Average 7] RD_ONLY

7169 FLOAT Max[8 - Average 8] RD_ONLY

7170 FLOAT Max[9 - Average 9] RD_ONLY

7171 FLOAT Max[10 - Average 10] RD_ONLY

7172 FLOAT Max[11 - Average 11] RD_ONLY

7173 FLOAT Max[12 - Average 12] RD_ONLY

7174 FLOAT Max[13 - Average 13] RD_ONLY

7175 FLOAT Max[14 - Average 14] RD_ONLY

7176 FLOAT Max[15 - Average 15] RD_ONLY

7177 FLOAT Max[16 - Average 16] RD_ONLY

7178 FLOAT Max[17 - Average 17] RD_ONLY

7179 FLOAT Max[18 - Average 18] RD_ONLY

7180 FLOAT Max[19 - Average 19] RD_ONLY

7181 FLOAT Max[20 - Average 20] RD_ONLY

7182 FLOAT Max[21 - Average 21] RD_ONLY

7183 FLOAT Max[22 - Average 22] RD_ONLY

7184 FLOAT Max[23 - Average 23] RD_ONLY

7185 FLOAT Max[24 - Average 24] RD_ONLY

7186 FLOAT Max[25 - Average 25] RD_ONLY

7187 FLOAT Max[26 - Average 26] RD_ONLY
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7188 FLOAT Max[27 - Average 27] RD_ONLY

7189 FLOAT Max[28 - Average 28] RD_ONLY

7190 FLOAT Max[29 - Average 29] RD_ONLY

7191 FLOAT Max[30 - Average 30] RD_ONLY

7192 FLOAT Max[31 - Average 31] RD_ONLY

7193 FLOAT Max[32 - Average 32] RD_ONLY

7194 FLOAT Max[33 - Average 33] RD_ONLY

7195 FLOAT Max[34 - Average 34] RD_ONLY

7196 FLOAT Max[35 - Average 35] RD_ONLY

7197 FLOAT Max[36 - Average 36] RD_ONLY

7198 FLOAT Min[1 - Average 1] RD_ONLY

7199 FLOAT Min[2 - Average 2] RD_ONLY

7200 FLOAT Min[3 - Average 3] RD_ONLY

7201 FLOAT Min[4 - Average 4] RD_ONLY

7202 FLOAT Min[5 - Average 5] RD_ONLY

7203 FLOAT Min[6 - Average 6] RD_ONLY

7204 FLOAT Min[7 - Average 7] RD_ONLY

7205 FLOAT Min[8 - Average 8] RD_ONLY

7206 FLOAT Min[9 - Average 9] RD_ONLY

7207 FLOAT Min[10 - Average 10] RD_ONLY

7208 FLOAT Min[11 - Average 11] RD_ONLY

7209 FLOAT Min[12 - Average 12] RD_ONLY

7210 FLOAT Min[13 - Average 13] RD_ONLY

7211 FLOAT Min[14 - Average 14] RD_ONLY

7212 FLOAT Min[15 - Average 15] RD_ONLY

7213 FLOAT Min[16 - Average 16] RD_ONLY

7214 FLOAT Min[17 - Average 17] RD_ONLY

7215 FLOAT Min[18 - Average 18] RD_ONLY

7216 FLOAT Min[19 - Average 19] RD_ONLY

7217 FLOAT Min[20 - Average 20] RD_ONLY

7218 FLOAT Min[21 - Average 21] RD_ONLY

7219 FLOAT Min[22 - Average 22] RD_ONLY

7220 FLOAT Min[23 - Average 23] RD_ONLY

7221 FLOAT Min[24 - Average 24] RD_ONLY
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7222 FLOAT Min[25 - Average 25] RD_ONLY

7223 FLOAT Min[26 - Average 26] RD_ONLY

7224 FLOAT Min[27 - Average 27] RD_ONLY

7225 FLOAT Min[28 - Average 28] RD_ONLY

7226 FLOAT Min[29 - Average 29] RD_ONLY

7227 FLOAT Min[30 - Average 30] RD_ONLY

7228 FLOAT Min[31 - Average 31] RD_ONLY

7229 FLOAT Min[32 - Average 32] RD_ONLY

7230 FLOAT Min[33 - Average 33] RD_ONLY

7231 FLOAT Min[34 - Average 34] RD_ONLY

7232 FLOAT Min[35 - Average 35] RD_ONLY

7233 FLOAT Min[36 - Average 36] RD_ONLY

7234 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7235 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7236 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7237 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7238 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7239 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7240 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7241 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7242 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7243 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7244 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7245 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7246 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7247 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7248 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7249 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

7250 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

7251 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

7252 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

7253 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

7254 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

7255 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY
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7256 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

7257 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

7258 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

7259 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY

7260 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

7261 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

7262 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

7263 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

7264 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

7265 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

7266 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY

7267 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

7268 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

7269 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

7270 FLOAT Archive_Max[1 - Average 1] 1 RD_ONLY

7271 FLOAT Archive_Max[2 - Average 2] 1 RD_ONLY

7272 FLOAT Archive_Max[3 - Average 3] 1 RD_ONLY

7273 FLOAT Archive_Max[4 - Average 4] 1 RD_ONLY

7274 FLOAT Archive_Max[5 - Average 5] 1 RD_ONLY

7275 FLOAT Archive_Max[6 - Average 6] 1 RD_ONLY

7276 FLOAT Archive_Max[7 - Average 7] 1 RD_ONLY

7277 FLOAT Archive_Max[8 - Average 8] 1 RD_ONLY

7278 FLOAT Archive_Max[9 - Average 9] 1 RD_ONLY

7279 FLOAT Archive_Max[10 - Average 10] 1 RD_ONLY

7280 FLOAT Archive_Max[11 - Average 11] 1 RD_ONLY

7281 FLOAT Archive_Max[12 - Average 12] 1 RD_ONLY

7282 FLOAT Archive_Max[13 - Average 13] 1 RD_ONLY

7283 FLOAT Archive_Max[14 - Average 14] 1 RD_ONLY

7284 FLOAT Archive_Max[15 - Average 15] 1 RD_ONLY

7285 FLOAT Archive_Max[16 - Average 16] 1 RD_ONLY

7286 FLOAT Archive_Max[17 - Average 17] 1 RD_ONLY

7287 FLOAT Archive_Max[18 - Average 18] 1 RD_ONLY

7288 FLOAT Archive_Max[19 - Average 19] 1 RD_ONLY

7289 FLOAT Archive_Max[20 - Average 20] 1 RD_ONLY
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7290 FLOAT Archive_Max[21 - Average 21] 1 RD_ONLY

7291 FLOAT Archive_Max[22 - Average 22] 1 RD_ONLY

7292 FLOAT Archive_Max[23 - Average 23] 1 RD_ONLY

7293 FLOAT Archive_Max[24 - Average 24] 1 RD_ONLY

7294 FLOAT Archive_Max[25 - Average 25] 1 RD_ONLY

7295 FLOAT Archive_Max[26 - Average 26] 1 RD_ONLY

7296 FLOAT Archive_Max[27 - Average 27] 1 RD_ONLY

7297 FLOAT Archive_Max[28 - Average 28] 1 RD_ONLY

7298 FLOAT Archive_Max[29 - Average 29] 1 RD_ONLY

7299 FLOAT Archive_Max[30 - Average 30] 1 RD_ONLY

7300 FLOAT Archive_Max[31 - Average 31] 1 RD_ONLY

7301 FLOAT Archive_Max[32 - Average 32] 1 RD_ONLY

7302 FLOAT Archive_Max[33 - Average 33] 1 RD_ONLY

7303 FLOAT Archive_Max[34 - Average 34] 1 RD_ONLY

7304 FLOAT Archive_Max[35 - Average 35] 1 RD_ONLY

7305 FLOAT Archive_Max[36 - Average 36] 1 RD_ONLY

7306 FLOAT Archive_Min[1 - Average 1] 1 RD_ONLY

7307 FLOAT Archive_Min[2 - Average 2] 1 RD_ONLY

7308 FLOAT Archive_Min[3 - Average 3] 1 RD_ONLY

7309 FLOAT Archive_Min[4 - Average 4] 1 RD_ONLY

7310 FLOAT Archive_Min[5 - Average 5] 1 RD_ONLY

7311 FLOAT Archive_Min[6 - Average 6] 1 RD_ONLY

7312 FLOAT Archive_Min[7 - Average 7] 1 RD_ONLY

7313 FLOAT Archive_Min[8 - Average 8] 1 RD_ONLY

7314 FLOAT Archive_Min[9 - Average 9] 1 RD_ONLY

7315 FLOAT Archive_Min[10 - Average 10] 1 RD_ONLY

7316 FLOAT Archive_Min[11 - Average 11] 1 RD_ONLY

7317 FLOAT Archive_Min[12 - Average 12] 1 RD_ONLY

7318 FLOAT Archive_Min[13 - Average 13] 1 RD_ONLY

7319 FLOAT Archive_Min[14 - Average 14] 1 RD_ONLY

7320 FLOAT Archive_Min[15 - Average 15] 1 RD_ONLY

7321 FLOAT Archive_Min[16 - Average 16] 1 RD_ONLY

7322 FLOAT Archive_Min[17 - Average 17] 1 RD_ONLY

7323 FLOAT Archive_Min[18 - Average 18] 1 RD_ONLY
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7324 FLOAT Archive_Min[19 - Average 19] 1 RD_ONLY

7325 FLOAT Archive_Min[20 - Average 20] 1 RD_ONLY

7326 FLOAT Archive_Min[21 - Average 21] 1 RD_ONLY

7327 FLOAT Archive_Min[22 - Average 22] 1 RD_ONLY

7328 FLOAT Archive_Min[23 - Average 23] 1 RD_ONLY

7329 FLOAT Archive_Min[24 - Average 24] 1 RD_ONLY

7330 FLOAT Archive_Min[25 - Average 25] 1 RD_ONLY

7331 FLOAT Archive_Min[26 - Average 26] 1 RD_ONLY

7332 FLOAT Archive_Min[27 - Average 27] 1 RD_ONLY

7333 FLOAT Archive_Min[28 - Average 28] 1 RD_ONLY

7334 FLOAT Archive_Min[29 - Average 29] 1 RD_ONLY

7335 FLOAT Archive_Min[30 - Average 30] 1 RD_ONLY

7336 FLOAT Archive_Min[31 - Average 31] 1 RD_ONLY

7337 FLOAT Archive_Min[32 - Average 32] 1 RD_ONLY

7338 FLOAT Archive_Min[33 - Average 33] 1 RD_ONLY

7339 FLOAT Archive_Min[34 - Average 34] 1 RD_ONLY

7340 FLOAT Archive_Min[35 - Average 35] 1 RD_ONLY

7341 FLOAT Archive_Min[36 - Average 36] 1 RD_ONLY

7342 FLOAT Archive_Avg[1 - Average 1] 2 RD_ONLY

7343 FLOAT Archive_Avg[2 - Average 2] 2 RD_ONLY

7344 FLOAT Archive_Avg[3 - Average 3] 2 RD_ONLY

7345 FLOAT Archive_Avg[4 - Average 4] 2 RD_ONLY

7346 FLOAT Archive_Avg[5 - Average 5] 2 RD_ONLY

7347 FLOAT Archive_Avg[6 - Average 6] 2 RD_ONLY

7348 FLOAT Archive_Avg[7 - Average 7] 2 RD_ONLY

7349 FLOAT Archive_Avg[8 - Average 8] 2 RD_ONLY

7350 FLOAT Archive_Avg[9 - Average 9] 2 RD_ONLY

7351 FLOAT Archive_Avg[10 - Average 10] 2 RD_ONLY

7352 FLOAT Archive_Avg[11 - Average 11] 2 RD_ONLY

7353 FLOAT Archive_Avg[12 - Average 12] 2 RD_ONLY

7354 FLOAT Archive_Avg[13 - Average 13] 2 RD_ONLY

7355 FLOAT Archive_Avg[14 - Average 14] 2 RD_ONLY

7356 FLOAT Archive_Avg[15 - Average 15] 2 RD_ONLY

7357 FLOAT Archive_Avg[16 - Average 16] 2 RD_ONLY
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7358 FLOAT Archive_Avg[17 - Average 17] 2 RD_ONLY

7359 FLOAT Archive_Avg[18 - Average 18] 2 RD_ONLY

7360 FLOAT Archive_Avg[19 - Average 19] 2 RD_ONLY

7361 FLOAT Archive_Avg[20 - Average 20] 2 RD_ONLY

7362 FLOAT Archive_Avg[21 - Average 21] 2 RD_ONLY

7363 FLOAT Archive_Avg[22 - Average 22] 2 RD_ONLY

7364 FLOAT Archive_Avg[23 - Average 23] 2 RD_ONLY

7365 FLOAT Archive_Avg[24 - Average 24] 2 RD_ONLY

7366 FLOAT Archive_Avg[25 - Average 25] 2 RD_ONLY

7367 FLOAT Archive_Avg[26 - Average 26] 2 RD_ONLY

7368 FLOAT Archive_Avg[27 - Average 27] 2 RD_ONLY

7369 FLOAT Archive_Avg[28 - Average 28] 2 RD_ONLY

7370 FLOAT Archive_Avg[29 - Average 29] 2 RD_ONLY

7371 FLOAT Archive_Avg[30 - Average 30] 2 RD_ONLY

7372 FLOAT Archive_Avg[31 - Average 31] 2 RD_ONLY

7373 FLOAT Archive_Avg[32 - Average 32] 2 RD_ONLY

7374 FLOAT Archive_Avg[33 - Average 33] 2 RD_ONLY

7375 FLOAT Archive_Avg[34 - Average 34] 2 RD_ONLY

7376 FLOAT Archive_Avg[35 - Average 35] 2 RD_ONLY

7377 FLOAT Archive_Avg[36 - Average 36] 2 RD_ONLY

7378 FLOAT Archive_Max[1 - Average 1] 2 RD_ONLY

7379 FLOAT Archive_Max[2 - Average 2] 2 RD_ONLY

7380 FLOAT Archive_Max[3 - Average 3] 2 RD_ONLY

7381 FLOAT Archive_Max[4 - Average 4] 2 RD_ONLY

7382 FLOAT Archive_Max[5 - Average 5] 2 RD_ONLY

7383 FLOAT Archive_Max[6 - Average 6] 2 RD_ONLY

7384 FLOAT Archive_Max[7 - Average 7] 2 RD_ONLY

7385 FLOAT Archive_Max[8 - Average 8] 2 RD_ONLY

7386 FLOAT Archive_Max[9 - Average 9] 2 RD_ONLY

7387 FLOAT Archive_Max[10 - Average 10] 2 RD_ONLY

7388 FLOAT Archive_Max[11 - Average 11] 2 RD_ONLY

7389 FLOAT Archive_Max[12 - Average 12] 2 RD_ONLY

7390 FLOAT Archive_Max[13 - Average 13] 2 RD_ONLY

7391 FLOAT Archive_Max[14 - Average 14] 2 RD_ONLY
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7392 FLOAT Archive_Max[15 - Average 15] 2 RD_ONLY

7393 FLOAT Archive_Max[16 - Average 16] 2 RD_ONLY

7394 FLOAT Archive_Max[17 - Average 17] 2 RD_ONLY

7395 FLOAT Archive_Max[18 - Average 18] 2 RD_ONLY

7396 FLOAT Archive_Max[19 - Average 19] 2 RD_ONLY

7397 FLOAT Archive_Max[20 - Average 20] 2 RD_ONLY

7398 FLOAT Archive_Max[21 - Average 21] 2 RD_ONLY

7399 FLOAT Archive_Max[22 - Average 22] 2 RD_ONLY

7400 FLOAT Archive_Max[23 - Average 23] 2 RD_ONLY

7401 FLOAT Archive_Max[24 - Average 24] 2 RD_ONLY

7402 FLOAT Archive_Max[25 - Average 25] 2 RD_ONLY

7403 FLOAT Archive_Max[26 - Average 26] 2 RD_ONLY

7404 FLOAT Archive_Max[27 - Average 27] 2 RD_ONLY

7405 FLOAT Archive_Max[28 - Average 28] 2 RD_ONLY

7406 FLOAT Archive_Max[29 - Average 29] 2 RD_ONLY

7407 FLOAT Archive_Max[30 - Average 30] 2 RD_ONLY

7408 FLOAT Archive_Max[31 - Average 31] 2 RD_ONLY

7409 FLOAT Archive_Max[32 - Average 32] 2 RD_ONLY

7410 FLOAT Archive_Max[33 - Average 33] 2 RD_ONLY

7411 FLOAT Archive_Max[34 - Average 34] 2 RD_ONLY

7412 FLOAT Archive_Max[35 - Average 35] 2 RD_ONLY

7413 FLOAT Archive_Max[36 - Average 36] 2 RD_ONLY

7414 FLOAT Archive_Min[1 - Average 1] 2 RD_ONLY

7415 FLOAT Archive_Min[2 - Average 2] 2 RD_ONLY

7416 FLOAT Archive_Min[3 - Average 3] 2 RD_ONLY

7417 FLOAT Archive_Min[4 - Average 4] 2 RD_ONLY

7418 FLOAT Archive_Min[5 - Average 5] 2 RD_ONLY

7419 FLOAT Archive_Min[6 - Average 6] 2 RD_ONLY

7420 FLOAT Archive_Min[7 - Average 7] 2 RD_ONLY

7421 FLOAT Archive_Min[8 - Average 8] 2 RD_ONLY

7422 FLOAT Archive_Min[9 - Average 9] 2 RD_ONLY

7423 FLOAT Archive_Min[10 - Average 10] 2 RD_ONLY

7424 FLOAT Archive_Min[11 - Average 11] 2 RD_ONLY

7425 FLOAT Archive_Min[12 - Average 12] 2 RD_ONLY
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7426 FLOAT Archive_Min[13 - Average 13] 2 RD_ONLY

7427 FLOAT Archive_Min[14 - Average 14] 2 RD_ONLY

7428 FLOAT Archive_Min[15 - Average 15] 2 RD_ONLY

7429 FLOAT Archive_Min[16 - Average 16] 2 RD_ONLY

7430 FLOAT Archive_Min[17 - Average 17] 2 RD_ONLY

7431 FLOAT Archive_Min[18 - Average 18] 2 RD_ONLY

7432 FLOAT Archive_Min[19 - Average 19] 2 RD_ONLY

7433 FLOAT Archive_Min[20 - Average 20] 2 RD_ONLY

7434 FLOAT Archive_Min[21 - Average 21] 2 RD_ONLY

7435 FLOAT Archive_Min[22 - Average 22] 2 RD_ONLY

7436 FLOAT Archive_Min[23 - Average 23] 2 RD_ONLY

7437 FLOAT Archive_Min[24 - Average 24] 2 RD_ONLY

7438 FLOAT Archive_Min[25 - Average 25] 2 RD_ONLY

7439 FLOAT Archive_Min[26 - Average 26] 2 RD_ONLY

7440 FLOAT Archive_Min[27 - Average 27] 2 RD_ONLY

7441 FLOAT Archive_Min[28 - Average 28] 2 RD_ONLY

7442 FLOAT Archive_Min[29 - Average 29] 2 RD_ONLY

7443 FLOAT Archive_Min[30 - Average 30] 2 RD_ONLY

7444 FLOAT Archive_Min[31 - Average 31] 2 RD_ONLY

7445 FLOAT Archive_Min[32 - Average 32] 2 RD_ONLY

7446 FLOAT Archive_Min[33 - Average 33] 2 RD_ONLY

7447 FLOAT Archive_Min[34 - Average 34] 2 RD_ONLY

7448 FLOAT Archive_Min[35 - Average 35] 2 RD_ONLY

7449 FLOAT Archive_Min[36 - Average 36] 2 RD_ONLY

7450 FLOAT Archive_Avg[1 - Average 1] 3 RD_ONLY

7451 FLOAT Archive_Avg[2 - Average 2] 3 RD_ONLY

7452 FLOAT Archive_Avg[3 - Average 3] 3 RD_ONLY

7453 FLOAT Archive_Avg[4 - Average 4] 3 RD_ONLY

7454 FLOAT Archive_Avg[5 - Average 5] 3 RD_ONLY

7455 FLOAT Archive_Avg[6 - Average 6] 3 RD_ONLY

7456 FLOAT Archive_Avg[7 - Average 7] 3 RD_ONLY

7457 FLOAT Archive_Avg[8 - Average 8] 3 RD_ONLY

7458 FLOAT Archive_Avg[9 - Average 9] 3 RD_ONLY

7459 FLOAT Archive_Avg[10 - Average 10] 3 RD_ONLY
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7460 FLOAT Archive_Avg[11 - Average 11] 3 RD_ONLY

7461 FLOAT Archive_Avg[12 - Average 12] 3 RD_ONLY

7462 FLOAT Archive_Avg[13 - Average 13] 3 RD_ONLY

7463 FLOAT Archive_Avg[14 - Average 14] 3 RD_ONLY

7464 FLOAT Archive_Avg[15 - Average 15] 3 RD_ONLY

7465 FLOAT Archive_Avg[16 - Average 16] 3 RD_ONLY

7466 FLOAT Archive_Avg[17 - Average 17] 3 RD_ONLY

7467 FLOAT Archive_Avg[18 - Average 18] 3 RD_ONLY

7468 FLOAT Archive_Avg[19 - Average 19] 3 RD_ONLY

7469 FLOAT Archive_Avg[20 - Average 20] 3 RD_ONLY

7470 FLOAT Archive_Avg[21 - Average 21] 3 RD_ONLY

7471 FLOAT Archive_Avg[22 - Average 22] 3 RD_ONLY

7472 FLOAT Archive_Avg[23 - Average 23] 3 RD_ONLY

7473 FLOAT Archive_Avg[24 - Average 24] 3 RD_ONLY

7474 FLOAT Archive_Avg[25 - Average 25] 3 RD_ONLY

7475 FLOAT Archive_Avg[26 - Average 26] 3 RD_ONLY

7476 FLOAT Archive_Avg[27 - Average 27] 3 RD_ONLY

7477 FLOAT Archive_Avg[28 - Average 28] 3 RD_ONLY

7478 FLOAT Archive_Avg[29 - Average 29] 3 RD_ONLY

7479 FLOAT Archive_Avg[30 - Average 30] 3 RD_ONLY

7480 FLOAT Archive_Avg[31 - Average 31] 3 RD_ONLY

7481 FLOAT Archive_Avg[32 - Average 32] 3 RD_ONLY

7482 FLOAT Archive_Avg[33 - Average 33] 3 RD_ONLY

7483 FLOAT Archive_Avg[34 - Average 34] 3 RD_ONLY

7484 FLOAT Archive_Avg[35 - Average 35] 3 RD_ONLY

7485 FLOAT Archive_Avg[36 - Average 36] 3 RD_ONLY

7486 FLOAT Archive_Max[1 - Average 1] 3 RD_ONLY

7487 FLOAT Archive_Max[2 - Average 2] 3 RD_ONLY

7488 FLOAT Archive_Max[3 - Average 3] 3 RD_ONLY

7489 FLOAT Archive_Max[4 - Average 4] 3 RD_ONLY

7490 FLOAT Archive_Max[5 - Average 5] 3 RD_ONLY

7491 FLOAT Archive_Max[6 - Average 6] 3 RD_ONLY

7492 FLOAT Archive_Max[7 - Average 7] 3 RD_ONLY

7493 FLOAT Archive_Max[8 - Average 8] 3 RD_ONLY

Reference Manual Pre-defined Modbus® Map Files
2-3-9000-744 July 2020

Rosemount 700XA 349



Register # Data type Variable Record # Access Format

7494 FLOAT Archive_Max[9 - Average 9] 3 RD_ONLY

7495 FLOAT Archive_Max[10 - Average 10] 3 RD_ONLY

7496 FLOAT Archive_Max[11 - Average 11] 3 RD_ONLY

7497 FLOAT Archive_Max[12 - Average 12] 3 RD_ONLY

7498 FLOAT Archive_Max[13 - Average 13] 3 RD_ONLY

7499 FLOAT Archive_Max[14 - Average 14] 3 RD_ONLY

7500 FLOAT Archive_Max[15 - Average 15] 3 RD_ONLY

7501 FLOAT Archive_Max[16 - Average 16] 3 RD_ONLY

7502 FLOAT Archive_Max[17 - Average 17] 3 RD_ONLY

7503 FLOAT Archive_Max[18 - Average 18] 3 RD_ONLY

7504 FLOAT Archive_Max[19 - Average 19] 3 RD_ONLY

7505 FLOAT Archive_Max[20 - Average 20] 3 RD_ONLY

7506 FLOAT Archive_Max[21 - Average 21] 3 RD_ONLY

7507 FLOAT Archive_Max[22 - Average 22] 3 RD_ONLY

7508 FLOAT Archive_Max[23 - Average 23] 3 RD_ONLY

7509 FLOAT Archive_Max[24 - Average 24] 3 RD_ONLY

7510 FLOAT Archive_Max[25 - Average 25] 3 RD_ONLY

7511 FLOAT Archive_Max[26 - Average 26] 3 RD_ONLY

7512 FLOAT Archive_Max[27 - Average 27] 3 RD_ONLY

7513 FLOAT Archive_Max[28 - Average 28] 3 RD_ONLY

7514 FLOAT Archive_Max[29 - Average 29] 3 RD_ONLY

7515 FLOAT Archive_Max[30 - Average 30] 3 RD_ONLY

7516 FLOAT Archive_Max[31 - Average 31] 3 RD_ONLY

7517 FLOAT Archive_Max[32 - Average 32] 3 RD_ONLY

7518 FLOAT Archive_Max[33 - Average 33] 3 RD_ONLY

7519 FLOAT Archive_Max[34 - Average 34] 3 RD_ONLY

7520 FLOAT Archive_Max[35 - Average 35] 3 RD_ONLY

7521 FLOAT Archive_Max[36 - Average 36] 3 RD_ONLY

7522 FLOAT Archive_Min[1 - Average 1] 3 RD_ONLY

7523 FLOAT Archive_Min[2 - Average 2] 3 RD_ONLY

7524 FLOAT Archive_Min[3 - Average 3] 3 RD_ONLY

7525 FLOAT Archive_Min[4 - Average 4] 3 RD_ONLY

7526 FLOAT Archive_Min[5 - Average 5] 3 RD_ONLY

7527 FLOAT Archive_Min[6 - Average 6] 3 RD_ONLY
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7528 FLOAT Archive_Min[7 - Average 7] 3 RD_ONLY

7529 FLOAT Archive_Min[8 - Average 8] 3 RD_ONLY

7530 FLOAT Archive_Min[9 - Average 9] 3 RD_ONLY

7531 FLOAT Archive_Min[10 - Average 10] 3 RD_ONLY

7532 FLOAT Archive_Min[11 - Average 11] 3 RD_ONLY

7533 FLOAT Archive_Min[12 - Average 12] 3 RD_ONLY

7534 FLOAT Archive_Min[13 - Average 13] 3 RD_ONLY

7535 FLOAT Archive_Min[14 - Average 14] 3 RD_ONLY

7536 FLOAT Archive_Min[15 - Average 15] 3 RD_ONLY

7537 FLOAT Archive_Min[16 - Average 16] 3 RD_ONLY

7538 FLOAT Archive_Min[17 - Average 17] 3 RD_ONLY

7539 FLOAT Archive_Min[18 - Average 18] 3 RD_ONLY

7540 FLOAT Archive_Min[19 - Average 19] 3 RD_ONLY

7541 FLOAT Archive_Min[20 - Average 20] 3 RD_ONLY

7542 FLOAT Archive_Min[21 - Average 21] 3 RD_ONLY

7543 FLOAT Archive_Min[22 - Average 22] 3 RD_ONLY

7544 FLOAT Archive_Min[23 - Average 23] 3 RD_ONLY

7545 FLOAT Archive_Min[24 - Average 24] 3 RD_ONLY

7546 FLOAT Archive_Min[25 - Average 25] 3 RD_ONLY

7547 FLOAT Archive_Min[26 - Average 26] 3 RD_ONLY

7548 FLOAT Archive_Min[27 - Average 27] 3 RD_ONLY

7549 FLOAT Archive_Min[28 - Average 28] 3 RD_ONLY

7550 FLOAT Archive_Min[29 - Average 29] 3 RD_ONLY

7551 FLOAT Archive_Min[30 - Average 30] 3 RD_ONLY

7552 FLOAT Archive_Min[31 - Average 31] 3 RD_ONLY

7553 FLOAT Archive_Min[32 - Average 32] 3 RD_ONLY

7554 FLOAT Archive_Min[33 - Average 33] 3 RD_ONLY

7555 FLOAT Archive_Min[34 - Average 34] 3 RD_ONLY

7556 FLOAT Archive_Min[35 - Average 35] 3 RD_ONLY

7557 FLOAT Archive_Min[36 - Average 36] 3 RD_ONLY

7558 FLOAT Component Data 1_Multi-level Calib 'a'[1] RD_ONLY

7559 FLOAT Component Data 1_Multi-level Calib 'a'[2] RD_ONLY

7560 FLOAT Component Data 1_Multi-level Calib 'a'[3] RD_ONLY

7561 FLOAT Component Data 1_Multi-level Calib 'a'[4] RD_ONLY
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7562 FLOAT Component Data 1_Multi-level Calib 'a'[5] RD_ONLY

7563 FLOAT Component Data 1_Multi-level Calib 'a'[6] RD_ONLY

7564 FLOAT Component Data 1_Multi-level Calib 'a'[7] RD_ONLY

7565 FLOAT Component Data 1_Multi-level Calib 'a'[8] RD_ONLY

7566 FLOAT Component Data 1_Multi-level Calib 'a'[9] RD_ONLY

7567 FLOAT Component Data 1_Multi-level Calib 'a'[10] RD_ONLY

7568 FLOAT Component Data 1_Multi-level Calib 'a'[11] RD_ONLY

7569 FLOAT Component Data 1_Multi-level Calib 'a'[12] RD_ONLY

7570 FLOAT Component Data 1_Multi-level Calib 'a'[13] RD_ONLY

7571 FLOAT Component Data 1_Multi-level Calib 'a'[14] RD_ONLY

7572 FLOAT Component Data 1_Multi-level Calib 'a'[15] RD_ONLY

7573 FLOAT Component Data 1_Multi-level Calib 'a'[16] RD_ONLY

7574 FLOAT Component Data 1_Multi-level Calib 'b'[1] RD_ONLY

7575 FLOAT Component Data 1_Multi-level Calib 'b'[2] RD_ONLY

7576 FLOAT Component Data 1_Multi-level Calib 'b'[3] RD_ONLY

7577 FLOAT Component Data 1_Multi-level Calib 'b'[4] RD_ONLY

7578 FLOAT Component Data 1_Multi-level Calib 'b'[5] RD_ONLY

7579 FLOAT Component Data 1_Multi-level Calib 'b'[6] RD_ONLY

7580 FLOAT Component Data 1_Multi-level Calib 'b'[7] RD_ONLY

7581 FLOAT Component Data 1_Multi-level Calib 'b'[8] RD_ONLY

7582 FLOAT Component Data 1_Multi-level Calib 'b'[9] RD_ONLY

7583 FLOAT Component Data 1_Multi-level Calib 'b'[10] RD_ONLY

7584 FLOAT Component Data 1_Multi-level Calib 'b'[11] RD_ONLY

7585 FLOAT Component Data 1_Multi-level Calib 'b'[12] RD_ONLY

7586 FLOAT Component Data 1_Multi-level Calib 'b'[13] RD_ONLY

7587 FLOAT Component Data 1_Multi-level Calib 'b'[14] RD_ONLY

7588 FLOAT Component Data 1_Multi-level Calib 'b'[15] RD_ONLY

7589 FLOAT Component Data 1_Multi-level Calib 'b'[16] RD_ONLY

7590 FLOAT Component Data 1_Multi-level Calib 'c'[1] RD_ONLY

7591 FLOAT Component Data 1_Multi-level Calib 'c'[2] RD_ONLY

7592 FLOAT Component Data 1_Multi-level Calib 'c'[3] RD_ONLY

7593 FLOAT Component Data 1_Multi-level Calib 'c'[4] RD_ONLY

7594 FLOAT Component Data 1_Multi-level Calib 'c'[5] RD_ONLY

7595 FLOAT Component Data 1_Multi-level Calib 'c'[6] RD_ONLY
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7596 FLOAT Component Data 1_Multi-level Calib 'c'[7] RD_ONLY

7597 FLOAT Component Data 1_Multi-level Calib 'c'[8] RD_ONLY

7598 FLOAT Component Data 1_Multi-level Calib 'c'[9] RD_ONLY

7599 FLOAT Component Data 1_Multi-level Calib 'c'[10] RD_ONLY

7600 FLOAT Component Data 1_Multi-level Calib 'c'[11] RD_ONLY

7601 FLOAT Component Data 1_Multi-level Calib 'c'[12] RD_ONLY

7602 FLOAT Component Data 1_Multi-level Calib 'c'[13] RD_ONLY

7603 FLOAT Component Data 1_Multi-level Calib 'c'[14] RD_ONLY

7604 FLOAT Component Data 1_Multi-level Calib 'c'[15] RD_ONLY

7605 FLOAT Component Data 1_Multi-level Calib 'c'[16] RD_ONLY

7606 FLOAT Component Data 1_Multi-level Calib 'd'[1] RD_ONLY

7607 FLOAT Component Data 1_Multi-level Calib 'd'[2] RD_ONLY

7608 FLOAT Component Data 1_Multi-level Calib 'd'[3] RD_ONLY

7609 FLOAT Component Data 1_Multi-level Calib 'd'[4] RD_ONLY

7610 FLOAT Component Data 1_Multi-level Calib 'd'[5] RD_ONLY

7611 FLOAT Component Data 1_Multi-level Calib 'd'[6] RD_ONLY

7612 FLOAT Component Data 1_Multi-level Calib 'd'[7] RD_ONLY

7613 FLOAT Component Data 1_Multi-level Calib 'd'[8] RD_ONLY

7614 FLOAT Component Data 1_Multi-level Calib 'd'[9] RD_ONLY

7615 FLOAT Component Data 1_Multi-level Calib 'd'[10] RD_ONLY

7616 FLOAT Component Data 1_Multi-level Calib 'd'[11] RD_ONLY

7617 FLOAT Component Data 1_Multi-level Calib 'd'[12] RD_ONLY

7618 FLOAT Component Data 1_Multi-level Calib 'd'[13] RD_ONLY

7619 FLOAT Component Data 1_Multi-level Calib 'd'[14] RD_ONLY

7620 FLOAT Component Data 1_Multi-level Calib 'd'[15] RD_ONLY

7621 FLOAT Component Data 1_Multi-level Calib 'd'[16] RD_ONLY

7622 FLOAT Component Data 1_Rel Resp Factor[1] RD_ONLY

7623 FLOAT Component Data 1_Rel Resp Factor[2] RD_ONLY

7624 FLOAT Component Data 1_Rel Resp Factor[3] RD_ONLY

7625 FLOAT Component Data 1_Rel Resp Factor[4] RD_ONLY

7626 FLOAT Component Data 1_Rel Resp Factor[5] RD_ONLY

7627 FLOAT Component Data 1_Rel Resp Factor[6] RD_ONLY

7628 FLOAT Component Data 1_Rel Resp Factor[7] RD_ONLY

7629 FLOAT Component Data 1_Rel Resp Factor[8] RD_ONLY

Reference Manual Pre-defined Modbus® Map Files
2-3-9000-744 July 2020

Rosemount 700XA 353



Register # Data type Variable Record # Access Format

7630 FLOAT Component Data 1_Rel Resp Factor[9] RD_ONLY

7631 FLOAT Component Data 1_Rel Resp Factor[10] RD_ONLY

7632 FLOAT Component Data 1_Rel Resp Factor[11] RD_ONLY

7633 FLOAT Component Data 1_Rel Resp Factor[12] RD_ONLY

7634 FLOAT Component Data 1_Rel Resp Factor[13] RD_ONLY

7635 FLOAT Component Data 1_Rel Resp Factor[14] RD_ONLY

7636 FLOAT Component Data 1_Rel Resp Factor[15] RD_ONLY

7637 FLOAT Component Data 1_Rel Resp Factor[16] RD_ONLY

7638 FLOAT Component Data 2_Multi-level Calib 'a'[1] RD_ONLY

7639 FLOAT Component Data 2_Multi-level Calib 'a'[2] RD_ONLY

7640 FLOAT Component Data 2_Multi-level Calib 'a'[3] RD_ONLY

7641 FLOAT Component Data 2_Multi-level Calib 'a'[4] RD_ONLY

7642 FLOAT Component Data 2_Multi-level Calib 'a'[5] RD_ONLY

7643 FLOAT Component Data 2_Multi-level Calib 'a'[6] RD_ONLY

7644 FLOAT Component Data 2_Multi-level Calib 'a'[7] RD_ONLY

7645 FLOAT Component Data 2_Multi-level Calib 'a'[8] RD_ONLY

7646 FLOAT Component Data 2_Multi-level Calib 'a'[9] RD_ONLY

7647 FLOAT Component Data 2_Multi-level Calib 'a'[10] RD_ONLY

7648 FLOAT Component Data 2_Multi-level Calib 'a'[11] RD_ONLY

7649 FLOAT Component Data 2_Multi-level Calib 'a'[12] RD_ONLY

7650 FLOAT Component Data 2_Multi-level Calib 'a'[13] RD_ONLY

7651 FLOAT Component Data 2_Multi-level Calib 'a'[14] RD_ONLY

7652 FLOAT Component Data 2_Multi-level Calib 'a'[15] RD_ONLY

7653 FLOAT Component Data 2_Multi-level Calib 'a'[16] RD_ONLY

7654 FLOAT Component Data 2_Multi-level Calib 'b'[1] RD_ONLY

7655 FLOAT Component Data 2_Multi-level Calib 'b'[2] RD_ONLY

7656 FLOAT Component Data 2_Multi-level Calib 'b'[3] RD_ONLY

7657 FLOAT Component Data 2_Multi-level Calib 'b'[4] RD_ONLY

7658 FLOAT Component Data 2_Multi-level Calib 'b'[5] RD_ONLY

7659 FLOAT Component Data 2_Multi-level Calib 'b'[6] RD_ONLY

7660 FLOAT Component Data 2_Multi-level Calib 'b'[7] RD_ONLY

7661 FLOAT Component Data 2_Multi-level Calib 'b'[8] RD_ONLY

7662 FLOAT Component Data 2_Multi-level Calib 'b'[9] RD_ONLY

7663 FLOAT Component Data 2_Multi-level Calib 'b'[10] RD_ONLY
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7664 FLOAT Component Data 2_Multi-level Calib 'b'[11] RD_ONLY

7665 FLOAT Component Data 2_Multi-level Calib 'b'[12] RD_ONLY

7666 FLOAT Component Data 2_Multi-level Calib 'b'[13] RD_ONLY

7667 FLOAT Component Data 2_Multi-level Calib 'b'[14] RD_ONLY

7668 FLOAT Component Data 2_Multi-level Calib 'b'[15] RD_ONLY

7669 FLOAT Component Data 2_Multi-level Calib 'b'[16] RD_ONLY

7670 FLOAT Component Data 2_Multi-level Calib 'c'[1] RD_ONLY

7671 FLOAT Component Data 2_Multi-level Calib 'c'[2] RD_ONLY

7672 FLOAT Component Data 2_Multi-level Calib 'c'[3] RD_ONLY

7673 FLOAT Component Data 2_Multi-level Calib 'c'[4] RD_ONLY

7674 FLOAT Component Data 2_Multi-level Calib 'c'[5] RD_ONLY

7675 FLOAT Component Data 2_Multi-level Calib 'c'[6] RD_ONLY

7676 FLOAT Component Data 2_Multi-level Calib 'c'[7] RD_ONLY

7677 FLOAT Component Data 2_Multi-level Calib 'c'[8] RD_ONLY

7678 FLOAT Component Data 2_Multi-level Calib 'c'[9] RD_ONLY

7679 FLOAT Component Data 2_Multi-level Calib 'c'[10] RD_ONLY

7680 FLOAT Component Data 2_Multi-level Calib 'c'[11] RD_ONLY

7681 FLOAT Component Data 2_Multi-level Calib 'c'[12] RD_ONLY

7682 FLOAT Component Data 2_Multi-level Calib 'c'[13] RD_ONLY

7683 FLOAT Component Data 2_Multi-level Calib 'c'[14] RD_ONLY

7684 FLOAT Component Data 2_Multi-level Calib 'c'[15] RD_ONLY

7685 FLOAT Component Data 2_Multi-level Calib 'c'[16] RD_ONLY

7686 FLOAT Component Data 2_Multi-level Calib 'd'[1] RD_ONLY

7687 FLOAT Component Data 2_Multi-level Calib 'd'[2] RD_ONLY

7688 FLOAT Component Data 2_Multi-level Calib 'd'[3] RD_ONLY

7689 FLOAT Component Data 2_Multi-level Calib 'd'[4] RD_ONLY

7690 FLOAT Component Data 2_Multi-level Calib 'd'[5] RD_ONLY

7691 FLOAT Component Data 2_Multi-level Calib 'd'[6] RD_ONLY

7692 FLOAT Component Data 2_Multi-level Calib 'd'[7] RD_ONLY

7693 FLOAT Component Data 2_Multi-level Calib 'd'[8] RD_ONLY

7694 FLOAT Component Data 2_Multi-level Calib 'd'[9] RD_ONLY

7695 FLOAT Component Data 2_Multi-level Calib 'd'[10] RD_ONLY

7696 FLOAT Component Data 2_Multi-level Calib 'd'[11] RD_ONLY

7697 FLOAT Component Data 2_Multi-level Calib 'd'[12] RD_ONLY

Reference Manual Pre-defined Modbus® Map Files
2-3-9000-744 July 2020

Rosemount 700XA 355



Register # Data type Variable Record # Access Format

7698 FLOAT Component Data 2_Multi-level Calib 'd'[13] RD_ONLY

7699 FLOAT Component Data 2_Multi-level Calib 'd'[14] RD_ONLY

7700 FLOAT Component Data 2_Multi-level Calib 'd'[15] RD_ONLY

7701 FLOAT Component Data 2_Multi-level Calib 'd'[16] RD_ONLY

7702 FLOAT Component Data 2_Rel Resp Factor[1] RD_ONLY

7703 FLOAT Component Data 2_Rel Resp Factor[2] RD_ONLY

7704 FLOAT Component Data 2_Rel Resp Factor[3] RD_ONLY

7705 FLOAT Component Data 2_Rel Resp Factor[4] RD_ONLY

7706 FLOAT Component Data 2_Rel Resp Factor[5] RD_ONLY

7707 FLOAT Component Data 2_Rel Resp Factor[6] RD_ONLY

7708 FLOAT Component Data 2_Rel Resp Factor[7] RD_ONLY

7709 FLOAT Component Data 2_Rel Resp Factor[8] RD_ONLY

7710 FLOAT Component Data 2_Rel Resp Factor[9] RD_ONLY

7711 FLOAT Component Data 2_Rel Resp Factor[10] RD_ONLY

7712 FLOAT Component Data 2_Rel Resp Factor[11] RD_ONLY

7713 FLOAT Component Data 2_Rel Resp Factor[12] RD_ONLY

7714 FLOAT Component Data 2_Rel Resp Factor[13] RD_ONLY

7715 FLOAT Component Data 2_Rel Resp Factor[14] RD_ONLY

7716 FLOAT Component Data 2_Rel Resp Factor[15] RD_ONLY

7717 FLOAT Component Data 2_Rel Resp Factor[16] RD_ONLY

7718 FLOAT Avg[1 - Average 1] RD_ONLY

7719 FLOAT Avg[2 - Average 2] RD_ONLY

7720 FLOAT Avg[3 - Average 3] RD_ONLY

7721 FLOAT Avg[4 - Average 4] RD_ONLY

7722 FLOAT Avg[5 - Average 5] RD_ONLY

7723 FLOAT Avg[6 - Average 6] RD_ONLY

7724 FLOAT Avg[7 - Average 7] RD_ONLY

7725 FLOAT Avg[8 - Average 8] RD_ONLY

7726 FLOAT Avg[9 - Average 9] RD_ONLY

7727 FLOAT Avg[10 - Average 10] RD_ONLY

7728 FLOAT Avg[11 - Average 11] RD_ONLY

7729 FLOAT Avg[12 - Average 12] RD_ONLY

7730 FLOAT Avg[13 - Average 13] RD_ONLY

7731 FLOAT Avg[14 - Average 14] RD_ONLY
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7732 FLOAT Avg[15 - Average 15] RD_ONLY

7733 FLOAT Avg[16 - Average 16] RD_ONLY

7734 FLOAT Avg[17 - Average 17] RD_ONLY

7735 FLOAT Avg[18 - Average 18] RD_ONLY

7736 FLOAT Avg[19 - Average 19] RD_ONLY

7737 FLOAT Avg[20 - Average 20] RD_ONLY

7738 FLOAT Avg[21 - Average 21] RD_ONLY

7739 FLOAT Avg[22 - Average 22] RD_ONLY

7740 FLOAT Avg[23 - Average 23] RD_ONLY

7741 FLOAT Avg[24 - Average 24] RD_ONLY

7742 FLOAT Avg[25 - Average 25] RD_ONLY

7743 FLOAT Avg[26 - Average 26] RD_ONLY

7744 FLOAT Avg[27 - Average 27] RD_ONLY

7745 FLOAT Avg[28 - Average 28] RD_ONLY

7746 FLOAT Avg[29 - Average 29] RD_ONLY

7747 FLOAT Avg[30 - Average 30] RD_ONLY

7748 FLOAT Avg[31 - Average 31] RD_ONLY

7749 FLOAT Avg[32 - Average 32] RD_ONLY

7750 FLOAT Avg[33 - Average 33] RD_ONLY

7751 FLOAT Avg[34 - Average 34] RD_ONLY

7752 FLOAT Avg[35 - Average 35] RD_ONLY

7753 FLOAT Avg[36 - Average 36] RD_ONLY

7754 FLOAT Avg[37 - Average 37] RD_ONLY

7755 FLOAT Avg[38 - Average 38] RD_ONLY

7756 FLOAT Avg[39 - Average 39] RD_ONLY

7757 FLOAT Avg[40 - Average 40] RD_ONLY

7758 FLOAT Avg[41 - Average 41] RD_ONLY

7759 FLOAT Avg[42 - Average 42] RD_ONLY

7760 FLOAT Avg[43 - Average 43] RD_ONLY

7761 FLOAT Avg[44 - Average 44] RD_ONLY

7762 FLOAT Avg[45 - Average 45] RD_ONLY

7763 FLOAT Avg[46 - Average 46] RD_ONLY

7764 FLOAT Avg[47 - Average 47] RD_ONLY

7765 FLOAT Avg[48 - Average 48] RD_ONLY
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7766 FLOAT Avg[49 - Average 49] RD_ONLY

7767 FLOAT Avg[50 - Average 50] RD_ONLY

7768 FLOAT Avg[51 - Average 51] RD_ONLY

7769 FLOAT Avg[52 - Average 52] RD_ONLY

7770 FLOAT Avg[53 - Average 53] RD_ONLY

7771 FLOAT Avg[54 - Average 54] RD_ONLY

7772 FLOAT Avg[55 - Average 55] RD_ONLY

7773 FLOAT Avg[56 - Average 56] RD_ONLY

7774 FLOAT Avg[57 - Average 57] RD_ONLY

7775 FLOAT Avg[58 - Average 58] RD_ONLY

7776 FLOAT Avg[59 - Average 59] RD_ONLY

7777 FLOAT Avg[60 - Average 60] RD_ONLY

7778 FLOAT Avg[61 - Average 61] RD_ONLY

7779 FLOAT Avg[62 - Average 62] RD_ONLY

7780 FLOAT Avg[63 - Average 63] RD_ONLY

7781 FLOAT Avg[64 - Average 64] RD_ONLY

7782 FLOAT Avg[65 - Average 65] RD_ONLY

7783 FLOAT Avg[66 - Average 66] RD_ONLY

7784 FLOAT Avg[67 - Average 67] RD_ONLY

7785 FLOAT Avg[68 - Average 68] RD_ONLY

7786 FLOAT Avg[69 - Average 69] RD_ONLY

7787 FLOAT Avg[70 - Average 70] RD_ONLY

7788 FLOAT Avg[71 - Average 71] RD_ONLY

7789 FLOAT Avg[72 - Average 72] RD_ONLY

7790 FLOAT Avg[73 - Average 73] RD_ONLY

7791 FLOAT Avg[74 - Average 74] RD_ONLY

7792 FLOAT Avg[75 - Average 75] RD_ONLY

7793 FLOAT Avg[76 - Average 76] RD_ONLY

7794 FLOAT Avg[77 - Average 77] RD_ONLY

7795 FLOAT Avg[78 - Average 78] RD_ONLY

7796 FLOAT Avg[79 - Average 79] RD_ONLY

7797 FLOAT Avg[80 - Average 80] RD_ONLY

7798 FLOAT Avg[81 - Average 81] RD_ONLY

7799 FLOAT Avg[82 - Average 82] RD_ONLY
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7800 FLOAT Avg[83 - Average 83] RD_ONLY

7801 FLOAT Avg[84 - Average 84] RD_ONLY

7802 FLOAT Avg[85 - Average 85] RD_ONLY

7803 FLOAT Avg[86 - Average 86] RD_ONLY

7804 FLOAT Avg[87 - Average 87] RD_ONLY

7805 FLOAT Avg[88 - Average 88] RD_ONLY

7806 FLOAT Avg[89 - Average 89] RD_ONLY

7807 FLOAT Avg[90 - Average 90] RD_ONLY

7808 FLOAT Avg[91 - Average 91] RD_ONLY

7809 FLOAT Avg[92 - Average 92] RD_ONLY

7810 FLOAT Avg[93 - Average 93] RD_ONLY

7811 FLOAT Avg[94 - Average 94] RD_ONLY

7812 FLOAT Avg[95 - Average 95] RD_ONLY

7813 FLOAT Avg[96 - Average 96] RD_ONLY

7814 FLOAT Avg[97 - Average 97] RD_ONLY

7815 FLOAT Avg[98 - Average 98] RD_ONLY

7816 FLOAT Avg[99 - Average 99] RD_ONLY

7817 FLOAT Avg[100 - Average 100] RD_ONLY

7818 FLOAT Avg[101 - Average 101] RD_ONLY

7819 FLOAT Avg[102 - Average 102] RD_ONLY

7820 FLOAT Avg[103 - Average 103] RD_ONLY

7821 FLOAT Avg[104 - Average 104] RD_ONLY

7822 FLOAT Avg[105 - Average 105] RD_ONLY

7823 FLOAT Avg[106 - Average 106] RD_ONLY

7824 FLOAT Avg[107 - Average 107] RD_ONLY

7825 FLOAT Avg[108 - Average 108] RD_ONLY

7826 FLOAT Avg[109 - Average 109] RD_ONLY

7827 FLOAT Avg[110 - Average 110] RD_ONLY

7828 FLOAT Avg[111 - Average 111] RD_ONLY

7829 FLOAT Avg[112 - Average 112] RD_ONLY

7830 FLOAT Avg[113 - Average 113] RD_ONLY

7831 FLOAT Avg[114 - Average 114] RD_ONLY

7832 FLOAT Avg[115 - Average 115] RD_ONLY

7833 FLOAT Avg[116 - Average 116] RD_ONLY
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7834 FLOAT Avg[117 - Average 117] RD_ONLY

7835 FLOAT Avg[118 - Average 118] RD_ONLY

7836 FLOAT Avg[119 - Average 119] RD_ONLY

7837 FLOAT Avg[120 - Average 120] RD_ONLY

7838 FLOAT Avg[121 - Average 121] RD_ONLY

7839 FLOAT Avg[122 - Average 122] RD_ONLY

7840 FLOAT Avg[123 - Average 123] RD_ONLY

7841 FLOAT Avg[124 - Average 124] RD_ONLY

7842 FLOAT Avg[125 - Average 125] RD_ONLY

7843 FLOAT Avg[126 - Average 126] RD_ONLY

7844 FLOAT Avg[127 - Average 127] RD_ONLY

7845 FLOAT Avg[128 - Average 128] RD_ONLY

7846 FLOAT Archive_Avg[1 - Average 1] 1 RD_ONLY

7847 FLOAT Archive_Avg[2 - Average 2] 1 RD_ONLY

7848 FLOAT Archive_Avg[3 - Average 3] 1 RD_ONLY

7849 FLOAT Archive_Avg[4 - Average 4] 1 RD_ONLY

7850 FLOAT Archive_Avg[5 - Average 5] 1 RD_ONLY

7851 FLOAT Archive_Avg[6 - Average 6] 1 RD_ONLY

7852 FLOAT Archive_Avg[7 - Average 7] 1 RD_ONLY

7853 FLOAT Archive_Avg[8 - Average 8] 1 RD_ONLY

7854 FLOAT Archive_Avg[9 - Average 9] 1 RD_ONLY

7855 FLOAT Archive_Avg[10 - Average 10] 1 RD_ONLY

7856 FLOAT Archive_Avg[11 - Average 11] 1 RD_ONLY

7857 FLOAT Archive_Avg[12 - Average 12] 1 RD_ONLY

7858 FLOAT Archive_Avg[13 - Average 13] 1 RD_ONLY

7859 FLOAT Archive_Avg[14 - Average 14] 1 RD_ONLY

7860 FLOAT Archive_Avg[15 - Average 15] 1 RD_ONLY

7861 FLOAT Archive_Avg[16 - Average 16] 1 RD_ONLY

7862 FLOAT Archive_Avg[17 - Average 17] 1 RD_ONLY

7863 FLOAT Archive_Avg[18 - Average 18] 1 RD_ONLY

7864 FLOAT Archive_Avg[19 - Average 19] 1 RD_ONLY

7865 FLOAT Archive_Avg[20 - Average 20] 1 RD_ONLY

7866 FLOAT Archive_Avg[21 - Average 21] 1 RD_ONLY

7867 FLOAT Archive_Avg[22 - Average 22] 1 RD_ONLY
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7868 FLOAT Archive_Avg[23 - Average 23] 1 RD_ONLY

7869 FLOAT Archive_Avg[24 - Average 24] 1 RD_ONLY

7870 FLOAT Archive_Avg[25 - Average 25] 1 RD_ONLY

7871 FLOAT Archive_Avg[26 - Average 26] 1 RD_ONLY

7872 FLOAT Archive_Avg[27 - Average 27] 1 RD_ONLY

7873 FLOAT Archive_Avg[28 - Average 28] 1 RD_ONLY

7874 FLOAT Archive_Avg[29 - Average 29] 1 RD_ONLY

7875 FLOAT Archive_Avg[30 - Average 30] 1 RD_ONLY

7876 FLOAT Archive_Avg[31 - Average 31] 1 RD_ONLY

7877 FLOAT Archive_Avg[32 - Average 32] 1 RD_ONLY

7878 FLOAT Archive_Avg[33 - Average 33] 1 RD_ONLY

7879 FLOAT Archive_Avg[34 - Average 34] 1 RD_ONLY

7880 FLOAT Archive_Avg[35 - Average 35] 1 RD_ONLY

7881 FLOAT Archive_Avg[36 - Average 36] 1 RD_ONLY

7882 FLOAT Archive_Avg[37 - Average 37] 1 RD_ONLY

7883 FLOAT Archive_Avg[38 - Average 38] 1 RD_ONLY

7884 FLOAT Archive_Avg[39 - Average 39] 1 RD_ONLY

7885 FLOAT Archive_Avg[40 - Average 40] 1 RD_ONLY

7886 FLOAT Archive_Avg[41 - Average 41] 1 RD_ONLY

7887 FLOAT Archive_Avg[42 - Average 42] 1 RD_ONLY

7888 FLOAT Archive_Avg[43 - Average 43] 1 RD_ONLY

7889 FLOAT Archive_Avg[44 - Average 44] 1 RD_ONLY

7890 FLOAT Archive_Avg[45 - Average 45] 1 RD_ONLY

7891 FLOAT Archive_Avg[46 - Average 46] 1 RD_ONLY

7892 FLOAT Archive_Avg[47 - Average 47] 1 RD_ONLY

7893 FLOAT Archive_Avg[48 - Average 48] 1 RD_ONLY

7894 FLOAT Archive_Avg[49 - Average 49] 1 RD_ONLY

7895 FLOAT Archive_Avg[50 - Average 50] 1 RD_ONLY

7896 FLOAT Archive_Avg[51 - Average 51] 1 RD_ONLY

7897 FLOAT Archive_Avg[52 - Average 52] 1 RD_ONLY

7898 FLOAT Archive_Avg[53 - Average 53] 1 RD_ONLY

7899 FLOAT Archive_Avg[54 - Average 54] 1 RD_ONLY

7900 FLOAT Archive_Avg[55 - Average 55] 1 RD_ONLY

7901 FLOAT Archive_Avg[56 - Average 56] 1 RD_ONLY
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7902 FLOAT Archive_Avg[57 - Average 57] 1 RD_ONLY

7903 FLOAT Archive_Avg[58 - Average 58] 1 RD_ONLY

7904 FLOAT Archive_Avg[59 - Average 59] 1 RD_ONLY

7905 FLOAT Archive_Avg[60 - Average 60] 1 RD_ONLY

7906 FLOAT Archive_Avg[61 - Average 61] 1 RD_ONLY

7907 FLOAT Archive_Avg[62 - Average 62] 1 RD_ONLY

7908 FLOAT Archive_Avg[63 - Average 63] 1 RD_ONLY

7909 FLOAT Archive_Avg[64 - Average 64] 1 RD_ONLY

7910 FLOAT Archive_Avg[65 - Average 65] 1 RD_ONLY

7911 FLOAT Archive_Avg[66 - Average 66] 1 RD_ONLY

7912 FLOAT Archive_Avg[67 - Average 67] 1 RD_ONLY

7913 FLOAT Archive_Avg[68 - Average 68] 1 RD_ONLY

7914 FLOAT Archive_Avg[69 - Average 69] 1 RD_ONLY

7915 FLOAT Archive_Avg[70 - Average 70] 1 RD_ONLY

7916 FLOAT Archive_Avg[71 - Average 71] 1 RD_ONLY

7917 FLOAT Archive_Avg[72 - Average 72] 1 RD_ONLY

7918 FLOAT Archive_Avg[73 - Average 73] 1 RD_ONLY

7919 FLOAT Archive_Avg[74 - Average 74] 1 RD_ONLY

7920 FLOAT Archive_Avg[75 - Average 75] 1 RD_ONLY

7921 FLOAT Archive_Avg[76 - Average 76] 1 RD_ONLY

7922 FLOAT Archive_Avg[77 - Average 77] 1 RD_ONLY

7923 FLOAT Archive_Avg[78 - Average 78] 1 RD_ONLY

7924 FLOAT Archive_Avg[79 - Average 79] 1 RD_ONLY

7925 FLOAT Archive_Avg[80 - Average 80] 1 RD_ONLY

7926 FLOAT Archive_Avg[81 - Average 81] 1 RD_ONLY

7927 FLOAT Archive_Avg[82 - Average 82] 1 RD_ONLY

7928 FLOAT Archive_Avg[83 - Average 83] 1 RD_ONLY

7929 FLOAT Archive_Avg[84 - Average 84] 1 RD_ONLY

7930 FLOAT Archive_Avg[85 - Average 85] 1 RD_ONLY

7931 FLOAT Archive_Avg[86 - Average 86] 1 RD_ONLY

7932 FLOAT Archive_Avg[87 - Average 87] 1 RD_ONLY

7933 FLOAT Archive_Avg[88 - Average 88] 1 RD_ONLY

7934 FLOAT Archive_Avg[89 - Average 89] 1 RD_ONLY

7935 FLOAT Archive_Avg[90 - Average 90] 1 RD_ONLY
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7936 FLOAT Archive_Avg[91 - Average 91] 1 RD_ONLY

7937 FLOAT Archive_Avg[92 - Average 92] 1 RD_ONLY

7938 FLOAT Archive_Avg[93 - Average 93] 1 RD_ONLY

7939 FLOAT Archive_Avg[94 - Average 94] 1 RD_ONLY

7940 FLOAT Archive_Avg[95 - Average 95] 1 RD_ONLY

7941 FLOAT Archive_Avg[96 - Average 96] 1 RD_ONLY

7942 FLOAT Archive_Avg[97 - Average 97] 1 RD_ONLY

7943 FLOAT Archive_Avg[98 - Average 98] 1 RD_ONLY

7944 FLOAT Archive_Avg[99 - Average 99] 1 RD_ONLY

7945 FLOAT Archive_Avg[100 - Average 100] 1 RD_ONLY

7946 FLOAT Archive_Avg[101 - Average 101] 1 RD_ONLY

7947 FLOAT Archive_Avg[102 - Average 102] 1 RD_ONLY

7948 FLOAT Archive_Avg[103 - Average 103] 1 RD_ONLY

7949 FLOAT Archive_Avg[104 - Average 104] 1 RD_ONLY

7950 FLOAT Archive_Avg[105 - Average 105] 1 RD_ONLY

7951 FLOAT Archive_Avg[106 - Average 106] 1 RD_ONLY

7952 FLOAT Archive_Avg[107 - Average 107] 1 RD_ONLY

7953 FLOAT Archive_Avg[108 - Average 108] 1 RD_ONLY

7954 FLOAT Archive_Avg[109 - Average 109] 1 RD_ONLY

7955 FLOAT Archive_Avg[110 - Average 110] 1 RD_ONLY

7956 FLOAT Archive_Avg[111 - Average 111] 1 RD_ONLY

7957 FLOAT Archive_Avg[112 - Average 112] 1 RD_ONLY

7958 FLOAT Archive_Avg[113 - Average 113] 1 RD_ONLY

7959 FLOAT Archive_Avg[114 - Average 114] 1 RD_ONLY

7960 FLOAT Archive_Avg[115 - Average 115] 1 RD_ONLY

7961 FLOAT Archive_Avg[116 - Average 116] 1 RD_ONLY

7962 FLOAT Archive_Avg[117 - Average 117] 1 RD_ONLY

7963 FLOAT Archive_Avg[118 - Average 118] 1 RD_ONLY

7964 FLOAT Archive_Avg[119 - Average 119] 1 RD_ONLY

7965 FLOAT Archive_Avg[120 - Average 120] 1 RD_ONLY

7966 FLOAT Archive_Avg[121 - Average 121] 1 RD_ONLY

7967 FLOAT Archive_Avg[122 - Average 122] 1 RD_ONLY

7968 FLOAT Archive_Avg[123 - Average 123] 1 RD_ONLY

7969 FLOAT Archive_Avg[124 - Average 124] 1 RD_ONLY
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7970 FLOAT Archive_Avg[125 - Average 125] 1 RD_ONLY

7971 FLOAT Archive_Avg[126 - Average 126] 1 RD_ONLY

7972 FLOAT Archive_Avg[127 - Average 127] 1 RD_ONLY

7973 FLOAT Archive_Avg[128 - Average 128] 1 RD_ONLY

7974 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

7975 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

7976 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

7977 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY

7978 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

7979 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY

7980 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

7981 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

7982 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

7983 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY

7984 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

7985 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

7986 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

7987 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

7988 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

7989 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

7990 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

7991 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

7992 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

7993 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

7994 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

7995 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

7996 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

7997 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY

7998 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

7999 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY

8000 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

8001 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

8002 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

8003 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY
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8004 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

8005 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

8006 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

8007 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

8008 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

8009 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

8010 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

8011 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

8012 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

8013 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

8014 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

8015 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

8016 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

8017 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY

8018 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

8019 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY

8020 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

8021 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

8022 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

8023 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY

8024 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

8025 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

8026 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

8027 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

8028 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

8029 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

8030 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

8031 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

8032 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

8033 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

8034 FLOAT Last FCalib_New Resp Factor[1 - Component 1] RD_ONLY

8035 FLOAT Last FCalib_New Resp Factor[2 - Component 2] RD_ONLY

8036 FLOAT Last FCalib_New Resp Factor[3 - Component 3] RD_ONLY

8037 FLOAT Last FCalib_New Resp Factor[4 - Component 4] RD_ONLY
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8038 FLOAT Last FCalib_New Resp Factor[5 - Component 5] RD_ONLY

8039 FLOAT Last FCalib_New Resp Factor[6 - Component 6] RD_ONLY

8040 FLOAT Last FCalib_New Resp Factor[7 - Component 7] RD_ONLY

8041 FLOAT Last FCalib_New Resp Factor[8 - Component 8] RD_ONLY

8042 FLOAT Last FCalib_New Resp Factor[9 - Component 9] RD_ONLY

8043 FLOAT Last FCalib_New Resp Factor[10 - Component 10] RD_ONLY

8044 FLOAT Last FCalib_New Resp Factor[11 - Component 11] RD_ONLY

8045 FLOAT Last FCalib_New Resp Factor[12 - Component 12] RD_ONLY

8046 FLOAT Last FCalib_New Resp Factor[13 - Component 13] RD_ONLY

8047 FLOAT Last FCalib_New Resp Factor[14 - Component 14] RD_ONLY

8048 FLOAT Last FCalib_New Resp Factor[15 - Component 15] RD_ONLY

8049 FLOAT Last FCalib_New Resp Factor[16 - Component 16] RD_ONLY

8050 FLOAT Last FCalib_New Resp Factor[17 - Component 17] RD_ONLY

8051 FLOAT Last FCalib_New Resp Factor[18 - Component 18] RD_ONLY

8052 FLOAT Last FCalib_New Resp Factor[19 - Component 19] RD_ONLY

8053 FLOAT Last FCalib_New Resp Factor[20 - Component 20] RD_ONLY

8054 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8055 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8056 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY

8057 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8058 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8059 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8060 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8061 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8062 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8063 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8064 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8065 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY

8066 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8067 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8068 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8069 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8070 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY

8071 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY
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8072 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8073 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

8074 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8075 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8076 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY

8077 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8078 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8079 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8080 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8081 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8082 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8083 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8084 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8085 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY

8086 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8087 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8088 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8089 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8090 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY

8091 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY

8092 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8093 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

8094 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8095 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8096 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY

8097 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8098 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8099 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8100 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8101 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8102 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8103 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8104 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8105 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY
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8106 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8107 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8108 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8109 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8110 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY

8111 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY

8112 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8113 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

8114 FLOAT Last FCalib_New Ret Time[1 - Component 1] RD_ONLY

8115 FLOAT Last FCalib_New Ret Time[2 - Component 2] RD_ONLY

8116 FLOAT Last FCalib_New Ret Time[3 - Component 3] RD_ONLY

8117 FLOAT Last FCalib_New Ret Time[4 - Component 4] RD_ONLY

8118 FLOAT Last FCalib_New Ret Time[5 - Component 5] RD_ONLY

8119 FLOAT Last FCalib_New Ret Time[6 - Component 6] RD_ONLY

8120 FLOAT Last FCalib_New Ret Time[7 - Component 7] RD_ONLY

8121 FLOAT Last FCalib_New Ret Time[8 - Component 8] RD_ONLY

8122 FLOAT Last FCalib_New Ret Time[9 - Component 9] RD_ONLY

8123 FLOAT Last FCalib_New Ret Time[10 - Component 10] RD_ONLY

8124 FLOAT Last FCalib_New Ret Time[11 - Component 11] RD_ONLY

8125 FLOAT Last FCalib_New Ret Time[12 - Component 12] RD_ONLY

8126 FLOAT Last FCalib_New Ret Time[13 - Component 13] RD_ONLY

8127 FLOAT Last FCalib_New Ret Time[14 - Component 14] RD_ONLY

8128 FLOAT Last FCalib_New Ret Time[15 - Component 15] RD_ONLY

8129 FLOAT Last FCalib_New Ret Time[16 - Component 16] RD_ONLY

8130 FLOAT Last FCalib_New Ret Time[17 - Component 17] RD_ONLY

8131 FLOAT Last FCalib_New Ret Time[18 - Component 18] RD_ONLY

8132 FLOAT Last FCalib_New Ret Time[19 - Component 19] RD_ONLY

8133 FLOAT Last FCalib_New Ret Time[20 - Component 20] RD_ONLY

8134 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8135 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8136 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8137 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8138 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8139 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY
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8140 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8141 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8142 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8143 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8144 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY

8145 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8146 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8147 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY

8148 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8149 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8150 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8151 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8152 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8153 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY

8154 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8155 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8156 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8157 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8158 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8159 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY

8160 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8161 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8162 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8163 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8164 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY

8165 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8166 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8167 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY

8168 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8169 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8170 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8171 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8172 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8173 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY
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8174 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8175 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8176 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8177 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8178 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8179 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY

8180 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8181 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8182 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8183 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8184 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY

8185 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8186 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8187 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY

8188 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8189 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8190 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8191 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8192 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8193 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY

8194 FLOAT Last FCalib_Old Resp Factor[1 - Component 1] RD_ONLY

8195 FLOAT Last FCalib_Old Resp Factor[2 - Component 2] RD_ONLY

8196 FLOAT Last FCalib_Old Resp Factor[3 - Component 3] RD_ONLY

8197 FLOAT Last FCalib_Old Resp Factor[4 - Component 4] RD_ONLY

8198 FLOAT Last FCalib_Old Resp Factor[5 - Component 5] RD_ONLY

8199 FLOAT Last FCalib_Old Resp Factor[6 - Component 6] RD_ONLY

8200 FLOAT Last FCalib_Old Resp Factor[7 - Component 7] RD_ONLY

8201 FLOAT Last FCalib_Old Resp Factor[8 - Component 8] RD_ONLY

8202 FLOAT Last FCalib_Old Resp Factor[9 - Component 9] RD_ONLY

8203 FLOAT Last FCalib_Old Resp Factor[10 - Component 10] RD_ONLY

8204 FLOAT Last FCalib_Old Resp Factor[11 - Component 11] RD_ONLY

8205 FLOAT Last FCalib_Old Resp Factor[12 - Component 12] RD_ONLY

8206 FLOAT Last FCalib_Old Resp Factor[13 - Component 13] RD_ONLY

8207 FLOAT Last FCalib_Old Resp Factor[14 - Component 14] RD_ONLY
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8208 FLOAT Last FCalib_Old Resp Factor[15 - Component 15] RD_ONLY

8209 FLOAT Last FCalib_Old Resp Factor[16 - Component 16] RD_ONLY

8210 FLOAT Last FCalib_Old Resp Factor[17 - Component 17] RD_ONLY

8211 FLOAT Last FCalib_Old Resp Factor[18 - Component 18] RD_ONLY

8212 FLOAT Last FCalib_Old Resp Factor[19 - Component 19] RD_ONLY

8213 FLOAT Last FCalib_Old Resp Factor[20 - Component 20] RD_ONLY

8214 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8215 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY

8216 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8217 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8218 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY

8219 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8220 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8221 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY

8222 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8223 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8224 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8225 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8226 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8227 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8228 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8229 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8230 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8231 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8232 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8233 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8234 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8235 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY

8236 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8237 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8238 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY

8239 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8240 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8241 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY

Reference Manual Pre-defined Modbus® Map Files
2-3-9000-744 July 2020

Rosemount 700XA 371



Register # Data type Variable Record # Access Format

8242 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8243 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8244 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8245 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8246 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8247 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8248 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8249 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8250 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8251 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8252 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8253 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8254 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8255 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY

8256 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8257 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8258 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY

8259 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8260 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8261 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY

8262 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8263 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8264 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8265 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8266 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8267 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8268 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8269 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8270 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8271 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8272 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8273 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8274 FLOAT Last FCalib_Old Ret Time[1 - Component 1] RD_ONLY

8275 FLOAT Last FCalib_Old Ret Time[2 - Component 2] RD_ONLY
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Register # Data type Variable Record # Access Format

8276 FLOAT Last FCalib_Old Ret Time[3 - Component 3] RD_ONLY

8277 FLOAT Last FCalib_Old Ret Time[4 - Component 4] RD_ONLY

8278 FLOAT Last FCalib_Old Ret Time[5 - Component 5] RD_ONLY

8279 FLOAT Last FCalib_Old Ret Time[6 - Component 6] RD_ONLY

8280 FLOAT Last FCalib_Old Ret Time[7 - Component 7] RD_ONLY

8281 FLOAT Last FCalib_Old Ret Time[8 - Component 8] RD_ONLY

8282 FLOAT Last FCalib_Old Ret Time[9 - Component 9] RD_ONLY

8283 FLOAT Last FCalib_Old Ret Time[10 - Component 10] RD_ONLY

8284 FLOAT Last FCalib_Old Ret Time[11 - Component 11] RD_ONLY

8285 FLOAT Last FCalib_Old Ret Time[12 - Component 12] RD_ONLY

8286 FLOAT Last FCalib_Old Ret Time[13 - Component 13] RD_ONLY

8287 FLOAT Last FCalib_Old Ret Time[14 - Component 14] RD_ONLY

8288 FLOAT Last FCalib_Old Ret Time[15 - Component 15] RD_ONLY

8289 FLOAT Last FCalib_Old Ret Time[16 - Component 16] RD_ONLY

8290 FLOAT Last FCalib_Old Ret Time[17 - Component 17] RD_ONLY

8291 FLOAT Last FCalib_Old Ret Time[18 - Component 18] RD_ONLY

8292 FLOAT Last FCalib_Old Ret Time[19 - Component 19] RD_ONLY

8293 FLOAT Last FCalib_Old Ret Time[20 - Component 20] RD_ONLY

8963 FLOAT Clear All Alarms RD_WR

8964 FLOAT Acknowledge All Alarms RD_WR

9006 INT Current Time(time_t) RD_WR MM

9007 INT Current Time(time_t) RD_WR DD

9008 INT Current Time(time_t) RD_WR YYYY

9009 INT Current Time(time_t) RD_WR hh

9010 INT Current Time(time_t) RD_WR mm

9011 INT Current Time(time_t) RD_WR ss

9012 INT Unused RD_ONLY

9013 INT Modbus Id[1 - Port 0] RD_ONLY

9014 INT Site Id RD_WR

9022 INT Analysis Time RD_ONLY

9023 INT Unused RD_ONLY

9024 INT Cycle Time RD_ONLY

9025 INT Unused RD_ONLY

9026 INT Run Time RD_ONLY
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Register # Data type Variable Record # Access Format

9027 INT Unused RD_ONLY

9028 INT Current Stream RD_ONLY

9029 INT Unused RD_ONLY

9030 INT GC Control_Analyser Control (Write Reg 9030) RD_WR

9031 INT Unused RD_ONLY

9032 INT GC Calibrating RD_ONLY

9033 INT Unused RD_ONLY

9034 INT Active Alarm Flag RD_ONLY

9035 INT UnAck Alarm Flag RD_ONLY

9036 INT Hourly Average Reset time RD_ONLY YY

9037 INT Hourly Average Reset time RD_ONLY MM

9038 INT Hourly Average Reset time RD_ONLY DD

9039 INT Hourly Average Reset time RD_ONLY hh

9040 INT Hourly Average Reset time RD_ONLY mm

9041 INT Daily Average Reset time RD_ONLY YY

9042 INT Daily Average Reset time RD_ONLY MM

9043 INT Daily Average Reset time RD_ONLY DD

9044 INT Daily Average Reset time RD_ONLY hh

9045 INT Daily Average Reset time RD_ONLY mm

9046 INT Weekly Average Reset time RD_ONLY YY

9047 INT Weekly Average Reset time RD_ONLY MM

9048 INT Weekly Average Reset time RD_ONLY DD

9049 INT Weekly Average Reset time RD_ONLY hh

9050 INT Weekly Average Reset time RD_ONLY mm

9051 INT Monthly Average Reset time RD_ONLY YY

9052 INT Monthly Average Reset time RD_ONLY MM

9053 INT Monthly Average Reset time RD_ONLY DD

9054 INT Monthly Average Reset time RD_ONLY hh

9055 INT Monthly Average Reset time RD_ONLY mm

9056 INT Variable Average Reset time RD_ONLY YY

9057 INT Variable Average Reset time RD_ONLY MM

9058 INT Variable Average Reset time RD_ONLY DD

9059 INT Variable Average Reset time RD_ONLY hh

9060 INT Variable Average Reset time RD_ONLY mm

Pre-defined Modbus® Map Files Reference Manual
July 2020 2-3-9000-744

374 Emerson.com/Rosemount



3099...3102 (Valid data flags): This flag is set to 1 when new valid data is put into the
Modbus registers and set to 0 if an alarm is active. The 4 copies of this flag operate in the
same way; they are intended for use by up to 4 independent Modbus master devices
attached to the 4 serial ports. This is a read-write register, so the Modbus Master can clear
the flag once the new results are read.

3103...3182 (Calibration update flags): Set to 1 when response factors are updated
during a calibration.

5001 (Last Analy_Cycle Time (1/30th sec)): Cycle time for last analysis in 1/30th seconds.
For example, if cycle time is 300 seconds, this register reads 9000.

5002 (Last Cal_Cycle Time (1/30th sec)): Cycle time for last calibration in 1/30th seconds.
For example, if cycle time is 300 seconds, this register reads 9000.

7001...70016 (Last Analy Mole %): These registers hold the mole % results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001...3016 which contains the component codes.

7017...7032 (Last Analy Weight %): These registers hold the weight % results for the last
analysis run. The order of components in these registers can be determined by reading
Register 3001...3016 which contains the component codes.

7033...7039 : Last analysis stream results.

7040...7044: User calculation results 1...5.

7046...7054: Last analysis stream results.

7070...7084: Most recent archive averages for Averages 1...15.

7085...7086: Current analog input values for Analog Input 1 and 2.

7087...7090: Last analysis stream results.

7091: Number of total calibration runs.

7092: Number of averaged calibration runs.

7093: Auto calibration start time.

7094: (Stream Sequence Select): Read-write register. When read, returns currently
selected stream sequence. To change stream sequence, write sequence number.

Value Stream sequence

1 Default stream sequence

2 Aux stream sequence 1

3 Aux stream sequence 2

7095...7110 (Last Analysis Response Factors): Response factor for Components 1...16
used on last run.

7111...7121: Results from last calibration.

7122: Calibration stream number.

7123...7125: Last analysis GS(M)R results.
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7126...7161: Current running averages for Averages 1...36.

7162...7197: Maximum sample value during current averaging period for Averages 1...36.

7198...7233: Minimum sample value during current averaging period for averages 1...36.

7234...7269: Most recent archived averages for Averages 1 through 36.

7270...7305: Maximum sample value in the second most recent archived average for
Averages 1...36.

7306...7341: Minimum sample value in the second most recent archived average for
Averages 1...36.

7342...7377: Second most recent archived averages for Averages 1...36.

7378...7413: Maximum sample value in the second most recent archived average for
Averages 1...36.

7414...7449: Minimum sample value in the second most recent archived average for
averages 1...36.

7450...7485: Third most recent archived averages for Averages 1...36.

7586...7621: Maximum sample value in the third most recent archived averages for
Averages 1...36.

7521...7557: Minimum sample value in the third most recent archived averages for
Averages 1...36.

7558...7573: Multi-level calibration coefficient a components 1...16.

7572...7589: Multi-level calibration coefficient b components 1...16.

7590...7605: Multi-level calibration coefficient c components 1...16.

7606...7621: Multi-level calibration coefficient d components 1...16.

7622...7637: Indirect calibration - relative response factors for components 1...16.

7638...7717: Repeat of 7558...7637 above for component table 2.

7718...7845: Current running averages for Averages 1...128.

7486..7973: Most recent archived averages for Averages 1...128.

7974...8053: Current response factors.

8054...8133: Current retention times.

8214...8293: Retention times from previous calibration.

8963 (Clear All Alarms): Write 1 to this register to clear all active alarms.

8964 (Acknowledge All Alarms): Write 1 to this register to acknowledge all alarms.

9006...9011: GC system date/time read-write registers.

9013 (Modbus ID [Port 0]): Modbus ID for Serial Port 0.

9014 (Site ID): GC site ID read-write register.

9022 (Analysis Time): Analysis time.
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9024 (Cycle Time): Cycle time.

9026 (Run Time): Run time.

9028 (Current Stream): Stream number.

9030 (Analyzer Control): Section B.6.

9032 (GC Calibrating): Tells you if the GC is calibrating. A value of 1 means the GC is
calibrating, 0 otherwise.

9034 (Active Alarm Flag): Tells you if the GC has any active alarms. A value of 1 indicates
that there are active alarms, 0 otherwise.

9035 (UnAck Alarm Flag): Tells you if the GC has any unaknowledged alarms. A value of 1
indicates that there are unacknowledged alarms, 0 otherwise.

9036...9040 (Hourly Average Reset Time): Date/time when hourly average results were
archived.

9041...9045 (Daily Average Reset Time): Date/time when daily average results were
archived.

9046...9047 (Weekly Average Reset Time): Date/time when weekly average results were
archived.

9051...9055 (Monthly Average Reset Time): Date/time when monthly averaged results
were archived.

9056...9060 (Variable Average Reset Time): Date/time when variable average results
were archived.

F.6 Remote control registers
Modbus register Description

GC Control_Auto Sequence Start chromatograph auto sequencing. Normally 0.0; write non-zero value to initiate
sequencing.
1.0 - start with purge

2.0 - start without purge

GC Control_Halt Halt chromatograph sequencing - Normally 0.0; write 1.0 to perform halt.

GC Control_Single Stream Start single stream run - Normally 0.0. Continuous Single Stream mode: Write the stream
number (in floating point) to start with a purge and the negative of the stream number to
start without a purge. Single Analysis Non-continuous Single Stream mode: Write (128.0 + the
stream number) (in floating point) to start with a purge, and the negative of (128.0 + the
stream number) to start without a purge.

GC Control_Calibration Start calibration sequence - Normally 0.0. For Normal Calibration: Write the stream number
of the calibration stream in floating point to start calibration sequence with a purge, or write
the negative of the stream number to start calibration sequence without a purge.
For Forced Calibration: Write (128.0 + stream number) of the cal stream in floating point to
start calibration sequence with a purge or writes the negative of (128 + stream number) of
the cal stream to start a calibration sequence without a purge.
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Modbus register Description

GC Control_Validation Start validation sequence - Normally 0.0. For Validation: Write the stream number of the
Validation stream in floating point to start validation sequence with a purge, or write the
negative of the stream number to start validation sequence without a purge.

GC Control -> Validation
Acknowledge

GC copies Start Validation command to this register; PLC can reset after confirming that
command was successfully issued.

GC Control_Stream Sequence
Select

Read-write register. When read, returns currently selected stream sequence. To change
stream sequence, write sequence number.

Value Stream sequence

1 Default stream sequence

2 Aux stream sequence 1

3 Aux stream sequence 2

Stream Sequence - Default Stream
Sequence

Reads the sequence of streams. For example, if current Sequence is 1, 2, then this register
reads a value of 12. To change the sequence of streams: For example, to change the
Sequence to 2,3, write 23 to this register.

GC Status > GC Running GC is running.
0 - GC is idle

1 - GC is running (Auto Analysis, Single Stream, Calibration, Validation)

GC Status > Current Analysis Mode Indicates mode of operation:
0 - GC Idle

1 - Auto Sequence

2 - Single Stream

3 - Manual Calibration

4 - Manual Validation
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F.7 Read-write remote control register (9030)
9030 is a read-write register that can be used for controlling GC operation and for reading
current operating mode.

The mode values read from register 9030 are:

0 Idle

1 In automatic sequencing mode

2 Running in single stream mode

3 Calibrating

4 Warm starting, running confidence tests

5 Validating (added in Firmware Version 2.1.0 and higher)

The commands that can be written to register 9030 are:

0 Halt at the end of the current analysis

1 Start automatic sequencing mode

2 Start a normal calibration, on first calibration stream

3 Run single analysis on stream 1, then halt

4 Run continually on stream 1

5 Run a single analysis on stream 2, then halt

6 Run continually on stream 2

7 Run a single analysis on stream 3, then halt

8 Run continuously on stream 3

9 Run a single analysis on stream 4, then halt

10 Run continually on stream 4

11 Run a single analysis on stream 5, then halt

12 Run continually on stream 5

13 Run a single analysis on stream 6, then halt

14 Run continually on stream 6

15 Run a single analysis on stream 7, then halt

16 Run continuously on stream 7

17 Run a single analysis on stream 8, then halt

18 Run continuously on stream 8

19 Run validation on first validation stream (added in Firmware Version 2.1.0 and higher)

...

41 Run normal calibration on stream 1 (added in Firmware Version 2.1.0 and higher)

42 Run normal calibration on stream 2 (added in Firmware Version 2.1.0 and higher)

...
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60 Run normal calibration on stream 20 (added in Firmware Version 2.1.0 and higher)

...

81 Run validation on stream 1 (added in Firmware Version 2.1.0 and higher)

82 Run validation on stream 2 (added in Firmware Version 2.1.0 and higher)

...

100 Run validation on stream 20 (added in Firmware Version 2.1.0 and higher)

Commands 1-19, 41-60, and 81-100 above are with 60 seconds purge. Adding 20 to any
command means no purge if relevant. These writes are done using Modbus functions 6 or
16. Except for commands 0 and 2, the GC must be idle. If a command fails because the GC
was not idle or because the code is invalid or the stream is not used, a Modbus exception
illegal data value will be returned. All these commands are allowed without requiring a
password or the security switch to be unlocked. These commands are available to both
User Modbus ports and SIM_2251 Modbus ports.

F.8 Writable Modbus registers
The following list documents all the Modbus registers in the GC that can be written when
the GC is under legal metrology control with the security switch locked. Please note that
not all the registers in this table are available in the SIM_2251 mapping.

Modbus register Remarks

GC Status -> Current Month Set GC clock. All 5 registers can be written in a single
request, or individual registers can be written. The new
date/time is validated before the GC system clock is
changed.

GC Status -> Current Day

GC Status -> Current Year

GC Status -> Current Hour

GC Status -> Current Minute

GC Status -> New Data Flag Flags for synchronizing Master and Slave. The Slave (GC)
updates its result registers and then sets the flag to 1. The
Master (PLC/Flow Computer) reads the data and resets the
flag to 0.

GC Status -> Hourly Avg Updated

GC Status -> Weekly Avg Updated

GC Status -> Daily Avg Updated

GC Status -> Monthly Avg Updated

GC Status -> Last Run Data Valid 1

GC Status -> Last Run Data Valid 2

GC Status -> Last Run Data Valid 3

GC Status -> Last Run Data Valid 4
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Modbus register Remarks

GC Status -> Last Run Data Valid 5

GC Status -> Last Run Data Valid 6

GC Status -> Last Run Data Valid 7

GC Status -> Last Run Data Valid 8

GC Status -> Last Run Data Valid 9

GC Status -> Last Run Data Valid 10

Stream 1 -> New Data Available

Stream 2 -> New Data Available

Stream 3 -> New Data Available

Stream 4 -> New Data Available

Stream 5 -> New Data Available

Stream 6 -> New Data Available

Stream 7 -> New Data Available

Stream 8 -> New Data Available

Stream 9 -> New Data Available

Stream 10 -> New Data Available

Stream 11 -> New Data Available

Stream 12 -> New Data Available

Stream 13 -> New Data Available

Stream 14 -> New Data Available

Stream 15 -> New Data Available

Stream 16 -> New Data Available

Stream 17 -> New Data Available

Stream 18 -> New Data Available

Stream 19 -> New Data Available

Stream 20 -> New Data Available

Discrete Output 1 -> Switch Master can write the following values to this register -

0 - Sets the discrete output to Off.

1 - Sets the discrete output to On.

2 - Sets the discrete output to Automatic (DO controller by
GC's timed events).

Discrete Output 2 -> Switch

Discrete Output 3 -> Switch

Discrete Output 4 -> Switch

Discrete Output 5 -> Switch
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Modbus register Remarks

Dewpoint Configuration 1 -> Pressure 1 Pressure at which hydrocarbon dewpoint results are
computed. Used only for dual-detector C9+ hydrocarbon
dewpoint GCs. These registers are not used in C6+ custody
transfer applications.

Dewpoint Configuration 1 -> Pressure 2

Dewpoint Configuration 1 -> Pressure 3

Dewpoint Configuration 1 -> Pressure 4

Dewpoint Configuration 2 -> Pressure 1

Dewpoint Configuration 2 -> Pressure 2

Dewpoint Configuration 2 -> Pressure 3

Dewpoint Configuration 2 -> Pressure 4

Dewpoint Configuration 3 -> Pressure 1

Dewpoint Configuration 3 -> Pressure 2

Dewpoint Configuration 3 -> Pressure 3

Dewpoint Configuration 3 -> Pressure 4

Dewpoint Configuration 4 -> Pressure 1

Dewpoint Configuration 4 -> Pressure 2

Dewpoint Configuration 4 -> Pressure 3

Dewpoint Configuration 4 -> Pressure 4

GC Control_Auto Sequence Start chromatograph auto sequencing.

Normally 0.0; write non-zero value to initiate sequencing.

1.0 - Start with purge.

2.0 - Start without purge.

GC Control_Halt Halt chromatograph sequencing -

Normally 0.0; write 1.0 to perform halt.

GC Control_Single Stream Start single stream run.

Normally 0.0.

Continuous Single Stream mode:
Write the stream number (in floating point) to start with a
purge, and the negative of the stream number to start
without a purge.

Single Analysis Non-continuous Single Stream mode:
Write (128.0 + the stream number) (in floating point) to
start with a purge and the negative of (128.0 + the stream
number) to start without a purge.
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Modbus register Remarks

GC Control_Calibration Start calibration sequence.

Normally 0.0.

For normal calibration:
Write the stream number of the calibration stream in
floating point to start calibration sequence with a purge or
write the negative of the stream number to start
calibration sequence without a purge.

GC Control_Validation Start validation sequence.

Normally 0.0.

For validation:
Write the stream number of the validation stream in
floating point to start validation sequence with a purge or
write the negative of the stream number to start validation
sequence without a purge.

GC Control_Stream Sequence Select Read-write register. When read, returns currently selected
stream sequence. To change stream sequence, write the
sequence number.
Value stream sequence

Value Stream sequence

1 Default stream sequence

2 Aux stream sequence 1

3 Aux stream sequence 2

GC Control_Analyzer Control (Write Reg 9030) GC remote control register. Please refer to Read-write
remote control register (9030).

for details.

Acknowledge All Alarms Normally 0.0. Write 1 to acknowledge all alarms.

Component Data 1_Calib Conc[Component 1..15] Update calibration concentration from PLC before starting
calibration.

Component Data 1_Resp Fact %[ Component 1..15] Update response factors from PLC.

Stream Sequence - Default Stream Sequence Reads the sequence of streams. For example, if the current
Sequence is 1, 2, then this register reads a value of 12.

To change the sequence of streams:
For example, to change the Sequence to 2,3, write 23 to
this register.

GC Control_Auto Valve Timing Start auto valve timing. Normally 0.0. Write
• Calibration stream number: to start AVT from current

settings.

• Calibration stream number + 20 - to start AVT from
default settings.
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G Engineering drawings

G.1 List of engineering drawings - Rosemount
700XA
This addendum contains the following engineering drawings:

• BE-22175 Label Set Field Wiring Card 1 (Sheets 1, 2, and 3)

• DE-22050 Outline and Dimensional Pole, Wall and Floor Mounting Units, 700XA

• CE-22260 Assembly, 6 Port XA Valve, Model 700XA

• CE-22300 Assembly, 10 Port XA Valve, Model 700XA

• DE-22143 (Sheets 1-7) Unit Assembly 700XA GC
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